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All of the people working in research labs, 
all those working in hardware and software 
companies, all of us working at Digit, and all of 
you – readers of tech magazines, web sites, and 
tech enthusiasts – all taken together, constitute 
a minority in the grand scheme of things. And 
not the whole of that minority, mind you, knows 
enough about technology to practise it well.

Over the past decade or so, I have seen 
technology enter every aspect of our lives, and 
the mobile phone is perhaps now the starting 
point for most of the world. However, I still find 
so many causes for complaint, when I encounter 
people who should just know better.

I can’t begin to describe the disappoint-
ment I feel when I speak to customer service 
representatives who know less than I do about 
their product. And no, I’m not special, most of 
you who read this magazine, have had similar 
encounters. 

Almost every month I find myself arguing, 
quite fruitlessly, with my ISP’s representatives, 
over some issue or another. Most often it’s a 
badly configured server, or some technical prob-
lem with their lines that causes me to call them. 
Of course all I get in return is standard verbiage, 
and ridiculous requests to “delete my IE cache”. 
I don’t even use IE, and what’s IE got to do with 
the fact that their DNS server is down? Why 
should I have to spend 15 minutes of my life, 
every month,  educating people about how their 
system is supposed to work?

The common everyday system assembler is 
no different. I can’t tell you how many times I’ve 
seen rear system fans pushing air into a cabinet, 
instead of out; or CPUs that run hot because the 
guy who threw it together thought, “Thermal 
paste? You can probably never have enough!”

The technology service providers across 
SoHos and SMBs are no better. Yes I will admit 
that there are quite a few gems, in this field, but 
overall, it’s just sad to see the pathetic state of 
knowledge and awareness.

I’ve spoken to quite a few small business 
owners who just cannot seem to find an afford-
able and reliable enough maintenance provider. 
One such company’s network was recently 
assailed by the Conficker worm, and a whole 
host of other malware. As usual, the sys-admin 
(from an outsourced company), felt the best 
solution was to format-reinstall Windows on 
individual computers. However, it was sad to see 
that he didn’t seem to have the common sense 
to unplug the LAN cable when reinstalling the 
OS, ensuring to plug it back in only after install-
ing an updated anti-virus software. As a result, 
by the time I pointed this out to him, he had 
formatted and reinstalled Windows on 3 PCs 

over 4 times each! Shouldn’t someone you pay 
to protect your PCs and data know such a basic 
thing? What about all the man-hours wasted?

Working in a media company, I also get a 
lot of FTP login details, to get ads, transfer pages, 
download images – the usual deal. I can’t begin 
to tell you how many times I’ve found the pass-
words to be weak, and sometimes, it’s the same 
as the root password to the actual server’s OS!

Then there’s the whole web site business, 
which is just another example of the visually 
impaired leading the blind. I’ve seen people with 
a distrust for open source software’s security, 
get custom-coded solutions that either break or 
have security holes the size of a bus. Very often, 
the “product” provided is just an open source 
package that’s coded on top of, without proper 
understanding of, the original code, thus result-
ing in security holes. If not, then it’s custom-
coded, without following some basic principles 
of security. 

The advantage we’ve always had at Digit, 
is the fact that we’re all a bunch of technology 
fanatics. There’s always someone around who 
will offer up better solutions, and all of us can 
troubleshoot, rip apart and rebuild our own 
PCs. We’re blessed with a lot of people who have 
the “tech sense” – or basically a combination 
of common sense, technology knowledge and 
experience. 

Although this tech sense has helped us stay 
numero uno in your eyes, we’re not content to sit 
back and do nothing more. Doing more, however, 
is not possible if we look at you as “readers” of a 
magazine. Starting this month, and hopefully a 
regular feature from now on – depending on the 
way you respond – we will be looking to interact 
more with you. Whether it’s online through our 
web site, via e-mail, in real-time via live chats, or 
face-to-face workshops, we’re going to go beyond 
the scope of any “magazine”, and try to empower 
the tech community of India.

Whether it’s saving you assembly costs by 
teaching you how to do it yourself, or help-
ing you use technology better, we’re going to 
listen to some of our readers who asked for an 
increased level of interaction, and help more 
people develop better “tech sense”. 

Turn to page 28 to find out more, and don’t 
forget to write in and tell me if you have some 
suggestions about how we can help more.

The Tech-sense
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Ninja Blade
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MULTIMEDIA
Apple iTunes 8.1.1

iTunes is a free application for Mac 
and PC. It plays all your digital music 
and video. It syncs content to your 
iPod, iPhone, and Apple TV. And it’s an 
entertainment superstore that stays 
open 24/7.

Vue 7 Pioneer 7.0

Easily create your own 3D worlds 
with Vue 7 Pioneer. Create vast 
expanses of terrains, add trees, 
select the best point of view and 
render hyper-realistic images 
of your landscapes in moody 
atmospheres in a few mouse clicks. 
Vue 7 Pioneer is a great way to learn 
3D. It’s so easy to use that you’ll be 
composing amazing 3D landscapes 
in no time. Vue 7 Pioneer is derived 
from the research e-on software 
makes for the high-end products it 
sells to large special effects studios.
■ ALShow 1.7
■ AndreaMosaic 3.31
■ Ashampoo Photo 
■ Optimizer Free 1.20
■ BurnAware Free 2.3.3
■ Contenta-Converter
 Basic 4.2
■ DarkWave Studio 2.7.2 
■ DivX Player 7.1.0.74
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■ WIA-Loader 1.5.2.0
■ WildFire CD Ripper 2.9
■ Zortam Mp3 Media Studio 9.10e

INTERNET
SeaMonkey 1.1.15
Web-browser, advanced e-mail and 
newsgroup client, IRC chat client, and 
HTML editing made simple - all your 
Internet needs in one application.

■ Hermes P2P 2.9
■ Billeo 2.0.0.15
■ BitKinex 3.1.1
■ BitsCast 0.14
■ FileZilla 3.2.3.1
■ GigaTribe 2.51
■ Gladinet Cloud Desktop Professional 
■ Edition 0.9.92 beta
■ InternetScrap 2.40
■ LimeWire 5.1.2 
■ Make Your Own Browser 3.19.09
■ NetPen 0.97
■ Orbit Downloader 2.8.8
■ Skimmer beta
■ Vuze 4.2
■ Xcelerator 1.2

SYSTEM
Moo0 SystemMonitor 1.37

Moo0 SystemMonitor lets you keep your 
eye on system resource usages of your PC. It 
currently supports 30 kinds of information 
including CPU, Memory, Network, and 
detailed HDD usages. Using this software, 
you may discover what is limiting your 
system performance in each occasion.
■ Allway Sync 9.2.11
■ AutoRuns 9.41
■ Daphne 1.41
■ Driver Magician Lite 3.5
■ Fast Duplicate File Finder 1.1
■ Fresh UI 8.28
■ Hawkscope 0.6.0
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■ Wise Disk Cleaner 4.23
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ESSENTIALS
■ .net Framework 2.0
■ .net Framework 3.5
■ Avast Home Edition 4.8
■ Comodo Internet Security Pro
■ 3.5.55810.432
■ Foxit Reader 3.0
■ Free Download Manager 2.5 build 758
■ Irfan View 4.20
■ Java(TM) 2 Runtime
■ K-Lite Mega Codec Pack FULL 4.2.5
■ Opera 9.64
■ Silverlight
■ Spybot Search and Destroy 1.6.0
■ VLC Player 0.9.4
■ WinRAR 3.80
■ µTorrent 1.8.1

UPDATES AND ADD-ONS
■ Adobe Shockwave

Gaming
GAMES
Wanted: Weapons of Fate 

Wanted is a video game based on 
the movie of the same name and 
features assassin time and curving 
bullets gameplay.
■ Watchmen: The End Is Nigh 
■ Codename Panzers: Cold War MP Flock
■ Myth II: Soulblighter v1.5.1

GAME TRAILERS
Jumpgate Evolution 

Nothing can prepare you for the 
journey that is about to unfold... 
The galaxy is in a fragile state, 
balanced on the brink of war. New 
threats emerge from the unknown 
depths of space, reaching forth with 
an iron grip, threatening to bring 
the surviving Nations of humanity 
to their knees.
■ Alpha Protocol
■ Black Prophecy 
■ Blade and Soul
■ Burn Zombie Burn
■ E.Y.E
■ Marvel: Ultimate Alliance 2
■ Metal Rage
■ Modern Warfare 2
■ Prototype

Entertainment
HD TRAILERS
Big Man Japan

A man transforms into a giant to 
fight monsters invading Tokyo in 
this ockumentary
■ 12 Rounds
■ Cloudy With a Chance of Meatballs 
■ Hunger
■ Ice Age: Dawn of the Dinosaurs
■ Sleep Dealer
■ Surveillance
■ The Song of Sparrows
■ Where the Wild Things Are
■ Year One

ANIMATIONS
■ Hector’s Hectic Life
■ The Cobweb Hotel
■ The Curious Adventures of Mr.
■ Wonderbird

Linux
ESSENTIALS
■ 7zip
■ amarok
■ Audacity
■ Mplayer Codec Pack
■ Pidgin
■ Vuze
■ Wine

DISTROS
■ Mandriva 2009.1 RC2
■ Nexenta 1.0.1
■ System Rescue CD 1.1.7
■ XPud 0.8.9
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Bryce 5.5
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■ Samsung Pixon Unboxing
■ Watchmen
■ XBMC

MAGAZINE CONTENTS
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FAST TRACK
Camstudio 2.0

CamStudio is able to record all screen 
and audio activity on your computer 
and create industry-standard AVI 
video files and using its built-in 
SWF Producer can turn those AVIs 
into lean, mean, bandwidth-friendly 
Streaming Flash videos (SWFs)
■ Tagscanner 5.3.1
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■ AVG Anti-Virus Free
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■ Burn4Free 6.6.0.0
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■ Wavosaur 1.0.4.0
■ Winamp 5.5.5.1

Tools
CREATE
Cool MP3 Mixer 1.01

Cool MP3 Mixer is an intuitive multi-
track mp3 sound recording, mixing 
and editing utility. You can record 
and mix multiple tracks of .mp3, .wav, 
.wma and .ogg audio files. It gives you 
the ability to mix multiple tracks in 
one. Add some sounds, record a few 
from the CD or microphone.

Wavosaur

WAVOSAUR is a free audio editor for 
Windows with VST plugins support. 
The program is ASIO compatible, can 
do loop points edition, auto-trim, 
noise removal .
■ Expresseur 2.0.8b
■ ActiveSolid 2.6.8
■ AD Sound Recorder 4.4
■ Cfont Pro 3.7.0.3
■ CineCenter 1.3.2
■ Decompile Flash Free 2.0.2.1512
■ DipTrace 2.0
■ EasyFLV Streaming Video 8.0 build 0.0.1
■ Episode 5.1
■ EximiousSoft Banner Maker 2.72
■ FaceMorpher Multi 2.51
■ Flash Protection Gold 1.41
■ Flex jpg Animator 8.77
■ Free PowerPoint to PDF Converter 5.5
■ Image Clip Hunter 8.10
■ Media Pop Up Ad Maker 8.0
■ RonyaSoft CD DVD Label Maker 1.03.01
■ SmoothDraw 3.1.3
■ Solid PDF Creator 5.1.204
■ SquidNet Network Distribution
■ Processor 2.18
■ Sweet Home 3D 1.8
■ Wirecast 3.5.1

PRODUCTIVITY
Spryka Desktop Budget Lite 2.0

Desktop Budget Lite lets you take 
control of your budget, and lets you 
manage all your finances including 
your checking, your credit cards, 
loans, savings accounts, and any 
debts you might have, all with easy 

to use, self explanatory windows and 
applications.
■ Notepad2 3.0.20
■ AceMoney Lite 3.16
■ Calendar Magic 17.2
■ Efficient Diary 1.51 build 25
■ Evernote 3.1.0.1107
■ FET - Free Timetabling Software 5.9.3
■ NeedForTrade Studio Lite 3.2
■ PhoneTray 1.33
■ Rainlendar Lite 2.5 Build 72
■ RGS-CardMaster 6.0.5
■ Savings Bond Wizard 4.15
■ Simple Home Budget Lite 1.7.5
■ Smart Diary 4.40
■ Smartstock 7.2
■ Splendid City Scheduler Lite 6.6.5.3
■ Task Coach 0.72.1
■ Text Encoder 2.0
■ Tiny Pad 2.0
■ Wammu 0.29

OFFICE
Dolphinity Organiser 2.1
A flexible personal information 
manager product that helps you 
to hierarchically store things-to-
do, tasks, facts and such for quick 
retrieval
■ NolaPro 4.0.4394
■ BillQuick Lite 2009 10.0.60
■ BillQuick Web Suite 2009 10.0.68
■ Brochure Template 1.0
■ Ghost Meeting 1.1
■ GreenLights 2.1
■ My Tenant Management System 
(MySQL as Database) 1.5
■ Nebula Business Suite 1.1

■ POSI 1.1.0.4
■ Primitive Word Counter 1.09
■ SnapshotMyVM 1.0
■ SoHoMoney 9.04.06
■ TortoiseSVN 1.6.1
■ Yugma Web Conferencing 4.1
■ TenderWiz
■ SoftDrom RFBServer 1.0.4
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ASTRONOMY 160
■ Lecture 1 _ Introduction
■ Lecture 2 - Planetary Orbits
■ Lecture 3 - Our Solar System and the 
Pluto Problem
■ Lecture 4 - Discovering Exoplanets: 
Hot Jupiters

LINUX JOURNAL
■ AIR Applications
■ DCop
■ Dropbox
■ Host File Tricks
■ Network Troubleshooting
■ RSI Break
■ Rsync
■ Symbolic Links
■ Top Commands
■ Upgrade Linux - Install IE7

BLEEDING EDGE TV
■ White Beats by Dr. Dre
■ Mophie Juice Pack
■ Zune Originals hands-on
■ Beats by Dr. Dre versions
■ An in-depth look a LASIK part 1
■ An in-depth look a LASIK part 2
■ An in-depth look a LASIK part 3

INTRODUCTION TO ROBOTICS
■ Lecture 1 - Course Overview
■ Lecture 2 - Spatial Descriptions 
■ Lecture 3 - Homogeneous Transform 
■ Interpretations
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The Digit Archive
Firstly, I would like to congratulate you 
for your success in the computer maga-
zine arena in India. I purchased my first 
copy of Digit in March 2007. Since then I 
have never missed even a single copy of 
Digit. The variety of the softwares in the 
CD/DVD are vast. Being a student, I loved 
the Fast Tracks to PHP, AJAX, C++. The 
new design of Digit is really beautiful. 
Digit has helped to expand my computer 
knowledge in every area of computing. I 
have few requests: 
1. Please provide Digit archive in your 
DVD. 
2. Please include the latest version (1.6) 
of Battle for Wesnoth for Windows 
which is available at wesnoth.org. I can’t 
download it because I have a dial-up 
connection and the cyber cafe has very 
high download charges. 
3. Where has “take a crack” gone? 

Nimesh, Ranchi

Hello Nimesh, 
Thank you for mailing in. Bringing back the 
Digit archive is one of the most popular 
request we get, and you’ll probably see one 
in the essentials section of the DVD from 
next month. We have recently given Battle 
of Wesnoth, but that was the Linux version. 
We’ll look into giving the Windows version.  

Editor 

More FOSS coverage
It was very nice to go through your April 
2009 issue. It was interesting as well. 
And why not? The future has always 
been interesting to the humans, largely 
because most of it is unknown. The 
“Cinematech” was certainly a very inter-
esting column, giving us a peek and the 
possibility about the future, but I don’t 
know whether you have actually missed 
out on big news or you actually wanted 
to postpone it for the next issue. This 
news I believe is “Once in a lifetime” 
kind of stuff.

The news is that there has been a 

collaboration between Microsoft and 
Red Hat on Virtualization Technology. 
You can certainly find the details of 
the same on the web site of both the 
companies. Microsoft, who has always 
believed in monopolistic business and 
who has always been against Linux (and 
Open Source) of all forms made this deci-
sion - is certainly a big news. Secondly, 
Microsoft is making Virtual Server avail-
able at no charge at all. Well, I tried all 
permutations and combinations to reach 
the conclusion which Microsoft had 
reached, but then I realised that I am 
“not Microsoft”, so its better not to think 
about it. I hope that you can bring out 
more news on this issue.

I have been a real, die-hard supporter 
of Linux and open source. Don’t you 
think that the above news means that 
open source is really giving a big chal-
lenge to proprietory software? If that is 
so, then can you tell me why you have 
not been writing about more of open 
source in your magazine rather than 
proprietory onces (which most people in 
India have pirated versions of). 

I skip most of the tips and tweaks 
section in your magazine as, it contains 
stuff related to Windows. I have been 
running Linux on my laptop and desktop 
machines for the past four years now and 
have not been facing any problems at all. I 
watch movies, play games, listen to music, 
connect to my internet wirelessly, surf 
internet, do some programming, in fact, 
do everything — all on Linux.

I believe that you need to look more 
into the future which is exisiting nearby 
and also help other people understand the 
the same. Someone do need to put their 
hand up and say “Okay dude! I am gonna 
do it.” That’s what I believe your job is 
because you always are the first to bring 
out something different and innovative 
and that’s what I believe that you should 
be doing.

Ashish Gupta. 

Hello Ashish 
Our Fast Track for this month is dedicated to 
Freeware. We openly support free and open 
source software, and often find that such 
software are better than their commercial 
counterparts. There is always a section of 
our DVDs dedicated to Linux distros and 
software. Maybe you should start going 
through the Tips and Tricks section more 
carefully, as quite a few of them cover Linux  
– based software. Thanks for mailing in! 

Editor 
More Video
I’d really like whole web sites about tuto-
rials (including java) in the DVD,  and 
you can even include the Digit web site 
and many more. The Videos in the DVDs 
are great, include more informational 
videos. Also include Java software for 
mobiles. 

Mukesh 

Hello Mukesh 
In this month’s DVD, you will find lots of 
informational videos. These include lectures 
from Yale and Stanford universities about 
Astronomy and Robotics. There are also 
instructional videos from Linux Journals, 
and procedures for the LASIK surgery from 
Bleeding Edge TV. Videos from the Digit 
team include a feature walkthrough of 
XBMC media server, and a video tutorial on 
animating in Bryce 5. Webaroo packs of web-
sites, particularly of the Digit website is a 
common request, and we will look into it.  

Editor
  

My phone sounds better!
Hi! I just want to express my views 
with your review of ‘Nokia 5800 XPress 
Music’. I am dissapointed by your review. 
I am a proud owner of this phone for a 
month now and I already own an iPhone 
3G. The touch interface of this nokia 
may not be as good as the iPhone but 
when it comes to sound quality this just 
thrashes the iPhone. You said that its 
performance is slow, but I don’t think 
it is slower than iPhone. I think you’ve 
recieved a tampered phone. Get a new 
one and re-review  
it soon!

Kshitij 

Hello Kshitij, 
Our main contention with the Nokia 5800 
XPress Music was that it was overpriced. If 
you are talking about how loud the speak-
ers are, yes the Nokia 5800 XPress Music 
produces a louder sound than the iPhone. 
This does not mean that the sound quality 
itself is better, as the iPhone simply has no 
competition when listened to on a good set 
of headphones. Rest assured that we never 
write about or review tampered products. 

Editor
 

Bazaar
We review all the 
latest technology 
to hit the streets 68
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Write in
Drop in a mail, write to  
editor@thinkdigit.com. 

Suggestion Box
I am a very big fan of your magazine and 
your magazine has improved a lot from 
the last few months. Your magazine is 
truly the best technology magazine in 
our country. There are a few suggestions:
1. When I opened the packaging of the 
April 2009 edition, the first thing I came 
to know that the paper quality of your 
magazine has improved a lot and should 
be continued for the coming months. 
2. On the April 2009 DVD, there were 
too many HD Trailers. I know that every 
one likes HD vids a lot, but there were 10 
on the first DVD. You should  provide at 
most 6 trailers as 10 trailers take lots of 
space and we miss out on valuable soft-
ware. You should rather provide normal 
resolution trailers. 
3. April 2009 issue the article on recy-
cling on computer wastes and LHC was 
great, but I found there was a bit of too 
much Sci-fi and the article on ‘Engines...’ 
should have normally found space on a 
Automobile Magazine. 
4. I also think there were too many pages 
about upcoming movies which should 
not have found the place on a tech mag 
as the tech shown in these movies are 
quite unreal and will take many years to 
be publicised. 
5. Fast Track to Ajax was good. You 
should consider revisiting some Fast 
Track topics like Security, Windows XP, 
Troubleshooting your PC.

Karan Raj Baruah, 
Guwahati 

Hello Karan
Thanks a lot for your valuable feedback. We 
recieve a lot of requests for HD Trailers and con-
tent, at the same time a lot of complaints from 
people who cannot playback these videos. For 
this reason, we have included both HD and nor-
mal versions of the trailers in this time’s DVD. We 
have revisited Fast Track to Freeware this month, 
and instead of a list of all the freeware out there, 
this is a hand’s on approach to accomplishing 
common tasks using Freeware.  

Editor

Larger fonts please, Editor
I have been reading Digit for the past 
2.5 years. With the new Digit interface 
you said that you cover more content 
per page, that is more words in a page. 
For that you have reduced the text size. 
Which is very difficult to read.

It is hard to read continuously with 
such a small text. Don’t ask me to check 
my eyes. As my eyes are good only. Please 
increase the text size. Because of this I may 
stop buying Digit. 

C.Karthik 

I have been reading Digit for last four 
year and within these years many 
changes have been made in the maga-
zine and I accepted them all from the 
business point of view and as a part of 
dynamism. However, since March 2009 
issue the font is very small and eye 
straining thus not been able to read the 
articles leasurely. I request you to kindly 
enlarge the font so that I would not be 
compelled to leave the beautiful maga-
zine at the cost of small font. 

Urgen Lama, 
Gangtok 

Hello  
Your feedback is important to us. The re-
design is a continous process, and we are 
still constantly improving the look of the 
magazine based on the feedback of read-
ers such as you. Stick with us, to see these 
changes. 

Editor 
 

No words to express!
This was a great issue — and I’m feeling 
that ‘sci-fi’ can become reality in the 
near future. Tech in movies and in real-
ity were astonishing. The discussion on 
‘LHC’ was informative. I was totally igno-
rant about it. ‘Space Odyssey’ section 
was great. Videos provided were informa-
tive. Speakers’ test gave me good choice 
for speakers. Tips and tricks for IE8 was 
very helpful to me.

Hard drives tested were great. Info 
about movies got my heart. I would like 
to get hands on all the full versions of 
games tested in this issue. Can’t you get 
‘Check your TQ’ section back? Please. 
Thanks to whole team of Digit for such 
an outstanding issue! 

Mayur Gaikwad.

Glad to know you liked the issue. Keep writ-
ing in!

Editor 
 

I have been reading Digit for the past two 
months and have found your surveys of 
various hardware components simply 
great. Even the Fast Track issues are 
comprehensively made. The magazine 
has simply taken over me ever since I 
recieved the March Issue. I just want to 
know as to how I could send my prob-
lems to your Q & A section. 

Rudrashish Bose 

Hello, 
If you run into any tech troubles and want 
us to answer queries in the Q & A space, just 
mail in your questions to sos@thinkdigit.com 

Letter of the month

Work@Tech
Find out your prospects
of a career in the field
of chip design 106

Ogg Vorbis
Ogg Vorbis is the FOSS (Free and 
Open Source) community's answer 
to the .mp3 format. The .ogg format 
does not use propriety encoding 
algorithms like the .mp3  forma.t 

Digit is an institution
Digit is an eye opener for me. I am a 
paramedic and I had no knowledge of 
computer once upon a time (even MS 
paint or MS office was beyond me) . 
Then came that day I saw my first copy 
of Digit in a book store. Now, I have 
improved a lot when it comes to tech-
nology. I can install Operating Systems, 
and know some things about hardware.

When I first started reading Digit, 
I was a beginner at producing music. 
Now, however, I am proficient because 
of practicing on my Yamaha keyboard. 
Digit provides its readers with image 
editing software, system tools, and 
video applications. However, the DVD 
contains very few software for audio. 

I have read the Fast Track to Digital 
Audio that Digit had provided in the 
Seventh anniversary DVD. I have tried 
Sound forge, Reaper, Music Studio 
14, some audio editors and Audacity 
(which I love it a lot). I Want to know 
how to connect my Yamaha PSR 630 to 
PC. There are more music studio apps 
like sonar, cubase, FL studio, Ableton, 
Midi sequencers, Protools, Sequel, and 
other studio tools like Virtual studio 
technology , sound fonts, synthesiz-
ers and infinite Audio plug ins. This 
is really another world. Very happy to 
have Ogg Vorbis (I came to know about 
it only from Digit’s knowledge base). 
I am very eager to have more digital 
audio studio apps further. I am learn-
ing Linux these days very seriously. Not 
yet tried Dual OS! (WinXP and Ubuntu). 
I want to know more about Ubuntu 
Studio – and the ISO if possible. Asking 
for too much? But, I know that only 
Digit can do this. Really! Digit is a 
university. Thanks a lot. 

Praveen Kumar 

Hello Praveen 
Just slip in this month’s DVD, amongst 
other audio software, you will find 
Darkwave Studio and Wavepad, two very 
good audio applications. You can con-
nect your Yamaha PSR 360 to the PC 
using a wire with 3.5mm jacks on both 
sides. You should find one of these is spe-
cialised hardware stores, or ask your local 
hardware vendor to make one using the 
componants. The jacks cost around three 
rupees each, and the wire comes for about 
three rupees a meter. Rest assured that 
you will find an ISO of Ubuntu Studio in our 
DVD as soon as the latest version comes 
out. Thanks for mailing in! 

Editor

Editor 
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The Playstation 2 runs a 64-bit 299 MHz 
processor with 32 MB RDRAM

Kumar Jhuremalani and Siddharth Parwatay

Under what category does this game
Fall in – RPG or Platform? 
With respect to the character and what 
is happening in the gameplay, I’ll put 
it as a platformer and the action genre. 
Since Hanuman has to go through a series 
of challenges and fight demons, it falls 
under the action genre. However, the 
movement around the smaller challenges 
such as swinging in the tree and collect-
ing fruits puts it in the platformer genre. 

Is this game meant only for India or 
worldwide? 
It’s not a worldwide launch for two reasons. 
In terms of the target audience, it’s targeted 
at Indians and the Indian diaspora globally. 
Therefore, it’ll most probably be launched 
in the UK, Middle East and most probably 
South Africa. However, being the first game 
with an Indian developer, our primary 
objective since the very beginning was to 
make it big in the Indian markets. The idea 
was intended to appeal to the Indian audi-
ence anywhere, not use Indian mythology 
to create a world game. 

How long did it take from scratch?
The whole journey started when we 
had the developers’ conference last year 
(DevStation Mumbai ‘08), which was also 
a first in its category (it was the first 
dev conference out of London). That was 
April 2008; the final game after alpha, 
beta, and QC (quality control) came in 
our hands mid-January. Effectively, it 
was a 10-month cycle.

With a price tag of Rs. 499, are you 
trying to undercut piracy? 
Earlier, pirated games were priced around Rs. 
125 a game, while our products were priced 
at Rs. 1,500. We have now brought this down 
to Rs. 499 with Hanuman. While creating 
games for the Indian market, one of the main 
parameters was to create games around the Rs. 
499 price point without any sub-optimisation 
in the animation quality, programming, or the 
gameplay complexities. However, the level or 
the depth of the game is perhaps 8 hours of 
gameplay, not more than that. 

How was it working with Indian devel-
opers?

have this. I have sat with programmers and 
am amazed with their artistic tendencies, 
their programming skills and optimisa-
tion techniques. I feel console gaming or 
PC gaming is all about optimisation. Only 
then will you be able to make a fantastic 
game. Career wise, although there aren’t 
sufficient institutes out there (and even 
if there are), institutes do not offer the 
gaming side of animation as a full course. 
Mostly, institutes offer a Flash-based anima-
tion gaming. There will be a few schools 
that will keep coming up and there are 
quite a few that are already running which 
will give you the opportunity of a one year 
course in getting into gaming as a pro-
grammer. I already have seen one school in 
Hyderabad that teaches programming very 
well – the Indian School of Gaming. Arena 
also does, but it’s more towards the multi-
media side. But more will come. Another 
thing about gaming that I have noticed is 
that while there are adequate game devel-
opers, they haven’t done enough in project 
management. In all our partnerships, we 
endeavour that the company will also be 
learning. I feel there is a lot that can be 
done in taking it beyond this. We have had 
some preliminary talks with Aptech, on 
taking it to the next level, with some sort 
of partnership. n

(For more of this interview, head over to  
www.thinkdigit.com)

kumar.j@thinkdigit.com
siddharth.parwatay@thinkdigit.com

Being very close to the dev team from UK, 
something coming out with a ten month 
cycle is nothing short of a miracle. And 
Aurona is not the only one. In June, you 
will have two quiz games from Candella. In 
another two months, two more games in 
PSP and PS2 SKU, from a company called 
GameShastra. One is a world quiz – it 
helps you in passing civil services and Joint 
Entrance type examinations. Earlier, we 
thought all that’s done here is Flash games, 
but it turns out there is more to it. Gaming 
is being covered in a big way. Gaming critics 
are being well heard. Gaming distribution is 
becoming big, modern channels are putting 
in gaming retailing sections, and experi-
ence zones will also start following. Arcade 
games are also coming up. The place where 
it falls short is that the gaming industry is 
not recognised as a full-fledged industry. The 
government is not in a position to under-
stand the full value of this industry. The fact 
that it can jump from zero to a five billion 
dollar industry even if it takes five years 
– that is not understood. 

How practical is gaming as a career 
in India?
If you want to make gaming a career in 
India, you have to have an interest in gam-
ing, because it is a very creative field. This 
can be in the story telling part, the pro-
gramming part, or the animation part. In 
terms of programming skills, you need to 

Atindriya Bose 
 Country Manager, 

Sony Computer Entertainment

industry connect
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India’s firstPS2 Game

An interview with the 
publishers of Hanuman 

Boy Warrior
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Jeeves is back
Ask, the search engine, is moving 
back to its previous name Ask 
Jeeves and has given the virtual 
butler a makeover.

To Wait or Watch: in HD

Many people opted for Direct-to-
home (DTH) services when they 
were launched. But what is the 

next step for these services? Are there 
going to be any technological advances? 
These questions have been answered by 
Sun Direct service as it has have recently 
launched its new High Definition (HD) 
DTH service.

Tony D’Silva, COO, Sun Direct, said 
that the new HD service will bring more 
realistic and breathtaking entertain-
ment to people’s homes. Sun Direct had 
reached a milestone that it had set, and 
had crossed 3.1 million subscribers. This 
was accomplished in a short period, 
compared to other similar services. The 
company therefore wanted to be the first 
to launch a service using this new HD 
technology. This step has also been taken 
after 1.5 million LCD TVs were sold last 
year and the expectation that this number 
will double this year, bringing a greater 
demand for higher quality content.

However, there are two major prob-
lems here – content and price. The 
content currently is very limited as there 
are only two channels, Tamil and Telugu 
movie channels, that offer HD content. 
The price of this HD box from Sun Direct 
costs approximately Rs. 10,000. So you 
really need to think whether you want 
to subscribe to such a service that has 
such limited content or wait until HD has 
become more mainstream. 
According to D’Silva, there are already 
more than 100 subscribers for this new 
HD service. So we guess there must be a 
lot of rich kids that can’t wait to get their 
hands on this.

3G Delayed  

The most talked about mobile tech-
nology these days is 3G. MTNL had 
announced it would launch 3G 

services soon, but this is not happening 
just yet. The launch is now supposed to 
be scheduled sometime in May. Jadoo, as 
the service is called, was supposed to have 
launched in February, but the response to 
this service in Delhi was nothing to boast 
about and this could have caused the 
delay in Mumbai.

MTNL has decided to move towards a 
new marketing strategy and will wait for 
a better 3G response before it goes ahead 
with the schedule. This brings up the 
question of whether the service will actu-
ally launch in May, as how much more 
could be actually considered as a better 

response. Jadoo has a capacity to support 
about 1,50,000 subscribers, but currently 
there are only about 500 subscribers in 
the capital.

The plan is such that you have 
to pay Rs. 500 for activation and a 
monthly subscription charge of Rs. 
599. Each call to a local MTNL number 
would cost 60 paise and Re. 1 to other 
operators. With 3G, video calls cost Rs. 
1.80 within the MTNL network, while 
Rs. 3 for other networks.

Cricket: On the Go

The DLF Indian Premier League (IPL) 
has hit us again with the second 
season being played in South 

Africa. Controversies aside, there’s 
finally some good news – you can now 
watch live coverage over the internet. 
If you were on the move, the only way 
previously that you could remotely 
follow the match was through the radio 
or score updates via SMS. But things are 
going to change now and you will soon 
be able to get ball-by-ball updates on 
your mobile phone. 
This service is not 
going to be limited 
only to those who own 
phones that have 3G 
capabilities, but will 
also be available for 2G 
phones as well.

To get ball-by-ball 
updates, all you need 
to do is download 
the application from 
zengaentertainment.com. 
You will also need a 
GPRS connection to 
access this service. 
Some operators levy a 
monthly GPRS charge, 
while with others you 
will have a pay-as-you-
use scheme, which may 
turn out to be costly. However, if you want 
such a live feed, then this is the best way 
to go.

Scientists + CO2 = 
Biofuel

Scientists from the Institute of 
Bioengineering and Nanotechnology, 
Singapore have found a way to 

convert CO2 into Methanol. They managed 
to do so by using the organocatalyst, 
N-heterocyclic carbenes (NHCs) in a reac-
tion with carbon dioxide. The reaction is 
supposed to be stable under mild condi-
tions in dry air. Adding to this, NHCs are 
easily available and only a little was used 
in the above reaction.

This is considered a big step that 
should help the environment. Some 
believe that this reaction still has flaws, 
even though the catalyst is abundantly 
available, the NHC decays very rapidly. 
Some also say this whole process is more 

of a negative energy process, in which you 
use up more energy to create the metha-
nol as compared to the amount of metha-
nol produced.

In our books, this is definitely a good 
start as people have moved away from just 
the ideation phase and entered into the 
proving and performing phase. 

Operation desert clone

Camel racing is popular in the Gulf 
region. So what does the Dubai 
Camel Reproduction Center do? 

It just cloned the first ever camel and 
have named her Injaz, which means 
Achievement. You must be wondering 
what’s the link between camel racing and 
cloning, well since this has been success-
ful, the Camel Reproduction Center plans 
on using this technique to clone some of 
the best racing camels so that they can 
keep their blood line going for years. Not 
only do they want the genes of the elite 
racing camels to be preserved and repro-
duced for future use, but also for their 
milk producing camels.

The technique used by the scientists 
was the same as that used to clone Dolly 
the sheep in 1996; she was put down as 
she was diagnosed with lung cancer in 
2003. Injaz is actually a clone of a camel 
that was slaughtered for it’s meat back 
in 2005. First the ovaries were removed 
and DNA was extracted from them. Next, 
the DNA was placed in the egg extracted 
from a surrogate mother. This egg is then 
planted back into the surrogate mother. 
Once Injaz was born, the tests showed that 
the DNA from Injaz matched that of the 
dead camel rather than the mother. Injaz 
was born after a 378-day gestation period 
and weighed 30 kg.

Brain invasion

Twitter, the microblogging, social 
networking web site has drawn a 
lot of attention of late. The first 

big achievement was thanks to celebrity 
Ashton Kutcher – he became the first user 
to have 1 million followers. The current 

Injaz the first cloned camel in Dubai
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number has grown to 12,82,994 and we 
are sure this is just going to keep grow-
ing. Next up we have Oprah, who posted 
her first tweet on her show with the help 
of Twitter CEO Evan Williams. Oprah has 
just brought a whole new audience to 
Twitter and has almost 5,00,000 followers.

Twitter has also helped some people 
with their business, a recent example 
being that of Kogi (Korean BBQ) sold in 
Los Angeles on Taco trucks. Mike Prasad, 
brand ambassador for Kogi, wanted a 
single place where fans could meet. What 
better way to pass on this message to the 
world than with Twitter. You could even 
say thanks to these tweets the business is 
booming as they can talk directly to the 
customers using the 140-character tweets.

This is all about the present, but 
what does the future hold for Twitter? 
Well, one Adam Wilson has built a brain 
interface that allows users to post Twitter 
messages. For this to work, you will need 
to don a dorky looking cap which has 
electrodes attached to it so it can moni-
tor your brain functions. This interface 
works by focussing on the alphabets being 
displayed on the screen. Once the desired 
character flashes, the cap can pick up 
the resulting impulse. The device still 
has its flaws as it can handle only about 
10 characters per minute. With Twitter’s 

character limit of 140, it would take you 
14 minutes to create a maximum size 
message. Though this is still in a nascent 
stage, it is a great accomplishment in 
terms of neural interfaces.

Google similar images

Here’s the latest tool from the labs at 
Google – search for similar images. 
With this option within the Google 

image search, users will get the chance to 
directly click on an image that might be simi-
lar to the one they are looking for instead of 
re-searching with different search criteria.

The similar image link is located 
below the thumbnail images which are 
displayed from your search. The tech-
nology that Google has used relies on 
metadata and image recognition based 
on content, perspective and colour, which 
helps users narrow their searches.

This search tool is currently available to 
try out at http://similar-image.googlelabs.com. 

You will clearly see that this 
has not been perfected yet 
as sometimes you might not 
get the image you are look-
ing for and at other times 
your image search might not 
even have the similar image 
link. We tried this similar 
image search with the 
words ‘smoke on the water’ 
which gave image results 
of Deep Purple as well as 
actual smoke over the water, 
but only two similar image 
buttons were displayed on 

the page.
This will be a really helpful addition 

to Google’s search engine and will save a 
lot of time for all of us.

Learn through DVD

Teachers from Dharavi in Mumbai 
will get to watch something other 
than Slumdog Millionare, thanks 

to Landmark International Institute for 
Empowerment (LIFE) trust. The LIFE trust 
is going to be conducting a two-month 
program during which 25 Anganwadi 
teachers will learn English. Anganwadis 
are pre-school centres which have been 
established by the Central Government 
so that children up to the age of six can 
study. Anganwadis are a great initiative 
on their own, but now with LIFE trust 
giving another helping hand, language 
proficiency among the masses is set to 
improve. Most of these Anganwadis are 
located in Dharavi, one of the biggest 

slums in the world, occupying about 175 
hectares of land and has about a million 
people staying in it.

LIFE trust has created an ‘English 
DVD’ for this task and will be training 
teachers using portable DVD players. They 
have tried to make the learning process as 
interactive as possible with voice, video, 
quizzes, discussions and role plays so that 
the children get some quality education. 
If this new DVD system of education is 
successful at the Anganwadi level, it could 
revolutionise the entire public school 
education system.

Bluetooth 3.0

Up until now Bluetooth was used 
to transfer images and small 
audio or video files between cell 

phone users, it never reached the status 
of a great new wireless norm. But that’s 
about to change as Bluetooth Special 
Interest Group (SIG) announced that 
the technology just got an overhaul and 

they have released a new version  
named – Bluetooth 3.0 + High Speed 
(HS). This new version of Bluetooth 
boasts of transfer speeds of upto 24 
Mbps which is due to the inclusion of 
802.11 protocol, the same protocol used 
in WiFi.

The good news here is of course the 
increase of transfer speed, but the bad 
news is that your current mobile phones 
will not support this. Mobile phones 
with this v3 should start rolling out 
within a year. The computers that have 
the Blouetooth 2.1 + EDR module have a 
better chance as they can be upgraded 
to the new version.

The question of power consumption 
may also arise, this also is sort of a 
problem as larger the files transferred, 
more power will be consumed. The work 
around for this, the 802.11 protocol is 
triggered only during the transfer and 
not all the time.

This also means that the devices that 
use this new version will have to WiFi 
technology as well, so that they can take 
advantage of the increased data transfer 
speeds. But don’t worry as this is also 
backward compatible and if paired with 
a device that does not have WiFi then it 
reverts to the old 2.1 + EDR module.

So what can this new Bluetooth 3.0 + 
HS accomplish other than what we have 
been using Bluetooth uptil now for, well 
to start off, the range should be a defi-
nite increase, and in the near future you 
will also be able to stream camcorders to 
HDTVs or even PC to PMP.

Scientist in Norwich, England have 
created a computer that can lip-read 
in different languages, Hindi has not 
been tested yet.

Scientist Stephen Hawkings has 
been hospitalised, but is said to 
be ‘comfortable’ after spending 
the night at the hospital
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Siddharth Parwatay

A
s with any path breaking technol-
ogy, every now and then you get 
a promising rival that is touted 
as the predecessor’s killer. It has 

happened with the iPhone, but we are yet 
to see a definitive iPhone killer. And now, 
Google is said to have another killer rival.
Recently, we came across several blogs and 
news items that claimed Kosmix, a three-
month old search tool, to be the next big 
thing in the web search domain. Some 
even going to the extent of calling it the 
harbinger of Google’s doom. What is ironic, 
however, is that while the media has been 
busy building up the Kosmix bubble, its 
founders (two silicon valley based Indians) 
are going to great lengths to underplay 
their product, especially when it comes to 
drawing comparisons with Google. 

Unlike a normal search engine 
that displays results which contain 
your search phrase, Kosmix generates a 

dynamic results page on the fly, popu-
lated by content from other sources. 
These snippets of information are gath-
ered from web sites such as Wikipedia, 
blogs, videos, photos, news and image 
results from Google. The idea is to give 
you a bird’s eye view of a particular 
topic. Search engines such as Google 
help users find specific information in 
the form of web sites, research papers 
or flight schedules. Hence the founders 
have given their product the moniker 
of explore engine and not search engine. 
Kosmix’s page title “The web organized 
for you” is perhaps an allusion to this 
concept. Sounds interesting, right?

We decided to give it a whirl for two 
reasons. One was the obvious curiosity 
about how it matches up to Google and the 
other to confirm reports from a New York 
Times article that Kosmix is best suited for 
certain specific uses. A quick random search 
will give you more than an inkling that 
this tool is not meant for serious research. 

A search for one of our favourite bands 
“Porcupine Tree” proved to be quite futile as 
a guide, or even as a starting point. Agreed, 
the topic is still not serious enough, but it 
makes you wonder how the site will handle 
“quantum physics”.

So, is it good for anything at all? 
Reports suggest that Kosmix does well 
in certain categories of searches such as 
travel, sports, health and electronics. For 
these categories, Kosmix is supposed to 
generate pages so specific and content 
rich that companies spending fortunes 
on developing such pages will squirm 
in their pants. A search on “Jaipur”, 
had us mildly surprised. Apart from 
the normal and annoying results from 
Wikipedia and Google images, the web 
site managed to cull some interesting 
contextual content. The result page had 
a Google map of Jaipur, results from 
Hostelworld for cheap accommodation, 
travelogue videos from blinkx, and 
further down the page Trip Plans from 
Yahoo! Travel. Further down were inter-
esting “how to” guides such as “How 
to Visit Jaipur” and “How to Buy Gems 
in Jaipur” from ehow.com. It would’ve 
been nice if the order of the results was 
different, but in the context of planning 
a trip, Kosmix can certainly be a good 
place to start. Was it useful to someone 
writing a college research paper on 
the city? Not at all. Go ahead and try 
it out, but certainly no one is expected 
to delete their bookmark for Google 
anytime soon. 

S
peaking of market disruptive 
technologies, something quite 
phenomenal is happening or rather 
could happen in the gaming world 

in the near future. OnLive, the revolution-
ary digital distribution technology, which 
was unveiled at the Game Developers 
Conference in San Francisco recently, 
could allow you to stream any game over a 
broadband connection to your computer, 
irrespective of your hardware. Essentially, 
this will turn any computer into a high-
end gaming console. 

With OnLive’s mega servers that 
remotely process and render signals,  
theoretically any PC, Mac, TV or even a 
piddly netbook can become a receiving 
station for ultra high-end games. For you 
to be able to play on your large screen 
TV, OnLive will be offering a modem-like 
hardware device called the MicroConsole. 
It’s most likely that the device will act as 

a thin client between 
your display and 
internet connec-
tion. A built in web 
browser will provide 
functionality and the 
device will have USB 
inputs and HDMI 
output.

What’s the 
catch? Obviously, 
for people living 
in this part of the 
world, it’s broad-
band! OnLive can 
dish out 60 frames per second in Wii 
quality at a bandwidth of 1.5 Mbps. At 
a bandwidth of 5 Mbps it can do 720p! 
How is this done? No one really knows 
but has to do with some insane interac-
tive video compression algorithms that 
have latency low enough to support 

on-line multi-player setups. So you 
guessed it — there is going to be large 
scale community activity too. This will 
include standard leaderboards, rank-
ings and level indicators apart from 
the ability to join live games at any 
point. An interesting concept debuted 
by OnLive was the creation of “brag-

Play in the cloud

Idea
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clips”, which lets you save ten-second 
clips of various in-game accomplish-
ments to share.

OnLive demoed 16 high-end titles 
which included Crysis, Burnout Paradise, 
and Grand Theft Auto IV. If you�����������’����������re wonder-
ing about the reaction of game studios 
to this technology you’d be surprised. 
Electronic Arts, Ubisoft, Take-Two 
Interactive, Warner Bros. Interactive 
Entertainment, THQ, Epic Games, Eidos, 
Atari Interactive and Codemasters have 
already joined the bandwagon. What 
would be interesting is the reaction of 
hardware manufacturers. Theoretically, 
since processing is done in the cloud, 
OnLive can make sure you never have 
to upgrade your PC. So bye bye high-end 
graphics card, see you quad core, adios 
gigabytes of memory? Will NVIDIA, ATI 
and Intel loose sleep over this? Maybe and 
maybe not. Because even if the games 
are not running in your system and 
are running in the cloud, they are still 
running somewhere on some hardware. 
Of course this hardware will be consoli-
dated and have better utilisation rates. 
What about console manufacturers? They 
are certainly the first candidates for loos-
ing sleep.

Yet we’ll have to wait and watch 
before ideas become a reality. Given how 

much trouble it is to encode and decode 
video, several critics are suggesting that 
this technology is unworkable. In its 
defence, OnLive has stated that apart from 
special algorithms, it has employed a 
custom built silicon chip that does encod-
ing at the server end and decompression 
at user end in milliseconds. Besides, 
transmitting such compressed data over 
an open internet connection poses its own 
problems. It will probably result in the 

need for a user to be in the geographical 
proximity of an OnLive server farm.

OnLive will be a subscription-based 
service, but since it’s still in beta, pricing 
hasn’t yet been revealed. Subscription 
models will probably let you play games 
for a certain amount of time or buy them 
outright for unlimited plays. The Bluetooth 
enabled device for playing on HDTV, 
(MicroConsole) will probably cost as much 
as any other console such as a Wii.

Sometime in the first half of April, 
the third instalment of the Web 2.0 
Expo came to quite a fruitful end in 

San Francisco. A yearly fixture now, the 
expo plays host to web designers, develop-
ers, entrepreneurs, marketers, business 
strategists, and venture capitalists; all 
connected within the all-consuming 
purview of Web 2.0.

This year, the response was a bit luke-
warm, with attendee numbers dropping 
from around 10,000 last year to about 
8,000 this time around. Who would want 
to physically attend an expo when every-

thing from the keynote to closing can be 
found on the web within a few hours? 

In the past, the conference has seen 
many exceptional ideas and technologies 
being showcased to the world for the first 
time, such as Zimbra, Flock and JobScore. 
Even with the current state of the econ-
omy, Launchpad, the startup podium, 
received about 80 entries. The approach 
this time was different, also reflecting the 
plight of the economy. Instead of the VC 
focus of previous years, this time the focus 
was on the end user. Here is a roundup 

of some of the most promising ideas 
presented at Web 2.0 Expo 09:

80legs: the most innovative of all the 
ideas presented. It is a web-scale platform 
for content discovery (crawling) and 
analysis. So developers, entrepreneurs, in 
fact anyone, can use 80legs to analyse the 
internet at lightning fast speeds (2 billion 
pages per day on a 50,000-node supercom-
puter). The possibilities are limitless. You 
could use it to understand web trends, 
scan for content, and perhaps it could 
spawn new search engines. It’ll be interest-

ing to see how this new platform can be 
used productively, if at all.

PhoneGap: launched by Nitobi, this 
one was the crowd favourite. PhoneGap 
is an open source framework that allows 
developers to author apps in HTML and 
JavaScript, while leveraging device capabil-
ities such as camera, vibration and sound. 
So what’s the big deal? PhoneGap apps are 
supposed to run on the iPhone, Android 
and Blackberry.

DubMeNow: is another step forward 
towards syncing mobile contacts with 
the web. It allows you to create a mobile 
business card which you can share with 
anyone through the cloud. In turn your 
contact’s info loads directly into your 
existing mobile address book and is auto-
matically updated whenever your contact 
changes their information. “Do away with 
visiting cards” seems to be the motto.

Bantam Networks: This is an online 
workspace for businesses, that features 
work flow management. So, basically, 

business teams get to create secure social 
workspaces where you access features 
such as information sharing, activity 
tracking, file storage, task lists and so on. 
Bantam also pulls in content from other 
Web 2.0 sources like Twitter and LinkedIn.

ZeaLog: A personal tracking app that is 
supposed to help you achieve any specific 
personal goal such as quit smoking, loose 
weight, drink more water, etc. 

siddharth.parwatay@thinkdigit.com
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Siddharth Parwatay

N
o we’re not talking about voting 
for your favourite star in Indian 
Idol. But there is the distinct pos-
sibility of mobile devices being 

used as voting machines for the next elec-
tions. Perhaps this article and the concept 
is a bit ahead of its time but indicators 
towards this electronic shift have already 
found their way into popular culture. Do 
the “what an idea sir ji” ads we’re being 
bombarded with so often, strike a chord? Or 
even the numerous reality shows where the 
contestants’ fate is decided by the mobile 
voting public. Another instance that comes 
to mind occurred two years ago, when the 
Taj Mahal’s right to be amongst the seven 
wonders of the world was put to a vote. Back 
then about 165 million mobile phones dou-
bled up as voting machines and surprised 
the international community.

Think about it – the juggernaut of 
India’s mobile subscriber base shows no 
sign of stopping. Despite the downturn it 
stands at around 360 million (36 crore), 
with close to ten million connections being 
added every month. This figure, however 
impressive, may not be close to the eligible 
voting population of today, but by the 
time the next election takes place in 2014, 
the numbers may be closing. A report by 

Gartner last year expected the subscriber 
base to hit 73.7 crore connections by 2012, 
owing to a compound annual growth rate 
of 21 per cent in the same period. Soon the 
Kafkaesque scenario of people being recog-
nised by numbers and not names might 
become a reality. Except the numbers won’t 
be government appointed dog tags but our 
very own cell phone numbers. One might 
argue that even a large subscriber base if it 
doesn’t cover half the country’s numerical 
strength, doesn’t represent a valid cross 
section of the population. True. But if the 
infrastructure allows it, those that can exer-
cise the option should be allowed to.

In other parts of the world this possibil-
ity is being seriously considered. VeriSign, 
the Internet infrastructure services provider, 
made a prediction just recently that voting 
by mobile devices could become a real-
ity in the US by 2012. It also predicts that 
citizens will have a greater connect with 
their elected representatives through the 
mobile medium. A small reflection of this 
is happening in India but only it’s the other 
way around with politicians using SMSs to 
reach citizens in their constituency.

In conclusion, if the problem of authen-
tication and accountability can be overcome 
by developing the appropriate infrastruc-
ture, the TRAI and EC should seriously 
consider the possibility. 

Y
ou are completely lost 
and on your way to an 
important even in an 
unfamiliar part of town. 

Worse yet, you are in a new 
city altogether and don’t know 
what to do. We’ve all faced 
this situation and wished for 
a GPS device. GPS however is 

not within everyone’s reach and doesn’t 
make sense for occasional use. But what 
if you could get turn-by-turn directions 
as a service then? Now you can! SatNav 
has launched India’s first voice-based 
Navigation Direction Service – SatGuide 
LCU (It stands for “Lost? Call Us!”) avail-
able to all phone users across India. With 
the launch of this service, finding your 
destination is theoretically just a phone 
call away.  
When you call in, an actual person will 
ask you for your details and will guide 
you to your destination. The other option 

is an SMS with distances and road names 
along with landmarks. The service works 
on a prepaid voucher model. Users get toll 
free calling accessibility from any telecom 
provider to be connected to a trained 
agent. To access the service, the customer 
will just have to purchase vouchers worth 
Rs. 100 from the SatGuide website, www.
satguide.in, to register with the service. 
These contain 15 minutes of talk time. 
In addition, the vouchers will be made 
available through retail partners such 
as E-Zone, Croma, Staples and Reliance 
AutoZone, all over the country in a phased 
manner. Higher value vouchers are also 
available. 
The service is available in Hindi and 
English between 6.30 to 11.30 pm. The 
maps have been developed in house by 
the company with detailed street level 
road maps of 200+ cities and include more 
than 15 lakh destinations.

siddharth.parwatay@thinkdigit.com

China Mobile’s subscriber base passed the 
450 million mark this year. The number is 
more than the combined populations of 
several small countries.

When cell phone’s become 
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Hit the road
Check out what goes into the 
Mobile Warriors Back pack

Siddharth Parwatay

I
t’s that time of the year when invari-
ably everyone catches the travel bug 
and decides to pack their bags and 
head out. But before launching off on 

a Lonely Planet fantasy, understand that 
as with all things these days, there is the 
old way of doing things and then there is 
the tech way. Sure you can call up any of 
the tour operators and opt for a standard 
package, but remember that people are 
increasingly becoming quite comfortable 
with doing their own online research for 
planning their vacations, and effectively 
cutting out the expensive middle man. 
Here we show you how you can plan your 
own vacation 2.0.

There are a multitude of online 
resources that can help you find all the 
information you need. Apart from your 
regular ticketing and booking facilities, 
you can get access to information on vari-
ous destinations, deals, reviews, local curi-
osities and a host of other things that 
would’ve ordinarily escaped your radar. 
There are resources that alert travellers 
to peculiarities that might transform into 
one of those major vacation blunders. The 
internet, of course, is a vast jungle of 
information, so where do you start? Let’s 
go step-by-step and see how it can help you 
along every step of the way. 

With the recession around, prices have 
gone through the floor. Hotel occupancies 

are down 30 per cent compared to last year, 
while prices for air travel and accommoda-
tion have been slashed by similar amounts. 
Everything is cheap and traveller friendly, 
so you can finally go to all those places 
you’ve always wanted to visit.

Part 1: Planning your itinerary 
Apart from the trip itself, this can be the 
most fun part of your holiday! Whether 
you browse the web site of the bird sanctu-
ary you’ve always wanted to visit, down-
load podcasts or watch videos of tours of 
ancient cities, the internet makes travel 
so much more enjoyable. If it’s a trip with 
several people – friends or family – you 
can involve everyone at this stage by shar-
ing links to travelogues and interesting 
pictures. Planning your itinerary can be 
done beautifully on the web. A good way is 
to browse some of the best travel web sites 
so that you can zero in on a suitable trip. 
The idea here is to come up with a package 

of your own. A package would involve the 
best places to see, sights and specialties 
to visit and things to do. Once you have 
chalked this out successfully, the next step 
involves figuring out the logistics of trans-
portation and accommodation.
 
Tourism Boards
Web sites of tourism boards of states 
within India or countries abroad are a 
good place to start. You might remember 
the Incredible India promotional campaign 
by the Ministry of Tourism or the Madhya 
Pradesh and Kerala tourism campaigns. 
Many Indian states have very interesting 
and comprehensive government promoted 
tourism web sites. They showcase the vari-
ous attractions found in that state and in 
many cases allow for booking accommoda-
tion in state-run and private facilities. For 
instance, keralatourism.org, which is perhaps 
the most elaborate of all state tourism web 
sites, is very comprehensive incorporating 
vital information such as calendar updates 
for local events and other facts and figures. 
Another good state tourism web site is 
rajasthantourism.gov.in which allows you to 
book hotels run by the state department. 
A simple search online will give you third-
party web sites where all the state tourism 
board web sites are listed. Internationally, 
you have web sites such as visitsingapore.
com which has a micro-site for India. While 
browsing these web sites be sure to look 
for special events. For instance, there could 
be the carnival or Goa fest happening or a 
concert of your favourite band coinciding 
with your trip to Bangkok.

Information sites
These information web sites will plant the 
seed of a travel idea in your mind. What 
you can expect to find on these websites is 
a large number of travelogues and custom 
packages. The web sites range from regular 
travel web sites to country specific ones 
and even ones for those who want to go 
down the road less travelled. What you can 
do is get inspiration from these sources 
and plan a customised package for your-
self. This gives you all the information and 
the freedom of tweaking your itinerary to 
your convenience. Here’s a small selection:

Infohub.com: a speciality travel guide web 
site with a lot of content. It describes 
itself as “the ultimate source for out-of-
the-ordinary and inspiring travel ideas” 
and going by how extensive the informa-
tion is we tend to agree. The web site has 
travel stories plus you can browse both by 
country or popular vacations, such as eco-
tourism, biking tours, photography and 
videography, scuba diving or sports. The 
quick vacation search helps you narrow in 
on options quickly or you have the option 
of searching for keywords. The web site is 
also a great source for finding profession-
ally managed tours. 

Learn how you can use online resources 
to plan your vacation

Vacation 2.0
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Tip:
Even when you are at a 
particular place you can use 
GPRS on your phone to look up 
info on wiki travel

Indiatravelog.com: this is an India specific 
travel web site that gives details of various 
holiday plans by theme. Their themes are 
quite extensive; ranging from adventure 
and wildlife to beaches and ayurvedic holi-
days. The site also claims to give free travel 
assistance by filling out an online form. You 
can ask their Tour Planner about prices, 
itinerary suggestions, bookings, etc.

Trivago.co.uk: as the URL suggests, this web 
site is aimed at a specific audience but 
nevertheless is a great resource to compare 
prices for hotels, browse the site for attrac-
tions, reviews and photos. It has an inter-
active Google powered map that lets you 
triangulate on an area and view the vari-
ous options including hotel availability 
and attractions. You also have the option 
of entering a city and duration of holiday 
and you’ll be presented with a list of hotels 
on the right. You also have the option of 
refining a search by price. When you click 
on the attractions tab in a particular city, 
you will have a sidebar to filter for events, 
nightclubs, museums etc. or pick specific 
places from a tag cloud of places and 
attractions. The best part is that all content 
is user generated.

Cultureholidays.com: again, an India specific 
site but probably targeted at foreigners. 
Still they’ve got some of the most innova-
tive itinerary plans around. You get great 
package deals to check out and learn from. 
The web site has a long left panel with 
resources ranging from car rentals, useful 
tips, distance calculator, weather, and shop-
ping. Apart from this you will also find 
innovative itineraries such as the Elephant 
Festival Tour, which is centred around the 
famous Jaipur festival.

travel.mapsofindia.com: a sub-site of mapso-
findia.com, this is one terrific collection of 
information on almost any place imagin-
able in India. The detail is so great that 
this can actually be a one stop site for your 

needs. For instance, click on the Travel 
to Goa link in the left side bar. You will 
find yourself with a multitude of in-depth 
details including a general roundup of 
attractions, ways to get there, fairs and 
festivals and destination guides.

Worldtravelguide.net: ease of use and 
attention to detail separate this one from 
the rest. Additionally, the website is the 
most thorough we have come across in its 
approach. It’s got travel guides to every 
country in the world as well as detailed city, 
ski, beach, cruise and airport guides. Click 
on Travel Essentials for world weather fore-
casts, a world clock, a World Events Guide, 
attraction guides, and more. First click 
a location from the map, and then you 
select the type of guide you’re looking 
for to the right. Options include, country 
guides, beach guides, cruise guides etc. 

Other notable mentions include 
Idiscoverindia.com, Indianholiday.com and lone-
lyplanet.com and zoomtra.com  

Communities and forums
Travel communities and forums are a 
good way to get first hand info and 
also to interact with fellow travellers. 
Indiamike.com is a fairly popular Indian 
travel forum with a huge database of 
user generated information. You get to 
see reviews, read travelogues of people 

within India, and also seek advice on 
almost anything even remotely connected 
to travelling. You have discussion threads 
on travel basics, states in India, cities, 
transportation, offbeat vacation ideas, and 
even a thread on itinerary advice. The itin-
erary advice incidentally has some 27,000 
posts! Forums and communities are also a 
good place to get visa and passport advice 
too.

Part 2: Transportation
The mode of travel is a major concern while 
on a vacation. After you have planned out 
your itinerary, you should have a fair idea 
of what modes of travel you need to look 
into. For domestic travel you have road, 
rail and air as the main transport meth-
ods. For international travel flight is the 
only option, and since flying to Bangkok 
is cheaper than flying to Bangalore you 
shouldn’t rule out international travel. 
So let’s say you zero in on flight as your 
transport of choice for the first leg of your 
journey. Which websites will help you book 
a flight and what else is there to know? 
Travel web sites such as Travelocity, Yatra, 
Cleartrip or MakeMyTrip are good for 
getting consolidated info on flights, espe-

cially international travel. They all follow a 
similar format which allows you to specify 
details such as destination, departure and 
arrival dates before searching for all avail-
able flight options. You can even filter 
the results by price, airline preference 
and timing preference. When it comes to 
domestic booking you can visit the carri-
ers’ web site directly to access better deals, 

Interactive live maps are available from a number of web sites. 

Innovative itineraries at culture holidays
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unless of course the travel website has 
some sort of special offer.

Bus booking can also be done online at 
web sites such as redbus.in and ticketvala.com. 
These web sites have essentially consoli-
dated all the small tourist bus operators in 
the country into a single platform. So you 

can look at bus timings, prices and other 
details and simply book online. In the 
booking process, you can even look at the 
seat layout and select your boarding point. 
Sure, you can probably go to a Konduskar 
or Neeta Travels yourself but isn’t this 
much simpler? Parijat Kaushik, an avid 
traveller and weekend getaway enthusiast 
said, “I found the experience with both 
these web sites quite satisfying. They are 
quick to respond to web queries and there 
is always the help line number where you 
can talk to customer service.”

Railtourism.com and travelchacha.com give 
you details on cab and car rentals within 
most cities. You can even book a car online. 
If you have no road transport planned for 
any part of your journey but want to get 
to your starting point (Airport, railway 
station), you have the option of city specific 
cab services such as www.merucabs.com for 
Mumbai, Delhi, Hyderabad and Bangalore.

Part 3: Accommodation
OK, now that you know where to go and 
how to get there you need to figure out 
your accommodation. For both domestic 
and international travel, people are increas-
ingly getting comfortable with booking 
hotels online. However, you need to put in 
a fair bit of research here. Lots of hotels 
from all segments are well covered by web 
sites such as travelguru.com and makemytrip.
com. You get to know indicative prices but 
as any experienced traveller will tell you 
that there is a bit of scope for bargaining. 
On a web site such as travelguru.com, you 
enter your destination, check in and check 
out dates, and number of people. Say your 
destination is Jaipur, the web site will 
instantly tell you it has 91 hotels registered 
under that location. Hitting search will 
give you several options. You can filter 
searches by which category of hotel you are 
looking for (5 star, 4 star, etc) and by ameni-
ties (swimming pool, internet access, etc). 
There is also a price slider to filter by price. 
For each hotel you have room descriptions 

and photos. Photos here are very important 
as you get to see the rooms and facili-
ties. There is also a lowest average price 
mentioned as well as user rating. Even a 
one star hotel we found had 22 reviews so 
the user community is pretty active here. 
One you decide on the type of room you 
want, simply pay online and book.

Another interesting web site is nivalink.
com which boasts impressive statistics such 
as 1,000+ custom itineraries, a database of 
3,000+ hotels / resorts, 1,00,000 individuals 
serviced, and over 10,000 pictures to browse. 
The web site describes itself as a web-

assisted, research-driven 
customised travel solu-
tions provider. Suppose 
you wish to find hotels 
in the Kerala backwa-
ters, simply click the 
link under itineraries 
and accommodation 
options. You will be 

presented with a list of all available hotel 
options. Click on any one and you get 
a detailed description of facilities with 
pictures and also contact details. If you 
are looking for reservations and travel 
assistance for an itinerary that covers more 
than one destination, email nivalink with 
details and they promise they will get back 
to you with a model itinerary, plus sugges-
tions and detailed cost estimates. 

A peculiarity with accommodation is 
that the bulk of it is provided by small 
and medium sized enterprises. These small 
businesses provide unique, friendly and 
quaint living experiences which are much 
more personal. It is always difficult for 
travellers to source information about 
their properties, let alone book them and 
receive instant confirmation.

Another booking solution is to go to 
the hotel chain’s web site directly. For 
instance, Ginger Hotels a budget hotel 
chain has a very comprehensive web site 
that lets you view, choose and book at a 
hotel of your choice. 

But how do you make sure that you will 
indeed get what you are paying for? This is 
where reviews come in. There are exclusive 
hotel review web sites such as oktatabyebye.
com where you can find a whole lot of user 
reviews. This site lets you cross check rates 
with other web sites such as makemytrip 
and travelocity. 

Using online mapping services to plot 
your itinerary
Now that you are all set to take off, you 
probably would want to plot your itiner-
ary on one of the online mapping services 
such as Yahoo! maps or Google maps. You 
can even print them out and carry along to 
help you along your journey. The My Maps 
service from Google allows you to overlay 
information such as photos, weather, and 
public transit maps. You can even mark 
the places you want to visit along the way 
on the map so that you don’t miss out any. 
Featured content by Google shows you hot 
spots and displays distance.

By now you must surely be toying 
with the idea of claiming all your accrued 
leave. So, be your own travel agent, head 
out and remember that everything is just 
a click away. n

siddarth.parwatay@thinkdigit.com

Locate hotel on maps at travelguru Use Google maps to plot direction and hot spots
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Mark the dates
There is a lot to look forward to next 
month. To find out more, flip over tofeature

Intl' travel specs
Communication is very important, so be 

sure to check out what’s available at 
www.matrix.in. You should visit your bank’s 
website to get information on international 
forex and debit card transactions.

Sure, it’ll be a bit complex but visit the 
Indian customs and excise website at www.cbec.
gov.in to get the latest information on baggage 
rules and other inputs on foreign travel.
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Hit the road 
Check out what goes into the Mobile 
Warriors Back pack

Obsessive-compulsive 
geekism. A vacation 

to escape the summer 
heat. What 

happened next? 
Read on…

feature
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Agent 001

Wednesday — Inspiration amid 
Perspiration
It’s April, and Mumbai is her usual hot, 
muggy self. Correction — its hotter than 
usual this year. My apartment, albeit 
decent, is on the top floor and the lack 
of any sort of air-conditioning means my 
flat has the feel of an oven by the time 
I get home. Okay — enough griping, I 
know there are others less fortunate than 
myself. But try as I might I couldn't shake 
the feeling that just this once, I needed to 
get away from the heat.

It’s the beginning of the month, we 

had just finished working on April’s issue 
and being the eleventh hour workers that 
we are, work for May had not begun. A 
geek with time to kill is an incurable  
web crawler. Juggling between posting on 
forums, moderating our own forum (www.
thinkdigit.com/forum) and reading up on the 
latest hardware, I was also going through 
a few wallpapers on www.interfacelift.com. 
Suddenly, I came across a wallpaper of 
a snow-clad mountainside with the sun 
setting as a backdrop casting a radiant 
orange glow across the ice. Maybe it was 
the heat getting to me, but as weird as 
this sounds my mind couldn’t help drift 
to the last time I was on vacation, which 
was just over a year ago. Why not? Serious 

Mobile
warrior's backpack

32
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Visit
backpack-newzealand.com for 
information on backpacking 
and hiking in New Zealand

Tip:
Even when you are at a particular place you 
can use gprs on your phone to look up info 
on wiki travel

CONNECTIONS

work wouldn't begin for another nine days 
so I had time to kill.

My runaway heart was doing a jig of 
its own by this time. Tamping down my 
excitement I approached our editor for 
leave. After a brief pause he acquiesced. 
I would get the entire week off — amaz-
ing! But wait… there was a snag. He told 
me to make a note of everything I carried 
with me. Nope, he wasn’t interested in the 
Brylcreem and shampoo, just the gadgetry. 
I enquired about his curiosity, but he was 
vague. I acquiesced, left his bay and got 
down to what little work I had for the day. 
During lunch, I made a list and checked 
off some of the things I’d need for the 
trip. I decided to shop for the stuff I didn’t 
have that evening after work. At 6.30 pm, 
I headed off to Croma. I’d get most of the 
stuff I needed there.

First, I picked up a bunch of Li-ion 
rechargeable batteries. Eight Sanyo 
Eneloop AA batteries rated at 2000 mAh 
with a four-cell charger set me back  
Rs. 1,250. These batteries are high-drain 
and the amount of drain if left lying 
inside any device is negligible. I also 
picked up four Uniross AAA rechargeable 
batteries for my GPS unit. Also on the list 
was a larger memory card for my compact 
camera, since my 1-GB card was with a 
friend. My camera, the Canon PowerShot 
A710IS does not support SDHC memory, so 
I was limited to a 2-GB card. I spent Rs. 450 
on a SanDisk SD card.

I got home to a location dilemma. 
Some place with mountains like the ones 
I saw in that wallpaper is where I wanted 
to be. This holiday was going to be all 
about being one with nature — the fewer 
people around the better. Till date I’m not 
quite sure exactly what made me choose 
Himachal Pradesh as my destination, but 
I’m pretty sure it had something to do with 
the climate there. Rolling hills and sweep-
ing valleys, clean unpolluted environs 
and some of the most untouched (by man) 
scenery was another factor. Last, but not 
the least, the thought of gorman-
dizing mouth-watering momos 
and seeing my breath vapour as 
I sipped piping hot coffee was the 
clincher. Himachal it was!

Destination confirmed, I 
decided to fly to Delhi and from 
there catch a bus to Shimla. I 
visited www.makemytrip.com and 
checked out the availability and 
cost of air tickets for Delhi on a 
Saturday. I booked myself on an 
afternoon flight and also booked 
my return from Delhi for the 
Saturday after next. That way I’d 
have Sunday to unpack and rest 
when I got back. After checking 
up on the availability of buses to 
Shimla and finding many options 
I leaned back for a moment of 
quiet contemplation — the calm 
before the storm in retrospect. 

Clothes... I’d need to pack warm. My Levis. 
were in for sure. My hiking boots I’d wear 
— these darn things take up a third of my 
duffel bag, so they’re better off on my feet 
at all times. And then the thunderbolt 
struck — which of my geeky possessions 
would I be able to carry with me and 
which would I be forced to part with for a 
whole week? From experience this is the 
most painful part of every vacation I take 
— the hours I spend agonizing over which 
of my lovelies I’ll have to live without. 

I was immediately depressed as I 
realised I would not be able to take as 
much as I wanted. I’d have to live with-
out the NVIDIA GTX 285 that I had taken 
home from the office for a whole week! No 
games. No beautiful 24-inch LCD. Damn! 

These thoughts alone were nearly enough 
for me to irrationally consider cancel-
ling my flight reservations — I kid you 
not. In anguish, I reached for a cola from 
my fridge and plonked on to the sofa, 
taking a long, hard swig from the can as 
my thoughts whirled. Rationality slowly 
returned. I decided to pack all my gadgets 
first and use the remaining space for the 
necessary evils such as toiletries, towel 
and clothing.

An action-plan in place, I checked my 
watch and decided to get a few things 
ready before hitting the sack. I unpacked 
my Nikon D60. This beast has a 10.2 mega-
pixel CCD sensor and features a vibration-
based dust cleaning system. The beauty of 
the D60 is that whether you’re a pro or a 

novice, you can get qual-
ity results and although its 
low-light performance isn't 
class leading, its pretty 
good and very newbie 
friendly. At Rs. 35,000 
(with its default lens) 
this camera comes highly 
recommended. Canon fans 
will want to look at the EOS 
400D. Priced almost iden-
tically to the Nikon D60, 
this camera offers similar 
quality, although I find its 
menu system to be unnec-
essarily complex. Canon’s 
lenses are also much cost-
lier. I removed my camera’s 
battery pack and set it 
to charge. Later, I would 
charge the spare battery 
pack I always carry. I also 

Nikon D60 — The entry-level king amongst DSLRs

iPod Touch — Amazing screen, amazing sound
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The D700 is Nikon’s cheapest full frame 
camera and boasts of terrific low light 
performancefeature

carefully packed the Nikkor 
18–200-mm lens I bought last 
year. Priced at Rs. 25,000, this 
long zoom lens can be used 
on all Nikon DSLR DX (ie. not 
FX format) cameras and allows 
for great versatility for distance 
and close-range shooting. 

The standard 18–55-mm 
lens that ships with the D60 
was also packed. Next I removed 
and backed up the 8-GB SD card 
that was inside the camera 
and emptied it. I also had an 
empty, identical spare and both 
cards were packed along with 
the camera. I had no inten-
tion of running out of space 
to shoot; it’s happened before and 
isn’t funny, I assure you. These cards 
are SanDisk eXtreme III SD cards and 
offer write speeds of up to 30 MBps, very 
suitable for high-end cameras and profes-
sionals swear by these cards. Such a card 
will set you back by Rs. 1,500 — expensive 
but they’re worth the premium. 16-GB SD 
cards can be had for as little as Rs. 2,600 
and are suitable if you want to shoot 
videos as well. Next I packed my Canon 
PowerShot A710IS with the new batter-
ies. This beauty has been a trustworthy 
companion over the past two years she’s 
been with me. What I love the most is 
her ability to deliver good night-time 
shots and her low-light performance is 
very decent. Optical image stabilisation 
takes care of blur-causing camera shake 
and she’s got a 6x optical zoom. She’s not 
truly pocketable, thanks to her curva-
ceous grip, but this makes for a firm 
hold. If you must have a compact, pocket-
able camera look at Canon’s Digital IXUS 
series — the Digital IXUS 80IS is good. It’s 
really compact and takes quality photos. 
I packed my camcorder next. I have a 
Panasonic SDR-H40GC-S. This camcorder 
features a 42x optical zoom and a 40-GB 
hard drive. What I really like about the 
model is the effectiveness of the image 
stabilisation unit — even at the long end 
of the zoom there’s no visible blur. I 
prefer hard-drive based camcorders above 
other media any day. These start up and 
record faster with fewer delays and one 
saves on the cost of disks and tapes. 
When shooting outdoors, the huge opti-
cal zoom does make a difference, allow-

ing one to capture even distant scenery 
rather well. Priced at just Rs. 25,000 the 
SDR-H40GC-S is definitely worth a look 
for someone looking to buy a camcorder. 
Thus concluded the packing of what I 

fondly call my memory-makers, cameras, 
camcorders and their ilk.

Some of the other stuff I had to pack 
is used daily, either in the office, or at 
home or  the gym, so I made a note lest 
I forget to pack them later. I’d carry my 
iPod Touch with me for sure. With no 
introduction necessary, this wonderful 
PMP is a must try for everyone. Apple’s 
multi-touch interface is nothing short 
of amazing. It’s got great sound quality 
and the screen is clear and crisp — a joy 
for viewing images and movies alike. I 
made sure to carefully pack both USB and 
mains chargers. I also threw in my in-ear 

Creative EP630 earplugs for use 
whilst commuting. For a mere 
800 bucks these earplugs are 
a steal and offer decent sound 
quality with slightly overempha-
sised bass. A good buy for anyone 
looking at portability and good 
noise isolation. My Grado SR 225 
supra-aural headphones would 
also accompany me for I cannot 
survive for very long without 
these beauties pampering my 
aural senses with their lovely 
sonic embrace and I’m bereft 
whenever we part. Besides, 
being extremely lightweight and 
robust they have an amazingly 
rich musical presentation and 

although not the most neutral of cans, 
the mid-range is superb. The highs are 
extended, although not harsh, and the 
bass, while not as deep as some, has good 
impact. Unfortunately, the SR 225s are 
not available in India, but you can check 
them out at www.gradolabs.com. With a lot 
of my gear laid out and notes made on 
most of what I’d be carrying I decided to 
call it a day.
 
Thursday — Oh weekend, where  
art thou?
After wrapping up work, I took a little time 
off to check up on the area around Shimla. 
There’s a wealth of information online. It 
seems there are local guides available to take 
one around and there are lots of places to 
stay. There were several inns and hotels that 
allowed online bookings. The editor dropped 
by my desk and told me to carry my note-
book along with me, and more importantly 
to check (and reply to) important mails. Not 
that I’m averse to packing a notebook, in fact 
I am not one of those people who can make 
do solely with a PDA — they aren’t produc-
tive enough for me — and I hate cramped 
keyboards. I have an Apple Macbook 2008 
with 4 GB of DDR3 RAM running OS X 10.5.6, 
with Windows XP Pro co-existing peacefully 
thanks to Boot Camp. It’s a compact note-
book with a screen size of 13.3 inches. For 
those looking at something really compact 
yet reasonably powerful, look at the 12.1-
inch screen size. 11.1-inch notebooks are 
also available but I also packed my trusty old 
Reliance data card with me. Although it’s an 
ancient CDMA 1x unit with a super-slow 56.6 
kbps connection, I stick with it as it’s enough 

Grado SR 225 — Entry-level audiophile joy

Apple Macbook 2008 — Sleek shell, superb performer

Creative EP630 — Affordable, good sounding in-ears
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for very basic browsing and email checking, 
which was about all the usage I intended for 
the duration of this trip. After all, holidays 
mean freedom from work and that means 
freedom from broadband. The major advan-
tage of using a Reliance CMDA card is that 
the network is so extensive that no matter 
where you go you’re never out of signal cover-
age range ninety per cent of the time. I’d also 
pack a spike guard. It’s an MX unit that I 
bought from Lamington Road in Mumbai for 
550 bucks and as asinine as this may sound, 
this is no ordinary spike. It’s probably among 
the best available in India with a noise filter 
as well as surge protection built-in. Each of 
the six connects have an individual switch 
and the sockets can fit a variety of plugs. 
Most small hotels have just one plug point 
and having a spike also helps by providing 
multiple points. With my notebook, cameras, 
camcorder, two cellphones and GPS unit to 
charge, I’d make sure to make full use of 
its abilities. If you are shopping for a spike 
guard make sure it also has the ability to 
connect various sizes and shapes of plugs. 
I’ve been in a fix once while staying at a hotel 
in Bangalore for two days where I could not 
charge my notebook despite having available 
plug points in my room and my charger 
— make sure this doesn’t happen to you.

Friday — Answering the call  
of nature!
My last day at office before my vacation 
and I was excited. I settled down to work. 
During my lunch break I thought of 
things I had missed. Another important 
piece of equipment to carry with you, 
especially when traversing through unfre-
quented spots or unfamiliar territory, is a 

GPS receiver. I use a Garmin eTrex H. 
Check it out at http://tinyurl.com/d4wfkv. 
Sadly the unit is grossly overpriced here 
at around Rs. 13,000 but is available in 
the US for around Rs. 5,000. We owe this 
huge premium to the binary facts that 
GPS receivers are considered a novelty 
in India and our government’s insane 
duties and tax structure. The eTrex H 
features a high sensitivity receiver that 
is able to lock on to signals even while 
under cover — such as if you’re hiking 
through a wooded region. Its battery 
lasts for a good 11 hours — more than 
sufficient. Navigation is easy and via 
five buttons and the unit, besides being 
sturdy, is water resistant, a fact that 
has been tested by yours truly. It’s also 
WAAS (wide area augmentation system) 
ready, which is a navigation aid that 
is aimed at augmenting the accuracy 
of GPS receivers. For those looking at 
something ideal for travelling by car and 
with inbuilt maps for navigation, look 
at the Garmin Nuvi 200. This beauty is 
priced at a pocket busting Rs. 20,000 but 
offers a lot for the price. It’s got a wide 
colour display, is capable of 2D as well 
as 3D mapping, offers turn-by-turn voice 
directions as well as allowing the user to 
define points of interest (POI) and later 
gives off a proximity alert whenever 
a POI is near. It’s SD card expandable 
as well. It also comes pre-loaded with 
the maps of India. The only downside 
is the battery life that lasts for around 
four hours real time, which means it’s 
impractical to carry around in-hand. But 
plugged in to your car’s charger point, 
you are assured not to get lost.

That evening I got ready the final 
few things I’d need. I packed my note-
book, my PDA phone and my iPod Touch. 

Nokia N95 8GB — Still the convergence king

I also carefully packed my Grado SR 
225 headphones into their box. I made 
sure to place the fragile stuff between 
denims and shirts — airport personnel 
are no better than the local buses in the 
way they throw baggage around and I 
certainly didn’t want to damage any of 
my beloved possessions. I also packed a 
generic all-in-one battery charger I had 
bought off eBay India. Priced at a mere 
150 bucks this charger works with all 
lithium-ion batteries. In case you happen 
to have two batteries for the same device 
this charger works like a charm. Imagine 
charging your cellphone’s battery while 
using another battery in the device. For 
the interested here’s a link to the product 
— http://tinyurl.com/cw35d2

What is really superb is this multi 
device charger from Power Traveller, 
called the powermonkey-eXplorer. It 
comes with a host of connectors for 
nearly every device including iPods, 
other PMPs, cellphones, PDAs, digital 
cameras, Sony’s PSP, among others. The 
eXplorer comes with a device called 
the solarmonkey which basically allows 
the use of solar 
energy to charge 
your devices. This 
killer device is 
a must have for 
road warriors 
— just hook up the 
eXplorer with the 
powermonkey to 
your backpack in 
the day time and it 
will keep charging 
as you trek as long 
as your backpack 
is in direct sunlight. 
Besides solar charg-
ing, it can also charge via AC power 
or a USB connect. Although expensive 
at close to 50 pounds or Rs. 3,700 
the powermonkey-eXplorer is definitely 
something that goes on my wishlist. 
Check it out at http://tinyurl.com/5aa7vn. 
Although note that its cheaper to buy 
this from Amazon UK. 

With all my packing done I was 
in readiness for the trip. I made sure 
to double-check everything and finally 
kept my e-tickets and ID inside my 
smaller bag that would be my cabin 
luggage. Before going to bed that night 
I had a look at all the stuff I’d be leav-
ing behind. Sure I’d miss my gaming 
rig, I’d miss my HiFi headphone ampli-
fier system and all my other stuff. I 
spent a couple of minutes looking at all 
the stuff I couldn’t carry with me. I got 
into bed. As I was drifting off to sleep 
my eyes went to my packed bags stacked 
in the corner of my bedroom. Of its own 
accord a smile touched my lips even as 
sleep overcame me. All that I couldn’t 
leave behind…

agent001@thinkdigit.com

Sandisk eXtreme III 
— Blazing fast

Garmin eTrex — Rugged, dependable

Celebrate
A big technology carnival, 
the Digit Anniversary Carni-
val, is just one month away. 
Find out more on

Hiking boots need to have ankle 
support else you risk sprains when 
steeping on uneven ground

CONNECTIONS
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The D700 is Nikon’s cheapest full 
frame camera and boasts of terrific 
low light performancevisual story
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Reliance CDMA data card 
— A must have when on the 
go sans broadband. 

Canon A710IS — An old 
model now, but one of 
Canon's better point-n-
shoots with good low-light 
performance

Cell phone charger — Never forget 
these, never leave home without 
it/them

Sanyo Battery Charger — A must 
if you're going to be carrying 
rechargeable batteries around

Apple Macbook 2008 — Sleek, sexy as 
hell and functional, now BootCamp 
adds Windows XP to the fun. A quality 
notebooking experience

Geek On Holiday
Agent 001 goes on 
holiday, here's some of 
the stuff he took along 
and why...
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Mileston Hiking bag — Get one of these 
when you go on long trips. The bag 
has a sleeve for the laptop inside, and 
compartments that can be used to store 
electronics. Make sure the one that you 
pick up is waterproof.  
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Given a choice, opt for Li-ion  
batteries over Ni-cad. This saves cost 
in the long term

Tip:
Hiking boots need to have ankle support 
else you risk sprains when steeping on 
uneven ground

CONNECTIONS

iPod Touch — the PMP of choice for 
music lovers and video junkies alike. 
Loved for its brilliant touch interface  
and excellent all-round performance

EP630 — For under a thousand 
bucks a great set of in-ears

Grado SR225 — Grado's sweet entry -
level offering to audiophiles. Slightly 
bass shy for some, but superb first 
row action in the mids and highs

Nokia N95 8 GB — One of the 
most converged and balanced 
smartphones on the market, 
until the N97 came out that is...

iPod data cable — Never leave your 
pod without it, even though batter-
ies last well over 16 hours

Imate KJam — A full QWERTY keypad 
PDA and one of the more affordable 
models in the market available, but 
slightly long in the tooth now

Nikon D60 — A solid entry-level DSLR  
this one has a 10 megapixel CCD sensor 
and comes with a vibration dust-removal 
system. A great beginners DSLR

ü
ü
ü
ü
ü
ü
ü
ü
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The Demoscene
All the dirt on the mostly underground 
computer generated art movement. 36

 Gamin’ Station. 
 Racing Simulator.

The Gamin’ Station is an add-on to your gaming console for 
the ultimate racing experience. The Racing Simulator works 

with the Xbox, the Xbox 360, the PS2 and the PS3. The default 
configuration comes with a 27-inch LCD screen, 5.1 surround 
speakers, a steering wheel with force feedback and a racing 

chair. This configuration can be updated and customised 
for individual orders, with additional modules such as cup-

holders, custom artwork on the body and a larger screen. The 
basic version will set you back by $2,435 (Rs. 1,27,793) not 

considering the shipping costs.

 LG Versa.
 Transformers edition 
LG is rolling out a limited edition Transformers Versa phone, 
to promote the upcoming Transformers: Revenge of the 
Fallen movie. Versa is something of a little transforming 
gadget itself, with a large touchscreen slate to which 
consumers can attach modules. At present, the only module 
available is a QWERTY keyboard, but planned modules 
include a gamepad. The limited edition Versa will feature 
a Decepticon icon on both the front and the back, which is 
a strange choice as Transformer fanboys are more likely to 
prefer the Autobot icon. No word on the pricing, and the 
phone will unfortunately ship only in the US. Yours for $440 
(Rs. 22,754).
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Learn Online
We give you the lowdown on all 
the hobbies that you can learn 
online. 

39
Bazaar
We check out the  
latest tech to  
hit the streets 68dSLRs

We test the latest
generation of 
digital SLR cameras

56

 Ulysse Nardin Chairman. 
Ulysse Nardin is a company known for making expensive hand-crafted watches. 

It has recently unvieled the Chairman, a smartphone with some unique 
watch-based technology. The side of the smartphone sports a crown, 

presumably to adjust the highly detailed watch shown on the 2.1 
inch touchscreen. Even better is the kinetic rotor, which 

powers up a backup battery on the smartphone in 
the same way movements power up a watch. 

The smartphone is a limited edition, each one is 
hand-crafted, and available in six colours. The 

craftsmen have also thrown in Wi-Fi capability, a 5 
MP camera, and a fingerprint scanner for biometric 

recognition – now you will just have to hide that 
Vertu in shame.

 Canon EOS IDs.
 Mark III.
The Canon EOS IDs Mark III is the top of the line in 
the Canon EOS DSLR range of cameras. The 21.1-MP 
CMOS sensor should satisfy even the most demanding 
enthusiast. While the camera lacks features such as 
HD video recording that much cheaper Canon cameras 
have, it more than makes up by addressing some of the 
most irritating faults inherent to digital photography. 
The tone priority setting makes sure that the minute 
tones in an image are preserved despite harsh lighting 
conditions. The DIGIC III image processor can churn out 
images at higher rates, and the autofocus system uses 
19 primary and 26 secondary autofocus points. The 
basic body is available for $8,000 (Rs. 4,00,141).

 Senses Lounger.
The 4 Senses Lounger takes the concept of the egg chair 

and ups it a few levels. Readers will recall the Ovalia 
with surround sound embedded in the chair. The 4 

Senses Lounger from Schletterer, a German company, is 
a therepautic one-man spa designed for psychological 
and physiological rejuvenation. Tweeters and woofers 
are strategically located for a programmed 20-minute 

audiotherapy sequence. Aromatherapy is provided along 
with vibrations along the surface of the lounger. The 

ambient lighting for relaxation is recognisable even with 
the eyes closed. Each unit is made to order, and the 

colours are customisable.
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From intros for cracked software, to an art movement, 
we trace the evolution of the mostly underground demoscene.

Early computer users, 
predating the 8-bit era, 
created display hacks, which 
were similiar to demos. 

The Demoscene
Aditya Madanapalle

F
or most people, a “demo” means a 
limited version of a program that 
you can try out before making a 
purchase. However, if you belong 

to a mostly scattered community of elite 
programmers and artists, a “demo” is 
a very versatile real-time audio-visual 
presentation. The content of the presen-
tation varies drastically, typically involv-
ing spectacular effects, synthesised 
music and an overall design. Demos 
are usually programmed by a group of 
people, and distributed over forums and 
web sites. The demoscene has a history 
dating back to the 1980s, when personal 
computers were first made available to 
the masses. Since then, the movement 
has been lurking in the shadows, neither 
growing nor fading, but changing in 
style and method.

The C64, Amiga and Atari consoles 
were among the first machines used 
to program demos. Original software 
was costly back then, and users traded 
disks with cracked versions of programs. 
The people responsible for cracking the 
software, tagged the cracked versions 
with pseudonyms for identification that 
helped in making sure of authenticity, 
an early version of the tags used with 
torrent files today. What began as a 
simple image or a macro to identify the 
cracked versions of the software grew to 
become elaborate sequences of sounds 
and images. These sequences were intros 
to cracked versions, called “cracktros”. 
Since the software took up most of the 
space on a disk, there was very little 
leeway for the crackers to work with. 
The fallout was that demo artists had 
to create the most spectacular effects, 
designs and sound possible, and fit them 
in a tiny space. Even today, the smaller 
the demo, the greater the respect it 
commands. A 64-kB sequence, complete 
with generated effects and music, can 
take up as much as 20 MB in a modern 
FLV format encoded for easy distribution 
on the internet. 

One of the key aspects of program-
ming demos was that everything was 
calculated by the computer in real time 
and graphics was rendered on the fly. 
Demos pushed the machine to new 
limits, and took weeks, if not months, of 
programming. For this reason, groups or 
teams emerged, called a “demogroup”. A 
typical demogroup consisted of anywhere 
between four to ten individuals, who each 
performed a specific task. The cracker 

broke down the copy protection and 
other legal restrictions on a program. An 
artist, typically from some other under-
ground faction such as a graffitti artist 
designed the logos and the graphics of 
the demo. Perhaps another artist would 
convert these designs to a digital format. 
A music artist programmed the music, 
which would typically be some form of 
electronica or industrial sounding track. 
A swapper was responsible for spread-
ing the demo, maintaining activity on 
forums, and most importantly, making 
all the contacts that would spread the 
software over the internet. All of this 
would come together on a single disk as 
a demo and a cracked program. Most of 
these people were anonymous, known 
only through their monickers.

Many of these groups were organ-
ised across wide geographic locations. 
Some of them had cycling members, 
and included over 100 people working at 
any point of time. This involved a large 
number of crackers, and a large number 
of traders or swappers. This allowed for 
the latest software to be quickly distrib-
uted to a large number of people. The 
demoscene was and is active mostly in 
Europe, particularly in the Scandinavian 
nations. 1985 to 1995 is considered by 
many in the scene to be the golden age 
of the demo, when the demos flourished 
the most. There are many reasons for this 
perception. Before the Windows-based 
PC came along, Amiga, Commodore and 
Atari were the computers used by most 
people. The hardware capabilities of 
these machines were more or less simi-
lar, and upgrades were almost unheard 
of. The components were fixed, and 
there was no need to cycle them as 
newer versions came into the market. All 
these consoles outperformed the early 
Windows-based machines in terms of 
native graphics and audio capabilities. 
Graphic cards and audio cards were 
very rare, and VGA was yet to make its 
presence felt. This allowed for the first 
generation of demo programmers a level 
playing field, where innovation was very 
hard to achieve.

More than benchmarks, software 
and perhaps even games, demos were 
responsible for pushing machines to 
their absolute limits. Demo program-
mers exploited every bug and glitch in 
the machine, both known and unknown, 
to program that many more compo-
nents into the demo. The way a machine 
operated was studied and used in every 
conceivable way—the swap space, the 
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100
buffer memory and the RAM hacked to accommodate the require-
ments of the demo. Programmers in the scene discovered new ways 
to use shaders and 3D models, smart approaches to combine live 
synthesis of sound with pre-recorded samples, and outrageous use 
of coding tricks. Demos increasingly became versatile with random 
elements. These approaches and methods were often reverse engi-
neered or mimicked by rival groups and used for their own demos. 
Arrogance at coding or design capabil-
ity, and respect towards such talent are 
two mainstays of the demoscene. The 
most well known or popular groups were 
treated and behaved like rockstars.

Early trading parties involved a bunch 
of people meeting up to exchange disks 
and collaborate on parties. Later on, demos 
and software were exchanged over the 
internet, through the use of modems. The 
proliferation of the internet allowed for 
an easy way to spread demos, modifying 
the role of a swapper in the group. The 
swapper became the public face of the 
group, posting on forums, registering for 
parties, representing the group at meets 
and the like. With an increasing focus on 
the demos themselves, the crackers also 
phased out. A lot of demo programmers 
still cracked software, but the associa-
tion with software was removed by the 
emergence of demoparties, where demos 
by different groups were showcased inde-
pendent of any affiliation. The movement 
still remained mostly underground, and 
cracked versions of software still carry 
demos even now, but the vast majority of 
the demoscene gradually became more 
focussed on the art of the demo, moving 
away from any criminal associations with 
software pirates. 

Bulletin boards were maintained 
by some groups, through the agency 
of which the group collaborated and 
released demos. Diskmags for the demo-
scene emerged which were periodical 
releases of a collection of the best demos 
on a floppy disk. A diskmag typically 
had user-rated charts for the best demos, 
appearing on which was considered the 
biggest token of recognition in the demo-
scene. The community developed around 
the demo, meeting up, socialising, and 
sharing a feeling of belonging to the 
same family, the same dedicated bunch 
of coders with a common purpose. Some 
of the early demos threw up better graph-
ics than the games of that time. A lot of 
the coders in the demoscene also coded 
games, or made mods for existing games.

The early Windows-based demos were 
restricted for a number of reasons. The 
platform itself was limited in terms of 
capability, and the existing coders had to 
learn new languages. A new generation of 
coders started coding demos on Windows, 
and diskmags gained a lot of ground in the 
early 1990s. The internet allowed for better 
collaborative efforts over longer ranges, 
and forums allowed for newbies to learn 
the ins and outs of coding. Demogroups 
were considerably reduced in size, because 
distribution and cracking software were 
no longer really relevant. Demoparties 

were organised on larger scales across Eruope, often combined 
with LAN parties. Videos and sampled loops instead of synthesised 
music were considered more acceptable for ease of distribution. 
The focus shifted heavily to artistic demos, moving away from 
flashes, blips, spectral forms and fractals, to smooth flowing 3D 
animations such as highly detailed models, fluids or particle anima-
tions. Demoparties started having segments for judging and voting 

on demos. All the old platforms were 
still allowed, with 4-KB or 64-KB limits, 
increasingly called “intros” as against 
“demos”. Demos were allowed in 256 
KB, 1 MB and upwards, sometimes with 
no upper limit. Synthesised music itself 
became a category at demo parties. 
Individuals were often proficient at 
both coding and synthesising, a neces-
sity as the groups became smaller.

With the growth of software piracy 
for Windows, demos started making a 
comeback along with cracked versions 
of programs. The coveted titles or an 

important version release of a program 
carried demos along with them. These 
demos, however, were just for identify-
ing the cracker or group, and were short 
but spectacular. Demoparties became 
more organised, sponsors were arranged 
for them, and large gatherings from 
the scene wre organised in European 
nations, particularly Germany, Russia 
and Finland. Some of the more recent 
demo parties showcased demos on large 
LCD screens, and involved lengthy and 
elaborate sequences. Within the scene, 
enthusiasts still code for the old plat-
forms, and some obscure devices, rang-
ing from programmable calculators to 
hand-held videogame consoles. Modern 
computers have varying graphic capabili-
ties. Not all demos can be distributed as a 
real-time rendering standalone program 
as the performance may vary dramati-
cally from machine to machine. Some 
will simply not be capable. Most of demos 
nowadays are distributed as video files, 
but that does not mean that they are 
mere animations. The focus is still on 
programming, and the demos maintain 
the format of the older demos, with 
a sequence and a “splash” every now 
and then. In recent times, crackers of 
X-Box and PlayStation games also started 
including demos along with the cracked 
versions of the games for these consoles. 
This kickstarted another alternative 
scene, for consoles. Demos programmed 
for these consoles are distributed as ISO 
disk-image files.

Although the glory days of the 
demoscene are long gone, the scene 
itself is still alive and kicking. The feel-
ing of bonhomie is much greater, and 
the focus is on style and method more 
than ever. Innovation and ability are 
still respected. Diskmags are still active, 
and still release issues, even if they are 
sporadic. The demoscene is still the 
large, highly competetive family that it 
was, and produces great art for those 
who know where to look.n

aditya.madanapalle@thinkdigit.com

Breakpoint, held in Germany 
every year is the biggest pure de-
moparty (a demoparty without a 
LAN party). The scene.org awards 
are given in this event.  
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Kumar Jhuremalani

E
ver felt the need to learn the guitar, and realise 
that you can’t commit the time? Well that’s where 
the internet comes to your rescue. With extensive 
detailed information available all over, anybody and 

everybody can pick up a new hobby. We are going to show 
you how to take advantage of this.

Apart from just strumming, everything right from learn-
ing how to read notes to actually playing any instrument is 
explained thoroughly online. The other hobbies that we will 
discuss here include art, cooking and gardening.

Music 
Most of us love music, but not all have had the 
opportunity to get into the depths of witness-
ing what happens in the making of it. www.
largemart.com/read-music/begin.html discusses the 
fundamentals of reading musical notes. Each 
page sheds more light on tasks such as learn-
ing notes on a piano and understanding where 
the notes fall on staves. For a more detailed 
understanding on reading music, visit http://datadragon.com/
education/reading/. 

Once you can read music by yourself, you will find it 
easier to play the guitar or piano online. Initially, you need 
to be aware of the theory behind the instrument you want 
to play. Consider the guitar as an example. Hear and Play 
(www.hearandplay.com/) is a good web site where you can 

learn more on the various parts of a guitar. This site also has 
vast information on the piano or the organ.  
About.com is another web site that gives you details and infor-
mation on several topics. We’re staying with to the guitar 
right now, so once you are at the site, select Guitar from 
the list they have. Ultimate Guitar (www.ultimate-guitar.com) 
is a site where you can learn various strumming techniques 
with the guitar. There are some detailed images along with 
lessons to teach you exactly how to hold the guitar and 
which chord to strum and when. This site also allows users 
to post videos and tutorials to help others. There are also 
those who may not be able to understand all that we see 
on the internet. Guitar Master Class (www.guitarmasterclass.
net) offers a great Mentored Training Program where senior 
members actually help beginners improve their guitar skills.  

Learning just a single instrument might not be that 
interesting. With sound mixing software such as Zulu DJ 
Audio Software, you can become a virtual DJ. You can mix 
songs you already have and create some exciting tracks. 
With this software, you don’t need to invest in expensive DJ 
and sound mixing equipment. Instead, you can practice with 
this right in the confinement of your home. Zulu is on this 

month’s Digit DVD if you want to give it a try. 
Once you get good at it, you might even move on 
to becoming a professional DJ. 

Art 
You can’t consider art as 
a single hobby — you need 
to be specific about what 
exactly you want to do in 
your free time. While arts 

and craft lessons were fun back in school, very 
few take this up as a hobby. Now, elementary 
and intermediate courses are no longer neces-
sary to learn the correct way to draw or paint. 
You can now sit in front of your computer and 
enjoy your new hobby.

www.learn-to-draw.com is one of the many web 
sites that teach you how to draw — right from 
the basics. There is also a section on caricatures, 
which is really interesting.

Online
Hobbies

Stop wasting time on the internet and 
do something creative and productive instead 

www.guitarnoise.com 
www.justguitar.com 
www.cyberfret.com
 

www.gopiano.com 
www.zebrakeys.com
www.freedrumlesons.com

More web sites to check out

Adventure sports such as sky diving, 
mountain climbing, bungee jumping, 
etc. are quick becoming hobbies for 
all age groups

DIGITAL LIFE
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Stamp Collection
Stamp Collection is a hobby taken up by 
many, where in you collect postage stamps

Jazz
Jazz was the first genre of music 
played on an electric guitar

After drawing, the next step forward with art is adding 
colour to your work. For this, a site such as www.watercolor-
painting.com comes in really handy. Here you get to learn basic 
brush techniques and also some advanced techniques such 
as splatter and spray textures. If you are more interested 
in oil painting, www.learn-to-draw-and-paint.
com has helpful theory and techniques. This 
web site also offers to teach you how to use 
charcoal and crayons in your art. So what 
do you do once you have completed your 
piece? How do you preserve it? These necessary 
details are also given at the same web site.

What about those of you who don’t want to get 
your hands dirty with paint, that’s where digital 
art steps in. With software such as Photoshop or 
Corel Draw, you can create artwork using the mouse. 
Just take a look at www.deviantart.com to see what people 
have done using the computer as a tool for art. This 
web site shows you some really beautiful artwork done 
by its members where software such as Photoshop is not 
just used for correcting images and adding final touches to a 
photograph, but instead can be used to create your very own 
unique style of art. To know more applications of Photoshop, 
you should check www.pixel2life.com, which is actually an index 
of all the tutorials that people have created and submitted 
to different art-related forums and web sites. Pixel2life also 
offers tutorials for a list of 2D-art related software and if you 
are planning to move with the times then you can use the 
same web site as it has links to tutorials for 3D art software 
such as 3D Studio Max, AutoCAD and Cinema 4D.

Also, check out www.mangatutorials.com and www.howto-

drawmanga.com — the 
names of these websites 
speak for themselves, 
and there are many other 
similar ones out there.

The next art form 
that you can learn online 
is calligraphy. This is the 
art of handwriting and is 
another hobby that you 
could pick up from the 
web. Just visit http://vaxx-
ine.com/mikwit/lessons to 
learn more about callig-
raphy and exactly what 
it is. This form of hand-
writing art, though often 
considered to be just a 
hobby, can help you to 
make money.

Let’s move on to craft — origami is the traditional 
Japanese art of folding paper. Check out www.origami-club.

com/en as this site gives you detailed diagrams on how to 
create your own paper models ranging from aeroplanes to 

dinosaurs. This site also offers animated 
tutorials to help beginners in understand-
ing how to start off with Origami.

Gardening 
How many of you know that the optimal pH to 
grow cauliflowers is between 6.0 to 7.0? This is 
just one of the many facts that can be found 

online that will help you in gardening, especially 
for those of you who are already interested in this field. To 
find out more facts related to gardening, visit www.thegar-
denhelper.com. This web site does not only give instructions 

about vegetable gardening, but also has a whole range 
of topics including houseplants, climate-based garden-

ing and many great tips on gardening.
If you are looking to cook the food you grow, then No Dig 

Vegetable Garden (www.no-dig-vegetable-garden.com) is a must visit 
where you will learn how to grow select vegetables on a self-
created organic garden bed.

Bonsai, the Japanese art of growing indoor miniature 
trees is really fun, and you have to take great care of the tree 
in the proper way in order to grow great looking trees. These 
miniatures look really fantastic and quite unreal the first 
time you see them as they are full grown trees but the size 
of a house show piece. There is a lot of useful information 
and guides on learning about Bonsai on the forums of www.
bonsaitreeforums.com. Many users have posted their own accom-
plishments in this field and they look really great.

You can cook a dish like this in no time with recipes from SanjeevKapoor.com

View and post your created artwork at Deviantart.com

Learn how to grow 
Bonsai trees and 
decorate your 
house

Create some funny caricatures like this 
one of Charlie Chaplin

feature
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Cooking 
Okay this might not interest everybody reading this, but cook-
ing is really a great skill to have and taking it up as a hobby 
will be a really wise choice. Food is one of the basic necessities 
that one needs to survive and cooking for friends is a useful 
social skill. Learning to cook online is really easy as there are 
tons of recipes and video tutorials available to help you. Many 
youngsters are opting to go abroad to study or work, and this is 
perfect for them as they might not always have a cook or might 
face a situation where cooking might be the only way out. 
So where should you start with this hobby? Well as http://
www.reluctantgourmet.com shows us, a basic tomato sauce or 
mashed potato is where you can start. After this, you can 
then move on to a simple pasta. Also see http://busycooks.
about.com/od/cookinglessons/a/cookinglessons.htm, and for Indian 
cooking: http://indianfood.about.com. Once you have mastered 
the basics, then check out recipe sites, such as: www.indianfoodrec-
ipes.net, www.tarladalal.com and www.sanjeevkapoor.com  where you 
can find the latest Indian recipes.

Photography
Photography has come a long way from the early box cameras 
to modern dSLRs, and the future is also looking bright 
for photography as 3-D cameras are already in research 
and development. So where does one start off if they 
want to learn about photography? The beginner’s guide 
at www.photonhead.com takes you through the basics of 
your camera and also gives you great information about 
some photographic concepts. Photohead also includes 
many good advanced tips and tricks for those of you who 

already know the basics and want to learn more about photog-
raphy.  

Visit http://photobites.blogspot.com/ to learn some advanced 
photography techniques and improve your skill level.

Even though you read these guides and learn these tricks, 
putting them to use is important. So anytime you leave your 
house taking your camera with you is a must. The inspiration for 
a photograph can just hit you anytime and anywhere. You might 
see a funny sign board or might even be caught up in a traffic jam 
when you could take a really great shot of your surroundings.

So what do you do when you have taken your photo? You can 

upload these photos on photo sharing web sites. There is 
more on that in this issue.

Photography can also be linked to digital art as you can 
touch up your photo using software such as Photoshop. To 
know more about how you can touch up your photos visit 
the web site mentioned in the arts section of this article.

Creative writing / blogging 
Blogging is something that most of you might have already 
started, but did you realise by doing so you are actually increas-
ing your skill at creative writing and in turn are unlocking your 
imagination? If you are just blogging about your daily routine 
then you should check out how to improve your writing skills. 

Creative writing is fun. Once you get the hang of it, 
you can write on just about anything. Check out http://
www.dailywritingtips.com/creative-writing-101/ for tips on 
creative writing.

Mod Casing
Mod Casing is basically any modification you do to a 
case (computer, console, phone), to change the look of 

it. This is a very niche hobby, but it is fun in its own way as it 
involves using tools to break and cut the metal from your cabi-
net. http://case-mods.linear1.org/ is a great place to start off if you 
are new to case modding. This site teaches you from the basics: 
how to case mod just by doing a paint job on your cabinet to 
give it a new look. People have gone to great troubles just for 
this hobby to create unique and simply fantastic case mods. One 
of our personal favourite mods is the Human Case Mod project 
where the case was built from a mould of the builder’s wife’s 
body!!! But of course, you don’t need to start off with something 
that complex, though it is just phenomenal, the basics that 
most people start off with entails cutting the side panel of their 

computer case and putting a sheet of acrylic to make it transpar-
ent done really well at the linear1 web site.  

Some of the resources mentioned would definitely draw your 
attention. Besides, Youtube.com is another great place to learn 
new hobbies. Users have posted video tutorials on all the above 
mentioned hobbies. If you actually keep practising your selected 
hobby or hobbies you might even be able to make it into your 
career and make money from it. This shows another example of 
how you can indirectly make money using the internet.

kumar.j@thinkdigit.com
Take advantage of online photography contests 

Half Life 2 based case mod

Check out www.casemodgod.com for some of the most insane case 
mods created by people. Once you mod your case you can always 
post it on sites like these and get people to go WOW! Other sites 
worth a visit are — www.mofocases.com, www.neatorama.com, www.
modders-inc.com

Don’t forget to visit

There is a bonus for those who want to take up photography as a 
serious hobby as this month we have a Digital SLR comparison test 
which can be found on page 56 of the magazine. This test will include 
some great cameras and will help you understand which one is best for 
you to purchase.

Bonus

Know more about the 
exciting Digit carnival 
next month 78

DIGITAL LIFE
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sci-tech
Tomorrow's Tech

A green Olympics
The 2012 London Olympics 
may be the greenest yet. The 
city is planning to use Solar 
shuttles on the river Thames
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Aditya Madanapalle

F
rom personal gadgets to mass transit systems, and household 
appliances to satellites, all depend heavily on electricity. For 
most of the twentieth century, the demand for electricity has 
mostly been met by power stations. Power stations typically use 

a generator that converts the kinetic energy into electricity energy. This 
typically involves a turbine rotated at high speeds. The mechanism for 
moving the turbine varies depending on the type of power plant. The 
flow of water is used in hydroelectric power plants, where the turbines 
are located in the structure of dams. Hydroelectricity was, for long, the 
most promising method of producing electricity. The source is renew-
able. Therefore, a single dam can produce electricity for decades. China 
has more than 15 large scale dams in various stages of construction.

Apart from generation, a vital step in electricity consumption 
is the transmission of electricity from power plants to consumers. 
Transformers are the units for transmission of electricity. Electricity 
cannot be stored in large quantities for mass distribution, and has to 
be consumed more or less as it is produced. Transferring electricity 
over large distances required cables and transformers, or distribution 
stations. Transformers occupied significant spaces in urban areas. 
Electricity consumption is constantly monitored, and the most innova-
tion takes place here, from low-power appliances and gadgets to acces-
sible meters for monitoring usage. 

Here, the entire system of generation, transmission and consump-
tion (known as a grid) is under review. A single grid may have a number 
of power stations, transformers, city users, industrial sectors and rural 
areas connected to it. The entire system tends to be large, problematic 
and uneconomical. The scientific community is in the process of 
innovating each step in the process, and coming up with a range of 
methods for addressing the various issues concerning the production 
and distribution of electricity. 

Microsized power 
Solar cells were one of the most promising sources of clean electric-
ity, and were heavily promoted in the pre-1980 oil crisis. As oil prices 
dropped in the early 80s, solar cell research slowed down consider-
ably. The biggest problem with solar cells is that they are very low in 
efficiency, which is measured by the fraction of incident solar energy 
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converted into electricity. The most common solar panels typically 
have efficiencies that are less than 15 per cent. It was only in 
2006 that technology allowed for an efficiency of more than 
40 per cent. However, in tropical nations, even the 15 per cent 
efficiency is ample for daily use. Small and remote villages in 

India are totally powered by solar panels, which saves the cost of hook-
ing these places up to the grid. 

Wind energy, using windmills is another option as a renewable 
power source. In recent times, there is a preference for large wind-
mills instead of the smaller, noisier versions. There are a number of 
large scale windmill farms coming up all over the world. Hundreds of 
windmills have been installed at Satara, and Suzlon is planning India’s 
largest windmill plant at Kutch, Gujarat. This plant will have a capacity 
of 450 MW and will put the arid, barren deserts to good use. Remote 
places are ideal spots for windmill farms, and in the future, companies 
may look into large scale windmill farms in the world’s oceans.

One of the ideas that is getting increasingly popular is microgen-
eration of electricity. This means every household, small community, 
or industrial area will generate its own electricity requirements. This 
has taken off already to some extent. In Canada, the government buys 
off some of the electricity generated by solar panels installed in resi-
dential areas. In the UK, the government has policies that encourage 
and subsidise microgeneration projects, with the politicians opting for 
it as a PR exercise.

Nuclear energy, when handled well is an environmentally sound 
method for generating electricity. Instead of large-scale nuclear power 
plants that are hooked to the grid, smaller nuclear power plants are 
being considered by a number of companies. Toshiba is planning 
on nuclear reactors as small as 15x10 feet to power entire buildings. 
These will be long term investments, and are basically more or less 
future proof, as the electric supply will continue for a period of four 
decades. Hyperion, a company based in New Mexico is in the forefront 
of nuclear microgeneration. It plans to mass produce small nuclear 
reactors that can each be installed across the globe, and power 20,000 
homes each. These nuclear plants will be smaller than a typical garage, 
and will be safely buried underground in a concrete envelope. They 
will need refuelling once every five years

These nuclear power plants use nuclear fission. Nuclear fusion, 
is something far more exciting and potentially economical. Present 
technology only manages to create less energy than the amount of 
energy used to create the fusion burst, and that only in extremely 
short bursts (less than a second). There are a number of experiments 
on fusion power around the world, the most significant being the 
Joint European Torus (Jet) at Oxfordshire, UK. Scientists have flirted 
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Leapfrog Technologies
Environmentally disasterous projects 
(such as Dams) are still being constructed 
in third world Nations (such as China). 
Leapfrog technologies aim to directly 
jump ahead in the progress timeline

Oil Peak
The maximum extraction of Oil 
from around the world is called 
"Peaking". Some say this occored 
in the 1970s, some say it will  
occur in 2020

First Solar Cargo 
Ship leaves docks
At the end of December 2008, the 
first Solar Cargo vessel set sail from 
Japan. The Auriga Leader transports 
Toyota vehicles across the seas 

with fusion power for a long time now, but the technology is proving 
surprisingly difficult to develop. This is mostly because when break-
throughs occur, fresh obstacles show up. The biggest problem lies in 
containing the very hot plasma required for fusion to take place, for 
which electrostatic or magnetic fields are currently used. The raw 
materials for fusion are deuterium and tritium, heavy isotopes of 
hydrogen, found in water. Fusion power is looked upon as the holy 

grail of power generation, promising a 
very scalable and sustainable source of 
electricity. When combined with micro-
generation, fusion power alone should be 
sufficient to meet mankind’s needs for a 

very long time.

Recycling energy 
The current methods of production and consumption of energy are very 
wasteful. A large chunk of the energy is not used for the final work, or gets 
dissipated as heat. A lot of electricity use is terribly inefficient. For example, 
power plants consume fossil fuel to boil water. The steam turns turbines 
that then produce electricity. This electricity is then converted back into 
heat to warm up a home, or prepare warm water. A solar water heater 
would reduce the maintenance cost of a grid, and conserve the energy 
lost in the various stages of production, transmission and consumption. 
Scientists will look to install usage-specific sources of electricity. Street 
lights and traffic signals around the world have already sprouted solar 
panels. The next step in this direction is to research innovative ways to 
convert wasted energy into electricity. 

Some kinds of materials generate electricity when put under pres-
sure. Metal plates beneath roads could theoretically be used to power 
up the streetlights. Electricity could be stored during the daytime, 
and used at the night. Similarly, plates could be placed below mass 
transport systems such as trains. Although generating enough elec-
tricity to power the trains themselves is impossible according to the 
laws of physics, auxiliary devices such as signal lights, fans, lights, 
indicators and doors could be powered by the movement of the trains. 
This would require more energy to drive the train, but overall could be 
more efficient. Existing vehicles do use some of the kinetic energy for 
some of the electric needs. The Toyota Prius for example is a hybrid car 
that does just this. At smaller levels, certain crystals produce electric-
ity when pressure is applied. This principle could be used to power 
gadgets; a gaming console, mobile phone or computer could be fed 
back at least some of the required power from the effort of pressing 
the keys.

Converting the energy from the movement of the human body 
into power with portable instruments is an idea that has been around 
for a long time. Kinetic rotors power watches, and some of them even 
power personal gadgets (refer to Drool Maal in this issue). Torches, 
radios, mobile phones, and cameras are all ideal candidates for using 
the kinetic energy released from human movement. The technology 
for this already exists but costs more to mass produce and deploy than 
traditional battery-driven gadgets. An MP3 player that juices up as you 
jog is a great idea, and there would be many takers for such a gadget. 
The California Fitness Center in Hong Kong is a gym that draws power 

from the patrons who work out, and use it to light up the place. In the 
future, expect to see more such usage specific ways to draw power. 

Enter the Matrix
Groundbreaking research suggests humans, potatoes, trees, cows and 
bacteria as possible sources of electricity. You can’t just connect wires 
to a human body and expect it to power a light bulb, but that does 
not mean that humans may not, one day, become batteries. Microbial 
Fuel Cell technology is a great candidate for extracting energy from 
any kind of biological matter. Bacteria decompose organic matter, and 
the energy that would have normally been used for the metabolism of 
the bacteria is channelled to electricity, and stored in batteries. Rotting 
foodstuff, waste and decomposing bodies – including human 
ones – could be used to produce electricity.

Bacteria can be bio-engineered to consume 

almost anything, and convert it into electricity. A source of energy that 
is green in more ways than one is the idea of pollution-eating bacteria 
that generate electricity. Wet garbage and night soil are rich in chemi-
cals that can be used for the generation of electricity. Use the right kind 
of materials with human urine, and you get a small, portable battery 
that lasts a few days. The digestive juices of cattle have also been used 
to generate electricity. Bacteria can be used to decompose human and 
livestock waste, and then the waste itself is reduced to a form of etha-
nol, which is then used as fuel in power plants. This is not a new idea, 
but an idea that has not been implemented for a long time. As much 
as a century ago, gas from rotting vegetables was used to light street 
lamps. Another idea applies pressure and heat to biological waste, 
mimicking the natural processes that many assume produced crude 
oil. Although the technology exists, the efficiency is not perfect, and 
development will take some time. 

Just connect wires to a potato or a lemon, and surprisingly, it 
will power a (small) light bulb. You will have to find a very low power 
light-bulb though. Large potato farms as a source of energy have been 
around in popular culture for some time now. While this idea may 
not be viable, there are similar ideas that can be put into practice in a 
practical way. For example, trees can line streets and be used to power 
the street lamps.

Supernova Batteries 
Some of the ideas that the scientific community has are beyond the 
scope of current technology. The Sun, for example, is a great source of 
energy. The incident solar radiation on a small part of the surface of 
the Earth, is a viable option. A modern industrial nation receives solar 
energy equivalent to approximately 1,000 times its normal energy 
usage. Imagine large solar arrays in space that beam back energy in 
the form of microwaves to Earth (killing countless birds — ed.). Now, 
imagine a ring of solar arrays arranged all around the sun, and the 
amount of energy it could beam back to the planet. How about a star 
completely enclosed within a spherical solar panel — you have what 
they call a Dyson sphere. This kind of a structure would capture all the 
power released from a star. 

Exotic materials or particles such as miniature black holes and 
anti-matter are thought of as great sources of energy. Anti-matter 
has been created, and power extracted too, but the particles are very 
rare and very costly to be commercially viable at present. However, 
there is active research going on in particle physics, and there may 
be properties or particles that are hidden from human science at 
this point of time. n

aditya.madanapalle@thinkdigit.com
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Mihir Patkar

I
t seems that in the end, all it takes to capture the male atten-
tion is the ability to let the guy boast: “Mine’s bigger”. These 
days, any advertisement for a new phone or camera hypes up 
the megapixel count. The Mobile World Congress was awash 

with new handsets touting 8-megapixel cameras, while Samsung 
is already launching a couple of those on our shores here. 

Meanwhile, technology enthusiasts continually shake their 
head. We all know that the true power of a picture lies in the 
image sensor. The battle between the two default technologies 
— charge-coupled device (CCD) and complementary metal oxide 
semiconductor (CMOS) has raged on since they were invented 
about 40–50 years ago. 

Two camps have developed, depending on manufacturer alli-
ances, which promote one of the two technologies.

The CCD camp touts its better picture quality, 
given that it has traditionally served as the bench-
mark. CMOS has slowly been catching up in this 
respect, but in all honesty, still has miles to go before 
it can click.

The CMOS camp, though, stresses on the smaller 
size of the sensors and lower power consumption. 
The latter is a key feature in favour of the technol-
ogy, as this greatly advances its chances of becom-
ing the de facto sensor type for mobile phones, where 
battery is king.

Size, however, is still up for debate. Yes, CMOS 
sensors are significantly physically smaller than CCD 
sensors; but they also require accompanying chips to 
optimise the captured colours, and of course, better 
quality lenses to achieve the same image quality. CCD 
sensors, on the other hand, bring the kitchen sink 
with them.

Where the companies stand...
Of course, for the end user, what matters most are for which sides 
the big companies are rooting. 

The CMOS camp is currently championed by two heavy-
weights in the photo industry, Sony and Canon.

The latter has already outfitted most of its digital SLR (DSLR) 
cameras with CMOS sensors, replacing the once-popular CCD, and 
rumours are that it could soon go the same way with pro-level 
digital camcorders. And at this year’s IEEE International Solid 
State Circuits Conference, the company discussed its efforts in 
developing a 3.3-MP CMOS image sensor that promises higher-
quality video and imaging for mobile phones. 

Sony, meanwhile, is concentrating on developing new tech-
niques for its proprietary CMOS sensor’s analogue-to-digital conver-
sion process. By enabling each pixel column on the sensor to have 

its own conversion process, the image quality could be 
pushed up significantly while loss is minimised.

When it comes to mobile phones the CMOS market 
is booming the most, with CCD nowhere in sight — 
Samsung’s OmniaHD is churning out 720p videos with-
out much effort on its processor or battery.

On the CCD side, Fujitsu Research’s efforts towards 
the Super CCD EXR have had CMOS proponents cowering. 
Incorporating a revised control circuit and new arrange-
ment for colour filters, new cameras like the FinePix 
F200EXR offer more bang for buck than ever before.

But the greatest advocate of the CCD technology 
over the years has been Kodak Eastman. Last year, the 
company wowed the world with the world’s first 50-mega-
pixel sensor. To get an idea of the sheer scope, consider 
that in an aerial photo of a 2.5-kilometre-wide field, you 
should be able to pick out a small 1x1 foot laptop. As 
always, with superior photo imaging, Hasselblad is the 
first to jump onto the bandwagon, touting this sensor in 
its H3DII-50 dSLR.

Of the major companies, Nikon is the only one still strad-
dling the fence. Some of its cameras incorporate both CMOS 

and CCD sensors.
And as always, the scientists who actually conduct the 

research on these technologies are least bothered about these 
cosmetic battles. For them, it’s all about getting out a better 
picture in the end.

Clear logic
The most path-breaking technological advance that we will come 
to see in the near future, we think, will be from the veterans of 
photography — Kodak Eastman. The company has arguably done 
more for the world of image capture than any other. The latest 
barrier it has broken down brings a wide scope, as it applies to 
both CMOS as well as CCD sensors, and promises to end the need 
for flash bulbs!

In a nutshell, Kodak’s researchers have figured out a way to 
enhance picture quality, especially at night or in motion, by two 
to four times that of a camera today. And they did it by adding 
nothing more than a ‘clear’ pixel to the existing Bayer pattern of 
filter arrays.

The improvement — by scientists John Compton and John Hamilton 
— could give image sensors a 2–4 times increase in sensitivity.

The two Johns have introduced a fourth pixel filter to the 
Bayer Pattern, which has no pigment on top. This clear pixel, 
called a ‘panchromatic pixel’, is sensitive to all visible light 

Sensory Activity
All you wanted to know about image sensor technology — where it’s at, 
what innovations it’s going through, and what the future holds...

The CCD sensor was invented 
in 1970 at Bell Labs

Live MOS and let live

To put it simply, Live MOS seeks to take the best properties of CCD 
and CMOS sensors to develop a ‘super-sensor’. It is claimed to 
deliver the image quality of a CCD, while using the kind of power of 
a CMOS sensor.

Essentially, it’s a souped-up CMOS sensor. The biggest break-
through for Panasonic researchers was reducing circuit paths on the 
surface of a CMOS sensor. By bringing these paths to the minimal two 
that a CCD requires, the photosensitive area of the sensor was boosted 
by thirty per cent.

This added clarity is what gives Panasonic the bragging rights for 
‘image quality that’s as good as CCD’, although quite a few reviewers on 
the internet would beg to differ.

Still, it is significantly better than CMOS in terms of picture qual-
ity, and the simplified circuit takes a lesser toll on the processor, thus 
providing photographs faster. Couple it with proprietary noise-reduc-
tion technology and LiveView functionality, the fast shutter speed in 
the compact Micro Four Thirds system promises to offer great bang 
for your buck.

And already, the Lumix DMC-L1 as well as the Olympus E-330 
have received some accolades from the industry as well as inde-
pendent reviewers. Has Panasonic really created a game-changing 
technology here?

UW-Madison electrical 
and computer engineer-
ing graduate student Hao-
Chih Yuan holds a sample 
of a semiconductor film 
on plastic
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wavelengths, and is designed to absorb 
light. The lack of filtering light to detect 
colour information makes the sensors 
more sensitive, thus providing greater 
luminescence, which translates to better 
clarity in the end result. 

In the new array, the panchromatic 
pixels would be predominant. So, (fig 2) 
the panchromatic pixels would be twice 
in number those of green pixels, while 
the green to blue/red ratio would still 
be 2:1. What’s more, the array could use 
different patterns with these new pixels, 
depending on the kind of applications 

and power requirements that the sensor demands.
“This represents a new generation of image sensor technol-

ogy and addresses one of the great challenges facing our industry 
— how to capture crisp, clear digital images in a poorly lit envi-
ronment,” said Chris McNiffe, General Manager of Kodak’s Image 
Sensor Solutions group.

Distilling distortion
While the issue with photo filters should be addressed in the 
near future, US-based scientists from two universities are look-
ing a bit further down the years. After all, they’re going after a 
much more complex problem, at least in terms of pure hardware  
engineering: the distortion caused by the relationship between 
flat photodetectors and curved lenses.

University of Wisconsin-Madison’s Electrical and Computer 
Engineering Associate Professor Zhenqiang “Jack” Ma and 
student Hao-Chih Yuan have developed a flexible light-sensi-
tive material that, they say, could revolutionise photography. 
The team also includes UW-Madison Materials Science and 
Engineering Professor Max Lagally and University of Michigan 
Professor Pallab Bhattacharya.

Their inspiration for this potentially ground-breaking tech-
nology: the human eye! Light enters the eye though a single 
lens, but at the back of the eye, the image falls upon the curved 
retina, eliminating distortion. “If you can make a curved imag-
ing plane, you just need one lens,” said Ma. “That’s why our 
development is extremely important.”

Ma and his group have created curved photodetectors with 
specially fabricated nanomembranes — extremely thin, flexible 
sheets of germanium, a very light-sensitive material often used 
in high-end imaging sensors. The researchers can then apply 
the nanomembranes to any polymer substrate, such as a thin, 
flexible piece of plastic. Currently, the group has demonstrated 
photodetectors curved in one direction, but Ma hopes to develop 
hemispherical sensors soon.

“We can easily realise very high-density flexible and sensitive 
imaging arrays, because the photodetector material germanium 
itself is extremely bendable and extremely efficient in absorbing 
light,” Ma said.

And what next?
Present research, near-future technologies and distant-future possi-
bilities aside, what’s next in the big picture for sensor technologies? 

The answer may lie with a bunch of Harvard guys, who have 
created what they call “black silicon”. This material can absorb more 
light than any other commercial material on the planet, so be on the 
lookout for great things from a spin-off venture called SiOnyx. 

After all, a material that captures the infrared spectrum is 
bound to capture the world’s attention with it!  n

readersletters@thinkdigit.com

Why distortion occurs

Ever taken a photo of a person from up close? Some can turn out look-
ing like images from an amusement park’s ‘Hall of Mirrors’, with an 
enlarged nose or a hand as big as a head.

This distortion happens because of the distance between the lens 
and the photodetector — a light-sensitive material such as the sensor 
in a digital camera. 

When a camera records an image, light passes through the lens 
and lands on the photodetector. However, a lens bends the light and 
curves the focusing plane. 

In a digital camera, the point where the focusing plane meets the 
flat sensor will be in focus, but the image becomes more distorted the 
farther it is from that central focus point.

High-end digital cameras correct this problem by incorporating 
multiple panes of glass to refract light and flatten the focusing plane. 

However, such lens systems — like the mammoth telephoto lenses 
sports photographers use — are large, bulky and expensive. And even 
high-quality lenses stretch the edges of an image somewhat, thus never 
providing a “true image” for the photo-enthusiast. 

Applications

The two main applications for this new sensor pattern are clicking 
photos in dim lighting, or snapping a picture of moving objects (see 
comparison shot provided by Kodak). 

In consumer technology, 
the obvious advantage lies in 
mobile phone cameras. Low-
light shots are still an eyesore, 
even with the dual LED flash 
on some of the new handsets. 
Sensitivity to light is the key 
to delivering less grainy (i.e. 
less noisy) images, and that’s 
exactly what panchromatic 
pixels offer.

As for blurry shots, mobile phones as well as end-user digital 
cameras have fallen prey to moving hands and faces. The promise 
to get rid of these, without the added hassle of image stabilisation 
algorithms, is quite attractive, as it reduces processing power and 
bloated software.

While Kodak is currently working on CMOS versions of the 
panchromatic array, and already has a sample sensor ready, the CCD 
version is more promising for scientific institutions, especially those 
involved in space science. 

It’s pure light out there, and in the near future, we might just 
get to see the most fantastic shots of the universe!

Technology has improved image 
stabilisation

The Bayer Pattern
To understand the breakthrough, one needs first to know the mechan-
ics of a sensor itself, be it CMOS or CCD. The sensor is an array of 
millions of sensor pixels, which collect and store photons from light 
captured by the camera’s lens.

By themselves, these sensor pixels would be able to capture only 
greyscale images. To capture colour, a filter needs to be placed over 
each pixel, thus letting each pixel capture only a particular colour from 
the incoming photons. The pixels, of course, are restricted to RGB (red, 
green and blue).

Once the pixels capture these colours, smart algorithms take over 
— in a simplistic explanation, they make sense of the colours from the 
millions of pixels on a sensor, join the dots, so to speak, and deliver the 
best image. 

In 1976, Kodak scientist Bryce Bayer 
figured out that the best output requires 
the best array of filters. Experiments led 
him to conclude that this optimal array 
was an alternating series of pixel filters, 
with the first line being red-green and the 
next one being green-blue, such that green 
becomes the dominant filter colour on the 
sensor (see Fig 1).

The Bayer Pattern has since become the basis for creating sensors, 
be it for CCD, CMOS, or any other. It is so widely used, that only an 
improvement of the same technology makes sense in terms of manu-
facturing, as an overhaul of the system is too much of a cost to bear.

Fig 1

Fig 2

Anniversary Carnival: 
Flip over to know more 78 Digital SLRs use larger CCD 

sensors than point and shoot 
compact digital cameras
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Computer Science and Artificial Intelli-
gence Laboratory (CSAIL) at MIT is using 
robots to do their gardeningfrom the labs

Mihir Patkar

P
ranav Mistry needs to make a phone call. While most of us 
would whip out our handset for this simple task, Pranav 
holds up his left palm in front of his chest. As if by magic, 
a number-pad appears on his fingers! His right index 

finger, tipped with a red cap, deftly dials out the digits and hits 
‘Call’. The earphones and mike — attached to the cellphone in his 
pocket — take over, and Pranav is happily yapping away.

Reality is a playtool for this 27-year-old. Studying for a PhD at 
the Massachusetts Institute of Technology’s Media Lab, he already 
holds a Master of Arts and Science from the institute, in addition 
to a Master of Design from IIT Bombay. 

“I’m a desigineer,” Pranav laughs. “Exposure to diverse fields, 
from design and technology to art and psychology, gave me an 
interesting perspective to the world.”

Born to an architect in Palanpur, a small town in northern 
Gujarat, Pranav has previously worked as a User Experience (UX) 
researcher at Microsoft India.

“I love to see technology from a design perspective, and 
vice versa. This vision reflects in almost all of my projects and 
research work,” he says.

His new endeavour stands testament: called ‘SixthSense’, the 
tool sees what the user sees, and augments surfaces or objects he 
is interacting with. What’s more, it’s small and light enough to be 

worn around your neck like a pendant, or affixed to your cap.
“SixthSense attempts to free information from its confines by 

seamlessly integrating it with reality, and thus making the entire 
world your computer,” he says. Pranav is associated on the project 
by the head of the MIT Media Lab’s Fluid Interfaces Group, Pattie 
Maes, and fellow student Liyan Chang.

Creating a sixth sense
Multi-touch and gesture-based devices have been getting increas-
ingly popular, Pranav says. Meanwhile, mobile devices are getting 
increasingly smaller, allowing us to be connected anywhere and 
all the time. So why not couple the two?

“We’ve evolved over millions of years to sense the world 
around us. When we encounter something, someone or some 
place, we use our five natural senses to perceive information 
about it; that information helps us make decisions and chose 
the right actions to take,” he says. “But arguably, the most useful 
information that can help us make the right decision is not natu-
rally perceivable with our five senses.” 

The data, information and knowledge that mankind has accu-
mulated about everything is now increasingly available online. 

“Although the miniaturisation of computing devices allows 
us to carry computers in our pockets, there is no link between 
our digital devices and our interactions with the physical world. 
Information is traditionally confined on paper or digitally on a 
screen,” the engineer says. 

Unveiling their project at the Technology, Entertainment, 
Design (TED) 2009 expo in February, Maes said, “I had been 
intrigued by this question whether we would evolve or develop a 
sixth sense, that would give us endless and easy access to meta-
information that may be relevant to making a right decision.”

That’s where Maes’ “genius” student came in. Pranav had 
previously worked in the field of augmented reality, in which 
real-world and computer-generated data are seamlessly blended 
into real footage in real-time. 

“I’ve noticed that we humans are interested in informa-
tion, not the computing. 
The idea of living in the real 
world, but still augmented 
with the advantages of the 
digital world, excites me,” he 
says. “In fact, I don’t like the 
idea of having two separate 
worlds. It should be seam-
less.” So Pranav decided to 
push augmented reality one 
step further.

Turning sci-fi to reality
Steven Spielberg’s 2002 
science-fiction film Minority 
Report offered many glimpses 
into the future of technology. 
On the computing side, the 
audience gasped in wonder as 
Tom Cruise’s character wore a 
special glove to manipulate a 
digital screen without touching it — operating it solely by gestures.

Spielberg had based this amazing interface on research 
pioneered by one of his science advisors — John Underkoffler. 
Since then, Underkoffler, an MIT alumnus, has developed this 
interface further at his company, Oblong. He recently demon-
strated a working prototype of the same, called the ‘g-speak’.

“Unfortunately, g-speak uses an array of 10 high-precision 
infra-red cameras, multiple projectors, and an expensive hard-
ware setup,” Pranav says, adding that it still served as one of his 
inspirations.

There are other such technologies too — although none as 
advanced as the g-speak — that share common hindrances — the 

With a fully functional keypad projected on his palm, Mistry dials a 
number by tapping his fingers

An Indian researcher wants you to develop a sixth sense that makes the entire world 
your personal computer. And his latest gizmo — made from off-the-shelf 

items and costing less than Rs 17,500 — might just do that!

Pattie Maes, Head of MIT Media Lab's 
Fluid Interfaces Group

Developing a sixth sense
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Siftables
Siftables are technology blocks from MIT, 
than can be put together like Lego bricks 
to make different divices. .

Bill Gates, the philanthropist, released 
mosquitoes into the air at TED 2009 
as he was making a point about 
Malaria.
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hardware has to be reachable by the user; the 
device has to be as large as the interactive 
surface; and they all need custom screens or 
goggles that display the projected images.

All these factors turn portability and cost 
into insurmountable problems.

Pranav needed to make his gizmo different 
in several significant ways. First, allow the user 
to interact with the projected interface using 
hand gestures. Second, free the user of the limi-
tations of physical space (giant screens) as well 
as personal (goggles), and make it portable and 
cost-effective at the same time.

Maes didn’t repeatedly praise him as a 
genius for no reason. A bit of brainstorming, 
and voila! The SixthSense was born…

So what is sixth sense?
“Other than letting many of you live out your 
fantasies as Tom Cruise of Minority Report, this 
is one of those devices that can really provide a 
sixth sense about everything in front of you,” 
Maes said during her address at TED (available 
on the DVD).

SixthSense is a wearable, gesture interface.  
The current prototype consists of three main 
hardware components: a pocket projector (3M 
MPro110), a camera (Logitech QuickCam) and a 
laptop computer.

For the software, Pranav developed several 
computer-vision based techniques/algorithms, 
using open libraries such as openCV. 

The entire cost, sans the laptop computer, 
runs to about $350 (Rs. 17,500 approximately). 

The engineers are discounting the expenses 
of the laptop because they have already figured 
out a way to use mobile phones in its place. 
While the notebook is still used for heavier 
computation, with mobile devices today sport-
ing the kind of power that a computer had 
five years ago, it’s only a matter of time before 
laptop is completely replaced by a cellphone.

Both the projector and camera are mounted 
on a hat or coupled in a pendant-like wearable 
device, and are connected to the laptop, which 
the user carries in a backpack.

Pranav prefers the pendant look: “It 
improves recognition as the body of the user 
moves less than the head.”  

“Plus, it would be socially more acceptable in this form 
factor,” he laughs.

The software program processes the video stream data 
captured by the camera and tracks the locations of the colour 
markers at the tip of the user’s fingers, using simple computer-

vision techniques. Currently, these mark-
ers are simple caps of whiteboard pens.

“The current prototype only tracks 
four fingers — two index fingers and two 
thumbs. This is largely due to the rela-
tive importance of the index finger and 
thumb in natural hand gestures,” Pranav 
explains. Needless to say, the number is 
currently restricted only by the program-
ming, and could easily be scaled up.

The system also implements a few 
object-augmentation applications, where 
the camera recognises and tracks physi-
cal objects such as a newspaper, a coffee 
cup, or a book, and the projector portrays 
relevant visual information on them. 

In a demonstration video (available 
on the DVD), Pranav walks into a book 
store and picks up a novel. The Wear Ur 
World system recognises the book, and 
portrays its Amazon.com rating. It can even 
provide reviews, user comments, and 
even additional annotations.

A bit of stylus input…
When it comes to operating an interface 
based on touch/hand gestures, the first 
technology to use it effectively was the 
stylus on touch-screen mobile devices. 
There’s a simple, yet lasting, joy in scrib-
bling a few words on a screen and seeing 
them digitised. The SixthSense, of course, 
had to have a pen-type input. The index 
finger, Pranav thought, would make a 
good replacement.

“The user can draw on any surface 
using the movement of the index finger 
as a pen,” he says. Putting the thumb out 
activates the pen, and putting the thumb 
back in holsters it.

Of course, this opens up a whole 
bunch of gesture-based shortcuts: 
“SixthSense lets the user draw icons or 
symbols in the air, using the movement 
of the index finger, and recognises those 
symbols as interaction instructions.”  

For example, to access your email, 
all you have to do is draw the “@” sign in 
the air, and you’ll land up on your inbox. 

Need to use Google maps? Just draw a star to start plotting your 
way.

And to undo any action or operation, simply draw an X in the 
air — the symbol for ‘incorrect’ doesn’t owe its origin to technol-
ogy, but it is universally recognised!

Still, this is just the tip of the iceberg as far as the SixthSense’s 
gesture-recognition system is concerned.

…a Bit Of The iPhone…
The world of gestures was revolutionised by Apple’s iPhone. Not 
many tech-enthusiasts can forget the moment when Steve Jobs 
leapt up on stage during his keynote address at Macworld 2007, 
and announced: “Who wants a stylus? Yuck! We’re going to use 
the best pointing device in the world — our fingers!”

With the popularity that the phone and its different touch-
gestures have seen, it just makes sense for a gesture-based device 
to incorporate these signs.

“SixthSense recognises gestures supported and made popular 
by interactive multi-touch based products such as Microsoft’s 
Surface or Apple’s iPhone,” Pranav emphasises. 

The gadget’s operations are not exactly the same as those for 
the iPhone, but they are influenced by Apple’s technology. 

For example, to zoom in on the iPhone, the user pinches 
A camera, mini projector and four colour markers later, you are ready to 
go

The various hand gestures used with SixthSense
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ESP
The labs at MIT are also work-
ing on Emotional Social Intel-
ligence Prosthetic, a device for 
reading minds. 

outwards on the phone’s screen with two fingers. In SixthSense, 
the same is done by moving all four fingers, or the hands, 
outwards. And vice versa: bring the hands in to zoom out. 

…an Indian angle
One of the coolest aspects of the iPhone was its ‘one-button-to-
rule-them-all’, that let you go to the home screen from within any 
application. It made navigation so much simpler in an interface 
devoid of a physical keyboard and a mouse, with their many 
shortcuts.

So how does Pranav ‘welcome’ a user to his home screen? 
The Indian connection comes to the fore, with the folded-hands 
“Namaste” gesture serving the purpose — from within any appli-
cation, just like the iPhone.

It seems so simple, it’s almost as if the MIT team was inspired 
by a game of dumb charades. In fact, freehand gestures, or 
postures, are just that — signs used in everyday life to depict 
certain events or actions. The demonstration video aptly describes 
many of these easy-to-understand gestures.

Pranav walks around a city, clicking pictures of various sites. 
He doesn’t have a digital camera with him, but why would he 
need one? He simply lifts up his two hands, and joins the fore-
finger tips of one hand to the thumb tips of another — forming a 
frame. Once he “frames” a scene, the camera takes over and clicks 
a picture, which is saved for viewing later.

Myriad applications
Indeed, the uses of this technology are limited only by one’s 
imagination. 

Pranav doesn’t wear a wristwatch any more. He simply looks 
at the back of his hand, and draws a circle near the wrist. Like 
with the number pad, a watch pops up out of nowhere! 

“When you go to the supermarket, and you’re standing 
there in that huge aisle of different types of toilet paper, you 
don’t take out your cellphone and open a browser and go to a 
web site to try to decide which of these is the most ecologically 
responsible decision to make,” Maes said during her address 
at TED. 

In her demonstration video, Pranav walked down such an 
aisle, and picked up a pack of paper towels. The SixthSense 
projected an unfavourable ecological rating on it, and Pranav 
moved to the next pack. This one got a green light, and the engi-
neer could even tap that to gain some more information about 
the product. What a satisfactory and knowledgeable way to make 
a purchase!

And Maes stressed how customisable SixthSense is: “Some of 
you may want the toilet paper with the most bleach in it rather 
than the most ecological choice.”

Another scenario had the ‘desigineer’ looking at his airplane 
ticket. His pendant locked on to the little piece of paper, and 
alerted him about any delays in schedule and changes in the 
designated gate.

The most interesting of the aspects — especially for news-
paper and magazine readers — was the use of the augmented 
reality tool with an article. On a blank piece of paper next to 
the article, or even a white space, the SixthSense can proj-
ect relevant videos, news channel feeds, updated scores of 
matches, etc.

A controversial use of the device had Pranav meeting his 
colleague, Chang. On Chang’s white t-shirt, the SixthSense 
projected “world clouds” linked to him across the internet, creat-
ing a virtual tag-based Google search result of his online persona. 
Everything from his hobbies to work was there to be seen — an 
aspect that could throw up many privacy issues in the future.

A fifth sense for the disabled
More than anything, an issue close to Pranav’s heart is the appli-
cation of his technology back home.

“I think the SixthSense and the vision behind it can act as 
the gap-filler for the digital divide in India and other developing 
nations,” he says. “I am really excited to extend the SixthSense 

vision to the fields of education, medicine and accessibility.” 
The engineer is currently working on versions of the 

SixthSense that can act as an eye for the blind and an ear for the 
deaf; or it can speak on behalf of a person who cannot speak. “It 
could act as the missing fifth sense, rather than a sixth sense,” 
he enthuses. 

Pranav also hopes to get kids back into playgrounds with 
his device: “I want to dig into education for kids, such that the 
power of digital world can be integrated into their everyday 
activities, including playing. Today’s kids are missing out on 
playing in real fields. I think the underlying technologies in 
SixthSense can redefine the world of education and gaming 
drastically, by making the world a playground.”

What Now And What Next?
The potential for the technology was evident at TED, an event 
that hosts some of the biggest minds in the world today — no 
exaggeration. At the end of Maes’ speech, Pranav stood up to 
receive a standing ovation from a crowd that has seen and regu-
larly participates in creating technologies that promise to change 
our world.

The commercially-available and off-the-shelf components 
hold a lucrative prospect in the near future: “In mass production, 
the device shouldn’t cost more than today’s cellphones,” Maes 
said. 

The elimination of physical input hardware makes it easy for 
the device to be scaled down in size in the future — opening the 
door for a more stylish product.

“I think it will take about 1.5-2 years before this can go 
into market,” says Pranav, who is working closely with several 
consumer electronics companies. Already, Pranav and the team 
are planning several improvements. The topmost among these 
is the development of a more sophisticated gesture-recognition 
technique that rids the user of the cumbersome need of wearing 
coloured markers.

“In a couple of months, we will be ready with a version that 
will eliminate the requirement of the coloured markers,” he 
says.

“I am also making some changes in the system design so 
that one can remove the SixthSense pendant, put it on any table, 
and start using that table as an interactive multi-touch screen,” 
Pranav says.

“It’s not perfect yet, and it’s still a work in progress,” Maes 
adds. And then the mad scientist took over: “Who knows, in ten 
years, we might come up with the ultimate ‘sixth sense’ brain 
implant.”  n

readersletters@thinkdigit.com

Here is a brief on the computer vision part of SixthSense. 
According to Mistry, “SixthSense continuously captures and 

processes the video stream captured by the camera. The core soft-
ware component of SixthSense is based on amalgamation of several 
machine vision algorithms.”

“SixthSense system is capable of tracking and recognizing the 
user’s hand movements and freehand gestures. A technique that 
I have developed using edge detection and color tracking helps 
performing this operation. The system also recognises and tracks 
the location of physical objects in users viewpoint. The system uses 
a few feature extraction and image matching algorithms in order to 
compare and identify pictures of the objects with the objects in user’s 
viewpoint. The system later retrieves related information about the 
identified object from the Internet and projects on the object itself, 
seamlessly augmenting them. SixthSense also is able to stabilise 
and correct the projected visual information on non-flat surfaces 
and objects. At the moment, I am also working on some additional 
features that will correct(change) the interface colors real-time on 
the basis of the characteristics of the surface the information need 
to be projected. All these algorithms are developed using C++ and 
C# and are based mainly on machine-vision based techniques. The 
visual interface is programmed using WPF.” he added.

from the labs
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camcorder test

Michael Browne

A
pril and May — the months of 
summer are characterised by 
unbearable heat and, of course, 
summer holidays for children and 

icy cold drinks. Most people are busy plan-
ning vacations to cooler climes at this 
part of the year. With kids on holiday 
from school, it makes an ideal time for 
parents to take their annual leave and plan 
vacations. Unfortunately, our busy work 
schedules almost always leave us with too 
little vacation time and there’s almost 
too much to do once we’re back, so more 
often than not, the vacation is forgotten 
almost as soon as it’s over. It’s for preserv-
ing such fun memories that camcorders 
were invented. 

Whatever the occasion, nothing 
preserves memories like a well-shot video 
of the whole scene; from the build-up to the 
main event and beyond. A camcorder is the 
best way to ensure that your memories of the 
years gone by remain fresh, and reliving the 
fun moments is but a matter of slipping the 
correct disk into your DVD player.

With digital cameras shooting movie 
clips at up to 720p resolutions, we thought 
camcorders were largely meant to go the 
way of the dodo. After all, why pay Rs. 

50,000 for a camcorder when you can buy 
a digital camera for Rs. 15,000 and record 
videos that are 80 per cent as good as 
some of the best camcorders around? Well, 
here’s where camcorders, as a product 
category get their retort. They’ve become 
a whole lot cheaper and many camcorders 
are now available for well below the Rs. 
20,000 mark. We found that there were a 
number of decent models in the market 
priced around the Rs. 17,000 to Rs. 20,000 
price range. 

Obviously, these are the more basic 
models available and typically use MiniDVD 
as their storage medium. Another emerg-
ing trend is the use of flash memory as 
storage. Thanks to the crash in flash prices, 
due to which USB drives have become dirt 
cheap, even camcorders that utilise the 
same flash memory to store captured video 
have become much cheaper. Owing to 
lower prices, the density of flash modules 
has also expanded and whereas last year 
we saw up to 8 GB of flash memory on a 
camcorder, this year we’re seeing 32-GB 
models emerge. Soon, 64-GB models will 
make a splash as flash prices continue to 
fall. 

The ultra common MiniDVD and DV 
tape camcorders also seem to be losing 
popularity. This was bound to happen, 

and is a trend we anticipated some time 
back. Why pay extra for removable media 
and have the hassles of extra moving parts 
with cassette trays and such, when hard 
drives and flash can handle twenty times 
the storage? Also, flash and hard drives are 
both more reliable and faster. Perhaps the 
biggest reason for the traditional storage 
media (MiniDVD and DV tape) gradually 
becoming obsolete is the emergence of 
cheaper, HD camcorders. As we know, HD 
videos take a lot of space and with one 
MiniDVD offering a paltry 288 MB — which 
is only enough for around 2-3 minutes 
of shooting — no wonder manufacturers 
are adopting hard drives and flash. HDD 
storage is also becoming cheaper — thanks 
to market-wide adoption of larger hard 
drives. Although the largest capacity we’ve 
seen on a camcorder is 80 GB, with 1.8-inch 
micro drives now scaling up to 250 GB, it’s 
only a matter of time until camcorders 
with drives of 100+ GB make a splash.

Perhaps the biggest shocker for us 
was the pricing. We actually found HD 
camcorders priced at well below the Rs. 
40,000 mark! And we’re not talking about 
a paltry HD resolution of 480p. We’re talk-
ing 1080i — yes! — 1920 x 1080 interlaced 
pixels, in a body that’s half the size of 
many MiniDVD camcorders.
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camcorder test

Camcorders are cheaper than ever and with holidays around the corner you 
don’t want to be left without one. We look at a selection across all price ranges.

Photographed by: Manas Parekh

tried & tested
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SONY HDR-XR100E 
Stunning performer
The HDR-XR100E is Sony’s gift to the masses 
— an HD camcorder that’s priced on a par 
with some of the costlier non-HD camcord-
ers around. It’s a handsome looking device 
— black, with a mixture of gloss and matte 
finishes. It’s not very large, but owing to 
the 80-GB hard drive, it comes across as 
being much bulkier than the flash-based 
camcorders. Owing to the colour and the 
shape, it looks a bit like the Canon HF11. 

The back of the LCD viewfinder has a 
lot of colourful stickers, a cheery respite 
from the all-black body. This viewfinder is 
crisp and clear with great colours, crisper 
than the viewfinder on its sibling, the Sony 
HDR-CX100. The viewfinder is also fast 
and there is never any sort of lag which 
admittedly is rare to find these days, but 
super annoying when found. Going with 
the norm that HD camcorders do not 
have great zoom, this one has only 10x. 
Although this may be enough for most 
uses those looking at shooting outdoors at 
distant scenery should look elsewhere. 

At full zoom, the performance of the 
Optical Image Stabiliser (OIS hereon) is 
impressive, and we were able to focus on 
the number plates of vehicles moving some 
300 m away clearly enough to read them. 
At full quality settings (equating to super 
fine quality at a resolution of 1080i), the 
HDR-XR100E will chew up 16 MBps, which 
is a lot of space, despite this, the massive 
80-GB hard drive gives more than 500 min 
of recorder video. Therefore, it’s safe to 
say your batteries will run out before the 
drive is full.

The layout of the buttons on this 
camcorder is excellent and the menu 
system very well thought out. In fact, the 

entire menu system is touch-screen based 
and the settings are very simple even for 
total newbies to find their way around. The 
record button is ergonomically placed and 
even people with large hands will never 
have to bend their thumbs much. This 
deserves special mention as continuously 
bending the thumb while shooting can 
become painful after just 10 to 15 minutes. 
Image quality of the videos is really good 
and we felt as though we were watching 
an HD movie, which in reality we were. 
All videos have great resolution and very 
good detail. 

The resolution is sharp and it’s worth-
while to invest in a large-screen LCD / 
plasma display for someone really into 
capturing and watching a lot of such 
videos – smaller displays do not do justice 
to the video output of this camcorder! The 
camcorder focuses fast at the long end 
of the zoom and indoor shooting is also 
good, which means low light perform-
ance is good and the output videos never 

seemed dim. Still image quality is 
also pretty good. In fact, at a size of 
9 x 10 inches, it’s as good as most 
mid-range digital cameras. The OIS 
system also works well for zooming 
in for photos. We did not register 
any image shake during the entire 
test, save for when we tried some 
over adventurous panning just to 
check how far the OIS system could 
cope.

At a price of Rs. 36,999, this 
camcorder is quite frankly a steal. 
Sure, it won’t replace your camera. 
But, if you intend to do a lot of 
quality video shooting, the Sony 
HDR-XR100E is just the thing. With 
its massive resolution and superb 
all-round quality you’d be daft not 
to at least check it out.

CANON HG20 
Silver Streak
The HG20’s bulk makes the Sony 
CX100 look really tiny and cute. 
That doesn’t mean it’s not attrac-
tive. It sports a refreshingly differ-
ent light grey / light silver and 

chrome colour scheme that keeps things 
interesting. The fit and finish is good 
with the lettering CMOS Sensor written 
in chrome. The lens is large and gives the 
camcorder an executive feel. The still shot / 
video select dial is conveniently located on 
the back of the camcorder in such a way 
that it comes really close to your thumb, 
which is ideal, and people with larger 
hands will not have any problems. There’s 
a small rough textured, raised portion on 
this dial that coincides with your thumb 
and makes switching from play and record 
mode a snap.

However, people with large hands may 
need to bend their thumbs a bit. There are 
AV, Component and HDMI outputs provided. 
A connection for an add-on microphone is 
also included. The LCD viewfinder is pretty 
decent and quite bright. The record button 
is very conveniently located and you don’t 
have to put in extra effort to navigate your 
way through. Even large handed people will 
find it comfortable. On a negative note, the 
photo click button is really hard to press 
and causes shake when you don’t have 
support while shooting. Halfway down the 
click, the autofocus is activated and after 
that the button becomes really stiff. Canon 
also provides a neat remote control unit 
with this camcorder and we tested this; the 
unit works flawlessly. The HG20 ships with 
a 60-GB HDD, more than enough for even 
frequent users.

Thankfully, unlike the Sony camcord-
ers that power on when the LCD flap is 
opened, there is a chrome-finished and 
hard to miss power button on the top of the 
body. The camcorder can be switched on 
and off regardless of the viewfinder being 
open or closed. Image quality on the HG20 
is really good and its OIS system works 
really well to deliver shake-free videos most 
of the time. The only time we had an issue 
with shake was when we wilfully jiggled 
our hands when shooting to check the 
effectiveness of the OIS system. The HG20 
does very well indoors as well, and thanks 
to its 12x optical zoom outdoor shooting is 
equally good. Still shot quality is also good, 
with great highlights and detail.

We were a little taken aback when we 
learned this camcorder was priced at Rs. 
95,995, which is quite honestly a sizeable 
chunk of cash and more than this camcorder 

Ergonomics
A variety of ergonomic 
devices tested! 64 Bazaar

A roundup of latest 
products in the market68 Like cameras camcorders can also 

have either CCD or CMOS sensors

Sony HDR-XR100E 

We divided the camcorders we received into 
two categories: regular and HD camcorders. 

After this we segregated them into categories 
based on the media they use. We logged all the 
specifications of each camcorder and also recorded 
the bundled software. A high weight was given to 
ergonomics. This is overlooked by many people, but 
is very important since it affects usability to a great 
extent. Finally, for performance, we tested each 
camcorder’s video capabilities both indoors and 
outdoors under both natural and artificial light-
ing. We also tested the quality with the zoom and 
used variable zoom throughout the testing. Finally, 
we checked the efficacy of the image stabilisation 
at the long end of the zoom. This is very impor-
tant because when zoomed in, even minor hand 
movements can cause blur and spoil the video. 
We tested the quality of still shots as well as the 
quality of audio captured while shooting the video. 
All the images were transferred to a test PC with a 
GeForce 8800 GTX graphics card and viewed on a 
ViewSonic VX2025WM monitor that has an 8-bit, 
MVA panel and is very suited for image and video 
editing work.

How we tested

Canon HG20

TRIED & TESTED
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Non-HD HD

Brand Samsung Samsung Canon Sony Sony Canon Canon Canon
Model No SMX-F30BP VP-DX205 FS 10 HDR-CX100 HDR-XR100E HG 10 HG20 HF11

Price (Rs) Rs. 16,900 Rs. 18,900 Rs. 30,995 Rs. 36,990 Rs. 39,990 Rs. 89,995 Rs. 95,995 Rs. 95,995

Plus (+) Affordable Built well Looks great Superb pricing, compact Great performer, looks good Neat looks, Built well Great OIS system, good performer Stunner, great performer

Minus (-) Mediocre performer Poor performance Mediocre performer OIS could be better None in particular Mediocre performer Bulky, expensive Expensive

Grand Totals (Out of 100) 44.94 41.18 48.58 62.99 72.09 62.36 72.54 69.5

Features 18.22 15.56 20.44 19.44 24.76 28.92 27.12 23.72

Performance 26.72 25.62 28.14 43.55 47.33 33.44 45.42 45.78

Features
General

Optical Zoom 34x 34x 37x 10x 10x 10x 12x 12x
Still Image Sensor 
Resolution 0.8 MP 1.07 MP 4 MP 4 MP 2.96 MP 3.3 MP 3.3 MP

Optical Sensor Size 1 / 6 inch 1 / 6 inch 1 / 1.6 inch 1 / 5 inch 1 / 5 inch 1 / 2.7 inch 1 / 3.2 inch 1 / 3.2 inch

Optical Sensor Type CCD CCD CCD CMOS CMOS CMOS CMOS CMOS

Minimum Illumination 3 lumens 2 lumens 0.2 lumens 5 lumens 5 lumens 0.2 lumens 0.2 lumens 0.2 lumens

Recording Formats H.264 BP MPEG-2 AVCHD, MPEG-4 AVC, H.264, 
MPEG-2 AVCHD, MPEG-4 AVC, H264, MPEG-2 MPEG-4, AVC/H.264 AVCHD AVCHD (MPEG-4 AVC/H.264 standard)

Storage Medium Flash DVD Flash Hybrid HDD HDD HDD Flash

Inbuilt Storage 16 GB NA 8 GB 8 GB 80 GB 40 GB 60 GB 32 GB
Image Stabiliser (Y/N) / 
IS Type Y / Electronic Y / Electronic Y / Electronic Y / Optical Y / Optical Y / Optical Y / Optical Y / Optical

Min Shutter Speed 1 / 60 sec 1 / 50 sec 1 / 6 sec 1 / 30 sec 1 / 30 sec 1 / 6 sec 1 / 6 sec 1 / 6 sec

Max Shutter Speed 1 / 10,000 sec 1 / 10,000 sec 1 / 2000 sec 1 / 1000 sec 1 / 1000 sec 1 / 2000 sec 1 / 2000 sec 1 / 2000 sec

Shooting Modes 4 4 Easy, P, TV, 10 10 Auto, Program (P, TV, AV, Cinema) 14 12

White Balance Presets 2 2 8 4 4 8 5 8
Widescreen Video Capture 
(Y/N) N N Y Y Y Y Y Y

Focal Length 2.3  96.6 mm 2.3  78.2 mm 2.6  92 mm 3.2  32 mm 3.2  32 mm 6.1  61 mm 4.8 mm - 57 mm 4.8 mm – 57.6 mm 

Lens Aperture f/1.6-4.3 f/1.6-4.3 f/1.8-2.2 f/1.8-2.2 f/1.8-3.0 f/1.8-3.0 

Focus System Type Automatic / Manual TTL video sensing Automatic / Manual Automatic / Manual 9-point AiAF 9-point AiAF Function TTL contrast detection 

Filter Size 30 mm 30.5 mm Not supported 30 mm 30 mm 43 mm 37 mm 37 mm

Connectivity / Interface USB USB USB USB / HDMI USB / HDMI USB, HDMI USB USB

Internal Viewfinder

Display Form Factor NA NA NA NA NA Widescreen NA NA

Size NA NA NA NA NA 0.27 inch NA NA

Resolution NA NA NA NA NA 1,23,000 pixels NA NA

External LCD

Size 2.7 2.7 2.7 inches 2.7 2.7 2.7 inches 2.7 inches 2.7 inches

Resolution 1,12,000 pixels 1,12,000 pixels 1,23,000 pixels 2,11,000  2,36,000  2,11,000 pixels 2,11,000  2,11,000 

Bundle

Remote control Y Y Y N N Y Y

Accessories Ac Adaptor/Charger, A/V Cable, 
USB Cable,     

Ac Adaptor/Charger , AC Cord, 
A/V Cable, 

AV and USB (data) cable and 
charger

AC adaptor, Cables Compnent AV 
Cable, A/V Connecting Cable, USB 
Cable

AC adaptor, Cables Compnent AV Cable, 
A/V Connecting Cable, USB Cable

Component, USB (data) and AV cables, 
charger

 Compact power adapter, USB cable, 
Component cable, Stereo video cable   

 Compact power adapter, USB cable , 
Component cable , Stereo video cable   

Software Cyberlink Media Show Pixela ImageMixer 3 Picture Motion Browser Picture Motion Browser InterVideo WinDVD SE, Ulead DVD 
Movie Factory SE, DVD Movie Writer SE Pixela ImageMixer 3SE Pixela ImageMixer 3SE

Weight 270 grams 365 grams 260 grams 330 grams 330 grams 465 grams 380 grams

Ergonomics (So 10) 6.25 6.5 6.5 4 7.5 7.5 7 7.5

Performance

Video Quality (So 10)
Indoors (Normal Lighting, 
variable zoom) 4.75 4.5 5 7.75 8 5.25 8 8

Outdoors (variable zoom) 5 4 5.5 8 8.25 6.5 8 8
Dim Lighting (variable 
zoom) 4 3.75 3.75 6.5 7 4 7 7

Image Stabilisation effec-
tiveness 3.25 4 4.25 6.5 8 6 7.25 7.5

Audio Quality (So 10) 6.75 6 5.25 7.5 8 6 7.5 7.5

Still Image Quality (So 10) 3.5 3.5 4.75 8 8.25 5.75 8 8

Know more about the 
exciting Digit carnival 
next month

  
Camcorders
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Non-HD HD

Brand Samsung Samsung Canon Sony Sony Canon Canon Canon
Model No SMX-F30BP VP-DX205 FS 10 HDR-CX100 HDR-XR100E HG 10 HG20 HF11

Price (Rs) Rs. 16,900 Rs. 18,900 Rs. 30,995 Rs. 36,990 Rs. 39,990 Rs. 89,995 Rs. 95,995 Rs. 95,995

Plus (+) Affordable Built well Looks great Superb pricing, compact Great performer, looks good Neat looks, Built well Great OIS system, good performer Stunner, great performer

Minus (-) Mediocre performer Poor performance Mediocre performer OIS could be better None in particular Mediocre performer Bulky, expensive Expensive

Grand Totals (Out of 100) 44.94 41.18 48.58 62.99 72.09 62.36 72.54 69.5

Features 18.22 15.56 20.44 19.44 24.76 28.92 27.12 23.72

Performance 26.72 25.62 28.14 43.55 47.33 33.44 45.42 45.78

Features
General

Optical Zoom 34x 34x 37x 10x 10x 10x 12x 12x
Still Image Sensor 
Resolution 0.8 MP 1.07 MP 4 MP 4 MP 2.96 MP 3.3 MP 3.3 MP

Optical Sensor Size 1 / 6 inch 1 / 6 inch 1 / 1.6 inch 1 / 5 inch 1 / 5 inch 1 / 2.7 inch 1 / 3.2 inch 1 / 3.2 inch

Optical Sensor Type CCD CCD CCD CMOS CMOS CMOS CMOS CMOS

Minimum Illumination 3 lumens 2 lumens 0.2 lumens 5 lumens 5 lumens 0.2 lumens 0.2 lumens 0.2 lumens

Recording Formats H.264 BP MPEG-2 AVCHD, MPEG-4 AVC, H.264, 
MPEG-2 AVCHD, MPEG-4 AVC, H264, MPEG-2 MPEG-4, AVC/H.264 AVCHD AVCHD (MPEG-4 AVC/H.264 standard)

Storage Medium Flash DVD Flash Hybrid HDD HDD HDD Flash

Inbuilt Storage 16 GB NA 8 GB 8 GB 80 GB 40 GB 60 GB 32 GB
Image Stabiliser (Y/N) / 
IS Type Y / Electronic Y / Electronic Y / Electronic Y / Optical Y / Optical Y / Optical Y / Optical Y / Optical

Min Shutter Speed 1 / 60 sec 1 / 50 sec 1 / 6 sec 1 / 30 sec 1 / 30 sec 1 / 6 sec 1 / 6 sec 1 / 6 sec

Max Shutter Speed 1 / 10,000 sec 1 / 10,000 sec 1 / 2000 sec 1 / 1000 sec 1 / 1000 sec 1 / 2000 sec 1 / 2000 sec 1 / 2000 sec

Shooting Modes 4 4 Easy, P, TV, 10 10 Auto, Program (P, TV, AV, Cinema) 14 12

White Balance Presets 2 2 8 4 4 8 5 8
Widescreen Video Capture 
(Y/N) N N Y Y Y Y Y Y

Focal Length 2.3  96.6 mm 2.3  78.2 mm 2.6  92 mm 3.2  32 mm 3.2  32 mm 6.1  61 mm 4.8 mm - 57 mm 4.8 mm – 57.6 mm 

Lens Aperture f/1.6-4.3 f/1.6-4.3 f/1.8-2.2 f/1.8-2.2 f/1.8-3.0 f/1.8-3.0 

Focus System Type Automatic / Manual TTL video sensing Automatic / Manual Automatic / Manual 9-point AiAF 9-point AiAF Function TTL contrast detection 

Filter Size 30 mm 30.5 mm Not supported 30 mm 30 mm 43 mm 37 mm 37 mm

Connectivity / Interface USB USB USB USB / HDMI USB / HDMI USB, HDMI USB USB

Internal Viewfinder

Display Form Factor NA NA NA NA NA Widescreen NA NA

Size NA NA NA NA NA 0.27 inch NA NA

Resolution NA NA NA NA NA 1,23,000 pixels NA NA

External LCD

Size 2.7 2.7 2.7 inches 2.7 2.7 2.7 inches 2.7 inches 2.7 inches

Resolution 1,12,000 pixels 1,12,000 pixels 1,23,000 pixels 2,11,000  2,36,000  2,11,000 pixels 2,11,000  2,11,000 

Bundle

Remote control Y Y Y N N Y Y

Accessories Ac Adaptor/Charger, A/V Cable, 
USB Cable,     

Ac Adaptor/Charger , AC Cord, 
A/V Cable, 

AV and USB (data) cable and 
charger

AC adaptor, Cables Compnent AV 
Cable, A/V Connecting Cable, USB 
Cable

AC adaptor, Cables Compnent AV Cable, 
A/V Connecting Cable, USB Cable

Component, USB (data) and AV cables, 
charger

 Compact power adapter, USB cable, 
Component cable, Stereo video cable   

 Compact power adapter, USB cable , 
Component cable , Stereo video cable   

Software Cyberlink Media Show Pixela ImageMixer 3 Picture Motion Browser Picture Motion Browser InterVideo WinDVD SE, Ulead DVD 
Movie Factory SE, DVD Movie Writer SE Pixela ImageMixer 3SE Pixela ImageMixer 3SE

Weight 270 grams 365 grams 260 grams 330 grams 330 grams 465 grams 380 grams

Ergonomics (So 10) 6.25 6.5 6.5 4 7.5 7.5 7 7.5

Performance

Video Quality (So 10)
Indoors (Normal Lighting, 
variable zoom) 4.75 4.5 5 7.75 8 5.25 8 8

Outdoors (variable zoom) 5 4 5.5 8 8.25 6.5 8 8
Dim Lighting (variable 
zoom) 4 3.75 3.75 6.5 7 4 7 7

Image Stabilisation effec-
tiveness 3.25 4 4.25 6.5 8 6 7.25 7.5

Audio Quality (So 10) 6.75 6 5.25 7.5 8 6 7.5 7.5

Still Image Quality (So 10) 3.5 3.5 4.75 8 8.25 5.75 8 8

MiniDVDs allow for a maxi-
mum of 1.4 GB on a single 
disc, or 2.6 GB if it’s a dual 
layer disc

Pay special attention to the view-
finder. Its your window to the 
action and should be crisp and 
clear and adequately bright

M AY  2 0 0 9M AY  2 0 0 9
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camcorder test

Sony HDR-CX100 

is worth. Sadly, Canon’s MRPs are not indica-
tive of street prices and you could probably 
find this camcorder for a good deal less. 
As it stands, it’s a very capable HD 1080i 
camcorder; but thanks to this atrocious pric-
ing it loses out on any sort of recommenda-
tion.

CANON HF11 
Black Beauty
In stark contrast to its sibling, the HF11 is 
a pure black colour with the finish alter-
nating between matte and glossy black. It 
has really nice contours and reminds one 
of designer gear. The quality of surface 
treatment and materials used is top notch, 
perhaps even better than the HG20. It’s 
slightly smaller than the HG 20 and 
features 32 GB of flash memory inbuilt. 
However, despite its slightly more compact 
dimensions, it’s no worse to hold. Despite 
the size, Canon has made sure to take 
care of ergonomics — the record button is 
placed perfectly for both small and large 
handed people and you’ll find the button 
conveniently located under the pad of 
your thumb. The zoom is variable and 
super slick. Gently nudge the zoom switch 
and the focus zooms in ever so slowly and 
slickly. Push the switch harder and the 
focus zeroes in more quickly — this is one 
of the best zooms we’ve used. 

As with the HG20, there is an easy 
button that disables all the extra options 
and settings for newbies. The click dial is 
placed on the side of the device and not on 
the rear as with the HG20. Thus you may 
not be able to use it one handed and using 
this dial sometimes requires the use of the 
other hand. As with the HG 20, there is a 
mini horseshoe connect provided for using 
an add-on flash. The LCD viewfinder is 
crisp and quite clear — however the colour 
saturation seems to be a little poorer, and 
this makes the HG20’s viewfinder appear a 
little crisper. Unlike the HG20 that features 
a 60-GB hard drive, the HF11 comes with 32 
GB of flash memory.

The OIS system works very well, and at 
the long end of the zoom there is barely any 
shake. In fact, the OIS system is marginally 
better than the one on the HG20, notice-
able at the maximum optical zoom (12x). 
Image quality indoors is also good; in fact 
its every bit as good a performer as the 

HG20 and we could hardly tell the videos 
apart. No surprise then when we found 
it priced identically — Rs. 95,995, equally 
atrocious pricing on Canon’s part. With 
the current era of aggressive marketing, 
Canon has a refreshingly different view 
— chase away consumers with exorbitant 
prices — mission successful.

SONY HDR-CX100  
Petite 
The CX100 gets full marks for being the 
most compact of HD 1080i cameras that 
we’ve seen. However this compactness 
comes at an cost to its ergonomic scores. 
The fit and finish of this camcorder is 
good, with Sony following a matte black 
finish that really sets the tone for a seri-
ous device. Parts of the body have a glossy 
finish. Canon’s HF11 looks better, however, 
and probably sported the highest quality 
of build in our test. The controls on the 
Sony are touch-screen based and the menu 
system is very easy to use. Everything 
seems designed with newbies in mind, and 
the menus are very simple; unfortunately 
for expert users this means a lot of the 

settings are not as visible. 
There’s an Easy button that totally 

idiot-proofs the settings and when acti-
vated this button glows with a blue-LED. 
This camcorder has a smart battery and 
the viewfinder has a small indicator of 
the battery life remaining based on the 
current usage. This is really helpful. The 
LCD viewfinder is bright with good colours 
and is more than adequate for most shoot-
ing, although it gets a bit dim in bright 
sunlight. The camcorder powers on when 
the display flap is opened, although it 
can also be turned off via a power button 
located inside this flap. 

We found Canon’s system of having 
a power button on the outer body more 
convenient. As further examples of idiot-
proofing, record quality has four preset 
settings, the lowest having a bitrate of 5 
Mbps and the highest using a whopping 16 
Mbps; this highest mode records at 1080i. 
The record button is rather annoyingly close 
to the grip and people with large hands will 
have to bend their thumbs. This is irritating, 
and becomes painful after some time. 

There is no click dial to select video / 
audio and capture and play modes as with 
most camcorders. Instead, there is a small 
button that toggles between still image 
and video. Thankfully, the photo button 
is conveniently located and has a nice 
soft feedback. The OIS system works well, 
although it is not as effective as the OIS 
system on its larger sibling, the Sony HDR 
XR-100E. As a result, a little arm jiggling 
has this camcorder lose its composure 
faster. However, for the 10x zoom most 
people will find little to complain about 
when it comes to blur while shooting. 

Once again the zoom is variable – it’s 
super slow or lighting fast depending on 
finger pressure. Sony’s performance in 
terms of video quality is really good. Sadly, 
the great performance when shooting in 
daylight conditions is not repeated indoors 
and the HDR-CX100 isn’t as good indoors, 
where a bit of noise and loss of detail mar 
the 1080i videos that it produces. 

Priced at Rs. 36,990, the Sony HDR-
CX100 is a lot of camcorder for the price 
and if you’re hunting for a super compact, 
HD camcorder this has to be the one. It’s 
easy to use and very well priced. If the ergo-
nomic issues associated with its compact-
ness don’t bother you, then this is the one 
for you. If they do, you’ll find the Sony 
HDR XR-100E a slightly better camcorder 
in all respects.

CANON HG10 
When young is not better
The cheaper sibling to the HG20, the HG10 
is built equally well and follows the same 
colour scheme as its pricier sibling. The 
grey / silver colour looks really neat and 
although we felt this unit was a little large, 
we couldn’t fault the quality of fit and 
finish. It feels rugged in-hand, something 
that most large camcorders cannot boast. 
Canon has got the ergonomics right once 
again, and the HG10 feels very comfortable; 
the record button really comes slap bang 
under the pad of your thumb when prop-
erly gripped — perfect. While the record 
button has a nice soft touch, the photo 
button is slightly tackier and it’s easy to get 
a bit of camera shake while using it. The 
HG10 comes with a 40-GB HDD which is 
enough for at least 200 hours of recording 
at a resolution of 1080i.

The HG10 actually has a slightly larger 
CMOS sensor than the ones on the HG20 
and HF11, and we expected better results. 
Moreover, larger CMOS sensors are cost-

Like cameras camcorders can 
also have either CCD or CMOS 
sensors

Canon HF11 
Canon HG10
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lier, and so the HG10 had big boots to 
fill. Unfortunately, it didn’t live up to our 
expectations and while outdoor shooting 
was good, indoor shooting was consider-
ably inferior to the other Canon and Sony 
HD models. Still image quality was also not 
that good. The OIS system works reason-
ably well, although it’s not as effective as 
those on the other HF camcorders. In fact, 
it’s nearly on a par with the Sony HDR-
CX100, which didn’t impress us in terms of 
the resulting image stability.

Priced at Rs. 89,995, the HG10 is expen-
sive and is outperformed by the other 
HD camcorders in this shootout. We can’t 
recommend it, not at that MRP and perhaps 
not even at half the price.

SAMSUNG SMX-F30BP 
Value for the masses
Samsung’s SMX-F30BP is touted as a flash-
based camcorder with 16 GB of memory. 
The device itself is a bright silver colour 
and looks lively. The build quality of the 
finish is also good and the camcorder 
looks rounded without any sharp edges. 
The LCD is not as good as we’d expect from 
Samsung, but it’s better than the unit 
of the DX205. Sadly there’s no variable 
zoom (one feature we really loved on the 
other units) and the camcorder tends to 
zoom too quickly — this is bad. Although 
this camcorder isn’t exactly compact, the 
record button is too close to your hand, 
which is uncomfortable. Interestingly, the 
palm grip swivels to a vertical alignment. 
Since the default grip works best, we don’t 
know what Samsung was thinking — with 
the grip vertically aligned it’s actually a lot 
more uncomfortable. 

The mode button to select between 
record, capture and play is well located and 
easy to use. The absence of an auto-focus 
means that images are a basic function. 

Video quality indoors was poor; in fact 
there was considerable loss of detail with 
the noise that crept into nearly the entire 
video. Outdoor shooting was much better, 
although only until you start to use the 
zoom. Once the zoom is used, the digital 
image stabilisation (DIS hereon) kicks 
in and quite frankly does not do much. 
We prefer OIS much better, DIS does not 
compensate for regular body movements 
and the resulting jitter is very evident from 
the videos. Maybe we’re nitpicking, because 
we tested the excellent HD camcorders 
first, but saying its performance could have 
been better is a gross understatement.

We weren’t impressed until the point we 
saw its price. At Rs. 16,900, the SMX-F30BP is 
the dream come true for someone looking at 
their first foray into the world of camcorders. 
Sure it’s far from the best around, but for the 
price, it’s good value for money.

SAMSUNG VP-DX205  
For the disk lover
This was the only MiniDVD camcorder we 
received. This was different from the disk 
recorders that we received last year. They 
stored only video on the disk and images 
had to be stored on an added memory card. 
This present camcorder can even store 
videos on an SD card — a plus for flexibility. 
It’s a very simple looking camcorder that’s 
nevertheless built quite well. Samsung uses 
a smooth metallic finish coupled with a 
dull textured finish that makes for quite 
a welcome contrast. The colours are black 
with gun-grey and quite frankly attractive. 

The lens flap has a nice positive slide 
open and close. The disk flap button is 
also well located so that you can operate it 
with your thumb. Once again the lack of a 
variable speed zoom is annoying, once you 
have become accustomed to this feature 
you really cannot do without it. The zoom 
is quite fast as a result, and at the long end 
of the zoom, the lens takes some time to 
focus on subjects. The photo button is easy 
to use and clicks easily — a pleasure after 
Canon’s hard buttons. There is no autofo-
cus for still images.

In terms of performance, the VP-DX205 
performed slightly worse compared to its 
sibling and we were quite frankly surprised. 
It doesn’t help that there is some lag associ-
ated with writing to mini-DVD disks. The 
DIS system works a lot better than the 
system on the VP-DX205. Still images are 
also not fun and are not as clear as we 
would expect. Priced at Rs. 18,990, the VP-
DX205 is obviously for the user on a budget 
who prefers the good old optical disk.

CANON FS10 
Classy looker, mediocre 
performer
The FS10 is a sleek looking camcorder, 
finished in glossy silver that is immedi-
ately eye-catching. It’s built well and feels 
solid in-hand. Quality of materials used is 
top class. Although this camcorder isn’t 
the most compact we’ve seen, it definitely 
scores points for ergonomic placement 
of the record button. You never have to 
really bend your thumb or align your grip 
to use this camcorder — a serious plus in 
our books. The photo button is also easy to 
use and well placed. Available with 8 GB of 
flash with additional memory expansion 
option available, the FS10 should not run 
out of memory considering at its highest 
quality it uses only around nine mbps. 

The viewfinder is pretty good, and 
although it’s not as legible as the other two 
Canon HD camcorders in bright sunlight, 
it’s clear, crisp and offers good brightness 
levels for indoor shooting. Image quality 
both indoors and outdoors was not too 
good, although in dim lighting the lack of 
quality becomes even more apparent. One 
point we liked was that the DIS system was 

slightly better than the Samsung camcord-
ers, although it was nowhere near the 
quality of the OIS based devices. Audio 
quality was slightly below par, although 
to be honest you’ll notice the lack of video 
clarity first.

Priced at Rs 30,995, the Canon FS10 
is a little expensive when one consid-
ers the excellent pricing on the Sony 
camcorders. How can we recommend even 
a decent non-HD camcorder when an HD 
camcorder is available for a meagre Rs. 
5,000 — 6,000 more? n

michael.browne@thinkdigit.com

Flash based camcorders are 
becoming cheaper thanks to 
the greatly diminished price of 
flash memory

If you shoot a lot consider a 
hard drive based camcorder, 
the extra storage space is 
worth the premium

 Contact sheet        Camcorder comparison test
Brand Contact Phone Email Web site
Canon Canon India Pvt Ltd 1800-180-33-66 info@canon.co.in www.canon.co.in

Samsung
Samsung India 
Electronics Pvt Ltd

+91-11–4151 1234 zion.kim@samsung.com  www.samsung.com/in

Sony Sony India Pvt Ltd 1800-11-11-88 sonyindia.care@ap.sony.com www.sony.co.in

Samsung SMX-F30BP 

Samsung VP-DX205
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Rossi Fernandes

P
hotography — a creative art, an 
essential tool for some and a hobby 
for many others. Today, we have 
reached a stage where everyone 

should have a camera.
Photography started with film cameras 

and they were always thought of as diffi-
cult devices to use and rightly so for many 
reasons. They were difficult to maintain 
and operate. You had to truly understand 
photography to be able to take good photo-
graphs. For the rest who wanted a camera 

Click to thrill
Whether you’re an amateur or a professional photographer, 
the dSLRs we present here will add extra sparkle to your thought...
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as a utility, something to keep memories 
as prints, there were the simple handheld 
cameras of their time. These were compact 
cameras and they were certainly cheap, 
and they made taking photographs much 
simpler, but not totally foolproof. There 
were still problems common to both SLR 
and point-and-shoot users. Film developing 
was a costly affair and plenty of photos 
were lost due to mistakes during shooting 
— this was a time before digital sensors or 
preview LCD screens.

Digital cameras gained significant 
acceptance quite quickly. They fixed many 

of the problems associated with film 
cameras — the instant ability to view your 
shot, most importantly, but they did so at a 
price. Even the really early digital cameras 
that lacked the refinements and the auto-
mation that we see today were much cost-
lier than the then-available decent film 
SLRs that were generally considered to 
be great cameras for professional and 
amateurs alike. As we’ve seen in the past 
with every new technology, users should 
perhaps have delayed purchasing these 
expensive gadgets, but instead the take-up 
of digital cameras was fast, and the market 
has continued to grow ever since. 
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Nikon launches the P90 
— a 12.1 MP camera with a 
24x optical zoom

Negative scanners can 
scan images directly from 
film negative into high-
quality images

It has been years now since point-
and-shoots (P&S) were developed, and the 
pace at which developments and improve-
ments have taken place has been stagger-
ing. Within a decade, we’ve gone from film 
cameras that couldn’t guarantee a proper 
set of photos in a film to digital point-and-
shoots that can detect faces, store them, 
click photos when people smile and there’s 
hardly any cost involved in using them! 

What else could anyone want? There 
are those who look at point-and-shoots and 
think of them as toys and consider the only 
proper cameras to be the dSLRs. Speaking 
practically, point-and-shoots are actually 
pretty decent. Prosumer P&Ss, such as 
the Sony DSC H5, the Canon SX 10 IS, the 
Canon PowerShot S5 IS and many more, 
have closed the gap between standard 
point-and-shoots and dSLRs. Easy opera-
tion, and the ability to take macro photos 
to telephoto shots on a single camera 
without the need for changing any lens or 
settings. For hassle-free photographs, these 
prosumer cameras are very good. 

However, if you are serious about 
photography and are analytical about 
quality and perfection, then we and other 
enthusiasts will tell you that you ought 
to buy a dSLR. If you are a professional 
photographer using a P&S camera, then 
we honestly aren’t sure why....

dSLRs bring a lot to the table, and 
there are good reasons for their weight, 
size and the number of knobs and 
settings they carry. You don’t just go 
out and buy a dSLR and walk around 
with it in your pocket. They require a 
rather more considered approach. They 
are meant for those who’ll sit an entire 
weekend in a nursery taking photos of 
flowers, go out and do some wild life 
photography, sports photography and 

The cameras were tested for many parameters and factors. We 
particularly focussed on the usability of the camera and its function-

ality. dSLRs are advanced cameras meant for the niche customer unlike 
regular P&Ss. 

Although each manufacturer lets you add different lenses to your 
camera, we used the set supplied to us for testing. Notes were made of 
the type of lens and we thoroughly tried out the functionality of the lens 
for both macro shots and telephoto. Portrait photos were also taken to 
see if there was any distortion when taking relatively close-up shots with 
the supplied kit lens. 

Photographs were taken at extreme ends of the ISO range (100 
— 3200) to get an idea of the amount of graininess (noise) that would 
be visible in the images. A good sensor and processor together would 
provide less graininess and would be better suited for low-light photog-
raphy. An overall rating for quality was given by comparing different 
photographs taken at different ISO settings and aperture settings. 

The autofocus functions on these cameras do not work the same 
way. A range of settings is available to control focus on different types 
and numbers of objects. We tried each of the settings to see if the camera 
could focus on smaller objects and also in low light. Cameras have built-
in features that use a strobe-like flash to help it focus on objects in the 
dark. We also tried out the flash to see how much of light the unit would 
disperse and also to see how well the camera evaluated lighting condi-
tions.

The screens on the dSLRs’ display photographic results, and in some 
of cases is even used to focus. We took note of the quality of the screen 
and how well they could cope in broad daylight. A larger screen would 
usually be welcome.

A dSLR is more advanced than a P&S, and gives the user much more 
control over its features. All features are controlled through its menus 
and for this reason the user interface is very important. With entry-level 
dSLRs, manufacturers have tried implementing simpler menus with help 
for each item. 

The quality of the dials on the camera is an important part of the 
build quality. Changing between settings is done using these buttons and 
dials, so these controls will take a battering over time. All dSLRs are built 
solidly to protect the mechanical components, so the chances of things 
going seriously wrong are pretty low. Still, cost cutting is something 
every manufacturer tries to do on their lower-end models, and so we 
kept an eye out for possible problems.

Notes were taken of all the additional features such as noise reduc-
tion and synchronising features for the flash. There were many other 
features — such as the Live View picture which lets you focus and shoot 
using the LCD screen and also video recording. 

Professional photographer and close friend of the magazine, Manas 
Parekh, came down to personally try out each camera. We were able 
to get a look at the cameras in a different light with his opinion of each 
camera that we tested. His inputs are incorporated into the reviews.

What we looked for while reviewing dSLRs

Canon EOS 400D

will take that kind of dedicated time on 
the camera trying out all kinds of shots. 
dSLRs are modular gadgets. So over time, 
you’ll be drawn into buying an extra lens 
or two. The type you buy and the amount 
you spend will obviously depend on your 
requirements.

The Contenders
For the dSLR test, we were looking at 
entry-level and prosumer dSLRs. These are 
cameras which existing P&S users would 
perhaps opt for in their second step into 
photography. We received cameras from 
Canon and Nikon, the giants with a 
history in dSLRs. Sony, a newcomer to the 
dSLR market also sent us its entry-level 
A200. Sony having bought out Konica-
Minolta’s dSLR business, this would be 
one camera not to be taken lightly. The 
Canon EOS 1000D and the EOS 50D were 
with us for the test and we also got our 
hands on the EOS 400D.

Canon EOS 400D
Canon’s EOS 400D is a slightly older camera 
than the rest. It followed the EOS 350D and 
is well known as a cheaper version of the 
EOS 450D.

The 18 — 55 mm autofocus lens that 
comes with the camera is average. It’s not 
going to be particularly useful when you go 
out on hiking trips or for wildlife photog-
raphy. The lens does not provide sufficient 
zoom for that kind of photography, but 
for casual photographs portrait and closed 
ranged photography, it will do. 

The buttons are small and the jog dial 
is a little hard to roll. A single jog dial is 
used to cycle the settings and a button 
is used together with the jog dial when 
combinations are required. All the settings 
expected from an entry-level dSLR are pres-
ent. There are no limitations with this 
camera in terms of features.



Nikon’s new dSLR, the 
D5000 comes with a 
foldable screen

DIGIT MAY 200958

Digital SLR test

T
R

IE
D

 &
 T

E
ST

E
D

Taking close-up shots is difficult with 
the standard shooting modes. The flash 
unit isn’t particularly good either. It’s 
bright enough for close areas and is too 
focussed on a narrow area. The build qual-
ity of the hinge and the flash unit isn’t 
very good.

Although this was a good entry-level 
Canon dSLR prior to the release of the 
EOS 1000D, in comparison, using it isn’t a 
very simple task, given its user interface. 
The menus are basic and sketchy. Using it 
with the Auto shooting mode gives decent 
results though.

Getting good shots in low-light situ-
ations can be a little difficult. It often 
requires you to increase the aperture size 
by a significant amount and also set the 
ISO to its maximum — 1600 to use a 
1/30 second shot. Fortunately, the amount 
of grain at higher ISO levels is low and 
manageable and image adjustments can 
fix this.

The camera uses CompactFlash memory. 
The EOS 500D has just been launched and 
so the EOS 400D will slowly be phased out. 
Availability might soon be a problem, but 
at the same time, it’s also interesting to 
find low prices for the EOS 400D.

 
Canon EOS 1000D
Canon’s new EOS 1000D competes with the 
Nikon D60. The 1000D lies at the bottom 
of the pyramid of cameras from Canon. 
The EOS 1000D is a smaller camera and 
also a light one. In looks, it appears a little 
more refined and polished than the other 
cameras. The corners are rounded and 
so are all the buttons. It almost feels like 
a P&S from the rear end of the camera 
around the screen. The finish isn’t very 
nice. It feels very sandy and it’s not the 
best feel you would wish for when you’re 
holding a camera. It’s also light and so 
attaching a big lens will probably upset the 
balance significantly. Very light dSLRs are 
probably not a good idea.

Large markings are present every-
where to inform the user of the controls. 
Clearly, this camera was made for a 
beginner who possibly might even buy 
a dSLR as his first camera. It’s not as 
impressive as the D60 though.

Canon EOS 50D

One of the key features 
of the EOS 100D is the Live 
View. It’s similar to the one 
found in the Nikon D90. It 
lets you use the LCD screen 
to focus. This should prove 
convenient to P&S users 
not used to a viewfinder. 
There is a slight delay as 
expected and we’re really 
not so impressed — many 
would agree that the old 
viewfinder way of focussing 
is the way to go.

The buttons on the EOS 
1000D are flat and easy to 
push. The jog dial feels as if 
it has large notches and isn’t 
as smooth and light as the other buttons 
and dials on the camera. Unlike the other 
Canons and the Sony, the EOS 1000D uses 
an SD/SDHC card. The body is built well and 
the flash hinge and structure is slightly 
better on this than the 400D. The lens itself 
looks similar and has a slightly silky grip 
which we didn’t like. There’s also the miss-
ing thumb-grip near the screen which was 
present in the EOS 400D.

The menus on the 1000D are basic but 
not as amazing as the 50D. The controls are 
a little more manual with the 1000D. Most 
of the controls are to be changed using the 
button and jogdial combination instead of 
using the direction keys in the software 
menu. The zoom buttons for the preview 
are set into bevelled slots on the back of 
the camera. 

Focussing is simple and straight 
forward. Macro shots are fairly easy to 
take as well. The camera feels and works 
a lot like the EOS 400D and it also 
happens to replace and take its place in 
the price range. 

The menu drags it all down, unfortu-
nately. The A200 in comparison feels richer. 
The EOS 1000D is a slightly better camera 
than the aged 400D in image quality, but 
we preferred the body and ergonomics on 
the EOS 400D. The MRP for the Canon EOS 
1000D is Rs. 34,995.

Canon EOS 50D
One of the most special cameras in this 

test has to be the EOS 50D. It’s sheer size 
and feel in hand was enough to get posi-
tive responses from everyone who used it. 
The EOS 50D was released late last year to 
replace the EOS 40D. Like its predecessor, 
the EOS 50D isn’t a full-frame camera, 
but it has a good 15-MP CMOS sensor. The 
DIGIC 4 processor is one of the other revi-
sions made to the camera.

This is larger than the others cameras 
that we tested. The EOS 50D also has 
slightly different controls from the others. 
The biggest difference lay with the large 
dial ring in place of the direction arrows. 
The directional arrows on the 50D are 
replaced by a joystick, rather like the ones 
found in mobile phones except this one is 
really sturdy and a little hard to use. Like 
the D90, the 50D uses two dials dedicated 
to change shutter speed and aperture in 
the manual mode. In the aperture or shut-
ter priority mode, the jog dial at the front 
is used. 

The camera is also wider than some of 
the other cameras. A lot of space on the rear 
isn’t used and only the dial-wheel and the 
joystick are present. All other controls such 
as the ISO level, white balance settings, 
and the autofocus settings are present on 
top, right behind the tiny screen on top of 
the camera. 

Using this camera isn’t particularly 
easy. It’s more geared towards the more 
advanced enthusiast. If you’re used to 
dSLRs, then you can get around it in an 
hour or so. The interface is more refined 
than other cameras and Canon has also 
tried to ease things by adding little fade-in 
effects and some colour to the menus — in 
our opinion is a nice touch.

The screen is of very good quality and 
is positioned well on the left. It displays 
colour accurately and controls for the 
brightness for the screen are easily acces-
sible — this is a good thing when you’re 
working in extremely dark or bright places. 
The primary information display is well 
thought of and has all the settings you 
need. All the menus and features work 
really quickly.

Canon EOS 1000D
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Canon Edge (www.can-
onedge.com) is a commu-
nity site started for Canon 
camera users

Photoshop 1.0 was released 
as an application only for 
the Mac

The autofocus works exceptionally 
well and is very quick. Similar focussing 
options are present on even the cheaper 
Canon dSLRs. We received the Canon EOS 
50D with a standard 18–55mm lens. The 
quality of lens is good, but it’s not opti-
mal for outdoor shooting of large areas. 
On the other hand, for macros with zoom 
engaged, it’s possible to get good up-close 
photos. The manual focus is also very 
good and you can get accurate focus on 
small objects.

The camera has a good burst shooting 
mode and it performs well for a second or 
two, but after that the shots slow down. We 
used a SanDisk Extreme III CompactFlash 
card for these tests. The flash isn’t strong 
or as impressive as the rest of the camera. 

The EOS 50D is clearly an exciting piece 
of equipment. The overall results are stun-
ning, but there are a couple of complaints 
— the biggest one being the ON / OFF switch 
being at the bottom, and a complete pain 
to use. It’s too tiny and is flimsy in compari-
son to all the other controls on the camera. 
For its feel, ergonomics, performance and 
features, this makes a strong contender for 
the best camera in this test. The price for 
this camera, with lens, is Rs. 81,995. 

Nikon D60
The Nikon D60 falls into the entry-level 
dSLR bracket. This category has been 
bubbling with activity with manufacturers 
trying hard to get the attention of eager 
enthusiasts who might take the leap. Like 
the rest of the contenders in that price 
range, the D60 is a 10.2 MP camera.

The biggest and the most prominent 
feature about the D60 is the usability of 
the functionality. Nikon has a done a lot to 
ensure that the user is never lost in a sea 
of options. All of the features and options 
are clearly distinguished and a dedicated 
help button gives a short description of 
each of the feature’s details. The menus 
are very warm and the main interface 
displaying the aperture 
size, shutter speeds and all 
the settings is highly inter-
active and animated. All this 
user-friendliness does not 

make the camera feel very bare 
and toned down — it still has an 
edge over the other dSLRs in the 
same price range. 

Holding it is as difficult as 
with the other small dSLRs. The 
body is close to the hand grip with 
just enough space for your fingers. 
However, the build is superior to 
the Canon EOS 1000D, 400D and 
the Sony A200.

Images turned out well and 
the Auto shoot mode does its part 
nicely. The noise at ISO 1600 is 
very manageable and is on a par 
with the EOS 1000D and the 400D. 
Nikon supplies a good 18–55 mm 
VR lens, which makes a big differ-
ence. The VR works pretty well, but a lens 
of this calibre doesn’t really need it. 

At the end of the evaluation, it’s the 
D60 that seems to be preferred; and rightly 
so, for its ease of use, it features excellent 
menus and has a user-friendly design. It 
feels very much like a refined camera than 
an attempt to tone everything down too 
much for the sake of ease of use.

Nikon D80
The Nikon D80 is actually a camera from 
late 2006. The D90 was released last year 
and the general reaction everywhere was to 
show the thumbs-up. The D80 was known 
to be a good camera. It made good sense as 
a dSLR for a casual photography enthusiast. 
We were interested in the D80 primarily 
for its lower pricing with the D90 now in 
the market.

The controls and body construction 
of the D80 are similar to those of the D90. 
The directional buttons aren’t very large, 
though. A two-jog dial setup is present on 
the D80 and is a welcomed feature any 
day. Changing shutter speed and aperture 
size simultaneously with them makes life 
easier, for sure. Controls for the white 
balance and ISO are lined along the left 
of the screen, so operating the camera 
settings requires using both your hands 
at times.

The smaller screen is present on top 
which immediately takes it a step up from 
the entry-level dSLRs. This feature makes 
adjusting settings much more straightfor-
ward. There’s no need to look at the screen 
and use the directional keys to change 
any of the settings. Taking photos while 
making adjustments simultaneously is a 
lot simpler this way. This is a feature only 
found on mid-ranged dSLRs. The other 
difference is the eyepiece which is larger 
than with other cameras. Focussing auto-
matically becomes simpler. There’s also 
support for a remote-control which is a 
nice function that can be useful when 
taking long exposure shots on a tripod.

One of the annoyances of the D80 has to 
be the tiny direction buttons all combined 
together. This is hard to use and is similar 
to the control used in the much older D70. 

Nikon D60

Nikon D80

The D80 supports a larger battery pack; 
this gives more power to the camera and 
also makes it easier to hold. The battery 
pack can hold two D80 batteries. Like the 
D90, the D80 also uses SD/SDHC cards for 
storing images.

The lens we received with the camera 
was Nikon’s AF-S 18–135 mm. It’s the most 
powerful lens of the ones in this test. This 
wasn’t a VR, but it didn’t affect us a lot 
while taking telephoto shots.

Another addition with cameras such as 
the D80 is the more comprehensive menu 
system. Control for many more of the 
features can be found and each one modi-
fied according to your needs. 

While the D80 is pretty identical to the 
D90 on most fronts, the larger and better 
quality screen is the biggest difference, we 
feel. Liveview and video recording are the 
other very important additions to the D90. 
With a price tag of Rs. 70,950 including 
the AFS DX 18-135/3.5-5.6G lens, the D80 is 
slightly cheaper than the D90.

Nikon D90
Nikon’s D90 is one of the newest entries to 
Nikon’s line-up. The D80 was known for its 
really great quality sensor and the D40X 
was another camera that used it. The D80 
was previously known as a great mid-range 
dSLR. The D90 therefore has a lot to prove, 
especially as it is quite costly.

The biggest difference going from a 
D40X or any other entry-level dSLR is the 
sheer size. It’s more or less the same as the 
D80. The D90 we received for review from 
Nikon came with an 18–105-mm VR lens. 
It’s functions and this kind of range lets 
the user to capture from wide-angle images 
to good telescopic images (for better tele-
scopic images, you would consider the 
Nikon 18-200 mm lens.). This lens could be 
described as having a 6x optical zoom. As 
an overall solution, this lens with the D90 
body makes an excellent choice.

Operating the D90 is pretty straight 
forward, although it isn’t as simple as the 
D60 or the D40X. There isn’t the help menu 
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Digital SLR test

Brand Canon Canon Canon Nikon Nikon Nikon Sony
Model EOS 1000D EOS 400D EOS 50D D60 D80 D90 A200

Price Rs. 34,995 Rs. 60,995 Rs. 81,995 Rs. 39,950 Rs. 70,950 Rs. 83,950 Rs. 27,990
Specifications

Sensor resolution 10.1 10.1 15.1 10.2 10.2 12.3 10.2
Sensor size (mm) 22.2 x 14.8 22.2 x 14.8 22.3 x 14.9 23.6 x 15.8 23.6 x 15.8 23.6 x 15.8 23.6 x 15.8
Sensor Type CMOS CMOS CMOS CCD CCD CMOS CCD
Highest Image resolution 3888 x 2592 3888 x 2592 4752 x 3168 3872 x 2592 3872 x 2592 4288 x 2848 3872 x 2592
File formats supported RAW, JPEG RAW, JPEG RAW, JPEG RAW, JPEG RAW, JPEG RAW, JPEG RAW, JPEG
Supplied lens (mm) 18 — 55 mm 18 — 55 mm 18 — 55 mm 18 — 55 mm 18 — 135 mm 18 — 105 mm 18 — 70 mm
Burst rate (fps) 3 3 6.3 3 3 4.5 3
ISO Rating 100 — 1600 100 — 1600 100 — 3200 100 — 1600 100 — 1600 200 — 3200 100 — 3200
Shutter speed range (sec) 1/4000 to 30 1/4000 to 30 1/8000 to 30 1/4000 to 30 1/4000 to 30 1/4000 to 30 1/4000 to 30 
White balance settings (number) 7+ custom 6+ custom 8+ custom 6 6 12 7
Auto focus modes (number) 3 3 4 3 3 3 3
Self-timer (Y/N, sec) 4 / 2, 10 sec 4 /10 sec 4 / 2, 10 sec 4 / 2, 5, 10, 20 sec 4 / 2, 5, 10, 20 sec 4 / 2, 5, 10, 20 sec 4 / 2, 10 sec
LCD screen size (inch) 2.5 2.5 3 2.5 2.5 3 2.7
LCD resolution (pixels) 2,30,000 2,30,000 9,20,000 2,30,000 2,30,000 9,20,000 2,30,400
Memory supported SD/SDHC CompactFlash CompactFlash SD/SDHC SD/SDHC SD/SDHC CompactFlash
Live view (Y/N) 4 6 4 6 6 4 6

Video recording (Resolution) 6 6 6 6 6 4, 1280 x 720 6

Battery capacity (mAH) 1080 720 1390 1000 1500 1500 1650
Dimensions of body (mm) 126.1 x 97.5 x 61.9 126.5 x 94.2 x 65 145.5 x 107.8 x 73.5 126 x 94 x 64 132 x 103 x 77 132 x 103 x 77 130.8 x 98.5 x 71.3
Weight (g) 450 510 730 495 585 620 552

Performance (Out of 10)
Auto mode (with flash)

Colours 6 6 8.5 7 7 8 7.5
Detail 6 7 8 7.5 8 7.5 6
Flash 7 7 8 6.5 7 7.5 7
Grain 6.5 6.5 7 6.5 7 7 6.5
Zoom Sharpness 7 6 7 7 7 8 6

Manual mode (low ISO, long exposure)
Colours 7 6.5 8.5 6.5 8 8 6.5
Detail 6.5 6 7.5 7 7 8 6
Grain 6 6 8 6 8 7 6

  
DSLR Comparison Test

for every single feature that you find on 
the entry-level cameras that are intended 
to attract the new dSLR user. It’s assumed 
that the D90 user would be well-versed 
with dSLRs or photography basics.

Two jog dials are present — one at the 
front of the shutter release button and 
one on the rear near the screen. Accessing 
them is simple and the feel of the dials is 
very nice as well, but holding the camera 
might be a problem for users with smaller 
hands. The same old tiny directional key 
set is still present on the D90. On a camera 
this size, a larger set of separated keys 
would have made better sense.

The focus ring on the lens is located on 
the body instead of the tip of the lens as 
on some of the other cameras. The camera 
focuses quickly, even in low-light, and the 

Nikon D90
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Even cheap full-frame 
sensor dSLR cameras are 
priced around a lakh and 
a half

Brand Canon Canon Canon Nikon Nikon Nikon Sony
Model EOS 1000D EOS 400D EOS 50D D60 D80 D90 A200

Price Rs. 34,995 Rs. 60,995 Rs. 81,995 Rs. 39,950 Rs. 70,950 Rs. 83,950 Rs. 27,990
Specifications

Sensor resolution 10.1 10.1 15.1 10.2 10.2 12.3 10.2
Sensor size (mm) 22.2 x 14.8 22.2 x 14.8 22.3 x 14.9 23.6 x 15.8 23.6 x 15.8 23.6 x 15.8 23.6 x 15.8
Sensor Type CMOS CMOS CMOS CCD CCD CMOS CCD
Highest Image resolution 3888 x 2592 3888 x 2592 4752 x 3168 3872 x 2592 3872 x 2592 4288 x 2848 3872 x 2592
File formats supported RAW, JPEG RAW, JPEG RAW, JPEG RAW, JPEG RAW, JPEG RAW, JPEG RAW, JPEG
Supplied lens (mm) 18 — 55 mm 18 — 55 mm 18 — 55 mm 18 — 55 mm 18 — 135 mm 18 — 105 mm 18 — 70 mm
Burst rate (fps) 3 3 6.3 3 3 4.5 3
ISO Rating 100 — 1600 100 — 1600 100 — 3200 100 — 1600 100 — 1600 200 — 3200 100 — 3200
Shutter speed range (sec) 1/4000 to 30 1/4000 to 30 1/8000 to 30 1/4000 to 30 1/4000 to 30 1/4000 to 30 1/4000 to 30 
White balance settings (number) 7+ custom 6+ custom 8+ custom 6 6 12 7
Auto focus modes (number) 3 3 4 3 3 3 3
Self-timer (Y/N, sec) 4 / 2, 10 sec 4 /10 sec 4 / 2, 10 sec 4 / 2, 5, 10, 20 sec 4 / 2, 5, 10, 20 sec 4 / 2, 5, 10, 20 sec 4 / 2, 10 sec
LCD screen size (inch) 2.5 2.5 3 2.5 2.5 3 2.7
LCD resolution (pixels) 2,30,000 2,30,000 9,20,000 2,30,000 2,30,000 9,20,000 2,30,400
Memory supported SD/SDHC CompactFlash CompactFlash SD/SDHC SD/SDHC SD/SDHC CompactFlash
Live view (Y/N) 4 6 4 6 6 4 6

Video recording (Resolution) 6 6 6 6 6 4, 1280 x 720 6

Battery capacity (mAH) 1080 720 1390 1000 1500 1500 1650
Dimensions of body (mm) 126.1 x 97.5 x 61.9 126.5 x 94.2 x 65 145.5 x 107.8 x 73.5 126 x 94 x 64 132 x 103 x 77 132 x 103 x 77 130.8 x 98.5 x 71.3
Weight (g) 450 510 730 495 585 620 552

Performance (Out of 10)
Auto mode (with flash)

Colours 6 6 8.5 7 7 8 7.5
Detail 6 7 8 7.5 8 7.5 6
Flash 7 7 8 6.5 7 7.5 7
Grain 6.5 6.5 7 6.5 7 7 6.5
Zoom Sharpness 7 6 7 7 7 8 6

Manual mode (low ISO, long exposure)
Colours 7 6.5 8.5 6.5 8 8 6.5
Detail 6.5 6 7.5 7 7 8 6
Grain 6 6 8 6 8 7 6

  
DSLR Comparison Test

manual focus is very easy. 
The 3-inch screen is exceptionally 

good and Nikon has implemented Live 
View in this camera — this lets you focus 
using the screen. The general reaction 
from professional photographers is that 
they aren’t really fond of it. The other 
interesting addition to the camera is the 
HD 720p video recording function. dSLRs 
have until recently lacked video record-
ing functionality so we think it’s a nice 
function to have in a dSLR, especially for 
a regular user. The quality of the video is 
surprisingly good too. The only drawback 
here is manual focussing.

The D90 together with the AF-S DX 18-
105/3.5-5.6G VR lens is priced a bit higher 
than the D80 at Rs. 83,950. It’s a great 
enthusiast multi-purpose camera, though!

Sony A200
Sony, in comparison to the other brands, 

is a newcomer to dSLR cameras. It recently 
took over Minolta-Konica’s dSLR business, 
so things can’t be as bad as some might 
expect. The Sony A200 is one of the cheaper 
offerings amongst the entry-level dSLRs in 
the market. 

There is a 10.2 MP CCD sensor onboard 
the A200 and Sony bundles an 18–75 mm 
lens with the camera; this is a decent lens 
for medium distance photography. It’s not 
as powerful as the Nikon’s 18–105 mm VR 
lens, but is a small step up from the 18–55 
mm lens supplied with starter dSLRs from 
other brands. The focus ring is positioned 
on the outer edge of the lens body. It has a 
fine gear-teeth-like feel to it as you focus. 
It’s different from other lenses but some 
might find this distracting or awkward. It 
doesn’t get in the way of functionality or 
performance, though.

The size also seems a tad larger than 
the EOS 400D and the EOS 1000D. It’s 
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Pretec releases the 64GB 
666x — the world’s fastest 
Compact Flash card

Brand Contact Phone E-mail adress Web-site

Canon Canon India Pvt. Ltd. 1800-180-33-66 info@canon.co.in www.canon.co.in

Nikon Inter Foto India +91-22-4092 5555 ajpa@interfotoindia.com www.nikon.co.in

Sony Sony India 1800-1111-88 - www.sony.co.in

 Contact Sheet        DSLR Comparison Test

better camera than the rest. This is mainly 
because of the features and the function-
ality of the camera. One of the very valid 
points emphasised by Manas and some-
thing with which we all fully agreed on 
was that the D60 was an easier dSLR to 
use, and the quality of the body and feel 
was far better than the rest. Of the two 
Canons, we felt that the 400D was better 
than the very new 1000D. 

The 1000D has a weird dusty feel to it 
and holding gives not the nicest and most 
confident feeling one can get. This was 
one of the D60’s biggest plus points. The 
EOS 400D was better in that aspect. As 
cameras, the 1000D is a little refined in its 
menus and interface. The EOS 400D we feel 
is the better of the two Canons, and right 
behind the D60 in our idea of the optimal 
camera for a beginner. The Sony A200 is a 
slightly different story. The camera is a nifty 
little thing with its features and menus. It 
caught us by surprise, and was not what we 
expected from Sony. Unfortunately, some of 
the complaints concern the average build 
quality of the lens and the feel of the 
camera. The body is solid, but its feel isn’t so 
great. It’s also a slightly noisy camera when 
you let it loose to autofocus all the time. 
Market prices might differ from MRPs. The 
Sony A200 is a decent camera, if it’s a lot 
cheaper than the D60. 

The next cameras we need to consider 
are the Nikon D80 and the D90. The D90 
was called in to replace the D80 and 
it does that easily. Although the video 
recording feature might not be on every 
photography enthusiast’s wish list, it’s the 
Live View that will interest many. As much 
as people would dismiss it, it’s a feature 
useful in many situations and that’s an 
edge the P&S always had. The D90 is on a 
par on that front now. The D90’s Live View 
works pretty well and the video quality is 
better than that found with many of the 
point and shoots cameras. Should you buy 
the D90? Yes! If you are looking for some-
thing better than the D60, then it is miles 
ahead, and also ahead of the D80. The D80 
now is left to slip out of the market, as 
the D90 takes centre stage. If prices seem 
attractive and photo shooting is all you 
want, it might be something to consider 
if you don’t mind buying outdated tech-
nology. The MRP for the older D80 is Rs. 
70,950 with the 18–135 mm lens and Rs. 
83,950 for the D90 with the VR 18–105 mm 
lens. Market prices might be lower.

There is no better way to describe the 
Canon EOS 50D. As a mid-ranged prosumer 
dSLR, it doesn’t come much better. Nikon’s 
D90 is a great dSLR and also a video 
camera, but the Canon EOS 50D is a better 
photographer’s camera. The price for it is 
a whopping Rs. 81,995, which includes the 
EF-S 18-55 mm f/3.5-5.6 IS kit lens. It’s not 
the best value for money product consider-
ing the 18–55 mm lens that comes with 
it, but it’s a camera we recommend if you 
have the money to splurge. n

rossi.fernandes@thinkdigit.com

Sony A200

easily the heaviest of the entry-level dSLRs. 
The quality of the camera is pretty good, 
although it feels of plastic almost all over.

The display quality of the 2.7-inch LCD 
screen is average. Sony has brought in 
colourful menus to the dSLR and every-
thing looks very user-friendly, but there’s 
little help to guide users through the 
menus. The buttons on the back for operat-
ing the camera are well considered. The 
direction key set, for example, lets you 
scroll through images diagonally. The 
buttons are flat, soft and effortless to 
use. But wear and tear on them through 
months of rough use might concern some. 

The controls are placed in different 
areas of the camera and not cramped all 
together. This might be comfortable for use 
once you get used to this kind of layout, but 
it also means that you have to move your 
fingers all over the camera to access them. 
It’s probably not the most optimal layout. 
While dSLRs try to give users the quick-
est access to controls, the A200 has a few 
settings hidden away behind a Function 
button. These include the flash mode, 
metering and autofocus mode settings. 
Noise reduction features for ISO and long 
exposure shots are also present.

We’re quite impressed by the features 
and design effort that Sony has put into 
this entry-level dSLR. One such feature is a 
meter that measures the amount of move-
ment while you are taking a photograph. A 
flashing indicator next to it warns you of 
it. The stabilization control is present as a 
simple slider on one corner of the camera 
and not on the lens. The stabilization is 
average, but just the warning is enough to 
get your attention and put that extra care 
into holding the camera steady.

The other very impressive feature is 
the flash. With almost everything auto-
mated, the flash is able to measure the 
light very accurately. We tried all kinds of 
shots with objects really close and some 
moderately far away. The amount of light 

fired is accurate and the backgrounds are 
rarely drowned in darkness. If you think 
that the flash on the Sony isn’t sufficient, 
then you might face a problem. Sony 
uses a different flash-mount compared to 
Canon and Nikon, so purchasing a third-
party flash might turn out to be a bit of a 
problem. It must be said that this mount 
feels more solid than the rest. The grip 
too is a little nicer than on the Canon 
cameras.

Image stabilisation is present on the 
camera and not on the lens with the Sony 
A200. A sensor detects your face in front 
of the eyepiece and then turns on the 
focussing and turns off the LCD, as with 
some of the other cameras. Those with 
high-definition TVs and monitors will 
be interested to know that this camera 
shoots at 16:9 aspect ratios. This means 
you don’t have to go through the trouble 
of cropping every single photo manually 
or automating it using an image editor, 
which often can crop out areas of inter-
est to you.

The camera isn’t very fast and the 
drive speed at 3 frames per second is 
also not as impressive as the upper-end 
cameras, but it does easily make a match 
for other cameras of its category. The 
A200 uses CompactFlash memory and not 
Sony’s proprietary Memory Stick Duo like 
its point-and-shoot cameras. 

The Verdict (s)
Knowing how great are the variations 
between P&S cameras, the case with 
dSLRs is quite different. The cameras we 
received were all very good in their own 
way. One thing’s for sure though — it’s 
safe to assume (at least most of the time), 
good quality comes at higher cost.

Roughly, the Nikon D60, the Sony 
A200 and the two Canons — the EOS 
1000D and the EOS 400D fell into the 
basic entry-level range of dSLR cameras. 
Our conclusion is that the Nikon D60 is a 
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S
cientists have proven that standing 
upright (while working) and lying 
prone (while resting) are the only two 
positions the human body was built 

for. We still sleep lying down but thanks to 
the modern work environment we no longer 
accomplish most of our work standing up 
— we’re in a sitting position on a chair or 
otherwise. The spinal column did not evolve 
for a sitting posture just as the wrists never 
adapted for the repetitive action of support-
ing the hand as one types on a keyboard, 
sometimes for hours at a stretch. 

As a result, repetitive stress injuries 
cannot be avoided and most users are 
unaware of the damage that takes place 
since such injuries typically do not manifest 
themselves as soreness at the injury spot 
until quite late, when most of the damage 
has been done. For most of the office-going 
fraternity rest is also not an option. Take 
Carpal Tunnel Syndrome (referred to as CTS 
here-on) for example, a very common repeti-
tive injury that occurs for a multitude of 
reasons. One of the ever increasing causes of 
CTS has been pinpointed in recent times to 
be RSI (Repetitive Stress Injury) that occurs 
after continual use of keyboards and mice 
with incorrect posture and insufficient rest. 
CTS is a painful, progressive condition caused 
due to compression of the median nerve in 
the wrist. This nerve gets compressed due 
to inflammation of ligaments in the carpal 
tunnel that houses the median nerve. These 
ligaments become inflamed as a result of 
certain mechanical movements among a host 
of other factors, including hormone deficien-
cies and even certain hereditary conditions. 
It is this collection of bones in the wrist 
(collectively called the Carpal bones) that 
allows the wrist to move and rotate vertically, 
horizontally and laterally. Once it develops, 
CTS can take several months to improve and 
any activity irritates the condition. Most of 
us would not even get a week away from 
work, let alone a few months. Therefore, as 
with most ailments prevention remains the 
best cure.

Thankfully when it comes to using 
computers, manufacturers of not just human 
interface devices like keyboards and mice 
but also office chairs have woken up to the 
fact that there is a problem that is affect-
ing an ever increasing number of desktop 
and notebook users and have designed solu-

tions meant to reduce such repetitive-action 
generated stress, if not totally alleviate it. 
We at Digit have had our share of what 
we fondly call technology related injuries and 
one of us jokingly refers to as technical inju-
ries. We’ve also learnt that ergonomic chairs 
and keyboards with palm rests really help 
keep such problems at bay. This article is 
devoted to such devices that can collectively 
be termed as ergonomic, or simply those 
designed with the nuances of the human 
body and posture in mind.

Logitech VX Nano: for the 
mobile warrior
The Logitech VX Nano mouse is the new 
ambidextrous version of the VX Revolution 
that was Logitech’s answer to mobile prosum-
ers demands of a powerful, feature rich 
mouse for use with notebooks. The VX Nano 
is small and has shallow scallops on each 
side that allow your thumb and little finger 
to grip the body. Although the VX Nano is 
not as comfortable as the VX Revolution for 
right-handed users it’s obviously a lot more 
comfortable for left-handed users. Also the 

VX Nano is smaller than the VX Revolution 
meaning those who like to palm their mice 
will be disappointed, you may need to grip 
it with your fingers, especially if your hands 
are relatively large. 

The mouse itself is finished in black and 
dark grey and looks very business-like at 
first glance. Even with two AAA cells it’s not 
heavy. The scroll wheel can be clicked and 
this toggles between a super fast friction-less 
scroll and the regular clickety-clack precision 
scroll that most mice have. This feature works 
very well and the mouse is a glide (literally) 
when scrolling through very long web pages 
or documents. The tilt wheel is another, plus 
particularly for us test centre types who use 
MS Excel extensively, and scrolling side to 

side is a snap. There are two customisable 
buttons on the top of the mouse accessible 
with your index finger. These are set to the 
default actions of forward and backward — a 
boon when surfing but they (as well as the 
other buttons) can be customised using the 
Set Point software bundled. Incidentally driv-
ers for Mac OS X are provided.

We mentioned that the VX Nano is 
compact and this suits its the fact that is is 
touted as the “ultimate notebook mouse”. 
It certainly has a tiny receiver, and this can 
aptly be described as “nano”. In fact, sitting 
in a USB port this receiver barely protrudes 
by six or seven millimetres — it’s positively 
tiny! The receiver can also be stored inside the 
mouse — to do this you need to remove the 
battery compartment cover. Usefully, once 
the receiver has been inserted into its bay, 
the mouse switches off and cannot be turned 
on until the receiver is removed — a useful 
power saving feature. And rather frugal it is, 
on batteries, that is. A set of two AA Duracell 
batteries are still happily running at well 
over 60 per cent charge, even after two weeks 
of heavy use. Safe to say your batteries will 
last for at least a month. The mouse itself 
tracks well enough for office use and most 
other applications. However, it’s not as good 
for gaming or even Photoshop applications 
where greater precision is required; and like 
all wireless mice the odd jump of the cursor 
takes place.

All in all, for a price of Rs. 5,295, the 
VX Nano is not cheap and cannot be said to 
offer value for money. But it has very little 
competition and occupies somewhat of a 
niche — the über-notebook mouse. Desktop 
users will scoff at its small footprint and this 
makes it not the most comfortable mouse to 
palm, but it’s just the tool for the discerning 
notebook user — compact, functional and 
very feature rich. A pity Logitech couldn’t 
make one each for right and left handed 
users and why couldn’t they make this one 
just a bit larger?

MX 5500 Revolution: 
Desktop King!
The Logitech MX 5500 Revolution is Logitech’s 
flagship desktop solution just below the 
astronomically priced De Novo. This duo 
consists of the MX 5500 keyboard and the 
MX Revolution mouse. This keyboard bears 
similarities to the older MX 3200 desktop 
keyboard, although there are a number of 
new shortcut keys added. The multimedia 

Relax amid work…we test some of the most comfortable computing equipment around

Built for you

Bluetooth mice work on a 2.4 
GHz frequency range. Any 
device operating on the same 
frequency in close proximity will 
interfere with signals and affect 
performance
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and zoom buttons are to the left of the main 
keys while three flat-button shortcut keys 
have been provided at the bottom right of 
the unit. The alphabet keys themselves are 
very well laid out and this together with the 
slight bevelling on the top makes typing a 
real joy. The key spacing is greater than on a 
regular keyboard, but similar to the key spac-
ing on the Logitech G15, which, strangely, 
is a gaming keyboard. This said we had no 
issues adapting to the slightly more spaced-
out layout. 

The feedback of the keys also seemed a 
little soft at first, but within a few hours of 
use we realised that this is noticeably less 
stressful on the fingers. However, the feed-
back isn’t as squishy as we’ve found some 
Microsoft keyboards to be. In fact, a light, 
almost whisper-like, touch is all that’s needed 
to type and our typing speed actually went 
up on this keyboard, which is about as good 
a praise as one can imagine. The palm rest is 
adequate, but we’d prefer one that extends 
just a little bit more; for us this palm rest is a 
little short to be termed properly ergonomic; 
the Logitech G15 has a slightly larger surface 
area on its palm rest although there is always 
a trade-off with workspace area. Unlike the 
MX 3200, its surface is not coated with any 
bacteria-resistant material and we noticed 
the palm rest does not get sweaty, even with 
prolonged use sans air conditioning. One 
annoying feature we found when using this 
keyboard was that the function keys have 
been split apart by the word Logitech and its 
monogram, therefore there is a two inch 
gap between the [F8] and [F9] keys. That 
being said, each of the function keys has an 
alternate function highlighted in orange. 
Corresponding to this orange colour scheme 
there’s a function key that replaces the right-
side Windows key and using this key allows 
the alternate functionality to be accessed.

The keyboard has a small display embed-
ded into the top, and this portion is tapered 
so that this display is convenient to read 
when looking down at the keyboard. This 
display will show you the status of any of the 
shortcut keys currently being used; other-
wise it can be programmed to display the 
time and date. For example, if you change 

the sound volume, a level indicator will be 
displayed. It also works with the calculator 
function in which case both operations and 
results are displayed. Do note that this LCD 
is not backlit, which means it will not be 
readable in dimly lit conditions; although 
if it were backlit it would drain a lot more 
battery juice — any sort of backlighting is a 
double-edged sword when it comes to wire-
less keyboards. The MX 5500 uses four AA 
batteries, which is two batteries more than 
the MX 3200 used. Logitech claims battery 
life at a whopping six months and while 
we had no way to test this, we used this 
keyboard for three weeks with heavy usage 
and had no issues at all.

The MX Revolution is no longer new, 
having being launched some time in 2006. 
But it’s still one of the most advanced (read 
designed for extreme office users) mice 
around. It follows the same black/dark grey 
colour scheme as the VX Nano, but it’s 

shaped radically different and is much larger 
and heavier. The scroll wheel has the ability 
to work as a free spinning (quick) scroll or a 
click-like (precision) scroll function. Toggling 
between these functions happens by pressing 
the mouse wheel but this is not a mechani-
cal function as it is in the VX Nano; instead, 
the switching is electronic, and for this 
reason the toggle does not work unless the 
Bluetooth dongle is connected to a computer. 
The built-in tilt-wheel functionality is a huge 
plus for those working with spreadsheets. 
This mouse is designed for right-handed folk 
and the thumb region is deeply recessed, 
with the body below the thumb tapering 
outwards sharply; this creates a wide base for 

the mouse to sit on and also a proper resting 
area for your thumb. In fact it reminds us 
of sports bikes’ wind-cheating bodywork in 
the way one’s thumb completely fits into 
this recess. The right side is lightly sculpted 
for your last two fingers. The forward/back-
ward buttons are located conveniently above 
the thumb recess and while they are easily 
accessible with the pad of the thumb, they 
are well out of reach to be accidentally or 
unintentionally used. With Logitech’s drivers 
installed the mouse wheel is actually pretty 
smart and can be configured to run in either 
precision mode or speed mode, according to 
the application.

Located within the thumb recess is 
another mouse wheel — the document flip. 
This one has limited movement both ways. 
Clicking the wheel brings up a window with 
all current programs running being shown 
as smaller windows. Nudge the wheel and 
you’ll start flipping through the documents. 
Once you get used to it, this is a faster, 
neater version of Windows’ alt + tab. A dedi-
cated search button is also provided, located 
behind the main mouse wheel; this provides 
instant online searching of a highlighted 
word or phrase. 

Using the MX Revolution for browsing 
and working with spreadsheets and docu-
ments is a joy. The mouse tracks fairly accu-
rately, although an MX 518 it is not, therefore 
don’t expect a lot of frag-fest wins with this 
mouse. Another plus is the sealed lithium-
ion battery and the battery lasts for around 
15 days on a single charge. A neat dock has 
been provided for effortless charging when 
it’s needed and the four-stage, green-LED 
battery indicator on the mouse body will 
notify you when the device needs juice. On 
a slightly negative note the MX revolution 
is heavy, understandably so considering the 
functionality it packs and its largish size. 
Despite the fact that most mice with a pair 
of AA batteries would be heavier we’d like it 
to be around 25 grams lighter.

As a combination of keyboard and 
mouse the MX 5500 Revolution is hard to 
beat. Although it doesn’t have the (ahem) 
split keyboard layout that is touted as being 
“really” ergonomic, we feel this is about as 

The Pneumatic Fabric Manager Chair is really not 
that great to look at. The chair is broader at the 
shoulder level and tapers slightly towards the 

base. The back rest ends at the neck and there is no head 
support. The fabric of this chair is made of a microsuede 
fabric and the colour of this chair is a dark bluish-grey.

This chair is not too soft but you can easily get used 
to sitting in it. There is also extra cushioning towards the 
base which gives good lower back support. Along with 
that some extra cushioning towards the top of the chair 
gives good shoulder and upper back support while sitting 
upright.

You can easily adjust the height of this chair. A tilt lock 
is also present on this chair, but the chair can only be locked 
in the upright position.

One interesting feature is the adjustable side arm 

handles which can be adjusted by a simple clip along with a 
pull-push mechanism located on the handles itself. Though this 
is a very useful feature to have in a chair, the model that we 
received had very wobbly side handles, which is not comfort-

able at all. Also these handles do not have any fabric on 
them, instead is made of rubber which is found on many 
computer chairs.

This chair would not suit a person who has to sit and 
type all day. It is more likely to be suited for a manager 
of a company who doesn’t need to type very much or 
even someone who spends the whole day in meetings 
in a board room. But a price tag of Rs. 9,990 (MRP), 

does not justify the features that this chair offers. 
It is much more of a comfortable meeting chair than an 
ergonomic computer seat.

Staples 13392, Pneumatic Fabric Manager Chair: Grey suit

Keys should not be too hard 
or too soft to press and their 
rebound should also be 
nominal — this is termed as 
good feedback

Extra mouse buttons enable 
you to do common tasks 
quickly and without using 
shortcut keys
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Although the split keyboard 
design is supposed to be 
ergonomic, it’s subject to what 
one is used to

ergonomic as it can get. We love the keys, we 
love the functions and we love the keyboard 
in general. The mouse is brilliant as an office 
tool and the fact that it looks very up-market 
may also do a lot for the look of your desktop 
space. This combo is probably more than 
most users will be able to fully utilise, so 
it’s largely overkill, but anybody looking at 
a quality combo will probably end up shop-
ping for one of these. Its price of Rs 11,495 
will make most users flinch and feel it’s a tad 
overpriced. At a price of around Rs. 7,500 we 
would gobble up this deal. Incidentally, the 
MX Revolution is available at an MRP of Rs. 
7,495 and street prices are as low as Rs. 5,000 
— which we reckon is a steal for what is argu-
ably one of the most functionally productive 
mice we’ve used.

Logitech Desktop Wave: Tidal 
wave of comfort
The Logitech Wave has been aptly named. 
While the mouse’s design itself brings noth-
ing remotely wave-like to mind, the keyboard 
has a slight raise in the centre that causes 
the keys towards the middle to be slightly 
raised. This slight undulation does not affect 
the top portion of the keyboard where the 
function keys lie; instead it is in the region 
of the alphabet keys and this gives this 
product its name. The keyboard itself is well 
laid out and the keys have a similar gap to 
that we found on the MX 5500’s keyboard 
— it seems Logitech is not following any 
standard for gaps between keys. However the 
keys themselves are well bevelled and easy 
to use. Feedback is poles apart from the MX 
5500’s keyboard, while that lacked much 
feedback and could be termed as slightly 
squishy, the keys on this one exude a lot of 
positive feedback and there is a feeling of 
the key rebounding back after being pressed 
— very good feedback. However, feedback is a 
double edged sword that compro-

mises on comfort levels and after spending 
some four hours typing non-stop we’d have 
to agree that the soft, minimal feedback of 
the MX 5500 kept our finger pads in much 
better shape. However, for non-touch typists 
this sort of a keyboard is easier to use, it’ll 
also be easier for newbies unfamiliar with 
the layout of a keyboard.

There are fewer shortcut buttons on the 
Wave than on the MX 5500, but the keys 
themselves are larger and much easier to use 
on account of their more positive feedback. 
There is a useful document flip button that 
is quite conveniently located to the left of 
the alphabet keys. The two-way zoom button 
is large and also easy to use, as are the other 
multimedia keys. Once again, as with the MX 
5500’s keyboard, all the function keys have 
secondary functions that are activated by a 
dedicated function key. Dedicated buttons 
for Media Centre and calculator have also 
been provided. All the dedicated shortcut 
buttons have a steel grey colour and this 
makes them really stand out in comparison 
to the other keys which are a generic black. 
There is no backlighting whatsoever and the 
Wave’s keyboard makes do without any sort 
of display. The keyboard has a really soft-
foamed wrist rest and for the first time we 
actually found our palms and wrists could 
rest very comfortably, sans sweat and any 
sort of itchiness after extended periods of 
time. The palm rest extends further than 
that on the MX 5500’s keyboard and this 
alone makes it more comfortable to use for 
longer periods of time. The palm rest has 
anti-bacterial treatment, a boon for sweaty 
climes such as ours. During use, we noticed 
that our palms and wrists never felt hot, 
due to the excellent choice of materials 
used in the palm rest and maybe also be due 
to the dimples in the material that cause 
small air pockets between the material and 
your hands. 

The mouse supplied with the Desktop 
Wave follows the same black/dark grey 

colour combo that to our eyes looks 
classy. The mouse is neatly shaped and 

ambidextrous. In fact it’s so ambi-
dextrous that there is single button 
above the thumb recess located on 
both sides. The mouse wheel is also a 

click button and has tilt capabilities, but 
this tilt wheel does not look as robust as the 
unit on the VX Nano or the MX Revolution. 
The mouse tracking is decent but does not 

in any way standout and cannot compare 
in accuracy to the VX Nano or the MX 
Revolution. That being said, it’s a solid wire-
less mouse that will satisfy all but the most 
demanding users. 

Priced at Rs. 5,995, the Wave is a great 
product, but we feel it should have been 
paired with a better mouse — Logitech has 
a vast repertoire, after all. The bundled 
mouse looks great, but does not equal 
the keyboard’s comfort or usability. The 
fact that it’s half the price of the MX 5500 
Revolution is a strong plus point, though 
we did not like the slightly hard feedback 
on the keys. If Logitech had bundled a 
better mouse than the LX8 we would heart-
ily recommend this deal.

Logitech V470: Fancy free, 
receiver-less
The Logitech V470 is a cute looking note-
book mouse available in a number of snazzy 
colours. It’s a Bluetooth mouse and does not 
need a receiver unit since the mouse can pair 
directly with any device with Bluetooth. 95 
per cent of all notebooks and netbooks come 
with Bluetooth and the major advantage of 
such a mouse is that a valuable USB port is 
freed up which would otherwise be occupied 
with some sort of receiver unit.

The mouse is built to mediocre standards, 
but when loaded with two AA cells it feels 
solid, mainly due to the increased weight. 
The mouse clicks have a positive feel to them 
but the build quality is obviously a couple of 
notches below the superb VX Nano. Mouse 
tracking is good, in fact much better than 
some of the other wireless mice we’ve used 
— no surprise since the V470 uses the same 
800 dpi laser sensor that the other Logitech 
mice — such as the VX Nano, VX Revolution 
and MX Revolution — use. In fact, we were 
pretty surprised to see that it’s nearly on a 
par with the MX Revolution when it comes 
to pin-point accuracy. Logitech has provided 
this mouse with a good set of smooth Teflon 

If you don’t fancy buying a new keyboard or 
mouse, but at the same time want to avoid 
Carpal Tunnel Syndrome (CTS) and Repetitive 

Strain Injury (RSI), then you need to have adequate 
support for your palms so that the wrists remain in line with the hands. 
This can be acheived through the use of gel wrist rests.

We tested the Staples 502451, Gel Keyboard WristRest Black as 
well as the 502499, Gel WristRest Black. The Keyboard WristRest was 
long and it covered the entire length of the keyboard, while the other 
WristRest was just enough for the mouse. The bases of these wrist rests 
have a rubber grip so that they do not move while typing or using the 

mouse. These gel rests have the right amount of 
softness to give enough resistance to support 
your palms.

While typing with the keyboard wrist rest, the 
palm of your hand gets the support it needs, thereby removing the strain 
on the wrist. The same is the case when using the mouse rest.

These gel wrists rests are really effective at removing the strain 
on your wrists. They are easily available at Staples and the mouse rest 
costs Rs. 99, while the keyboard rest costs Rs. 199. If you are a gamer we 
would suggest you buy the mouse rest, while if your work involves a lot 
of typing then you should definitely look at the keyboard gel rest.

Gel Wrist Rests 
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Optical sensors do not track 
on glass laser sensors have 
no such issues

One of the most important 
parts of a keyboard is the 
palm rest that supports the 
entire weight of your upper 
wrist and palms

feet and this is probably what makes it 
accurate. Our complaint, if any, was with the 
tacky mouse wheel that just does not feel as 
good as the metal units on some of the other 
Logitech mice. Thankfully, the tilt function 
is a little more robust, but mouse clicking 
feels very tacky.

Priced at Rs. 2,995, the V470 seems very 
expensive. But do note that this price is the 
MRP and street prices are sure to be lower. A 
good mouse if you’re looking for something 
usable and functional without extra buttons 
and such. The fact that this mouse doesn’t 
utilise a USB port like 99 per cent of other 
wireless mice do is probably a clincher for 
anyone who uses printers, cameras, cell-
phones or other such USB interface devices 
with his notebook.

Microsoft Comfort Curve 
Keyboard 2000: 
Not comfortable enough 
The Comfort Curve Keyboard 2000 from 
Microsoft is a wired USB keyboard aimed 
at those looking for comfort while 
typing for many hours a day.

The layout of the keys is such 
that towards the centre of the 
alphabet keypad the keys are 
slightly lower and closer to the 
user than the keys to the right and 
left. This when viewed from above 
gives the impression of a down-
ward directed curve in the entire 

layout. The rest of the keys i.e. the numeric 
keypad, are flat.

Each key in the first row, starting at 
Esc and ending at Pause Break, has a slight 
rounded top, making it easy to distinguish 
between the keys.  The rest of the keys have 
more of a comfortable dip which results in a 
good flow while typing.

There are a few internet and multimedia 
keys also present on the keyboard, and these 
include: Back, Forward, Web/Home, Search, 
Mail, Play/Pause, Volume Controls (including 
Mute) and Calculator.

This keyboard does not have standard 
key sizes as there are long keys towards 
the centre, giving more accessibility while 
typing. Another thing we noticed was that 
the last row of alphabet keys seem to dip 
downwards. Both these layout features add 
to the natural and ergonomic experience 
while typing.

Coming to the Space Bar key, this is the 
only key we particularly did not like as the 
feedback is just too mushy. This is expected 
from most keyboards as the Space bar key is 
the most used. Other than the space bar, the 
feedback of the other keys is good.

The Curve does not have a palm rest 
even though the design matches the design 
of the general curved layout. But we feel 
this is a gross ergonomic blunder, as with-
out a correct type of wrist rest you risk 
Carpal Tunnel Syndrome — a serious prob-
lem. Another flaw we noticed was that while 
typing, you tend to put pressure on the edge, 
which in turn causes the keyboard to lift up 
from time to time as it is very light.

Though there has certainly been some 
thought put into this keyboard to make it 
ergonomic and comfortable, it has not been 
executed that well and we wouldn’t recom-
mend that you buy this.

  
Microsoft Wireless Laser Mouse 
6000: The Right Choice 
The Wireless Laser Mouse 6000 is one of their 
ergonomic mice. It’s not an ambidextrous 
mouse, as the design favours only right-
handed people.

Its a greyish-silver colour on the top 
surface, and black everywhere else. It feels 
a little heavy due to the AA batteries power-
ing it. The mouse connects to the PC by RF 
through a USB dongle which can also be 
clipped on the back of the mouse.

The mouse curves slightly to the right, 
with just the right amount of space that 
results in a scallop for your thumb to fit into. 
There are also indents present for the rest of 
the four fingers so that they can comfortably 
rest on the mouse; this adds to its ergonomic 
feel. There are two shortcut buttons pres-

ent on the top, towards the left side, which 
control zooming. The keys are appropriately 
placed and so you will neither tend to acci-
dentally press them nor are they hard to get 
to if you use your thumb.

This mouse also has a Windows Flip 3D 
key which can be used from the scroll button. 
The scroll wheel also allows for 4–way scroll, 
in a similar manner to a tilt-wheel.

This mouse is big and is better for 
desktop use, though it can be used with 
a notebook, carrying it along might seem 
a burden.

The only complaint we have is with the 
scroll wheel, in that it is too smooth and does 
not have precision scroll. This causes inaccu-
rate scrolling from time to time.

It does not have as many features or buttons 
as the MX Revolution, but it definitely beats the 
LX8 in terms of design and comfort. n

michael.browne@thinkdigit.com
kumar.j@thinkdigit.com

Staples 14548 Fabric Managers Chair Black: 
Comfy and Elegant

A comfortable chair and one that is almost too comfortable for anyone looking at doing 
any serious work. After a couple of hours in this beauty we felt as if we could fall asleep 
in it — high praise indeed for a chair that’s meant for executives and managers. Called 

the Staples Ellston Chair, this beauty is finished in black microsuede and the fabric feels very 
comfortable and soft to touch. It’s a well-padded chair and the padding is firm, so it does not 
depress with your body weight; this is important so that you do not get that sinking-into-the-
chair-feeling. There’s lumbar support provided and the chair is well contoured to fit the normal 
human back. Just near the neck there’s a slight protrusion in the foam padding that provides 
good support to the neck region when seated in a proper upright posture. When seated in such 
a position we also found that the extra padding around the lower back area provided support to 
the lower lumbar region and basically reduced stress on the lower back, which is exactly what 
such chairs are designed to do. On a slight negative note, the armrests are not height adjustable, 
but they are at a perfect height for most people, so this should not be an issue. The padding 
on the armrest is also sufficient. Another negative and maybe 
a serious omission is that while the chair is height adjustable 
there is no locking mechanism for the back rest. Some chairs 
we’ve seen have this very useful feature allowing one to simply 
lean on the back rest thereby pushing it back and locking it into 
position — this allows you to recline backward without stressing 
the muscles of your back by continuously applying pressure on 
the back rest to keep it from swinging back into position. The 
fabric used is cool, a blessing for climates such as ours, and 
even without airconditioning we didn’t find ourselves perspiring 
as much as when seated in some faux leather and real leather 
chairs.

Priced at Rs. 7,990 (MRP), the 14548 Ellston is expensive and 
may not be worth its price but it’s a really comfortable chair, possi-
bly too comfortable for an executive, but for a manager who wants 
to really relax after gruelling, productivity inspiring speeches 
delivered to his team — this may be just the thing. Home users 
who spend hours in front of their PCs may also want to consider 
it, since it’s priced better than its sibling.
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GTX 275
has been launched in India by XFX

Even though the boom in LCD and 
Plasma TVs is great news for everyone, 
broadcasting of HD content still hasn’t 

taken off. This means that people have to 
depend on Bluray disks and their movie 
databases to make good sense of their expen-
sive purchases of LCDs and Plasmas. 

The only way out is to the setup an 
HTPC for HD. However, Western Digital 
might have something of interest. 
Diversifying from its main hard drive busi-
ness, it has created a compact little player 

called the WD TV HD Player, which plays 
every format you can think of — well 
almost every format we could think of.

The user-interface on the player is 
clean and designed very professionally 
and is extremely easy to use. The remote 
has all the controls required to run the 
device. The remote isn’t chunky but is 
light and flat, but it doesn’t feel so great 
in the palm of your hand.

The performance of the player is very 
good. It provides good quality audio and 

video. We tried all kinds 
of media dumped on an 
external portable storage 
drive from WD as well as a 
few flash drives. However, 
the movies encoded with 
digital audio had problems 
decoding. These have to be 
connected using the optical 
out to a receiver.

Making this player has 
been a great move by WD and it 
removes the need for an HTPC 
solely for playing back HD 
videos. An HTPC is a nice thing 
to have, but then there’s the 
trouble of getting a compact 

case, setting up all the hardware and software. 
Sure, you get all the flexibility you need to run 
whatever you want – games, movies, music, 
photos, browse the net, chat, etc. On the other 
hand, many of us just want music, photo view-
ing and videos on our TV. If you’re like us, then 
we honestly think this player a must-have for it’s 
price which isn’t very high for the performance 
and format support. 

Specifications:
2 USB ports, Display interface: HDMI, 
Composite A/V, Dimensions: 40 x 100 x 125.5 
mm, Weight: 303 g

Ratings
Features: 8
Performance: 9
Build quality: 7.5
Value for money: 7
Overall: 8

Contact: Amarjeet Singh
Phone:  +91-93210 29204
Email: amarjeet.singh@wdc.com
Web site: www.wdc.com
Price: Rs. 8,500

WD HD player
Have an HDTV? Buy this now!

XFX ATI RADEON HD 4890
From Green to Red

The time has finally come for XFX, a 
company that used to manufacture 
only NVIDIA solutions, and has now 

moved onto ATI graphic cards. XFX has 
launched ATI’s HD 4000 series, and we have 
with us the new high-end ATI Radeon HD 
4890 graphics card.

XFX has followed ATI’s reference design 
in terms of the cooling solution for this 
card. One thing to note is that ATI has not 
moved to a 40 nm GPU, but stuck with 
the 55 nm GPU, the same used on the HD 
4870. This card has 800 stream processors, 
the same as the HD 4870, with a core 
and memory speed of 850 MHz and 3,900 
MHz, which is faster than the HD 4870. 
There are two 6-pin power connectors for 
this card, but it is lacking an HDMI port. 
XFX has provided a DVI-to-HDMI converter, 
but an HDMI port would have been much 
appreciated. 

On our test setup consisting of an Intel 
QX9650 @ 3.0 GHz, 4 GB DDR2 memory 
running at 1,066 MHz and a Windows Vista 
operating system, 3D Mark Vantage gave us 
a score of 10,668 under performance mode 
and a GPU score of 10,220, which is quite a 
good score. The XFX Radeon HD 4890 is ATIs 
newest entry. In all reality it’s a tweaked up 

version of the HD 4870. It does not stand 
a chance against the GTX 285 or GTX 295 
from NVIDIA, but it definitely performs 
better than the 4870. If you really want 
a high-end card, but want to spend less 
than on the 4870, this is the card for you. 

Specifications:
Bus Type PCIe 2.0, GPU Clock: 850 MHz, 
Memory Bus: 256-bit, Memory Size: 1024 
MB DDR5, Memory Speed: 3900 MHz 

 
 

Ratings
Features: 8 
Performance: 8 
Build quality: 8 
Value for money: 9 
Overall: 8 
 
Contact: Rashi Peripherals Pvt. Ltd. 
Phone: +91-22-6709 0828 
Email: response@rptechindia.com 
Web site: www.rptechindia.com 
Price: Rs. 19,999
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40 nm GPUs
have been used in the new 
Radeon HD 4770 cards

GA-GC230D
the motherboard from Gigabyte 
with inbuilt Atom 230 processor 

The Dell Studio XPS 13 is a nice sleek 
and stylish 13.3” screen laptop. 

It’s a fusion of leather, alumin-
ium and plastic – these are the three 
materials that are present on the back 
of the lid. When you start this laptop 
the first thing that we liked is the way 
the touch buttons light up, then you will 
also see the backlit keyboard. Having 
backlight for the keys is a big plus point. 
Along with that the keys on the keyboard 
are well separated with pseudo key spac-
ing. Not only do the keys have backlight, 
but the mouse buttons of the trackpad 
also do, and the buttons are a joy to press. 
Though the trackpad is smooth and accu-
rate, it is slightly small. 

A few features of this laptop that we 
didn’t quite like are the thickness and 
weight. We find this laptop to be too thick 
for 13.3 inch screen and also it is slightly 
on the heavier side weighing in at 2.2 kgs.

Looking at the sides of the laptop we 
found some interesting ports. There is a 
USB-eSATA combined port on the right, a 
DisplayPort and an HDMI port on the left, 
and instead of the regular single head-
phone and microphone ports, there are 
two 3.5 mm ports for headphones accom-
panied by a single microphone port. The 
optical drive on this laptop is the slot 
loading kind. 

The screen of this laptop is 
really something to talk about; it 
has really great viewing angles as 
you can sit on the side and still 
view a clear picture. The inbuilt 
speakers are decent, nothing out 
of the ordinary, but just a slightly 
better than average.

This motherboard has an 
Nvidia MCP79MX chipset and 
also a GeForce 9400M graphics 
solution which work together in 
Hybrid SLi. Stacked up with 2 GB 
DDR3 memory, it is a really good 
performer. 

The battery that came along 
with this laptop was a 4-cell battery 
and it lasted for a total of 1 hour and 
25 minutes under performance mode of 
Hybrid SLI – this is what we expected from 
a 4-cell battery. 

If you are willing to look past the exte-
riors, the Dell Studio XPS 13 is a good buy. 
The model we received costs Rs. 59,900 and 
is definitely a good performer with the 
configuration that was present, but the 
price will vary according to the hardware 
you select.

Specifications: 
Dimensions (W x H x D): 319 x 22.55 x 236.12 
mm, Weight: 2.2 kgs, Processor: Intel Core 2 

Duo P8400 @ 2.2 GHz, 2 GB DDR3 1066 MHz, 
320 GB HDD, 2.0 MP Integrated Webcam

Ratings
Features: 8 
Performance: 8.5 
Build quality: 7 
Value for money: 7 
Overall: 7.5 
 
Contact: Dell India 
Phone: 1800-4254026 
E-mail: dell_enquiries@dell.com 
Web site: www.dell.co.in 
Price: Rs. 59,900

Dell Studio XPS 13
13.3” with all muscle

This phone is definitely stylish and 
has looks that would attract anybody. 
Most of the rear cover is made of 

leather which gives a nice finish to the 
phone. The front of the phone sports a 
2.8-inch VGA display and the body is glossy 
black in colour. The phone is light as 
it weighs only 120 grams. The buttons, 
located below the display are well placed 
and easy-to-use making them quite ergo-
nomic. Except for the call accept, reject, 
the quick menu and OK buttons, the other 
navigation buttons can be customized to 
lead you to a specific menu. 

The ASUS P565 is built on Windows 
Mobile 6.1, but with ASUS’ Glide features 
you should be able to scroll and perform 
tasks such as zoom and scroll with just 
flicks of the finger. However, the phone 
was quite slow and the Glide feature was 
laggy. This phone is supposed to have the 
fastest processor – Marvell PXA930 800 
MHz – but it did not seem to be fast at all. 

For messaging or typing anything on 
this phone, you need to use the stylus 
- it’s not very comfortable for on-the-go 

typing. Alternatively, you can also use 
your own handwriting to enter messages 
and this works brilliantly. Much better 
than the Nokia 5800 XpressMusic we 
tested last month.

The call quality is clear and audible on 

both ends of a call, but when you use the 
loudspeaker, the microphone picks up a 
lot of ambient noise, which is a draw back. 
The speaker is good enough when consider 
that this is on a mobile phone. 

Overall, the phone does have it charms 
but it does not come without its faults either. 
But even so, the price tag of Rs. 21,900 is not 
justified for this phone and we would not 
advise you to pay this much.  

Specifications:
Form Factor: Bar type, Operating Sytem: 
Windows Mobile 6.1 Professional, Dimensions: 
102 x 60.5 x 16 mm, Display: 2.8” VGA 480 x 
640 / 65K /TFT

Ratings
Features: 7 
Performance: 6 
Build quality: 7 
Value for money: 6 
Overall: 6.5 
 
Contact: ASUS Technology Pvt. Ltd.
Phone:  +91-22-67668800 / 1-800-2090365
E-mail: media_india@asus.com
Web site: www.asus.in 
Price: Rs. 21,900

ASUS P565
Another Windows Mobile
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X-Wing Laptop Cooling Pad 
launched by GlacialTech

With its attractive size, the Black 
Current might draw the atten-
tion of those who want an 

HTPC. The Panache Black Current comes 
without a monitor, so basically you will 
be getting the cabinet and everything 
inside it – nothing else. 

The motherboard is a mini-ITX form 
factor and does not have many upgrade 
options due to its form factor. It comes 

with two DIMM slots, two SATA ports 
and just a single PCIe x1 expansion slot. 
There is no chance of installing a discreet 
graphics solution here. The cabinet also 
is quite tightly packed with one optical 
drive slot which is already in use. The 
hard drive is mounted vertically on the 
side. There are two SATA connectors, one 
being used by the hard drive and the 
other by the optical drive, so expansion is 

a problem. The CPU heat-
sink and fan are not the 
regular size, but instead 
there is a low profile heat-
sink to compensate for 
the lack of space within 
the cabinet. The model 
we received comes with a 
Core 2 Duo E7400, a pretty 
up-to-date configuration 
which will easily handle 
any quality high-defini-
tion content.  

There are some things 
lacking in the Panache 
Black Current – firstly 
there is no HDMI port, 
which means that even 
though this could make 
a good HTPC, it lacks the 
most essential connectiv-

ity option. Next is the lack of an expan-
sion slot for a graphics card for those of 
you who would want to play some games 
on their HTPC. For a person who does not 
want to go through building an HTPC 
this would be ideal, but for a gamer who 
wants to play on a 42 inch LCD, this PC is 
lacking in the (3D) graphics department. 

Specifications: 
Processor: Intel Core 2 Duo E7400 @ 2.8 GHz, 
Cache: 3 MB, FSB: 1066 MHz, Chipset: Nvidia 
610i, Memory: 2 GB DDR2 800 MHz, Hard Disk 
Drive: WD 320 GB Caviar Blue

Ratings 
Features: 7 
Performance: 7 
Build quality: 7 
Value for money: 8.5 
Overall: 7.5 
 
Contact: Panache Infotech Pvt. Ltd. 
Phone: +91-93200 22012 
Email: info@panache.co.in 
Web site: www.panache.co.in 
Price: Rs. 16,500

Panache Black Current
Compact and Affordable

Even though this is an mATX board, 
it has all the features of a full-sized 
ATX board. The GENE also supports 

either 2-way SLi or CrossFire as it has two 
PCIe x16 slots. These slots are separated 
by a single PCIe x1 slot. A very notice-
able feature in that the DIMM slots hold 
the memory in place by a single clamp 
instead of the traditional clamp on both 
ends of the slot. This makes for a very 
intelligent design for when you need 
to remove a memory stick, you do not 
need to remove the graphics card that is 
usually present and blocks the removal 
of the RAM stick. The overall layout is 
good, the heatpipes are sturdy,  the SATA 
connectors are facing outwards so that 
the wires aren’t cramped for space.  

ASUS has also provided an LCD poster 
along with this motherboard. When there 
is an error or problem, the board detects 
this and displays the errors during POST. 
Very useful for quick diagnostics when 
problems occur. 

The first option that you see in the BIOS 
is the Extreme Tweaker which has many 
controls that can be used to overclock your 
processor, memory, etc. There are LED indica-

tors on the motherboard itself 
that change colour to warn you 
against overvolting. This moth-
erboard also lets you overclock 
on the fly via Tweakit.

We tested this mother-
board with the Intel Core i7 
965, 3 GB of Kingston Hyper X 
memory running at 1,333 MHz 
and an ASUS ENGTX285 TOP. 
The GENE performed equally 
well compared to the other 
X58 boards we have reviewed. 
Game benchmarks also gave 
some great scores from games 
such as Doom 3 and Prey. A 4 GB file transfer 
test took a total of 69 seconds while video 
encoding a 100 MB file through the DivX 
converter took 79.3 seconds.

Priced at Rs. 16,750, this board is best 
suited for gamers who want to save space 
or attend many LAN parties as the small 
size will be a bonus. 

Specifications: 
CPU Socket: LGA 1366, Chipset: Intel X58 / 
ICH10R, Audio: SupremeFX X-Fi onboard 8 -
Channel High Definition Audio CODEC 

Ratings
Features: 8 
Performance: 8 
Build quality: 8 
Value for money: 7 
Overall: 7.5 
 
Contact: ASUS Technology Pvt. Ltd.
Phone:  +91-22-67668800 / 1-800-2090365
Email: media_india@asus.com
Web site: www.asus.in 
Price: Rs. 16,750

ASUS Rampage II Gene
Honey I Shrunk My Rampage
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Nokia E75 - the new business 
phone now available

Megalodon is a 7.1 Surround 
Sound Gaming Headset soon 
to be released by Razer

The Pixon is simple with its 
completely black look. It has a 3.2-
inch full touch screen and is just a 

few mm thicker than the iPhone with a 
width of 13.8 mm. The Pixon gives more 
of an overall phone feel rather than the 
delicate feel that you would expect with 
an iPhone. 

There are three buttons below the 
screen – Call Accept, Back and Call Reject. 
None of these buttons have backlight on 
them, so you would need to get used to 
them while using the phone in the dark. 
The stylus for this phone is supplied 
separately and has to be attached to the 
phone as an accessory. The same is the 
case with the Samsung Omnia. 

On tapping an option that looks like 
a mirror from the quick access menu, 
the small second camera that is on the 
front of the phone becomes activated and 
you see yourself. Keeping this option as a 
mirror is quite innovative. While scroll-
ing through the menus in this phone, 
we came to the conclusion that though 
Samsung has tried to mimic the scrolling 
of an iPhone, it has not yet achieved it as 
the effect is not that accurate.

There are three ways to enter text 
with this phone while sending an sms or 
entering anything in general. The first 
mode is the alpha-numeric keypad that 
will be displayed if your phone is upright, 
if you turn it horizontal, you get a full 

QWERTY keypad. The third way to input 
text is by handwriting, but it just fails 
when it comes to that feature. 

Overall, the main attractive feature 
on this phone is the 8 MP camera. But 
this phone does have a quite a few flaws 
and paying Rs. 28,750 for it is just not a 
good option. For around the same price, 
you can opt for the symbian platform 
N96, but if you want a full touch inter-
face then you should go for the iPhone 
even though it has a poor camera. 

Specifications: 
Battery: 1000mAh, Design: Bar, Screen: 3.2”, 
262K Color TFT Screen, Memory: 200 MB 
internal, Dimensions: 107.9 x 54.6 x 13.8 mm, 
Weight: 122 gm

Ratings
Features: 7.5 
Performance: 7 
Build quality: 8 
Value for money: 7.5 
Overall: 7.5 
 
Contact: Samsung India Electronics Pvt Ltd  
Phone: 011 - 41511234  
E-mail: sarfaraz.b@samsung.com 
Web site: in.samsungmobile.com 
Price: Rs. 28,750

Samsung Pixon
Good Camera, Not So Good Phone

The Iomega eGo is a portable drive 
with a capacity of 250 GB, and we 
just had to see how well this drive 

performs.
When it comes to performance this 

drive didn’t do that badly and almost 
matched up to the April’s Best Buy WD 
MyPassport Studio, which was also 250 
GB. The eGo slightly outperformed the 
WD drive when it came to synthetic 
benchmarks that we ran on it – SiSoft 
Sandra and HD Tach (8 MB and 32 MB 
zones). But when it came to real world 
file transfer tests it fell slightly short. 
The eGo did do well in the read and write 
transfer tests but it clearly fell short 
when we tried to load a 1 GB image in 
Photoshop (140.8 seconds). This was the 
only bad point with this drive as it was 
the slowest from all the drives that were 
there in last month’s test.

The iomega eGo is really a good drive 

and in our opinion if you want style and 
a design that is slightly unusual then 
there is nothing better. The performance 
almost matched up to our last month’s 
Best Buy and it only fell short in one 
test, and we would recommend this as 
great value given that the price is only 
Rs. 3,750.

Specifications: 
Dimensions (L x W x H): 134 x 89 x 19 mm, 
Interface: USB, Rotational Speed: 5400 RPM, 
Memory Cache: 8 MB

Ratings
Features: 7 
Performance: 8 
Build quality: 7.5 
Value for money: 8 
Overall: 7.5 
 
Contact: iomega 
Phone: 09841022940 
E-mail: baskaran@iomega.com 
Web site: www.iomega.com 
Price: Rs. 3,750

Iomega eGo 250 GB
Don’t Drink and Drive
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ASUS launches Bamboo 
Notebook in India

The first thing we noticed about this 
cabinet is that it is huge, being even 
wider than the CM Stacker RC-810. 

This is due to the protruding side panels of 
this chassis. There is a large knob present 
on the front top of the cabinet which is 
used to control the speed of the cabinet 
fans, a really useful feature. Inset within 
this knob is the button for controlling the 
LED lights, another useful feature for those 
who get too irritated with these lights. This 
feature is also great while downloading 
things at night, just switch off all the LED 
lights of the fans and go to sleep instead of 
having a completely lit room. Along with 
these are a nice big Power button and a 
small, hard to press, Reset button, four USB 
ports, one e-SATA and one FireWire port as 
well as two 3.5 mm audio connectors. The 
cabinet is raised above the ground with 
stands that can be rotated. 

Cooler Master has really gone screwless 
with the Sniper as you don’t need screws 
to attach hard drives, optical drives or even 
cards into the expansion slots, each of 
these locking in a different way. With the 
optical drives, there is just a button push to 
lock it into place, with the hard drives you 
can just slide them in the trays supplied 
and with expansion cards, there is a clip 
mechanism that is quite easy to use. 

The Sniper is definitely well built 

but it is not as good as the CM 
Stacker, which falls in the same 
price bracket. It would be a cabinet 
worth consideration if it had cost 
somewhere around Rs. 7,000. But 
unfortunately that’s not the case 
here with its price of Rs. 11,400 
– this is too pricey in our opinion, 
even though it does have some 
unique features. 

Specifications:
Material: Stell, ABS Plastic, Mesh 
bezel, Dimensions (D x W x H): 566.6 
x 254.6 x 551, Weight: 10.6 kg, 5.25” 
Drive Bay: 5, 3.2” Drive Bay: 5

Ratings
Features: 7.5 
Build quality: 7.5 
Value for money: 7 
Overall: 7 
 
Contact: Cooler Master India 
Phone: 9833870302 
E-mail: Tanmay_L@Coolermaster.com 
Web site: www.coolermaster.com 
Price: Rs. 11,400 

CM Storm Sniper
The Assassin That Cannot Hide

The 600W Real Watts power supply unit 
falls under Zebronics Pro Series range 
which consists of power supplies 

ranging from 350W to 850W. 
This is not a modular power supply and 

only the 24-pin motherboard cable has a 
sleeve on it. There is a 6-pin PCIe connector 
as well as an 8-pin PCIe connector, which 

means this PSU is able to handle 
some high-end GPUs. Some cards 
such as the GTX 280 or even some 
of the newly launched GTS 250s 
require 8-pin PCIe connectors 
and that’s where the 8-pin PCIe 
connector will come in handy. 
This power supply does not have 
enough cables to support SLI or 
CrossFire of high-end GPUs, but 
it would suit if you want to SLI 
low end cards.  

This power supply has a triple 
+12V rail rated at 24A each. The 
manufacturer specified total 
outcome is 575W of the triple 
12V rails.

We setup an Intel QX9650 @ 3.0 Ghz, 
4 GB DDR2 memory running at 1066 MHz, 
an Nvidia 8800 GTX to test the stability of 
this power supply. We observed that the 
3.3V rail was providing 3.29V and the 12V 
rail was providing 12.23V. Also the fan was 
running pretty quietly. 

With a price tag of Rs. 3,850, this 

power supply is slightly overpriced but will 
still suit a basic gamer who would want a 
decent PSU, without spending too much 
money. A person who uses the computer 
just for basic tasks need not invest in this 
power supply.

Specifications:
1x 24-pin ATX cable, 4x SATA connectors, 4x 4-
pin Molex connectors, 1x 12V 8-pin connector, 
1x 4-pin floppy connector, 1x 6-pin PCIe con-
nector, 1x 8-pin PCIe connector.

Ratings
Features: 7 
Performance: 7 
Build quality: 7.5 
Value for money: 6.5 
Overall: 7 
 
Contact: Top Notch Infotronix India Pvt Ltd 
Phone: +91-44-4393 6000 to 99 
Email:enquiry@zebronics.info 
Web site: www.zebronics.com 
Price: Rs. 3,850

Zebronics RealWatts PRO-600
Just the right amount of power
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Kingston DDR3 HyperX memory 
now available for SO-DIMMs of 
notebook PCs 

Buffalo has launched a new portable 
DVD drive that consumes only 7.5 W 

Monochrome laser printers are 
really good for office use and espe-
cially SoHos, but they are equally 

good for home users, as they deliver quick 
prints and are also very cost effective 
compared to ink-jets. One such mono-
chrome laser printer is the Canon LBP 
3370, aimed at the home user. 
The exterior of this printer is boring, as 
it is looks like a box with a white and 
grey exterior. There are two ways to load 
the paper, one through the bottom tray 
while the other through an opening front 
tray. There is an indicator on the bottom 
tray which gives you the approximate 
measure of the paper present in the tray. 
This feature is very helpful at times so you 
know when to refill the paper. On the rear 
of this printer, the USB port is located, 
together with the Ethernet port for print-
ing over the network.

The paper comes out on top and the 
controls for this printer are located next 
to the tray on the right. There is also 
a single line backlight display which 
has a slight tilt forward for easier read-
ing. Other buttons include: Utility, Job, 
Settings, Reset, Feed Selection, Cancel Job 
and Online. Within these menus we found 
a few interesting options like Toner Saver 

mode, Power Saver mode 
and even 2-Sided print, 
which can work out to be 
beneficial in the long run.

Since this was a mono-
chrome laser printer we 
decided only to check the 
time taken to print text 
documents, and it did 
extremely well. It took only 
7.6 seconds to print a single 
text document; very fast. 
Quality wise it wasn’t as crisp as it could 
have been and the detail of the text just 
seemed a bit off, but it is still acceptable 
with these speeds. Next we printed 15 
pages and it took a total of 57.5 seconds 
which is really fast.

The Canon LBP 3370 is definitely fast 
and the outcome of the prints are very 
good. This printer would go well for home 
use, but we say it would go equally well 
for office use, especially with its network 
connectivity options. Priced at Rs. 29,995 
it would be a great buy for any business 
or home.

Specifications: 
Dimensions (W x D x H): 399.7 mm x 378.6 
mm x 267 mm, Weight: Approx. 12.2kg, 

Memory: 64 MB, Print Resolution: Upto 600 
x 600 dpi

Ratings
Features: 8 
Performance: 8 
Build quality: 7 
Value for money: 7 
Overall: 7.5 

Contact: Canon India Private Limited 
Phone: 1800-180-33-66 
E-mail: info@canon.co.in 
Web site: www.canon.co.in 
Price: Rs. 29,995 

HCL has introduced a new laptop, 
or ‘leaptop’ as it calls it, to its 
range of laptops. The HCL Leaptop 

is certainly good looking, but how well it 
performs we are about to find out. 

It has a nice piano-black finish with 
some curvy and circular print designs on 
the back of the lid, as well as the wrist rest. 
HCL is not the only brand to be sporting 
such a design, as lately many prominent 
brands have adopted similar designs on 
their laptops to increase the style factor. 
This laptop has a 14.1” display and is 
heavy, 2.4 kg with the battery. On opening 
this laptop you will notice that the screen 
used is highly reflective.  The keyboard 
is a standard QWERTY keyboard which 
starts to get cramped towards the end as 
you notice the slightly squished arrow 
keys. The surface of the trackpad is really 
smooth and we didn’t think it would be 
as accurate during usage, as that is the 
case with most smooth trackpads. But HCL 
proved us to be wrong in this case. 

Coming back to the screen, the viewing 
angles on this laptop are really bad, the 
screen starts washing out from a slight tilt 
in any direction. The optical drive present 

causes the laptop as well as the table it is 
on to vibrate when you load a disk into it, 
which is a no-no for us. 

This sample we received came 
with 1 GB DDR2 RAM and Windows 
Vista OS – these are the basic require-
ments for that OS, but we still feel 
that you should have 2 GB of memory 
instead.

Specifications: 
Processor: Intel T5800 Core 2 Duo @ 2.0 
GHz, Operating System: Windows Vista, 
Graphics: Intel GMA 4500 Graphics with 
shared system memory/.

Ratings
Features: 6 
Performance: 5 
Build quality: 6.5 
Value for money: 6 
Overall: 6 
 
Contact: HCL Infosystems Ltd 
Phone: SMS leaptops to 56161 
E-mail: infiniti@hcl.in 
Web site: www.hclstore.in 
Price: Rs. 39,990

Canon LBP 3370
A box that prints

HCL Leaptop Series 39
Just a Design
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New Quadro FX5800 from Nvidia 
has 240 parallel CUDA processing 
cores, 4 GB high speed shader RAM 
and cost around $3300

Thermaltake is known for making 
expensive high-end cabinets intended 
for the gaming audience and has a 

series called the Armor series of cabinets. 
One of the recent additions to this line is 
the Armor+ MX, a slightly cheaper cabinet, 
which is a mid tower cabinet with some 
unique features to offer gaming enthusiasts.

One eSATA, two USB, a microphone 
and headphones port and the power and 
reset buttons are located on the top of 
the cabinet, towards the front. The reset 
button is tiny and difficult to push in 
comparison to the power button.

There is a unique mechanism to open 
the side panel, first the two thumb screws 
behind and then there are two clips that 
you need to slide forward to open. The 
panel just snaps into place on closing and 
is simple and easy to use. The design is well 
considered and the good thing about these 
clips is that you don’t even need to bother 
with the thumb screws.

The interiors are neatly setup. The PSU, 
which needs to be mounted on top, has its 
own support beam. This beam can also be 
removed for the convenience of setting 
up your PC and cable management. The 
hard drive bays have their own trays and 
the entire cage can also be removed. The 

drives bays give you easy loading and 
you don’t even require to use screws 
when installing hard drives or even 
optical drives. Along with screwless 
drive bays there are also screwless PCI 
slots, which really are great and save 
you considerablt time and effort. 

This cabinet has a total of three 
fans, one 120 mm for intake, one 120 
mm for exhaust and a 230 mm side 
intake fan. We feel that the inclusion 
of a top or bottom fan would have been 
a bonus for this cabinet. This cabinet is 
a bit pricey at Rs. 7,000 and you might 
be better off going for something else 
such as the CM 690.

Specifications: 
Dimensions: 21.1 x 9.4 x 19.3 inch (H x W 
x D), Front Door Material: Aluminium / 
Chassis: 0.8 mm SECC, Motherboards sup-
ported: Micro ATX, Standard ATX

Ratings
Features: 7.5 
Performance: 7 
Build quality: 6 
Value for money: 6 
Overall: 6.5 
 

Contact:  Tirupati Enterprises 
Phone: +91-93392 07519 
Email: mail@tirupati.net 
Web site: www.tirupati.net 
Price: Rs. 7,000

Thermaltake MK+ Armor
A Mightly Shield

Anyone working in a professional 
computer graphics development 
environment will tell you the impor-

tance of accurate colours. This is a problem 
often ignored. To get these perfect colours 
on a PC monitor or TV, you need to cali-
brate it. That’s where the Spyder 3 Elite 
comes in. It’s the top-of-the-line calibrating 
unit for displays and projectors. It’s some-
thing we used thoroughly through the LCD 
and Plasma TV test a few months back for 
both testing and to give the screens an even 
playing ground.

The package comes with the main 
calibrating unit, a stand and the soft-
ware required to operate it. The hard-
ware connects through a USB connector. 
A balance weight is attached so you can 
easily hang the device on your screen if 
you don’t use the suction cups that come 
with it. For LCDs with delicate surfaces, 
suspending the device this way is required. 
The hardware also has a small sensor 
facing the front of the device to measure 
the ambient light.

Once the software is installed, the 
device is detected easily. The software 
works by displaying a set of colours on 
screen which are detected by the hardware 
sensor. You are first required to check 

boxes in the software to tell it all the 
controls available for your TV or monitor 
– RGB values, colour temperatures, etc. 
Once this is done, you make changes to 
the values for as the software requests. 
Eventually, Spyder 3 makes changes to the 
colour profile on your system that calibrate 
your screen and gets you as close as possi-
ble to the optimum colours.

We really liked the results that the 
Spyder 3 Elite and it’s something that lets 
you get multiple screens to look very alike 
each other. That’s something very impor-
tant in professional work places and it’s 
highly recommended that you get one for 
your studio. It’s also very good to calibrate 
your PC monitors and televisions. 

The cost for the Spyder3 Elite is Rs. 
20,800 which is somewhat on the high-side 
given the software limitations.

Specifications:
USB connectivity, Dimensions: 1.5 x 3.5 x 4.0-
inches
Requirements: Windows XP, Windows Vista, 
Mac OS X (10.3 and higher), 100 MB free space

Ratings
Features: 7
Performance: 8

Build quality: 7
Value for money: 6
Overall: 7

Contact: Eesh Dewan
Phone:  +91-11-4153 9116
Email: info@bhushanphoto.com
Web site: www.bhushanphoto.com
Price: Rs. 20,800

Datacolor Spyder3 Elite
Colour perfect



Buffalo has launched a new series for 
NAS solutions =  High Performance 
Reliable NAS TeraStation III (2TB) series

ASUS now offers burnt warranty on 
the P5KPL-AM/PS motherboard to 
actually boast about the Anti-Surge 
technology present

TRIED & TESTED

For home users who do use ADSL 
modems and want something differ-
ent, then the D-Link GLB-802C comes 

into the picture and for small offices this 
router offers a whole range of options and 
features, so let’s take a look at them..

The GLB-802C continues with the usual 
D-Link design that is used for its routers 
and has not gone with anything different. 
The front displays LED light status indica-
tors, while the rear has connections for 
LAN, USB, RJ11 ADSL port, power button 
and a small reset button. A telephone line 
splitter is also provided with this ADSL 
router. With this splitter you can use the 
phone and the internet at the same time.

The Home menu gives you an over-
view of your connection where you can 
also change your IP if needed. Under LAN 
settings an interesting option is for you to 
use the device as a DHCP server. IP routing 
is also possible through the Routing option. 
Dynamic Domain Name System (DDNS) is a 
feature present with this router which 
automatically configures your dynamic IP 
with your domain. A great feature for 
those who don’t have a static IP. There is 
also an IP filter present which can be easily 
configured by just adding the IP to the list. 

Other options with this router include: 
NAT, RIP, DNS, UpnP and SNTP. 

For a basic router this does have a lot 
of options, but you really don’t need all of 
them. This router will mainly be used by 
those who are not happy with the one they 
were provided by their ISP. This router is 
also aimed at SoHos and has all the features 
required to establish a secure connection 
for a SoHo. Priced at Rs. 1,600, with all the 
options it offers, this router would be great 
for home or small office use. 

Specifications: 
Dimensions (L x W xH): 142 x 108 x 32 mm, 
Weight: 198 gm
 

Ratings
Features: 7.5 
Performance: 7 
Build quality: 7.5 
Value for money: 7.5 
Overall: 7.5 

Contact: D-Link 
Phone: +91-22-3061 6666 
Email: sales@dlink.co.in 
Web site: www.dlink.co.in 
Price: Rs. 1,600

If your work involves travelling to differ-
ent locations and scanning pages, then 
you probably need a portable scanner. 

The Plustek OpticSlim M12 Plus is a slim 
and light scanner that can easily fit into 
any laptop bag. Although compact and 
light, the performance is something we 
still need to judge...

The scanner looks like a rod of some sort 
with buttons on it. The grey and dark blue 
body give it a professional look. The attach-
ments that come along with this scanner are 
a wall mount and a holding dock. We really 
don’t know why they provided a wall mount 
since this is meant to be a travel scanner. 
There are only two buttons on the scanner 
- Scan and Custom. The USB connection is 
located on one end of the scanner. By the 
by, this device does not run on any external 
power source, it is powered by through the 
USB cable. The OCR and BCR are part of the 
bundled software and are easy to set and use. 
You just have to select the function you want 
to use and hit the scan or custom button 
accordingly.

This scanner is a single feed scanner 
where you have to initially give a slight push 
to the paper until the scanner’s motor takes 
over and pulls the paper in. It takes a little 
more than half a minute to scan an A4 size 
colour page at 200 dpi, which is slightly slow 

in comparison to the other Plustek scanner 
we tested. But considering how portable 
this scanner really is, it is acceptable. Some 
amount of banding was noticed in the colour 
scan which would make the quality just 
above average. In greyscale, the time taken to 
scan was reduced to under half a minute and 
the quality was also better. We also tested 
the scanning at 600 dpi of a colour page and 
found that the output was almost spot on 
and we were quite impressed, ignoring the 
time taken; more than two minutes. 

This scanner is definitely not the fastest 
scanner around but you have to consider the 
fact that it is very portable. Since it also comes 
with its own cloth casing, it is great for mobile 
scanning, but a price tag of Rs. 7,500 just does 
not justify all that it offers. If you need some-
thing for the office then this is not for you.

Specifications: 
Interface: USB 1.1, Dimensions (D x W x H): 
47 x 274 x 33.8 mm, Weight: Approx. 330 g, 
Resolution: Hardware optical 600 dpi 

Ratings
Features: 7 
Performance: 7 
Build quality: 7 
Value for money: 4 
Overall: 6 

Plustek OpticSlim M12 Plus
Slim is in

D-Link GLB-802C
As basic as it gets
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Contact: Fujisan Technologies Ltd 
Phone: +919987567015 / +919987567008 
E-mail: sales@fujisan.co.in 
Web site: www.fujisan.co.in
Price: Rs. 7,500
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Stellarium
Rossi Fernandes

Astronomy is a hobby that really requires you to go out and 
observe the night sky but there are programs made to ease 
understanding and learning. If astronomy interests you, 
then one program that will let you browse through the infin-

ity of space without having to go outdoors is Stellarium. It’s free, 
open-source and available for download from www.stellarium.org.

In this article, we’ll be looking at how to use Stellarium and we’ll 
also take a panoramic photo of our surroundings and then use it in 
the application itself. Why so? This lets you use the surroundings you 
are in and get the exact location of the planets, nebulas, stars and 
other objects in the sky. It makes pinpointing objects in the sky much 
simpler and is informs you in advance when and where a planet or 
star will appear along your actual horizon. 

A look at the interface and how to use it
Stellarium’s interface is extremely simple and it runs mostly as a 
full-screen application. The software shows you a perspective view 
of the sky standing from a point on the Earth. You can change this 
point of view whenever you wish.

There are two main toolbars on the left bottom of the screen. 
The horizontal one contains all the toggling for the elements in 
the scene. This basically allows you to hide away the trees and the 
ground or turn on the constellations and the artwork. You can even 
turn off the atmosphere.

The toolbar on the left contains the application controls. Here, 
the current time and location from where you are viewing the sky 
can be set. The search function is also available to find a particular 
object in the sky.

Navigating through space is simple. Use the arrow keys 
to look around. Think of yourself looking up, down and side-
ways. To zoom in, use the Page Up and Page Down keys. You 
can also use the mouse-scroll.  Left-click to select an object 
and to view information on it which is displayed on the left 
top. To hide the information, right-click.

Setting time and starting real-time
In Stellarium, just like in real-life, the skies can only be 
viewed at night. The only way to see the skies during the 
daytime is to turn off the environment. This can be done by 
clicking the Atmosphere button on the horizontal toolbar on 
the bottom of the screen. 

What is a panorama and why do we need one?
A panorama is basically a single image that you could wrap 
around virtually so as to give you the freedom to look all 
around you. A panorama is great because you can use it to 
relate to different points in the sky. For example, you can 
be looking up to the sky and can expect a star to rise from 
behind a building in your vicinity well in advance. To look for 
that same star otherwise would be a more confusing task.

How to shoot a panorama?
Shooting a panorama shot is the difficult part of creat-
ing a panorama, at least in comparison to the stitching of 
the images. In short, a whole sequence of photos needs to 
be shot of the area you plan on using as a panorama. The 
photos have to be taken in the open. This sequence of photos 
must cover the entire area of which you wish to create a 
panorama. Start from a position at eye level and keeping 

the zoom to a minimum, start clicking photos while keep-
ing in mind the area covered in the viewport. Next, move 
to the adjacent section of the view and click another photo. 
Continue doing this for all the photos in a row and shoot 
multiple rows till  you have covered the entire 360 degrees, 
including the area above you. 

While taking the photos, try not to change any of the settings 
on the camera. This ensures that there will be no big changes in the 
colours, brightness and contrast of the images. If you have a camera 
with manual settings, switch to that mode and set a comfortable 
setting for the ISO, aperture, shutter speed and megapixels. Use 
settings such that the scene is well illuminated and the shutter speed 
is kept reasonably fast so as to avoid any blurring.

You should also do this exercise really quickly so you 
don’t have a big difference in lighting. If you start in the 
morning and end in the evening, there’s a big chance that 
one side of your panorama is going to be dull or grainy. Be 
prepared with a charged set of batteries and a large memory 
card as well.  As the end result is going to be a large image, 
it’s alright to turn down the sensor resolution to something 
small, such as 1600 x 1200.

Stitching it up
The panorama sequence of shots cannot be used separately 
but they have to be merged together into one. This can be 
done with a couple of programs. Using Adobe’s Photoshop 
CS3 is one of the simpler ways of getting a panorama shot 
done. Firstly, dump the sequence of images into one folder 
on your hard drive.  

Start Photoshop, then go to File > Automate > Photomerge. 
Set the layout as Auto and select the files or folder that has the 
images. Click OK when done. (See figure 1). Photoshop will then show 
you a preview of the panorama. (See figure 2) Photoshop will then 
load the images, align them and merge them into a single file. Save 
the image when you’re done. 

Editing the panorama image
Now that the panorama is created, we need to clear out the 
sky so that the skies can be viewed. Double click on the only 
layer that exists - the background and make it a layer. Now, 
use the Eraser Tool and then erase the area above the hori-
zon. To be even neater, use the line tool from the toolbar on 
the left. Draw a line and make as many nodes as required. 

Setting the current date and time

toolbox
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SETI@Home can compute 
528 TeraFLOPS; the world’s 
fastest supercomputer can 
do 596 TeraFLOPs



The Hubble tele-
scope's 19th birthday 
was celebrated on 
the 24th of April 09

Complete the loop to make a shape. Then, right-click on the 
drawn path and click on Make Selection.

Once the image has been modified, it needs to be exported into 
the PNG image format. Click on File > Save As. Choose the format as 
PNG, give the file a name and save it. If you feel the output image 
is too large, you can also resize it down to something smaller. 
Remember the name of the file as you will require it to make the 
landscape.ini configuration file.

Making the configuration file for the panorama
All the information that is to be used by Stellarium along 
with the panorama image is stored in a small text file called 
landscape.ini. The file is read by Stellarium when you select 
a landscape. This file is kept in the same folder as the 
panorama image. Use Notepad and create a file by the name 
of landscape.ini in the same folder as the panorama image.

A sample landscape file needs to contain the name for the land-
scape, the description, the image location itself and the altitude.

For example, we created a file called landscape.ini 
with these lines in it
[landscape]
name = Test panorama
author = Digit
description = Panorama test
type = spherical
maptex = panorama.png

This configuration should be fine if you shot all your photos 
starting from the east. If you haven’t, then you have to rotate the 
landscape. First take a distinct point on the image that points out 
to the North (0 degrees). If required, draw a small mark on it on 
Photoshop. Looking at the entire panorama, judge how much to the 
left from the left of the image it is. 

A simple formula is to be used : 270 + b - (360 * x / X)
x is the distance in pixels between the left of the image to 
the spot you’ve chosen and X is to the horizontal length 
of the entire image. Use Photoshop or any image editor to 
measure the distance in pixels. b is to be the heading you’ve 
chosen for the point. So if the spot, you’ve chosen is to be 
the North, then b will  be 0. 

The result of this formula will be the degrees. Add the value to 
a line in the same text file

angle_rotatez = ____.

Inserting a panorama in Stellarium
Installing downloaded panoramas into Stellarium is simple. Unzip 
the zip file into the \Stellarium\Panoramas folder. Restart 
Stellarium and then use the vertical toolbar and click on the Sky and 
Viewing Options window. Click on Landscape and then choose the 
panorama you just installed. 

In our case, we will  simply copy the folder we created for 
the panorama into the Panoramas folder.

Packing up the panaroma 
With the panaroma ready to go, you can upload it to the 
Stellarium’s Wiki. Create a thumbnail to put up on the page 
with the dimensions 200x114. Pack the files up into a ZIP 
folder with the folder, the image and the landscape.ini file 
in it.  Also, it’s a nice idea to include a README.TXT file which 
contains information about the landscape.

Once the panaroma is ready, you can upload it to the Wiki 
located at http://www.stellarium.org/wiki/index.php/ Landscapes. 
There are landscapes created by other users there for you to 
download and try out .

rossi.fernandes@thinkdigit.com

Figure 1: Adding the files and folders to the panorama

Choosing from a list of landscapes

Figure 2: The rough mockup of the panorama in Photoshop

Clearing out the sky with the eraser and selection tool
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The Voyager spacecraft that 
was launched in 1977 is still 
travelling at 17 kilometers 
per second

Google Earth also 
has mapped the 
skies and terrain of 
the planet Mars
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Image and file hosting sites are aplenty. We present exciting ways to 
share your holiday memories with your nearest and dearest...

share images
Exciting and interesting

ways to

Nash David

S
ummer is just around the 
corner, and so along come holi-
days. You’ve probably planned 
of going on an exotic vaca-

tion. When you return, most of your 
friends, relatives and colleagues will 
want to know all about it. That’s an 
exhilarating moment by itself — wait-
ing to tell how that adventurous trek 
uphill amidst slippery steps really 
was, or how the chilling breeze felt! 
With the internet and MMS services 
well within reach, you don’t really 
need to wait that long. In fact, you 
can start sharing instantly, whether 
you’re holidaying in India or Indiana. 
When it comes to image sharing, in 
addition to the familiar names, there 
are many other options. 

Flickr
A Yahoo! entity, Flickr is a popular 
image sharing service. The site is 
simple in its design, but don’t ignore 
its potential. It offers a wide range of 
services. You can upload either by using 
its standalone software, or uploader, 
which is available for the PC as well as 
Mac. Further, you can also use the web 

interface at Flickr.com/upload. Finally, 
you can directly upload the photos you 
capture using your camera phone via 
WAP. To do this, simply visit Flickr’s WAP 
site at m.flickr.com. After you login, you 
will be prompted either to select a photo 
from a folder on your phone or turn your 
camera on to capture while on the go. No 
longer is this restricted to sci-fi movies. 
It’s as simple and practical as it gets. 

After you are done uploading, you get 
to decide whether to keep your photos 
private or allow them public access.

Another useful feature in Flickr 
is the ability to upload your photos 
via email. To do this, simply email 
your photos to a unique email address 
assigned to you. Any image that you 
send as an attachment to this address 
is uploaded to your flickr album. After 
you uploaded your photos, you can edit 
them using Picnik’s online photo editing 
tools from within your Flickr account. 

Picasa
What Flickr is to Yahoo!, Picasa is, more 
or less, to Google. Once again, as is the 
case with all Google services, sign in 
with your Google id and you are ready 

with the usual pattern — upload, store and 
share! 

Again, with Picasa, you have an option 
between offline installation software, or 
a web interface to upload your albums. In 
fact, if you have a Gmail id, take a closer 
look towards at the top left of your Inbox. 
There is a whole list of services there. Click 
on Photos and you will be redirected to 
Picasa’s web interface. 

Another good point about Picasa is that 
if you are a blogger, especially with Google’s 

With a user friendly interface, uploading photos 
is very easy with Flickr
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Tagging
On Flickr, you can sort images by the 
camera used. This also lets you judge 
the camera and its following for 
yourself. For more, read our dSLR and 
Camcorder tests this month.
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With the acquisition of Konika-Minolta's cam-
era business, Sony has marked its entry into 
the dSLR segment.

free blogging platform 
Blogger.com, any picture 
you upload on Picasa is 
available on your blog and 
vice-versa. Unfortunately, 
Picasa doesn’t let you 
upload pictures from 
your camera phone. You 
can only browse images 
you have already uploaded 
from a PC. To do this, go 
to picasaweb.google.com/
m. But then, that’s Google 
— the intenetion is a one-
stop shop for all possible 
services, isn’t it?

zeec.net
Although we haven’t heard much about 
the site, zeec turns out to be really fast in 
the whole uploading and sharing process. 
In addition to a standard web upload, you 
can also upload pictures directly from 
your handycam. Zeec is compatible with 
Wordpress blogs. You can also use Zeec’s 
mobile feature. However, at this point 
in time only Nokia blogs are supported. 
While the site talks of a URL for GPRS 
users (zeec.mobi), it didn’t work when we 
tried testing it. Maybe sometime in the 
future this feature will be added. So, it is 
best to wait and watch.

Snapfish.in 
Sharing your images online just makes 
everything so easy. But thinking it over 
it, your loved ones back in the village, 
or for that matter a colleague sent off to 
some remote location? Are they going to go 
online to check your photos? Probably not. 
We guess there’s still some time left for that 
to develop in our country — which is why, at 
times, we prefer print copies to forwarded 

URLs. Snapfish (powered by HP) has a solu-
tion to this. It charges Rs. 2.95 for high qual-
ity photo prints. Not that these are the only 
sites that provide such a service, but believe 
it or not, Snapfish happens to be the only 
site of brand value, credibility and reputa-
tion to offer you such a service in India and 
charge you in Indian rupees. And best of all, 
your first 10 prints are free.

It charges around Rs. 40 to 50 for logis-
tics depending on the number of prints 
you order, and guarantees three days for 

Mumbai and Goa and four days for the rest 
of India.

In addition, you can have your pictures 
on notebooks, mouse pads, coffee mugs, 
t-shirts and more and have them delivered 
to your doorstep — all ordered from the 
comfort of your living room.

Photobucket 
This site has become popular with the 
advent of online social networking. 
Photobucket lets you share your images 
on most social networking sites such as 
Facebook and Myspace in addition to 
Blogger and Livejournal.

Photo sharing online is a vast play-
ground and by no certain means can 
we list all the options you have. The 
reason for selecting the sites we have 
mentioned here is their user-friend-
liness. Rather than having complex 
menus, these sites are more or less self 
explanatory and you should be able to 
manage your way through effortlessly. 
Also, depending on how urgently you 

want to share the images, 
you might prefer one site 
over the other. So while a 
GPRS user would probably 
prefer Flickr over Picasa; a 
Gmail user may go the other 
way. Also, those addicted to 
Facebook (it is considered 
by many a clinical condi-
tion, after all) would opt for 
Photobucket.

An additional feature 
with image sharing sites 
is the public feature. You 
get to see really funny and 
amusing images of the 

darndest things that some people do! 
Nevertheless, freedom given to users 
can get out of control. Therefore, self 
monitoring is very important. Despite 
precautionary measures taken by most 
web sites, provocative and offensive 
images do find their way to such sites 
in the public domain. As a word of 
caution, we recommend to keep your 
private moments within the private 
domain and not make them public. n

nash.david@thinkdigit.com

TOOLBOX



DIGIT MAY 200982

T
O

O
LB

O
X

workshop

Become the audience
Rossi Fernandes

L
CD and plasma TVs sales have seen a phenomenal increase 
recently, and this should continue with falling prices. Most 
users don’t have a clue about high definition and the ones 
who do cannot access it. HD broadcasts today are almost 

non-existent in India and the distribution of Blu-ray discs is still in 
its infancy. In the past issues of Digit, we’ve shown you how to build 
an HTPC and why it’s so useful.

Just setting up a compact PC and running an OS doesn’t make 
an HTPC and doesn’t bring out the fun either. What helps is install-
ing HTPC software that makes the operation of the PC completely 
hassle-free and tunes everything to the very bare basics. A Windows 
Media Center Remote or a wireless keyboard is all that you need. 
There is no shortage of good HTPC front-end programs and they’re 
available for every operating system you can imagine. Of the avail-
able options, we like XBMC this is a widely talked about program, 
and for good reason. 

XBMC is free, open-source, and can be downloaded from www.
xbmc.org. The last stable release was version 8.10 and a new alpha 
release 9.04 Alpha has just been produced. XBMC is also available 
for the Xbox, Apple TV and also a LiveCD for the PC.

We like the idea of HTPC systems and software for several 
reasons. They let you view your TV from a distance and operate 
all the media functions using a single input device. Your entire 
database of media can be easily accessed from either a server on 
the network, a NAS, a camera or even directly streamed over the 
internet. While the same can be done using any operating system, 
software such as XBMC make it so much simpler and do it in a 
very interactive and colourful manner. XBMC can handle most file 
formats. We’re going to look through some of XBMC’s features and 
help you set things up. We’ll also briefly look through some of the 
less popular HTPC front-ends.

The system requirements for XBMC aren’t too high either, but 
a decent graphics solution is always recommended for the smooth 
transition effects and interface animations. Installation of XBMC 
is quick and easy. 

The entire program is menu driven and requires minimal input 
on your part. Most of the features are automated once you set it up. 
In fact, it’s so simple that you can use a keyboard to access all func-
tions without having to ever use the mouse. You can also purchase 
a cheap media centre remote control and have it configured to keys 
you would use on your keyboard. Another way to control the HTPC is 
through a gaming controller such as the Xbox360 controller.

To further simplify it, we suggest setting up Windows in a 
manner that it automatically starts XBMC 
on bootup. To do this, we assume that there 
is a single user setup on Windows. This will 
ensure that the account automatically logs 
on if there’s no password set. Click on the 
Startup folder in the Start menu. Right-click 
on it and click Explore. Create a shortcut 
in it which points to XBMC’s executable. 
Now every time Windows boots, XBMC will 
start up so you don’t have to manually start 
XBMC from the Start menu.

Movie handling on XBMC
Movies are mainly the reason people setup 
an HTPC. Although standard DVD and DivX 
players can run most formats, there’s one 

thing they can’t do well — play HD videos. For this, even a low-end 
dual core processor with a decent amount of memory can do the 
job perfectly. Obviously a faster processor and a good graphics solu-
tion will go a long way and you won’t have to upgrade the HTPC 
any time soon. 

To watch movies on XBMC, one needs to go to the Movies 
menu. Use the arrow keys to move up and down the menus and 
press [Enter] when you reach the menu. You can also use the 
mouse to click on the menus and features. 

When you do this for the first time, your movies and video 
collection need to be imported. You can set multiple locations as 
the source for the videos and this includes network connections. 
This is useful when you have two or more PCs at home. You can 
share a folder on another PC and access the share over the network. 
To do this, go to Movies > Add Video Source. Click on Browse 
and choose the paths. Click OK when done. You can set additional 
sources in this same manner by clicking on Add and then Browse.

Setting content type for media
To set the folder you’ve added to a content type, click on Set 
Content. Click the up/down arrows and set the type of media. 
Choose between Movies, TV Shows and Music Videos. Enable the 
button for Run Automated Scan. This will enable XBMC to query 
the video information and get the appropriate information on the 
movie. For example, it’ll show you a short brief of the movie, it’s 
overall rating, fan-art, etc. We’ve chosen IMDb.com, but you can 
choose from any of the sites listed.

Getting XBMC to download covers
Having movie names as text alongside a default image name is 
boring. Similar to downloading of movie details, XBMC can also 
download movie covers. Although this might seem silly, it’s a great 
combination when used with a more advanced theme or script for 
XBMC. For a trial, set the MediaStream theme for XBMC through 
the Settings > Appearance menu. We prefer the MediaStream 
theme. Once the theme is set, go back to the Settings menu. 
Remember that the skin that you choose changes the functionality 
of the software a bit and also the menu names.

All the media that is added to XBMC can have the album covers 
downloaded for you. Typically on a PC, you need to manually 
set folders to be scanned for the album and some software even 
requires you to choose an album cover. Go to XBMC Settings > 
Music > Library. Here, choose the radio buttons for album cover 
and information to be downloaded while adding to the library. 
XBMC will scan each of the albums added automatically and down-

load the covers for you. You can also do this 
for movies and TV shows.

Using the XBMC interface (on 
MediaStream)
The XBMC interface looks good, but isn’t as 
exciting or polished as some of the inter-
faces we see on media players and gaming 
consoles. MediaStream as a theme is much 
closer to that and to some, even better than 
those. 

All the menus can be accessed by press-
ing the up and down keys and pressing 
[Enter] to access them. The submenus 
can usually be accessed by pressing the left 
and right keys. The [Tab] and [Esc] keys 

We tell you why it’s high time you installed HTPC software, sat back and truly relished 
your home theatre setup..

Mercury launches two Intel 
Motherboards - PIG43M and 
PIG41M with HDMI Support

Changing XBMC themes changes the look and some 
of the menus and features
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access additional functions such as bookmarks, aspect ratios and 
quality settings for the video playback. The backspace key takes 
control back to the previous root menu. So once you have the 
movie and music folders setup, XBMC automatically takes you 
to those folders. To add new folders or change settings, one must 
go back to the root. In every menu, the right-click button on the 
keyboard (alternate menu key on the keyboard; to the left of the 
right Ctrl key) or the right-click button on the mouse brings up 
a menu of alternate functions such as removing media from the 
database.

Using the File Manager
Almost all the media played using XBMC is done by first adding 
the source and then playing it from the respective folders. The 
file manager lets you play any file format directly from the file 
location itself. To go to the file manager, go to the main menu 
if you are using a default theme and go to File Manager. With 
MediaStream, the file manager can be accessed through Configure 
the System menu. The File Manager has two paths on either side 
and additional paths such as network paths can be added by select-
ing Add Source. A display of the system resources can also be seen 
in this menu. File operations can be performed by right-clicking 
in this menu or by using the alternate-click key on the keyboard. 
Files and folders can be deleted and renamed using this feature. 
This feature is especially useful as it removes the need for using 
Windows to make changes to the folder structure and also for 
quickly running isolated media files without having to import 
them every time to the XBMC library.

Streaming audio from the internet
The advantage of using a desktop as a media playback device for your 
TV is great because it lets you connect and access resources on the 

internet in real-time. 
Shoutcast streams are 
just an example and 
they are very much 
like any radio station 
except in this case, 
there are thousands 
of them streaming 
audio all the time. 
Think of it as a satel-
lite radio system but 
there are no subscrip-
tion rates here.

Listening to inter-
net radio stations is 
simple. Go to Listen 
to Music (if you are using the MediaStream theme) and then to Add 
Source. If this takes you to the music collection window that you 
already added, you can go back to the root folder by right-clicking 
here and clicking on Go to Root. To add the stations, click on Add 
Source and then go to Browse. Scroll down to Shoutcast and press 
Enter. The next menu you see is the entire database of genres avail-
able. Choose the Genre you want to add or press OK if you want to 
add all the genres. Click OK again.

Now from the root of the Music menu, go to Shoutcast and 
select a genre. Choose one of the many radio stations and the 
stream will start playing. The volume can be controlled by pressing 
the + and – keys.

Setting up the weather panel
XBMC has a nice little feature which lets you see current weather 
for different places. Weather is updated all the time and all you 

XBMC can list and play Shoutcast streams over 
the Internet

Did you know that Youtube sup-
ports high-definition content?
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need to do is add 
an entry for your 
city. Go to Check 
the Weather link 
menu and then to 
Settings. Choose 
to change the Area 
code and type in 
the city followed 
by a comma, then 
India. If weather 
updates for your 
town or city are 
available, the 
weather window 
will show them. Change the Region in the same settings menu to UK. 
This will display temperatures in Celcius instead of Fahrenheit. Click 
on Refresh to update the cities you’ve added to the list.

Controlling using an Xbox controller
If you already have an Xbox 360 or an Xbox 360 controller, it’s a good 
idea to use it with the HTPC. For one, the cable is long enough for 
you to sit at a comfortable distance and control the PC without the 
need of a keyboard and mouse. We suggest using free software called 

Xpadder 
(www.xpad-
der.com). 
Xpadder lets 
you bind 
keyboard 
keys to the 
controller. 
XBMC is 
controlled 
by a set of 
some 8 to 10 
keys in all. 
The same 
keys can be 
bound using 

this software.
First, download and install the Windows drivers for the X360 

controller and then install Xpadder. Xpadder will detect your 
controller. First, start the controller setup by clicking the control-
ler icon on the left top of the software. Click New. Here, enable all 
the buttons and triggers you want to use for XBMC. Once that’s 
done, you can click on each of the buttons shown in the display 
and a virtual keyboard will be displayed. You can click on each of 
the keys to bind that button to the keyboard. You will also see a 
mouse on this virtual keyboard. You can even set the buttons and 
joysticks on the controller to function as a mouse. 

XBMC Scripts 
and Plugins
Being an open-
source software 
package, scripts 
and add-ons are 
available for 
XBMC. One of 
the plugins that 
comes with the 
program is the 
Apple Trailers 
script. This plugin 
downloads Apple 
Trailers videos 
for you from 
its site without 
having to open a browser. The site is updated pretty often and it’s 
good fun to be able to view trailers this easily. 

Plugins can be installed by simply unzipping the archive to 
your Plugins folder in the installed XBMC folder. To access the 
plugin, go to the Use your Programs menu and to the Programs 
Plugins folder. XBMC Zone (www.xbmczone.com) and http://tinyurl.
com/d25nrz are good places to start looking for plugins of interest. 
It’s not hard to find scripts and plugins for all kinds of needs start-
ing from viewing RSS feeds from Google Reader in XBMC to view-
ing videos in full-screen from Youtube. n

rossi.fernandes@thinkdigit.com

Trailers from Apple’s site can be viewed directly 
within XBMC

Using Xpadder, you can set a game controller to control 
XBMC

DisplayPort like HDMI is a 
display connectivity standard 
but is royalty-free

Media Portal
www.team-mediaportal.com

Media Portal is geared 
more towards those 
who have their TV and 
radio broadcasts being 
processed through the 
computer. The general 
look and feel of the 
software isn’t very nice 
and the performance 
seems to be slightly 
sluggish as well. One of 
the interesting features 
is the configuration 
tool. It allows users to completely configure the system outside of 
its HTPC interface like any other Windows application. Support and 
configuration for the hardware remotes is also done within the soft-
ware. Installation of plugins is also simple. Media Portal is versatile 
with great potential but requires users to sit and tweak and configure 
bits of the software themselves. 

Boxee
www.boxee.tv

Boxee is somewhat similar to XBMC and that’s because it’s a branch 
of XBMC like Media Portal. It’s geared more towards social network-

ing and some of interesting features is the ability to retrieve and view 
content off the internet, all without having to go through the hurdles 
of installing and setting up plugins to do that for you. 

Vista Media Center
www.microsoft.com 

Vista comes with a built-in media centre application and if you 
own Vista, you most likely have an HTPC frontend program built-in. 
Although it might not support all the formats you want to use, it’s 
depends highly on the internet for media and information on sports 
matches and such like. It also has the ability to record TV programs, 
access internet TV channels and even burn disks. Unfortunately, a 
lot of the online content isn’t available for India so you’re left with 

somewhat handi-
capped software. If 
you don’t want to go 
through the hassle 
of downloading and 
installing a program 
and use conventional 
media formats or 
play movies off your 
DVD drive, then Vista 
Media Center should 
be sufficient for your 
needs. 

The Weather menu displays current for the speci-
fied cities
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SECRETS THAT KEEP YOU AHEAD IN THE RACE

ADVANCED SYSTEM CARE 3
Advanced System Care 3 is a comprehen-
sive system utility for protecting, cleaning, 
repairing, and speeding up your Windows 
PC. Cleaning up the system involves main-
tenance tasks such as deleting temporary 
files, downloaded internet files, recycle bin, 
redundant registry entries and other tasks 
that free up memory and generally keep the 
system well oiled.
 

Getting started
The interface of has four large buttons 
— Maintain, Diagnose, Utilities and Home. 
In the home section, you get an over-
view of version, 
statistics and 
other details. 
When you click 
on “View” under 
statistics, you 
know when the 
last scan was 
done, number 
of problems 
Advanced System 
Care (ASC) has 
fixed, and the amount of defragmenta-
tion done.

Diagnose the system
To diagnose the system, click on the 
Diagnose System button and scan. ASC 
will analyse your system for performance 
and security problems, after which the 
number of problems found is displayed. 
Click repair to fix. 

Enable ASC to clear junk from 
Recycle Bin
By default, the application does not scan 
the Recycle Bin for junk files. To enable this 
option, click on Option > Junk Files 
Clean and check the box for Windows 
Recycle Bin.

a new restore point. A restore point lets you 
undo unhealthy changes to your system 
that may happen. The system restore utility 
helps return your computer to an earlier 
time without loosing data. To select the 
processes that you want Restore Center to 
back up, click Settings and Check/Uncheck 
the boxes accordingly. You can even specify 
the number of backup files that should be 
stored (upto 100), and choose to create a 
restore point at start up everyday.

Retaining certain cookies
During a privacy sweep, the application 
may get rid of certain cookies that essential. 
These cookies could be those that have your 
personalised settings on certain web pages 
such as Google or Yahoo!. You can decide on 
the cookies you want to delete or retain by 
clicking on Options > Ignore List, 

and then click on the cookies tab. Here, you 
will find a list of cookies on the left. Moving 
certain cookies from the left column to 
the right column marks them as ‘cookies 
to keep’.

Check hard disk for errors
Click on the Utilities button. Under the 
Tuneup tab, you will find the Disk Check 
icon. The disk check utility inspects the 
file system and partition to confirm it is 
healthy. It scans for problems related to bad 
sectors, lost clusters, directory errors, etc. 
Click Yes to proceed.   

Defrag registry
The Registry Defrag tool is also found 
under the Tune Up tab of Utilities. Clicking 
on it will launch a registry defrag wizard. 
It basically compacts the registry size, 
which in turn, is supposed to reduce boot 
up time. It will ask you to close all pro-
grams before continuing.  

Update drivers 
The Update Drivers utility automatically 
scans the installed hardware components 
and suggests new updates for them after 
looking up the information online. Click 
on ‘Learn More’ for more information on 

 
Running maintenance

To enter the maintenance section, click on 
the Maintain Windows button. Click the 
scan button to start scanning your system. 
This checks for spyware, registry problems, 
privacy issues, and junk files. Once the scan 
is complete, it will give you the number of 
problems detected in each area. Click on the 
repair button to fix all issues.
 

Tweak Defrag settings
Click on Options > Disk Defragment. 
Here, check the box for skip huge files and 
change defragment point to 15%. This should 
make your defragmentation process faster. 

Setting up Restore point
Click on the Restore button at the top left 
to enter the Restore Center. Here, you will 
find a list of back up points created earlier. 
By default, ASC saves upto 20 such back up 
files. Click on Create Restore Point to create 

tips & tricks

ASC Interface Buttons

Advanced system care, fix problems after scan 

Cookies to be retained

1 month away
Digit is coming to 
you with a big  
bonanza turn over to 

TIPS
Advanced System Care 3 .  .  .  .  .  .  .  .  .  .  .  33
Google Tips .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  35
XCHAT IRC .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  36

28

 

Movie Management .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  38
K3B  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  39



Vol 9: 34

each of the driver updates that the utility 
suggests. Click Download to download and 
install the drivers. This function of the 
application is still in Beta testing and the 
recommended updates list that it produces 
may not be correct. 

Remove unnecessary files
Under Utilities section, click on the Disk 
Cleaner utility and select the drives you 
want to scan. This utility lets you find 
unnecessary files and recover space blocked 
up by temp, backup, cache, and log files. 
Click Next to continue. You have the option 
of moving the files that it detects to the 
recycle bin, or backup or permanently 
delete them.

Optimise Firefox
Under Utilities > Tune Up tab you 
will find the Firefox TCP Optimizer. This 
tool can modify your TCP/IP protocol and 
Firefox settings to increase speed. You have 

the option of selecting the Auto Optimise 
option or configure settings manually. To 
do it automatically, simply click the Boost 
now button. 

Boost gaming performance 
Many of the tools listed under utilities are 
available as independent applications from 
10 bit, the makers of ASC3. Once such tool is 
the Game Booster. Clicking on it will open 
up a download page for the component. The 
premise behind the tool is pretty simple; 
it works by temporarily shutting down back-
ground processes, cleaning RAM, and inten-
sifying processor performance. Once down-
loaded, you can click on the icon to run. 
The interface will show you a large list of 
processes that it intends to suppress. These 

include Windows help, certain web clients, 
etc. You can choose the ones you want to 
keep selected and press the large ‘Switch 
to Gaming Mode’ button. The application 
then prompts you to close certain programs 
that are running. You can skip this step if 
needed. Now the large button changes to 
“Back to Normal Mode’ button which you 
can click to return. 

Defrag your drive 
The Smart Defrag tool found under the 

Utilities is also an independent application. 
Use it to defragment your hard drives effi-
ciently for better performance. Once down-
loaded, simply select the drive and click 
start. The defrag process can be quite time 
consuming. Smart Defrag also gives you the 
option of scheduling defrags. 

Smart RAM
The Smart RAM tool shows you physical 
and virtual memory utilisation. It also frees 
RAM while the processor is idle. Under the 

settings menu, you can toggle this setting. 
You can also activate the tool at command. 
Click ‘Go’ to clean memory with a Smart 
Clean or Deep Clean option. Smart clean 
on the first pass cleans around 30 MB. Deep 
clean momentarily clears Virtual memory 
to a significant extent. 

Back up system 
This tool is found under the Security Tab 
of Utilities. It launches a wizard that helps 
you back or restore your system setting and 

documents. In the wizard, you can choose to 
back up specifically or preset items like My 
Documents. If you choose My Documents 
and Settings, it will back up favourites, 
desktop and cookies as well. Click Next to 
continue and give a location for backup. The 
data will be stored in a BKF file which you 
should ideally move to a remote location. 
Click on Advanced to specify type of backup 
(Copy, incremental, differential, or daily). 
Click Next to backup. 

Add / remove programs from 
startup
Removing programs from the start up list 
can significantly reduce time needed to 
boot. Under the Admin Tools tab, you will 
find the Startup Manager. This shows you 
a list of programs that are there in your 
Startup. Simply uncheck the ones that you 
don’t want to load at startup. 

Reduce right-click menus 
As we installing more programs on our 
system, our right click context menus keep 
increasing in size. It becomes very annoying 
when you can’t identify the action you want 
among all the clutter. Click on Context 
Menu Manager to alter these menus. You can 
remove items from New, Send To, and Shell 
Extensions right-click menus. Simply select 
the item and click on the Remove button.
 

View space usage graphically 
Disk Explorer depicts the space utilisation 
in your hard drive in the form of a pie chart. 
Simply select the partition to analyse and it 
will show you a detailed break up of items.

File duplicate files and get rid of 
them  
Every PC has a lot of duplicate files that 
occupy unnecessary space. With the Disk 
Explorer tool, you can find these files on 
a drive and instantly delete them. In Disk 

Recipe Puppy
A Recipe search engine finds meals by a 
list of ingredients or keywords

Updates Driver

Optimise Firefox

Game Booster

Smart RAM

Back up wizard

File explorer showing disk usage
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Explorer, click on the Clone Files tab. Click 
on the Find Clones button and the list will 
be populated. Hold [Ctrl] and select mul-
tiple file, right click and send them to the 
Recycle Bin. 

View system processes in
better detail  
Click on the Windows Manager tool under 
the Admin Tools tab. You will be able 
to see a whole list of processes in better 
detail. Click the terminate button to stop 
any process.

View more detailed system
information 
The System Information tool provides a 
much better look at system details than the 
Windows tool for the same purpose. The 
information is logically seperated into OS, 
Processor and MB, Drivers, Display, Network 
etc. Click on File > Export to export 
information as text or HTML.

GOOGLE TIPS
We all use Google for fulfilling our daily 
search needs. But do we really know how to 
use it optimally? There is much more to the 
Google search engine than just typing your 
search phrase and hitting [Enter]. Google 
has many options that will let you reach 
the information you are looking for in the 
wilderness of cyberspace, more quickly and 
efficiently. Here we look at some tips that’ll 
make you a Google God. 

Search exact phrase 
If you want to search for an exact phrase, 
use quotes. For example high quality 
desktop printers will only find that 
exact phrase. To slightly broaden the search 
results you can use quotes in combination, 
for instance high quality “desktop 
printers” will find pages that contain 
the words high quality and the exact phrase 
“desktop printers”.

Search using “OR” operator 
Google normally searches for pages that con-
tain all the words you type in the search box, 
but if you want pages that have one term or 
another (or both), use the OR operator. For 
instance high quality desktop OR 
printer will give you results which con-
tain the words high, quality, desktop or only 

printers or all of the terms. Remember the 
operator is case sensitive and has to be in 
upper case. Alternatively, use the | symbol.

Asterix operator 
The Asterix operator serves the exact func-
tion it did in DOS (remember Dir *.exe). It’s a 
wildcard and can be used in place of search 
terms you can’t quite recall. For instance, 
if you can’t remember the exact name of 
software you need, you can type advanced 
* cleaner and it will give you appropriate 

results. The operator 
can also be used to find 
information on certain 
domains. For instance 
to search for educa-
tional information type 
printers research 
“*.edu”.

Ignore certain 
terms 
If you need Google to 
ignore certain terms, 
use the - operator. 
For example, if you’re 
looking for “dark choco-
late” and not at all inter-
ested in milk chocolate, 
you can use dark -
milk chocolate.

Find similar terms 
Use the ~ symbol to return similar 
terms. For instance, ~dark choco-
late -dark will get you pages that 
contain words similar to dark or dark-
ness combined with chocolate. These 
words might include something related 
to night.

Find results for a particular 
date range 
When you want to find instances of your 
search phrase, say web 2.0 appearing on 
the internet in a particular chronological 
era, you can use the daterange: operator. 
However, there are two important points to 
note. The dates have to be entered in Julian 
format (which is no simple task) and the 
date is not the date of creation, but the 
date on which Google indexed the page. 

For example, the Julian date for April 16, 
2000, is 2451650. To find the instances of 
“web 2.0” being used between April 16, 2000 
and April 16, 2003 use the search web 2.0 
daterange:2451650-2452745. There 
are Gregorian(normal) to Julian converters 
available online.

Search for terms in the title of 
web pages 
By default, Goolge searches for your term 
within a web page, but by using intitle: 

you can search for pages that 
have the words mentioned in 
the page title field of a web 
page. intitle: Social 
Networking Basics will 
return articles with this title. 
A variation of this command 
is allintitle: that will 
search for all of the above 
terms in the title of a page.

Find results within a 
range of numbers 
Say you are looking for results 
for a range of numbers such 
as cameras between 4 and 10 
megapixel, you can use the .. 
operator. For example, 4..10 
megapixel cameras.

 
�Search for a specific
file type 

This is most useful when looking for some 
whitepapers or other research orented 
material. This is because most serious or 
in-depth reports on any topics are most 
likely to be found in formats other than 
regular HTML pages. All this information 

UN to launch a web site that 
will offer free access to rare 
manuscripts, books, films and 
maps from around the world

Image search improvement
A Similar Images feature added to Google’s Image Search 
tool lets people scour the Internet for similar photographs

Back up wizard

Use asterix operator if you do not remember the exact phrase
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is likely to be stored on the web in for-
mats such as PDF, DOC or PPT. Use a file-
type operator to specify fileytypes in your 
searches. For example, filetype:pdf 
intel architecture will return only 
PDF results containing the terms Intel and 
architecture.

Using Google Scholar 
Google Scholar (scholar.google.com) 
searches  articles, books, reports, theses and 

more. You can use it to search, but full-text 
content is not always available. However, it’s 
worth a shot for that last bit of information 
on your semester report.

Internal web site search 
Often, you want to search a specific web site 
for content that matches a certain phrase. 
Even if the site doesn’t support a built-
in search feature, you can use Google to 
search the site for your term. Simply use the 
site: search modifier. If you want to find 
out what Agency FAQ has to say about viral 

marketing, use this string viral mar-
keting site:www.afaqs.com.

Using Google Cache 
This one has many functions, and in some 
cases it can be used as your very own proxy 
to get around restriction. It can be used to 
highlight search phrases in the page. It can 
also be used to view pages that have been 
taken of the air since this is an image of the 
page Google has captured sometime in the 

past. To access a cached page 
simply click on “cached” under 
the result entry.

Use Google as a quick 
dictionary 
Very often we come accross 
words that muddle us. But it’s 
time quite an effort to actually 
go to a free online dictionary 

to get the result. Instead try the define: 
function. With it Google aggregates mean-
ings and definitions from several sources on 
a single page. For example, define:moot.

Use Google as a converter 
Google can be used as a currency as well as 
units converter. Google normally understands 
loose syntaxes, but it is better if you know 
the currency notations; for example, INR, 
GBP or USD. Following are some examples: 
50 yards in feet and 100 INR in 
USD.

Use Google for mathematical 
calculations 
Google calculator allows you to calculate 
using certain mathematical operators. 
Operators such as log, factorial, and trigno-
metric functions can also be used. These 
searches have to be entered into the google 
search bar directly. Following are some 
examples.
3+3 returns 6
5-2 returns 3

9*2 returns 18
24/2 returns 12
7^2 returns 49 (7 raised to 
power 2) 
5%2 returns 1 (the 
remainder after division)

Search for terms 
in a URL 
This is another example of 
a specific location-based 
search. Using the function 
inurl: will return results 

that contain certain terms in 
the web site’s URL. For instance, 
inurl: geometry circles 
will search for phrases not in the 
text of the site, but in the URL 
of pages.

Find the exact word 
Google automatically searches 
for synonyms. For example, it 
finds United States for a query 

on US, when you may be searching for Us 
Magazine. Sometimes, Google helps out a 
little too much and gives you a synonym 
when you don’t really want it. By attaching 
a + before a word e.g. +us magazine, you 
get an exact match for that word. It’s easier 
than putting quotes.

XCHAT IRC
XChat is an IRC chat application for Linux 
and Windows. It allows you to join multiple 
IRC channels at the same time, talk publicly, 
and hold private conversations. It also has 
the added functionality of file transfers.

Getting started 
When you start the XChat client, it will ask 
you to enter a nickname of your choice and 
a few alternatives in case your preferred 
nick is not available. Here, you also have to 

IRC was born sometime August 1988 when 
Jarkko “WiZ” Oikarinen wrote the first IRC client 
and server at the University of Oulu, Finland

Internal Website Search

Define function

Converter

In URL search

Google scholar lets you preview academic books

Results for Google Scholar

Cashed Results
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Timeline
A recently launched Google Labs experiment 
presents information already available in Google 
News organised and displayed chronologically

choose a network. Scroll through the list to 
view available networks. Click on a network 
(say FreeNode) and click connect. Once you 
are connected to the network or channel, 
you will have to select a channel to start 
chatting. Here, you have three options. One 
is to join a channel later. The second radio 
button allows you to specify a channel, pre-
ceded by #. This option can only be opted 
for if you know the channel name you want 
to join. The third option is to open the 
channel-list window, which will retrieve all 
the available channels.

Joining a channel 

Once you are in a network (eg FreeNode), click 
on Server > Join a Channel. Here, you 
can type the name of the channel preceded 
by a # sign e.g. #think-digit. You can also 
click on retrieve channel list. You will see a list 
of all the channels hosted on the server and 
the number of users in each channel. You can 
narrow down the list by entering a search key-
word of your choice. Select the channel you 
want to join and click Join Channel. You can 
join multiple channels in the same way. Close 
window when done adding channels.
 

Get notified when a user joins 
the server 
This can be done by adding a user to your 
friend list in Xchat. Right-click on the user-
name and click “+Add to Friend List. Now 
whenever this user logs on to the server, you 
will get a notification, irrespective of the 
channel he is logged into. This is in effect 
the same as using the /notify command. 
To view the friendlist, click Window > 
Friend List.

Change Channel View
(tree / tab) 

XChat offers two choices of organising 
the channels you have joined. The views 
available are Tree and Tab view. To change 
the view go to View > Channel 
Switcher > Tab / Tree View.

Change Background 
and Text colour 
To change the look and feel of 
your interface, go to Settings 
> Preferences. Under 
Interface, you will find Colours. 
The “foreground” colour is your 
text colour while the “back-
ground” is your terminal colour. 
“Marking Text” is the selection 
or highlighting colour. You can 
also set transparent background. 
Enabling this option will show 
your desktop wallpaper. To do 

this, go to Settings > Preferences 
> Text box and check ‘Transparent 
background’.

Auto join favourite channels on 
start up 
You can have a number of channels that 
you can set for Xchat to join as soon as it 
starts up. To do this start up XChat or go to 
XChat > Network List or hit [Ctrl] 
+ [S]. This will open up the Network List 

Box. Select a Network and click Edit. Check 
the box for “Auto connect to this network 
on start up”. Enter favourite channels seper-
ated by commas. For example, #think-digit,
#phptips,#codebreakers. Click close.

Add private chat buttons 
To be able to have private chat with any user 
click on the username, right click and click 

As of today the top 100 IRC 
networks serve more than 
half a million users at a time

Transparent background

Edit network for auto joining favourite channels

IRC Commands 
These are some common IRC commands that can be used with any IRC client, hence they 
are not specific to XChat 

/HELP	 General help or help on the given command.	 /Help Ping 
/LIST	 Lists all current channels. 
/JOIN	 To join a channel	 /Join #think-digit 
/LEAVE	 To leave a channel	 /Leave #justvhat 
/QUIT	 Exits your IRC session,	 /Quit [reason] 
/NICK	 Changes your nickname	 /Nick nonnewbie  
/AWAY	 Leaves a message saying you’re away	 /Away [Message] 
/WHOIS	 Displays information about someone	 /Whois nonnewbie 
/KICK	 Kick someone off a channel (in operator mode)	 /Kick [#Channel] [Nick] 
/TOPIC	 Changes the topic of the channel	 /Topic [new topic] 
/MSG	 Sends a private message	 /Msg [Nick] 
/QUERY	 Starts a private conversation	 /Query [Nick] 
/NOTIFY	 Informs you when people logging in or out IRC	 /Notify [Nick] 
/IGNORE	 Blocks responses of certain users	 /Ignore [Nick]

Joining a Channel in XChat

Adding Dialog buttons

Getting started with Xchat
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Did you know?
Media Monkey is a good application 
to manage your Audio
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Siddharth Parwatay

A 
few years ago, when MP3s enjoyed 
all the hype, globally there was a 
deluge of audio content. People 
accumulated thousands of MP3 

tracks and didn’t know how to manage 
them. Tracks were repeated in collections 
and strewn about over the hard disk. Most 
of all, listeners didn’t get quick access to 
the songs they were in the mood to hear. 
A similar type of situation has risen once 
again, but this time for movies — driven 
not by a diminishing file size, but by ever 
expanding storage space. By now, you may 
have accumulated hundreds of files that 
need to be sorted, categorised and managed. 
Often, you don’t even know the movies you 
have, which one you’ve seen, and to what 
genre a particular movie belongs. Consider 
the situation where you have friends over, 
and they’re all in the mood for an action 
flick. Which one should you play? The file 
names alone don’t really ring a bell. Well 
fear not, for movie management applica-
tions are here to help you. 

Several paid as well as free-licence pro-
grams that perform a multitude of func-
tions are available these days. These applica-
tions catalogue your movies, keep track of 
titles you have lent out (in the case of DVDs), 
let you browse movies by various param-
eters such as actor, director, genre, etc., and 
most will even look up movie information 
from online databases such as IMDb. Some 
have their own database such as Coolector. 
Sadly, after going through several, we are 
yet to discover one that covers everything, 
especially in the realm of freeware. 

We have, however, zeroed in 
on one that fulfills most of our needs 
– Rock Solid Software’s MovieManager. 
You can download it at http://movie-
manager.ca/WindowsSetup/Freeware/
MovieManagerSetup.exe.  It’s free to use 
and whatever little lacunae there are can 

be worked around with a bit of 
tweaking. 

General interface 
The application provides two 
viewing modes – by movies or 
by actors. The movies perspec-
tive is preferable. On the left 
half of the screen you have a list 
of movies that are currently in 
your database. On the right, one 
pane shows you details such 
as IMDb rating, duration and 
genre. The bottom pane displays 
the movie poster and the cast. 

Adding movies 
The MovieManager database 
can be populated in several ways. 
When you run the application 
for the first time, the list is blank. Click the 
+ icon to open a movie editor tab on the 
right pane. You can key in the name of the 
movie and click the IMDb lookup button. 
The details will be automatically filled in. 
Click Save when done. 

Scanning for movies 
Scanning for movies is a better way to 
add movies to your database. Before scan-
ning, go to Tools > Properties and click 
the Load Database tab to add file types. 
We found MKV and BIN to be missing 
from the list. To scan your hard drive, go 
to Tools > Load Movies. Click on 
Add to select your movie folders. If you 
wish to synchronise your database with 
your current collection, then check the 
Replace Database Contents button. If you 
want to sort your movies into genres, 
check the ‘Use Parent Folder As Genre’ 
box. Click the Load db button to scan. 
Your movies will now appear in the list. 
Click on the IMDb lookup icon to get 
information for the movies. You may have to 
clean up the names of the files as they may 

contain more than just the 
movie name. The software, 
however, pulls info more 
easily if folder names have 
a date of release. Therefore, 
use the following format 
for folder names — <Movie 
Title> (<year>).

Generating HTML 
Often, we feel the need to 
share some great movies 
we have with our friends. 
How do you let them know 
the movies that constitute 
your awesome collection? 
Simple, just mail them an 
HTML list of your database! 
The generated HTML page 
contains the movie title 

and other fields that you have selected 
including the picture, rating, etc. The list 
can be sorted by genre too. To create an 
HTML list go to Tools > Generate 
HTML. Here you can choose the order and 
the details that you want. The default name 
for the file is MOVIES.html and will be saved 
on the desktop. Click Generate once done.
 

Listing parts played 
by a particular actor 
Suppose you want to know all movies in 
your database with John Travolta. In the 
movie view, double-click on the actor’s 
name on the right hand side pane. The view 
will automatically shift to ‘actors’ view and 
will display movies featuring John Travolta 
in the bottom pane. Double-click on any of 
those fields to bring up a tab of that movie. 

Seen / Unseen 
You can save two different databases for 
movies you have seen or have yet to see. 
To do this, click on File > Backup 
Database and save it in a new folder 
called seen / unseen. Maintain separate 
folders for the two categories. n

siddharth.parwatay@thinkdigit.com

Movie Management

HTML page of your movies

Scanning your hard drive for movies

Scanning your hard drive for movies



Open Dialog Window. Here you will find cer-
tain buttons for performing standard actions 
such as WHOIS, SEND and PING. To add new 
buttons click Settings > Advanced > 
Userlist Buttons. Click +Add New and 
define your action. Click Save.

Private chat on double click 
XChat doesn’t open a new query box (or 
private chat) when you double-click on a 
user’s nick name. This can be rectified. 
Go to Settings > Preferences> 
User list. Under Action Upon Double 
Click, replace QUOTE WHOIS %s %s with 
QUERY %s. Click Ok. Now when you double-
click on a nick name, a query window  
will open.

Move tabs around 
In the tabbed view holding down [Alt] key 
and pressing Left/Right arrow keys can move 
tabs around.

Installing themes for XChat 
on Linux 

XChat doesn't have a themes function 
directly, but there is a way by which you 
can change the look of the UI consider-
ably. What you need to do is replace colors.
conf file named with replacement files that 
are available online. This file is found in 
/home/username/.xchat2 for Linux. 
There are very few places from where you 
can get colors.conf files. One such source is 
www.t0x.in/xchatthemes.html. You can also 
replace the pevents.conf file for additional 
UI changes, but it may not be visible in all 
versions of XChat.

Use special characters 
XChat has its own character map from 
where you can insert special charac-
ters. Click on Window > Character 
Chart to view all characters. Click on 
the ones you wish to insert.

Using Plugins and scripts 
You can install scripts and plugins 
into XChat by clicking on XChat > 
Load Plugin or Script and 
pointing to the script file. We found a 
useful script online that automatically 
displays the real name of any user 
joining a channel. After downloading 
the script file (in this case autoreal-
name.pl), simply load it in XChat. Visit 
XChat / IRC forums for finding other 
useful scripts and plugins.

The DVD Re-Writable AD-7240S 
from Sony is the world’s first DVD 
burner to achieve a 24x burning 
rate (available in India at Rs 1,500). 
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K3B
K3b is a user friendly CD / DVD writing suite for 
Linux optimised for KDE. It is a versatile applica-
tion and handles music, video and data equally 
well, and has no trouble burning “ISO”.

Getting started 
When you start K3b, it will automatically 
recognise your writer drive. The interface 
will start at the Quickstart page. This has 
quick buttons for most common burning 
tasks such as new audio, data, DVD projects 
as well as other tasks such as 
copy CD, CD image, and burning 
DVD ISO image. Any new project 
you click on will be opened in a 
new tab.

Copy CD 
You can either click on Copy CD 
in the Quickstart menu or click 
Tools > CopyCD. This will 
open the Copy CD dialog. You 
need to specify source and burn 
medium (which is the blank CD 
you wish to copy into). Under the 
Options tab, you can specify if 
it's a normal copy, i.e. burn into 
another CD or only create an 
image, in which case it will copy 
the image into the hard drive. 
This option can be found under Copy Mode 
drop down menu. Under the image tab, you 
can specify where to write the image file in 
the hard drive. 

Erase CD/DVD RW 
Under Tools menu, you will find Erase CD 
RW and the Format DVD RW buttons. In the 
Erase CD dialog, you can choose the erase 

type from the dropdown menu. Your 
options are Fast, Complete, Erase last 
track, Reopen last session, Erase last 
session. You can even specify the erase 
speed. Click start to begin the process. 

Normalise Audio 
To normalise an audio file means to 
bring the loudness of the audio to a 
standard level, so that some songs don’t 
sound much louder or softer than 
others. Hence you don't keep reaching 
for the remote or volume control all the 
time. To add Normalisation audio sup-
port, follow the following steps. Enter 
sudo apt-get install nor-
malize-audio in the terminal. Once 

executed, restart K3b. Go to Settings > 
Configure K3b. Under the Programs you 
will see /usr/bin/normalize show up 
under the “normalize” heading. If not, you 
can click on search. Now when burning an 
Audio CD, you will be able to select Normalise 
Volume Levels in the advanced tab. 

Add MP3 support 
By default, K3b will not support MP3. You 
need to download a dependency package, 

for K3b to be able to support this 
file type. In the terminal, type 
the command - sudo apt-
get install libk3b2-mp3. 
However, if you have a newer 
distribution, enter the command 
- sudo apt-get install 
libk3b2-extracodecs. After 
the package is installed, restart 
K3b and click on New Audio CD 
Project. You will now be able to 
drag MP3 files into the new audio 
CD to burn.

Ripping Audio 
When you insert an Audio CD, 
the application will immediately 
look up the artist and track info 
on CDDB. You can also choose 

Burning audio CD from MP3

K3B
CD/DVD writer software 
for Linux

Matrix-like theme

Quickstart menu

Writing Audio CD in K3b
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to manually write the info. Click on Edit 
Track and Edit Album Info buttons or 
right-click on the track. Once this is done 
you can click Start Ripping. You will be 
able to choose the file type you want to rip 
to (FLAC, Ogg, or Mp3). In the file naming 
tab you can choose the way in which the 
ripped files are named. You can insert %g 
in the string to have the genre included in 
the file names. You can then click on Start 
Ripping to extract audio.

Slow down the read speed 
K3b allows you to slow down the read speed so 
that the annoying high pitched noise reduces 
while reading CDs. Click on Device > Set 
Read Speed and specify the speed you 
want. This speed will be set for the currently 
mounted drive.
 

DVD Image Burning  
K3b allows you to burn iso images onto DVD 
media. Click on Tools > Burn DVD ISO 
Image. You can then point to the ISO image 
file that you wish to burn and the burner 
will do the rest.

Overburn 
Overburning is a way to burn a little bit of 
extra data which is beyond the specified 
capacity of the media. If you have a 700 MB 
disk and wish to burn that little extra 4 MB 
song on it, you can. Click on Settings 
> Configure K3b. Go to the Advanced 
options and check Allow Overburining.

No Eject after burning 
Sometimes it gets very annoying when 
writing applications pop the disk out after 
the burning process is over. K3b allows you 
to choose to not eject the medium. Go to 
Settings > Configure > Advanced. 
Under Miscellaneous, uncheck the box for 
‘Do not eject medium after write process’

Change look 
As with most applications, you can change 
the feel of K3b. It allows for themes to be 
changed to change the look of the software. 
To change theme, go to Settings > 
Configure > Themes. Here, you will 
find a few themes that come bundled. Click 
on any theme and click Apply. You can also 
install new themes. Click on the Install New 
Theme button and point to the theme file. 
You can search online for themes.

Saving all projects 
Sometimes burning a DVD can be quite a 
process which can last multiple sessions. In 
fact, since K3b allows you to work on more 
than one project (in tabbed form) it can be 
even more time consuming. In such a case, 
you can choose to save all the projects that 
you’re currently working on. To save all the 
projects, click on File > Save All. You 
will then be prompted to assign project names 
to each of the tabs and save them.

Split audio tracks 
K3b allows you to split audio tracks 
while burning audio CDs. Simply right-

Writing Audio CD in K3b.png

click on the track in the current project 
and click split tracks. You will get a 
slider to choose the splitting position, 
or you can specify the new timings of the 
split tracks (e.g. 00:00:59 - 00:02:12).

Make a data CD for Linux, 
Windows or both.
A data CD is a optical disk that is formatted 
to store data in the form of files. The files 
typically stored on a Data CD include MP3 
audio, doccuments, compressed archieves, 
and even Linux packages. With K3b, you 
can write a data CD that can be read on 
both Windows as well as Linux Machines. 
To make a data CD in K3b, click on File 
> New Project > New Data 

CD Project or you can click 
on the New Data CD icon in 
the quick start menu. You can 
rename the volume by entering 
a name on the top right corner 
above the contents of the 
project. Click on Project > 
Add Files to open the dialog 
box to add files. You can drag 
and drop or select multiple files 
and click Open. Once you are 
done adding files, click on Burn 
to initiate the burning process. 
In the new dialog box, click 
on the File System Tab. In the 
drop down menu choose the 
appropriate option (Linux/Unix 
+ Windows or Linux/Unix only). 
Click on Burn when ready.

Make a mixed mode CD
A disk with a data track as well as 
an audio track is a mixed mode CD. 
Therefore, you can effectively combine 
two data types (files and playable audio). 
Such CDs can be played on a Hi-Fi system 
and the data track can be read on a com-
puter. To make a mixed mode CD click 
on File > New Project > New 
Mixed Mode CD Project.

In the adding menu, you will find an 
audio track and a data track section. Select 
one of them before adding files. When you 
add an MP3 file to the data track, it will be 
stored as data if the selection is on data 
track. If it is on audio, it will be converted 
to CD audio.

Click on Burn when done. In the new 
Dialog box, click on the Misc tab. Here, 
you can choose if you want the data 
track or the audio to be the first track 
on the CD. Typically, the Data Track is 
the first track.

Copper chrome theme

Ripping

Change read speed

Mixed Mode CD

Split Audio Tracks

Keep yourself free
Take part in the Digit  
Carnival coming your way 28
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All your computer 
niggles and nags are 
dealt with here!

Your Questions, 
Our Answers

 
A couple of problems
1.	 I have a wired broadband connection on my PC connected 

through a normal ADSL2+ router, but it doesn’t have Wi-Fi 
capabilities. Is there some way to share the internet bandwidth 
with the PC and my laptop. Also, can I play a game such as 
Counter Strike over LAN with both? 

2.	 Can I use my old 80-GB hard drive as an external drive using 
some external casing? Is there a way to use it as a backup drive 
with XP?

3.	 Is there a way to see all the details of a video file and save 
some other video to that format? Can I put some other video 
that isn’t recorded through my handycam into my handycam 
by converting that video to the handycams default format and 
by naming it in the sequence followed by my handycam. One 
of the ways for outputting the file was given in your Tips and 
Tricks section using the VLC transcoder. 

Vishal Singh

 You will have to buy a separate router that accesses the 
ADSL2+ router to let you access the internet using the laptop 

and the PC. It will also allow you to play Counter Strike between the 
two PCs.
You can use old 80-GB hard drive as an external storage disk. Pur-
chase a 3.5-inch casing for it. It shouldn’t cost you more than Rs. 
700 for a decent one. Make sure it has an interface for your drive 
before you do.

Use a program called G-Spot to get details of the video format 
used by your camera. Often, manufacturers use proprietary or 
modified codecs within existing / known containers; hence, it 
might not work if you try and re-encode videos to the specific 
resolution and codec.

Major overheating problems!
My configuration is: AMD Athlon 64 x2 4200+, MSI motherboard 

with inbuilt NVIDIA 6100 graphics, 2 GB 667 MHz RAM, 250 GB Hard 
Disk. The drive has two partitions — one with Windows XP SP3 and 

other runs Windows Vista. When I use my computer for 3 to 4 hours 
at a time, it restarts due to overheating. When I check the BIOS, my 
system temperature shows up as 87 degrees. A few days ago, I discov-
ered my PSU’s fan wasn’t moving, so I thought this could be the prob-
lem. Therefore, I changed my SMPS and bought an Intex 450-W SMPS, 
but the problem hasn’t gone away. I cleaned my processor fan and 
RAM modules, but the condition has remained the same. I thought 
that it could be due to an infection so I ran a complete scan with Avast 
2009 Home Edition with latest updates, but it didn’t work either. My 
computer usually shuts down when I play games such as Far Cry 2 or 
Need for Speed Undercover. 

Bidyankur Bhagawati

 Your’s certainly seems to be an overheating problem. Your CPU 
temperature is way too high. Install SpeedFan that lets you 

monitor your CPU temperature while running Windows. If cleaning 
doesn’t help, try touching the metal heatsink immediately after 
powering off the system. If it feels really hot, then remove the 
heatsink and apply a new layer of thermal paste and reattach the 
heatsink. The existing paste might have dried up or your heatsink 
may not be properly thermally connected to the heatsink. 

Connecting a new PC with Windows XP to a domain
I have bought a new PC with Windows XP Professional. I have a 

network with a domain setup. I want to know how to configure XP 
to connect to the network so that a user can login into the domain. I 
know how to configure Windows 98, but I’m not sure how it’s done on 
Windows XP. 

Rajesh Kumar

Making your PC a part of the domain can be done by clicking 
on Start > Control Panel > System. Within the 

Computer Name tab, click on Change to rename the PC name or 
set a workgroup or domain. Choose to be a member of a domain 
instead of a workgroup. 

DOS window problem
I have a Dell XPS M1530 laptop running on Windows Vista Home 

Premium SP1. Whenever I type ipconfig in Start > Run, the window 
opens for a brief second and then closes immediately. The same 
problem occurs when I run some DOS programs. What can I do? The 
problem does not arise when I open command prompt and then type 
ipconfig. This doesn’t occur on my PC running on XP SP2.

Roy Fernandez

 Command prompts accessed through Start > Run 
automatically shut once the execution of the command is 

completed. Using Start > Run > cmd and pressing [Enter] 
might be the simplest way to start your command line applica-
tions. If commands such as ipconfig are required to be run very 
often, then you can create a batch file in notepad with the 
following text.
cmd
ipconfig
Save the file as a BAT file and run it when you need it.

Strange errors in Windows
My PC configuration is as follows:

Processor: Intel Core Duo CPU E7200
Motherboard: ASUS P5GCMX-1333 I am using Windows Vista as my OS.
My computer has a couple of problems.

1. During start up, it shows up errors that say “Rundll32 not found”.
2. I am unable to run Task manager. It says “Disabled by adminstrator”. 

G-spot displays information on the format

S.M.A.R.T is monitoring and 
analysing technology found in 
almost every hard drive today

q & a
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3. I am unable to open the cookies. It says “Access is denied”.

Chitrabhanu Pattnaik

All of your problems suggest that you have some kind of a 
worm or virus. It’s a good idea to install an antivirus, update 

it and run a complete PC scan.

How do I host a web site?
I have a static IP and want to host a web site on my PC. I have 

Vista Home Premium installed. I have also registered two domain 
names. Please guide me how to host a web site on my PC.

Nadeem

Hosting a web site requires decent bandwidth depending on 
the amount of traffic you plan on getting. Still, hosting a web 

host is simple and there’s plenty of methods to choose from. If you 
just have to host a basic set of pages without a MySQL server or a 

PHP environment setup, then something as small and free as 
AnalogX Simpleserver (http://www.analogx.com/contents/
download/network/sswww.htm) or Abyss Web Server (http://www.
aprelium.com/abyssws/) will do. If you want the complete thing, 
downloading XAMPP for Windows is recommended. It comes with 
Apache, the web server, MySQL, PHP, Perl and everything you 
require. Once you have the web server installed and setup, simply 
login to the account on the domain provider’s control panel and 
redirect the domains to your static IP.

PC slowdowns
I have a problem with my PC and I am sick of it. My PC has an 

Intel Dual Core 3.0 GHz processor, 1.5 GB of RAM, a motherboard 
running on the 945 express chipset and 80 GB of hard disk space. 
My problem is that when I format my system with Windows XP 
Professional SP2, after some days my PC gets slower and the speed 
decreases. Although the CPU usage is at a minimum, the fan rotates 
at its full speed when I copy some data such as movies, it performs 
well, but the CPU usage is only 7 or 8 per cent. There is no virus in 
my PC. When I use Windows Vista as my operating system, there is no 
problem and it works perfectly. I want to work with XP Professional, 
so please tell me what’s wrong and what is the solution.

Manish Kumar 

Your problem is pretty strange. One possible explanation 
could be drivers. Try upgrading your drivers to the latest 

versions. Check your CPU temperature to make sure it isn’t 
overheating and it’s being throttled down. Do this from the BIOS 
and if it isn’t, try turning off any CPU-throttling features.

System locks every time I boot into XP CD
Whenever I try to format my drive, the system hangs on the screen 
with the option for continuing or repair. I tried it with different disks. 
I have 384 MB of RAM and a 1.5 GHz Pentium 4 processor. Please help 
me with a solution to this problem.

Dushyant

Securely passing on files
I want to write a CD containing my personal 

information and give it to a friend. I want it to 
be secure so that the data can only be read by 
my friend. Is there any simple software that I 
can use to encrypt it?
Also, I read in the magazine that to prevent 
most viruses from activating I should create a 
write-protected file AUTORUN.INF. The prob-
lem is that I don’t know how to create a write 
protected file. I went to the properties window 
and ticked on the read only button but I don’t 
think it works.

Ashish Mathew   

A simple and secure way to send files 
on a CD to your friend might be to 

use an archiving tool such as WinZip or 
WinRAR. Set a password to the archive 
and it should be fairly secure.

To create a write-protected file, start a 
command prompt by clicking on Start 
> Run and typing cmd. Go to the drive 
or partition you want to create the file by 
typing E: assuming that E is your flash 
drive. Type copy con autorun.
inf and press [Enter]. Type [Ctrl] 
+ [Z] and press [Enter]. Then, type 
attrib +r +s +h autorun.inf. 
This will set the file to be hidden, read-
only and also a system file.

AnalogX is one of the most basic web servers you can find

Disabling Intel’s Speedstep technology from the BIOS might help boost 
performance

Storing files securely using password protection 
in WinRAR

Question of the Month

T
O

O
LB

O
X

q & a
Windows 7 RC is expected 
to be out by the end of May 
2009



DIGIT APRIL 2009 95

It seems that the problem lies with your hard disk. You can try 
after a complete disk check. For this purpose, use a bootable 

floppy disk or CD for Windows 98 or ME and format the drive.

Rabi Poudyal (Tech QnA Expert)

How to install Windows games on Ubuntu
How do I install and play Windows games on Ubuntu? What is this 

“dependency is not satisfiable” error and how do I get rid of it?

Wine and PlayonLinux are needed to play Windows games on 
Ubuntu. You can simply install these by typing sudo apt-

get install wine playonlinux.
While trying to install any packages on Ubuntu, it may require 

some other dependency. Some packages depends upon other 
packages, those packages are called dependencies for the package 
being installed. You need to install the dependency packages to 
install the final package.

For example, some of the dependency packages of wine are 
libfmt-support and libaudio2.

It is generally faced during off-line package installation. You 
need to download the package and its dependency, and install 
using dpkg command. After installing all packages use the fol-
lowing command.

sudo apt-get -f install
This command will install all packages with dependencies resolved.

Rabi Poudyal (Tech QnA Expert)
 

FIFA 07 keeps crashing
I have a Windows XP SP3 PC that runs on an Intel P4, 3.00 GHz 

processor with 512 MB of RAM. I recently reinstalled Windows XP on my 
computer because it had crashed due to a virus. Earlier, I had installed 
FIFA 07 on it and it was working perfectly. After rebooting, I reinstalled 
the game. However, when I try to run it now, a window opens saying:

“FiIFA07.exe has encountered a problem and needs to close. We 
are sorry for the inconvenience. If you were in the middle of some-
thing, the information you were working on might be lost”

I have tried reinstalling the game but it still does not work. 
Should I upgrade to Service Pack 3? Please help!

I think you should upgrade to SP3 and update your graphics 
card drivers. You should also check what applications you 

have installed on your system that were not installed on your 
previous Windows installation and clean your registry with any 

good registry cleaner. You can try using CCleaner for this purpose 

and check if your problem is fixed or not.
Navjot Tomer (Tech QnA Expert)

Surround sound audio editing
I wanted to know about software for 5.1 channel audio editing. 

Can you name the software?

Almost all popular audio editing programs available can 
render 5.1 channel surround sound. A couple of examples are 

below: Sony ACID Pro (http://www.sonycreativesoftware.com/
acidpro/mixing) Vegas Pro 8 (http://www.sonycreativesoftware.
com/vegaspro) Supports audio as well as video editing.

Nagarjun Bodduna (Tech QnA Expert)

How do re-enable the registry editor on Windows
While installing any game or any application, I try to add informa-

tion to the registry, a message pops up saying — “Registry editor is 
disabled by your administrator”. I can’t run that program because of 
this. Do you have any solution? 

To enable the registry editor after it was disabled by some 
malware, try the following to regain access:

Click on the Start > Run and type gpedit.msc on the 

field. Go to User Configuration > Administrative 
Templates > System.

On the option Prevent access to registry edit-
ing tools, Click Disabled and click on the OK button to save 
settings. Now type regedit from the Run dialogue.

Jagdeep Virdi (Tech QnA Expert)

NTLDR missing errors — XP won’t boot!
I use Windows XP SP2. While booting, it shows an error message 

that the file NTLDR is missing. Press Ctrl+Alt+Del to restart your PC. 
After restarting, I continue to get the same error. What should I do?

Enter the recovery console by booting into the Windows Setup 
CD. In the console, use the EXTRACT command from the I386 

folder into the root of your Windows partition.

Sanjeev Chharia (Tech QnA Expert)

Trouble installing Windows 7
When I tried to install Windows 7, it did not work. It shows a 

message — “Upgrade to Windows 7, the computer needs to be running 
Windows Vista with Service Pack 1 (SP1) or later. Upgrading from 
Windows XP to any edition of Windows 7 is not supported. You can 
choose to install a new copy of Windows 7 Ultimate instead, but this 
is different from an upgrade, and does not keep your files, settings, 
and programs. You’ll need to reinstall any programs using the original 
installation disks or files. To save your files before installing Windows, 
back them up to an external location such as a CD, DVD, or external 
hard drive. To install a new copy of Windows 7 Ultimate, click the Back 
button and select “Custom (advanced)”.

You need to have Windows Vista as a prerequisite to install 
Windows 7. All your previous software installed on Windows 

Vista will get removed once you install Windows 7. Windows 7 
cannot be installed as an update and you can’t keep the files in 
the installation drive intact. Back them up.

Aditya Rupani (Tech QnA Expert)

Access to the Registry Editor can be re-enabled from the Group Policy Editor 

The Conficker worm blocks 
access to antivirus sites and 
also www.microsoft.com

CCleaner can clear up the Windows registry and sometimes speed it up a bit

Vegas Pro was initially developed 
and published by Sonic Foundry

TOOLBOXTOOLBOX
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Did you know?
Did you know that digital cameras 
have firmware that can be updated?

street smart
Agent 001

Agent001 doesn’t want you mistreating 
your camera! Here’s a list of accessories 
for extending your life and getting more 
out of it!

Camera
accessories

Agent001

D
gital cameras have been in the 
market long enough and people 
have taken great interest in them. 
Accessories for cameras are meant 

for more than just maintenance. Here we 
look at the kinds of accessories available in 
the market and the money you will have to 
shell out for them.

For dSLRs, an additional lens is more 
than just an accessory. Cheaper dSLRs are 
usually bundled with a basic 18-55 mm lens 
and the very next requirement for amateur 
dSLR users is a zoom lens. For example, an 
18-200 zoom lens is good both for wide-angle 
and telescopic shots. Third-party lenses are 
also available from manufacturers such as 
Tamron and Sigma. Check if your camera 
supports the lens you opt for. You also get 
55-250 or 75-300 mm zoom lens. These are 
priced around the Rs. 10,000 mark. Image 
stabilisation usually costs a little more and 
prices can be slightly higher. For example, 
a 70-300 mm Sigma lens is priced around 
Rs. 9,000 and a 150-500 mm lens is approxi-
mately Rs. 52,000. 

Filters are used to create certain effects 
without the need for further processing of 
the images. These are used in a way similar 
to lenses and are fitted atop the existing lens. 
UV filters and polarising filters help improve 
image contrasts, and a UV filter is needed at 
high altitude in the mountains. A neutral 
filter is often used simply to protect the lens 
from contact or damage and can also protect 
from dust and accidental fingerprints on 
the lens. Most of the basic filters range from 
Rs. 500 to Rs. 2,000. It’s a good idea to have 
a basic filter that can help protect the lens 
without adding unnecessary colouration or 
distortion to the image. 

A tripod is a must-have for every photog-
raphy enthusiast. It helps to keep the camera 
stable so you don’t end up with blurry images 
due to jittery hands. The size of a tripod 
isn’t as important as its quality. Tripods 
can be relatively cheap and you can buy 
small compact ones from well-known brands 
such as Vivitar and Manfrotto for between  
Rs. 1,300 to Rs. 3,000. These are good for 

picnics or hikes. With it all folded up, they 
can easily fit into a back pack. For the more 
professional, heavy-duty tripods, keep aside 
at least Rs. 5,000 to Rs. 10,000 for high-end 
kit from brands such as Benro. Monopods 
are cheaper and can be bought for Rs. 2,500 
to Rs. 5,000 or so. Watch out for cheap plastic 
tripods. Carbon fibre tripods are rigid, and 
not as heavy to carry. Metal tripods are best 
left in the studio.

dSLR owners will always have a few 
complaints about the performance of the 
flash on their cameras. They’re generally too 
weak and aren’t easily controlled. Flash kits 
are available for different cameras makes. A 
basic flashgun such as the Nikon SB400 is 
under Rs. 6,000, whereas the more superior 
SB600 is priced around Rs. 12,000. The advan-
tages these bring are better control using the 
display on the flash unit, more power, faster 
charging and greater flexibility in position-
ing the flash. Each brand has its own set of 
compatible flash units that can be mounted 
on the cameras; prices vary.

A carry pouch helps in carrying your 
camera without damaging it. The cost of 
a pouch is really low and good ones for a 
point-and-shoot camera under Rs. 500. A 
slightly larger handbag with sections to keep 
a battery charger and other bits will cost you 
somewhere between Rs. 1,000 and Rs. 3,000 
for brands such as Lowepro. Those who want 
to go out on outings for shooting should 
invest in complete bags with provisions for 
the flash, batteries, extra lens, a laptop and 
even a tripod. Models start from around  
Rs. 3,000 and go up to as high as Rs. 15,000.

Like any other expensive electronic prod-
uct, cleaning and maintaining cameras is a 
must. One of the first things to buy for the lens 
and the LCD display is a lint-free micro-fibre 
cloth and/or a lipstick-style lens brush. Cost 
range in the hundreds of Rupees. A small hand-
powered air blower that costs around Rs. 15 is 
also worth keeping in your carry bag to blow 
off loose dust from the crevices. 

Film cameras used up film rolls, but 
when it comes to digital cameras, battery 
consumption is significant; especially, when 
you’re clicking with your flash turned on. 
On a typical charge, it’s possible to take over 
150 to 200 photos on a standard point-and-
shoot camera. Buy additional Li-ion batteries 
that are compatible with your camera. For a 
dSLR, a power pack costs around Rs. 1,000 for 
entry-level model and around Rs. 2,000 for 
the higher-end.

With AA batteries, you can always put 
in a new set and continue shooting. AA 
batteries are easy to find if you run out 
of charge. Uniross and Sanyo’s Eneloop 
rechargeable batteries are known to charge 
quickly and don’t discharge for long periods. 
Although slightly expensive compared to 
other rechargeable batteries, they still make 
a good buy in the long run. Expect to pay 
around Rs. 600 to Rs. 800 for a two-battery 
set and a charger. 

Memory cards are cheap and for 
a point-and-shoot, a 2 GB standard SD 
memory card from Sandisk    or Kingston is 
nothing more than Rs. 600. Sony’s propri-
etary memory cards can be costly. SanDisk 
also manufactures MemoryStick Pro Duo 
cards for use with Sony cameras. A 2 GB 
Sony MS card costs Rs. 1,050 and a 4 GB 
one is available for Rs. 1,799.  Most dSLRs 
also use SD cards, but it’s a good idea 
to go in for the high capacity SD (SDHC) 
cards. A 4 GB SDHC card can be bought 
for around Rs. 2,000 and an 8 GB one 
for around Rs. 3,200. Some cameras use 
CompactFlash cards. This format is a little 
bulkier than standard SDHC cards, but 
there are high-performance CF cards from 
SanDisk – Extreme III and Extreme IV. The 
price of a SanDisk Extreme IV 4 GB CF card 
is around Rs. 3,000 and Rs. 6,050 for an 8 
GB card. SanDisk Extreme III CF cards are 
around 20 to 30 per cent cheaper depend-
ing on the capacity. n

agent001@thinkdigit.com

A
sh

w
in

i B
av

is
ka

r



DIGIT MAY 2009 97

XXX
Xxxx xxxxxxxxxxxxxxx
Xxxx xxxxxxxxxxxxxxx 76 XXX

Xxxx xxxxxxxxxxxxxxx
Xxxx xxxxxxxxxxxxxxx76 XXX

Xxxx xxxxxxxxxxxxxxx
Xxxx xxxxxxxxxxxxxxx 76NVIDIAs GTX 275 makes a 

splash with very competitive 
prices and performance just 
behind the GTX 285

Seagate’s new 5400.6 
Momentus notebook drives 
pack up to 250 GB on a 
single platter

Know more about the 
exciting Digit carnival 
next month

My PC configuration is an Intel Core 2 Duo 
E8400, MSI P7NGM-Digital motherboard, 

2X2 GB Corsair XMS2 RAM, CoolerMaster 600 
Watts Xtreme Power PSU. I want to buy a 22-
inch LCD monitor and a graphic card. I have 
decided upon Dell 2209WA and ZOTAC 9800 
GTX+ AMP Edition or an MSI 9800 GTX+ 
T2D512. Can I get anything better for a budget 
of Rs. 25,000? And please help me decide 
upon the graphic card. My basic requirement 
is gaming and multimedia. I would also be 
using Photoshop and Maya.

Charles Peter, Ghaziabad

The Dell 2209WA is a good monitor by all 
accounts, but why spend around Rs. 15,000 
on a 22-inch monitor from Dell when you 
can spend Rs. 10,000-12,000 on other 22-
inch monitors from brands such as Acer 
and ViewSonic. Instead of a 
GeForce 9800 GTX+ you could 
spend a little more, say up to 
Rs. 17,000 and get yourself an 
ATI Radeon HD 4870, which 
is a much faster card. With a 
monitor priced at Rs. 10,000, 
this just exceeds your budget 
by Rs. 2,000 but will be more 
future proof.

My PC configuration is as 
follows: Intel Core 2 Duo 

4400 @ 2.0 GHz, Dynet 2 GB @ 
667 MHz DDR2, Intel D945GCNL 
Motherboard, LG 17-inch Flatron. 
Please suggest a good graphics 
card below Rs.3000?

Mohit Shah

I recommend a graphics card based on the 
GeForce 9400GT chipset. Brands to look 
at are Palit, ZOTAC, EVGA and MSI. These 
should be the slightly cheaper priced cards 
available. Expect to pay anywhere between 
Rs. 2,800 and Rs. 3,400. Try to get a card 
with 512 MB of video memory.

My configuration is as follows: P4 HT 
2.8GHz, Intel 865 GVHZ board, 1GB 444 

MHz RAM, 400W power supply. Can I add a 
graphics card to my board as there is no AGP 
slot present. I only see PCI slots. I also asked 
several vendors for a PCI graphics card, but 
they told me that the result or performance of 
a PCI graphics card is not good. Should I 
increase the RAM or is there a solution for 
graphics on my board? Budget is not a prob-
lem. Can I overclock this board?

Bhushan Nandane
I have one word of advice for you – upgrade! 
Components are at all time low prices and 
you can pick up a reasonably fast configu-
ration for around Rs. 25,000 without a 
monitor, which you no doubt already have. 
In case you do not want to upgrade there 
are a couple of very costly options for you. 
The PCI version of the GeForce 6200 GPU 
is available but it’ll cost you Rs. 4,000, or 

thereabouts, and is priced higher than the 
PCIe version of a GeForce 9400GT, which 
is a much newer card. Increasing the RAM 
will do little to make your current configu-
ration faster. DDR RAM is also double 
the price of DDR2 RAM. Your PC is sadly 
outdated and I reiterate – upgrade it.

I want to buy a good, cheap, value-for-
money large capacity hard disk, prefera-

bly an internal one, which I want to use exter-
nally since I have no available power supply to 
spare. Please suggest a hard disk for me and 
also what I need to buy in order to convert it 
into a temporary external solution.

Eric Pereira 

All 3.5-inch external solutions need an 
external power supply. In case you want 

an external solution with-
out the need of a power 
supply, you can look at 2.5-
inch external solutions that 
draw all the power they 
need from the USB port. I’d 
suggest a 320-GB external 
solution priced at around 
Rs. 4,500. In case you want 
something really colos-
sal, to the tune of 1 TB or 
more, then you had better 
stick to a 3.5-inch solution 
as these are cheaper. Buy 
the Seagate 1 TB 7200.11 
series hard drive. Priced at 
Rs. 6,500 in the street, it’s 

great value for money. Unfortunately, 
when you convert it to an external solu-
tion you will discover you need an exter-
nal power connection. Why not buy a 
spike guard to solve this problem? For 
the external case (in case you are buying 
an internal drive) look at vendors such 
as Zippy and Transcend, their cases are 
decent.

I want to buy a high-end graphics card – 
which one is better, the GTX 295 or 

Radeon HD 4870 x2?

The GeForce GTX 295 is the newer and 
faster card. It should be priced at Rs. 35,000 
or so. Look for brands such as EVGA, Palit, 
ZOTAC and MSI. These are priced slightly 
lower than brands such as ASUS, Gigabyte 
and XFX.

I Want To Buy an MFD with good print 
quality. My budget is around Rs. 10,000. 

Please suggest something. Can I print photo-
graphs with such a printer?

Pawan Maurya

In case you do not need the additional 
fax feature, look at the Canon MP 486, 
available at a price of Rs. 8,495. It’s a good 
printer and will satisfy the need for a photo 
printer as well.

My current configuration is: Intel P4 (3.0 
GHz), MSI G31M3, 2X2GB DDR2 800, XFX 

9500GT 512 MB, Samsung 320GB (SATA), 
Odyssey 450 W PSU. I upgraded to this config-
uration around a month back. I played games 
such as Crysis, Prince of Persia, NFS 
Undercover at minimal resolution. I want to 
play at higher quality settings without getting 
my system to hang. I’m totally confused in 
choosing the processor (Q6600 / Q8200). 

Please help me to choose any one among 
these processors and also a better solution 
for the power supply. I have a budget of  
Rs. 10,000.

Dhamodharen Sundar

Your PSU is unable to supply the required 
power and for this reason your PC is hang-
ing. First, I recommend you upgrade your 
power supply to a Corsair VX 450 – that 
should cost you around Rs. 4,000. After 
that, upgrade your graphics card to a 
GeForce 9600 GT. This will make a huge 
difference to the performance. Such a card 
will set you back around Rs. 6,000. Next, 
please upgrade your CPU. I recommend 
buying at least a Core 2 Duo E7400. Priced 
at Rs. 6,000 this CPU will reduce the bottle-
neck on your GPU.
 

I’m planning to buy a netbook. My 
budget is Rs.25,000. I’m going to

use it for basic multimedia (watching HD 
movies and playing music), work
on PowerPoint and Excel, and surf the net. 
Which is the best one I can
get around Bangalore at the given budget?

Arnie Adderstone
I don’t think any netbooks are powerful 
enough to allow you watch any kind of 
HD content on them, but for regular 
DVD movies you should be covered. Do  
remember that netbooks do not have 
an optical drives. I recommend ASUS’ 
EEPC 1000HA that has a 10-inch display. 
Alternatively you could look at the Acer 
Aspire One D150. Both these netbooks 
should be around the Rs 25,000 mark on 
the street. n

Want a tech product, but 
don’t know how to go about 
buying it? Email
agent001@thinkdigit.com
with your complete 
contact details, and he might 
answer them here! Please 
note that Agent001 only 
answers purchase-related 
questions in this space.

Ask Away

Corsair VX450

Canon MP 486
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nSeagate 250 GB 7200.11 / Rs. 1,900
nSeagate 1 TB 7200.11 / Rs. 5,500
nSeagate 500 GB x 2 RAID 0 (7200.12) / Rs. 7,000 

nVIP 350 Watts / Rs. 850 
nCorsair TX 650 / Rs. 6,500
nCorsair HX 1000 / Rs. 13,500

nZebronics Antibiotic / Rs. 2,100
nCoolerMaster 690 / Rs. 4,400
nCoolerMaster STACKER RC 832 / Rs. 14,500 

nOnboard / NA
nPalit Radeon HD 4870 1 GB SONIC / Rs. 15,325
nZOTAC GeForce GTX 295 / Rs. 35,000 

nAcer 1916W / Rs. 6,800 
nDell E228WFP / Rs. 14,500
nLG 246 Wp / Rs. 23,000

nASUS NVIDIA 7025 M2N68-AM /  Rs. 2,250
nMSI P45 Platinum / Rs. 9,000
nIntel DX58SO / Rs. 16,000

n None 
nAltec Lansing MX 5021 / Rs. 6,500
nLogitech Z5500 / Rs. 14,000

nLogitech 3 button scroll / Rs. 300
nLogitech MX518 / Rs. 1,300
nRazer DeathAdder / Rs. 2,500

nOnboard / NA
nASUS Xonar DX / Rs. 3,700 
nCreative X-Fi Titanium / Rs. 12,000

n2 GB DDR2 800 MHz (Kingston Value) / Rs. 1,050
n2 GB x 2 DDR2 800 MHz (Corsair XMS2) / Rs. 3,350
n2 GB x 3 DDR3 1600 MHz OCZ Platinum XTC / Rs. 18,000

n AMD Athlon XP 6000+ / Rs. 2,850
nIntel Core 2 Duo E8400 / Rs. 8,200
nIntel Core i7 940 / Rs. 26,000

n Logitech Multimedia / Rs. 1,750
nLogitech G15 / Rs. 4,000
nLogitech G15 / Rs. 4,000

KILLER RIGS
nBasic rig = Rs. 19,150 
nMultimedia-cum-gaming rig = Rs. 86,300 
nUltra high-end PC / Gaming rig = Rs. 1,92,000
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everything you will ever need to build your own PC. whatever your budget.
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Let’s take one example, from Manoj Nair in Chennai. He 
has had repeated problems with his Compaq Presario V3225AU. 
I spoke to him just before writing this, and he told me that so 
far his motherboard had been repaired or replaced a total of 
eight times! He felt very little confidence that his laptop would 
now be free from problems, particularly because service centre 
engineers had told him that the particular graphics processor 
and CPU in this model are not suitable for the Indian market, 
they are subject to overheating and consequent failure of the 
motherboard. 

He wonders why HP does not fix the underlying problem 
rather than repeatedly repairing his machine. However, he 
has found HP very unresponsive to his requests, except the 
fact that the company does keep fixing the machine. Another 
reader, Nishant Mohan, has had similar problems with exactly 
the same model. His has failed four times now, and it takes a 
month each time to have it fixed.

Others have made similar comments, that HP is a very 
uncommunicative company, although often good, but slow, 
at fixing machines. This is also our experience. At the time of 
writing, HP has not satisfactorily resolved or answered any of 
the reader problems that we have passed on.

Another example: reader Dr. Sanjay Tharoor in 
Thiruvanathapuram purchased an HP Pavilion Laptop 
DV9312TX back in July 2007. After a year, his motherboard 
needed replacing, and this took a whole month, just as 
Mishant Mohan had described. The motherboard failed again, 
and the machine was returned to him, after a delay of more 
than one month, at the very beginning of April. I spoke to him 
a couple of weeks later, and the system had failed yet again, 
and he was just about to deliver it back to HP. He pointed out 
that one would expect better from a laptop that cost over  
Rs. 60,000! Indeed...

No wonder he feels “much frustration and anger”, and also 
thinks that a better course than repairing the same system 
time and again would be to give him a different model. One 
cannot help but wonder if the HP engineers also consider this 
one to be unsuitable for the Indian market and climate.

We look forward to hearing some positive responses from 
HP to these and other similar issues. n

Edward Henning

Digit subscriptions
It had to happen. Having started a series of occasional articles 
on customer service, a few readers have written in to point out 
that there are times when our service at Digit does not meet 
expectations. This mainly takes the form of the magazine 
either turning up late or failing to arrive at all for subscribers. 
Thankfully, there are few of these, but we picked a couple of 
them, and asked our subscription department to investigate.

G. Kumar wrote from Bangalore to say that he had renewed 
his subscription, but that the January issue had failed to 
arrive, even though he did receive the Febrauary issue on 31st 
January. Where the fault lies, we cannot be sure, but to the best 
of our understanding, the cheque for his subscription renewal 
was received late — too late in fact for it to clear before the 
beginning of January, and for this reason he was not on the list 
for the January issue. A copy has now been sent to him.

It is important to remember when renewing a subscrip-
tion, that it takes time, both for our subscription department 
to process the request and also for the banks to clear the 
cheque. Please be early when renewing.

Another reader, Pratik Gupta, wrote to say that he was also 
not receiving Digit, but he also expressed great frustration in 
trying to contact us to get help — specifically when calling our 
helpline. We found that the problem with his copies of Digit 
lay with the courier company that we were using to make the 
delivery, and as this has now been changed, we hope that he 
is reading this issue at the very beginning of May. We checked 
the new courier POD (proof of delivery) for the April issue, and 
it was delivered correctly on the 1st April.

In general, if you have problems because of either not 
receiving the magazine, or it is arriving late, please call the 
helpline, on +91-22-4078 9612 / 13 / 14 — but only in normal 
office working hours, between 9.30 am and 6.30 pm, Monday to 
Friday. You can also use email: help@thinkdigit.com. Of course, 
if all this fails, you can also do what these two readers did, and 
email us at: servicewatch@thinkdigit.com.

Does Hewlett-Packard have service problems?
Since having suggested to readers that they write to us if they 
are having some particularly bad support or service experi-
ence with a vendor, we have received a steady trickle of emails. 
Surprisingly, at one point, nine out of the 18 complaints we had 
received concerned just one company, HP. The ratio is down now, 
and about 40 per cent concern HP; but this is still far too high. 
So, is this a statistical cluster, or does HP really have a problem? 
I am still discussing this with HP, but it seems that the company 
does have problems that need to be addressed.

Problems at home and 
problems with HP
Some readers have pointed out to us that Digit also has problems with service when it comes 
to delivering subscription copies on time, and a surprising number are having a real struggle 

with Hewlett-Packard, particularly regarding laptops

Service problems? Write in the servicewatch@thinkdigit.com 
and we’ll do our best to help to resolve them

Know your rights
You are allowed to rip DVDs for home use

consumer  
protection
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Stuff we would buy...

Model Market Price Tested in Socket PCI-e x8/x16 slots SATA Ports No of rear USB Ports
ASUS M3A Rs. 4,950 AM2+ 1 4 4

ASUS M3N78-EH (Geforce 8200, AMD) Rs. 5,450 November 2008 AM2+ 1 6 4
ASUS P5Q Deluxe Rs. 12,600 June 2008 LGA775 2 6 6
ASUS P5Q-E Rs. 10,800 LGA775 2 6 8
ASUS P5Q-PRO
ASUS P6T Deluxe Rs. 20,800 April 2009 LGA1366 3 6 8
Gigabyte GA-EP45-DS3R Rs. 8,500 LGA775 2 6 8
Gigabyte GA-EX58-UD5 Rs. 17,650 LGA775 3 6 8
MSI X58 Eclipse Rs. 20,500 LGA1366 3 10 8
Zotac 780i Supreme Rs. 14,500 AM2+ 3 6 6

Motherboards

Model Market Price Tested in Socket Speed FSB L2 Cache

AMD Athlon X2 5200+ Rs. 3,000 November 2008 AM2+ 2.7 GHz 2000 MHz 
HyperTransport 1 MB

AMD Athlon X2 5600+ Rs. 3,675 November 2008 AM2+ 2.9 GHz 2000 MHz 
HyperTransport 1 MB

AMD Phenom 2 X4 920 Rs. 10,975 AM2+ 2.8 GHz 3600 MHz 
HyperTransport 2 MB

AMD Phenom X4 9550 Rs. 6,850 November 2008 AM2+ 2.2 GHz 3600 MHz 
HyperTransport 2 MB

AMD Phenom X4 9650 Rs. 6,800 November 2008 AM2+ 2.3 GHz 3600 MHz 
HyperTransport 2 MB

AMD Phenom X4 9850 Black Rs. 8,000 November 2008 AM2+ 2.5 GHz 4000 MHz 
HyperTransport 2 MB

AMD X2 6000+ Rs. 4,175 November 2008 AM2+ 3.1 GHz 2000 MHz 
HyperTransport 2 MB

Intel Core 2 Duo E5200 Rs. 3,500 November 2008 LGA775 2.5 GHz 800 MHz 2 MB
Intel Core 2 Duo E7300 Rs. 5,750 LGA775 2.66 GHz 1066 MHz 3 MB
Intel Core 2 Duo E8400 Rs. 9,050 LGA775 3 GHz 1333 MHz 6 MB
Intel Core 2 Duo E8500 Rs. 9,600 March 2008 LGA775 3.16 GHz 1333 MHz 6 MB
Intel Core 2 Quad Q6600 Rs. 9,750 November 2007 LGA775 2.4 GHz 1066 MHz 8 MB

Intel Core 2 Quad Q8200 Rs. 9,025 November 2008 LGA775 2.33 GHz 1333 MHz 4 MB

Intel Core 2 Quad Q9550 Rs. 14,850 LGA775 2.83 GHz 1333 MHz 12 MB
Intel Core i7 920 Rs. 15,100 April 2009 LGA1366 2.66 GHz 4.8GT/s QPI NA

Processors

Model Market Price Tested in Size Resolution Contrast Ratio Response time
Acer AL1916 Rs. 6,500 19-inch 1280 x 1024 700 : 1 8 ms
Acer AL2216 Rs. 9,800 22-inch 1680 x 1050 700 : 1 5 ms
BenQ T2200HD Rs. 9,750 21.5-inch 1920 x 1080 1000 : 1 5 ms
Dell 1909W Rs. 7,200 19-inch 1440 x 900 1000 : 1 5 ms
Dell S1709W Rs. 6,550 17-inch 1440 x 900 600 : 1 8 ms
LG 177WSB Rs. 6,400 May 2008 17-inch 1440 x 900 700 : 1 8 ms
LG W192W Rs. 7,550 19-inch 1440 x 900 700 : 1 5 ms
LG W1942S Rs. 7,100 19-inch 1440 x 900 700 : 1 5 ms
Samsung 2033SW Rs. 7,850 20-inch 1600 x 900 15000 : 1 5 ms
Samsung 740NW Rs. 6,500 17-inch 1280 x 720 500 : 1 8 ms
Samsung 743NX Rs. 7,300 17-inch 1280 x 1024 500 : 1 5 ms
Samsung 943NWX Rs. 7,500 19-inch 1280 x 1024 1000 : 1 5 ms
ViewSonic VA1918WM Rs. 6,600 19-inch 1440 x 900 1000 : 1 5 ms
ViewSonic VX2255wmb Rs. 12,500 May 2008 22-inch 1680 x 1050 1000 : 1 5 ms
ViewSonic VX2835WM Rs. 28,000 28-inch 1920 x 1200 1000 : 1 3 ms

Monitors

80 Plus is a certificate on 
Power Supplies that are 80% 
energy efficient
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Model Market Price Tested in PCIe connectors SATA connectors MOLEX connectors
VIP 400 EX Series Rs. 1,150 NA NA NA
VIP 400W SMPS Temperature-controlled Rs. 1,650 NA NA NA
Zebronics ZEB 400W Power Supply Rs. 1,475 1 NA NA
POV Black Diamond 400W Rs. 2,512 2 2 6
Corsair 400CX Power Supply Rs. 3,300 1 6 6
Cooler Master Extreme Power 460W Rs. 2,425 1 4 5
Corsair 450VX Power Supply Rs. 3,950 2 (1x 8-pin) 6 6
Zebronics Pro 500W Power Supply Rs. 3,120 1 4 6
Cooler Master Real Power Pro 550W Rs. 5,450 2 6 5
Tagan BZ600 600W Modular Power Supply Rs. 6,050 2 (1 x 8-pin) 5 4
Corsair 620HX Power Supply Rs. 7,900 2 8 10

Power Supply Units

Model Market Price Tested in Core Speed Type of memory Memory

EVGA 9600GT Knock-out Rs. 7,350 November 2008 700 MHz GDDR3 512 MB

EVGA 9800GT (Super Clocked) Rs. 9,250 650 MHz GDDR3 512 MB
Palit GeForce 9400 GT Rs. 2,400 550 MHz GDDR2 512 MB
Palit Radeon HD 4850 SONIC Rs. 9,265 685 MHz GDDR5 512 MB
Palit Radeon HD 4870 1 GB SONIC Rs. 15,325 750 MHz GDDR5 1024 MB
Palit Radeon HD 4870 SONIC Rs. 13,725 October 2008 750 MHz GDDR5 512 MB
XFX GeForce 8600 GT Rs. 3,400 540 MHz GDDR2 256 MB
ZOTAC 9800 GTX+ AMP! Edition Rs. 11,150 October 2008 738 MHz GDDR3 512 MB
ZOTAC GeForce GTS 250 Rs. 10,350 738 MHz GDDR3 1024 MB
ZOTAC GeForce GTX 260 Rs. 17,000 650 MHz GDDR3 896 MB
ZOTAC GeForce GTX 285 Rs. 24,900 February 2009 648 MHz GDDR3 1024 MB

Graphic Cards

Model Market Price Tested in Sensor Optical Zoom LCD Screen Size

Canon Powershot A740 Rs. 6,500 September 2008 7.1 MP 3.4x 2.5 inches
Canon A2000 IS Rs. 12,500 10 MP 6x 3.0 inches
Canon SX110IS Rs. 16,500 9 MP 10x 3.0 inches
Canon SX10IS Rs. 24,995 10 MP 20x 2.5 inches
Nikon COOLPIX L19 Rs. 7,250 8 MP 3.6x 2.7 inches
Olympus FE20 Rs. 5,800 8 MP 3x 2.5 inches
Panasonic FS5 Rs. 9,499 10 MP 4x 2.5 inches
Sony S950 Rs. 8,800 10 MP 4x 2.7 inches
Sony H10 Rs. 15,660 8.1 MP 10x 3.0 inches

Digital Cameras

Model Market Price Tested in Speed Cache Interface

Hitachi 500GB Rs. 2,975 7200 RPM NA SATA 2

Seagate 1.5TB Rs. 7,700 March 2009 7200RPM 32 SATA 2

Seagate 1TB Rs. 5,500 April 2009 7200 RPM 32 SATA 2

Seagate 7200.12 500 GB Rs. 3,250 April 2009 7200 RPM 32 SATA 2
Seagate 750GB Rs. 4,550 April 2009 7200 RPM 32 SATA 2
Western Digital Caviar Blue  640GB Rs. 3,700 7200 RPM 16 SATA 2
Western Digital Caviar Blue 1TB Rs. 5,150 7200 RPM 16 SATA 2
Western Digital Caviar Blue 750GB Rs. 4,450 7200 RPM 16 SATA 2

Hard Drives

ASUS Maximus II GENE 
launches in India and is based 
on the Intel P45 chipset
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Siddharth Parwatay

A 
business, be it small, medium sized or large, has some 
basic computing prerequisites. First there should be IT 
stability. This means that downtimes are strictly unac-
ceptable. Productivity should ideally never have to be 

halted on account of failure in the IT backbone of a company. 
Another prerequisite that makes complete business sense is 
lowering the cost of infrastructure. Most businesses these days 
are trying to lower their TCO (Total Cost of Ownership) by any 
means possible.

A buzzword that’s been doing the rounds lately promises to 
take care of the above requirements. That word is virtualization. 
This solution is expected to improve utilisation, reduce costs, 

increase productivity and aid disaster recovery. The current 
adoption rate of virtualization in India is at around 19 per cent 
but is expected to quadruple in the next two years.

What is Virtualization? 
Virtualization basically means abstraction of computer resources. 
But to get a better understanding of what that really means, one 
must delve deeper into its forms. Virtualization has several vari-
ants but the ones that makes most sense in the business arena 
are platform virtualization, and — at the other end of the spec-
trum — desktop virtualization. 

Let’s look at platform virtualization first. Platform virtual-
ization is performed on a given hardware platform by virtualiza-
tion software, which creates a simulated computer environment, 
a virtual machine, for its guest software. The guest software here 
is a fully functional operating system. This means that one piece 
of hardware or computer can have several virtual machines (VMs) 
running within it simultaneously. Each one of those machines 
has its own virtual components such as memory and storage 
space. Each one of the VMs have an operating system. This is 
all possible thanks to advances in hardware technology such as 
quad core processors that are so powerful that they have plenty 
of resources to spare. In such a scenario, you actually have one 
server but it acts as though it were several servers. Virtualization 
software enables that server to be split up into different parti-
tions. With virtualization, each server’s programs, files, and 
processes are merged into one image file. This will be one of the 
many image files constituting each of the virtual servers.

Therefore, one physical server could act as, say, three virtual 
servers with each virtual server performing a specific, and differ-
ent, function. You could have a Windows-based file server, while 
another could be a Linux web server hosting web sites on Apache. 
Another could be a DBMS server based on another platform. Each 
virtual server acts completely independently from one another, 
hosted on a virtual abstraction layer provided by the virtualiza-
tion software. If one server crashes, the others are not affected. 
The net result is that you have to buy only one powerful physical 
server and you get the benefit of three servers for the cost of 
that one.

Desktop virtualization, on the other hand, is a variant of 
the thin client model, only with greater flexibility. For example, 
users can use a stripped down PC as a client, connect to virtual 
resources and software on a server, but at the same time have the 
freedom to install and configure their own applications. A user’s 
server-based desktop can be accessed from other locations as well. 
However, since this variant is discussed more commonly, we will 
look more at hardware or server virtualization.

What server virtualization software is available and 
how does it work?
VMware currently has the largest market share worldwide when 
it comes to server virtualization software. It has both free as well 
as paid options. VMware Server and VMware ESXi are free solu-
tions. Virtualization software is installed as an application on 
top of a host Windows or Linux operating system. Once installed, 
a thin virtualization layer partitions the physical server to 
be able to run multiple VMs simultaneously. The computing 
resources of the physical server are pooled and allocated to the 
VMs as per their needs. The layer of virtualization ensures that 
each VM is isolated from its host and other VMs. Within the 
limits of your hardware configuration you generally get near 
native performance.

The other options for server virtualization software are paid 
solutions such as XenServer from Citrix and Parallel’s Virtuozzo 
Containers. In the open source world you have OpenVZ  and 
Linux V-Server. There is also a popular application called Virtual 
Box, which many home users would’ve tried.
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Server utilisation would commonly be at 
around 12% in most organisations

In a recent report, McKinsey is 
more gung-ho about virtuali-
zation than cloud computing

The virtualization concept 
dates back to the days of 
Mainframe computing

What are its advantages?
An obvious benefit of consolidating hardware in such a way 
is cost saving. Consolidation of IT resources improves server 
utilization and consequently increases efficiency, lowers power 
consumption, and reduces the need for physical real estate.

Since hardware resources are utilised more efficiently, 
the compute capacity on each physical server is maximised. 
Thus the utilisation of resources increases by at least 5 to 15 
per cent. It is important to note that savings increase propor-
tionately with the number of servers that are consolidated by 
a business. If only a handful of servers are deployed as VMs, 
then savings will be significantly smaller. Some virtualization 
platforms claim to have a virtual consolidation ratio of 10:1. 
Consolidating servers results in increased ROI for both existing 
and future server expenditures. 

With virtualization, each server’s programs, files, and 
processes are merged into one file, and this file then placed 
among other images on one physical server. This means that 
software can easily be relocated bringing in an important aspect 
of portability. If upgrading to a better IT infrastructure the VMs 
can easily be moved without having to go through the lengthy 
process of setting up systems all over again. 

Small businesses sometimes even deploy virtualization as a 
way to simplify disaster recovery. Conventionally, disaster recov-
ery can be quite a harrowing ordeal to any IT admin personnel. 
Issues such as finding the right backup disks, offloading them 
on to new hardware, and encountering all sorts of problems such 
as not having a record of software licenses and not being able to 
find the original CDs for their operating systems and other appli-
cations are commonplace. Then comes the cumbersome process 
of re-installing and re-configuring everything and making it work 
on the new hardware. Virtualization on the other hand makes it 
easy to capture everything onto a single image file which makes 
recovery easier.

Another consequence of this attribute is that it becomes 
easy to quickly respond to growing business needs. Since virtual 
servers can be deployed on blade servers, which themselves are 
modular, it becomes easy to scale up the IT infrastructure.

Testing is another area where virtualization has its uses. In 
a virtual environment, virtual test servers can be quickly setup, 
tested and broken down or reconfigured. Some organizations are 
still running applications on legacy operating systems, which 
with the help of virtualized servers can now be run on the latest 

hardware. Security is also somewhat heightened. System admins 
go to great lengths to isolate each of the machines in a network 
by a complex system of firewalls and other measures. Now virtu-
alized servers can reside on the same physical server and yet 
remain in their own encapsulated environment.

Your roadmap to virtualization
Now that you know the benefits of virtualization it is important 
to know a few points that will act as guidelines for your enter-
prise to enter the virtualized world.

Assess your needs: the first step in a virtualization deploy-
ment programme should be to assess your needs. Make a business 
case for virtualization and determine whether the technology 
will indeed provide a return on investment. Businesses should 
look at how their current servers are being utilised and answer 
the following questions
l 	Are common applications running on several different servers?
l 	Are there enough servers that could and should be consoli-

dated?
l 	Is the business’s server requirement likely to increase?

Licensing and tech support: it is important to check if current 
software licenses can be migrated to the virtualized servers. Also, 
some application developers may be unwilling to provide techni-
cal support to their applications when they’re moved to a virtual-
ized environment.
 
Virtualization deployment plan:
an SMB must understand the importance of a sound plan. 
Timelines, budgets and an implementation programme should 
be chalked out. Backing up data is very important. Also, the 
plan should be technically sound. For instance, it is important 
to assess the hardware requirements of each virtual machine. 
i.e. how much hardware is needed for it to operate smoothly. 
The number of VMs should not be allowed to exceed what the 
hardware is able to support. A thorough implementation plan 
will help the enterprise minimise glitches. n

siddharth.parwatay@thinkdigit.com
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Application virtualization is an interesting variant of virtualization. 
Unlike server virtualization, where an isolation layer is built around each 
OS, here, an isolation layer is built around each appli-
cation. So, in effect, the application is wrapped 
or packaged by a layer that 
does not allow it 
to freely interact 
with the underly-
ing OS. This way the 
application is fooled 
into taking registry 
entries and other 
information from the 
virtual layer around 
it and hence the appli-
cation cannot damage 
the OS. Virtualized 
applications can there-
fore run alongside each 
other perfectly well. In fact, 
different versions can also 
run alongside each other with-
out causing any conflicts. Hence, 
every application is a nice little bundle that can be very easily 
distributed. In effect the virtualized program can be streamed or 
deployed from one central server to clients. Error resolution becomes 
simpler and so does updating the package. In the context of large work-
places where deployment is a hassle, this makes good sense. Altiris SVS 
(Software Virtualization Solution), Microsoft Application Virtualization 
(MAV) and XenApp are some of the AV options available. The way in 
which each of these solutions creates an abstraction layer differs other-
wise they’re quite similar in function.
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EDA stands for Electronic Design 
Automation, and denotes the design 
tools used for designing electronic 
systems such as integrated circuits

Siddharth Parwatay

C
hip designing is a challenging job with constant innova-
tion in process technology. In addition to its dynamic 
nature, there are challenges that need to be overcome as 
products become increasingly complex. At its base lies 

Electronics Engineering and Computer Science and like others, this 
industry too, is not without its lore and legend. 

The Indian story of VLSI began in 1985, when Texas Instruments 
set up the first design centre at Bangalore, thereby ushering in an era 
of wide-spread chip design and VLSI. Today, there are several companies 
in the field including AMD, Intel and NVIDIA, apart from companies 
engaged in ASIC (Application Specific Integrated Circuit) designs such as 
KPIT and Mindtree Consulting. VLSI design service companies brought 
in $927 million last year according to the ISA (Indian Semiconductor 
Association), from all three segments — analogue, digital and mixed 
signal. However, the industry is expected to shift to mixed signal in the 
coming years. Also, despite the difference in salaries slowly narrowing, 
having designs produced in India still presents a huge comparative 
advantage; so the future is bright.

The Indian link to VLSI
Processors and chips developed today contain hundreds of millions 
of transistors; hence, the term VLSI (very large scale integration). 
NVIDIA’s Indian operation has 780 employees across three sites – 
Bangalore, Pune and Hyderabad. According to Amit Verma, Director 
of Human Resources, NVIDIA (India), “In these centres, the focus is 
on end-to-end ASIC product development encompassing architec-
ture, RTL design, verification, timing, physical design, system engi-
neering (including board bring up and debugging) and quality assur-
ance for chipset and mobile products. NVIDIA’s Indian engineers are 
part of the company’s worldwide team and their contribution is vital 
to the business as a whole.” 

On the other hand, AMD has two centres in India, where AMD 
teams usually work on one or two products at a time. This involves 
a fair bit of interaction with the teams abroad. “Shanghai was, for 
example, a joint effort between Boston and India”, said Karthik 
Muthusamy, General Manager, India Design Centre at AMD India 
Engineering Centre
 
Basic requirements
Passion and having an early understanding of this field is essen-
tial. Aspirants will work with sophisticated design tools, chip 
architectures and test methods. So, apart from technical expertise, 
additional skill sets are also important. “Key areas that we look for 

in our engineers would be strong analytical skills, good problem 
solving skills, a willingness to work with teams as collaboration 
is a part of the job profile, and so a lot of communication skills.” 
said Rohit Vidwans , Director — Digital Enterprise Group (DEG), Intel 
India. Specific to chip design activities, companies look for engineers 
in Electrical and Computer Science, even Chemical engineers or 
someone with a strong background in Physics. As for degree certifi-
cation, companies hire all the way down from a Bachelors degree to 
a Masters in Science degree, as well as PhD holders; thus, spanning 
the entire spectrum of educational degrees.

Technical requirements
A strong hardware engineering background with specialisation in 
VLSI design is a must. Additionally, knowledge of digital systems 
and VLSI design, computer architecture, computer arithmetic, 
C/C++ programming languages, CMOS transistors and circuits is 
necessary. In VLSI design, tools play a major role. An integral part 
of an engineer’s work deals with using the latest industry tools 
from Synopsys, Cadence and other EDA vendors. An understand-
ing of hardware languages such as Verilog is also important. Other 
languages such as Perl and C come in handy too.  Processor descrip-
tion languages such as nML and Lisa will be an added plus if you are 
thinking of a career specialisation in microprocessor design.

“Apart from architecture and HDLs, chip designing in today’s 
world will need in-depth knowledge of even transaction level model-
ing using SystemC, knowledge of electronic design automation tools, 
and some understanding of the backend timing / manufacturing 
issues. Knowledge of simulation tools and interactions with memory 
/ cache design will also be needed.” says Sandeep Kumar a consultant 
architect at Coware India Pvt Ltd. Sandeep has sketched a successful 
career in this field, now spanning over 17 years of experience.
 
Recruitment
Companies are in search of highly motivated individuals with 
strong analytical and communication skills. Apart from educational 
degrees, companies are also interested in the fundamentals. “There 
are people who understand how to push the tools, but when we talk 
to candidates we try to see if they are familiar with fundamentals. 
For example, if we’re working on a GCC component we would want 
to know where you put this particular switch. Why here? Why do 
you use it? OK, you know how to use ASIC tools, but do you know 
why you did certain things that way? Ability to understand and pick 
up is important,” said Karthik from AMD. Arriving at the answer is 
as important as getting to the answer itself. So you can expect these 
kinds of questions in the interview rounds. Most companies have 
tests for analytical ability.

Talent is sourced by tying up with premier schools in the 

Be a Chip
off the 
old block
All that you ever wanted to know about a 
Career in VLSI and Chip Design
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Evidence from the VLSI world may 
suggest that Moore’s Law, which states 
that technical advances relating to chips 
double every 2 years, is slowing down

The use of integrated circuits by the 
US military in the 1960s marked the 
begining of widespread use of the 
new technology

country, where companies engage in open forums and interviews. 
Internship is another means. Intel has a very strong internship 
programme. Hiring engineering students as interns and having 
them work with their design teams lets students get a first-hand 
experience of what it’s like to work in this industry. At the end, 
companies take on the better ones as fulltime employees. This year, 
Intel has over 100-150 interns working in different development 
groups across India.

The intake varies widely from company to company. AMD 
believes in taking only a few people at a time. This is due to the steep 
learning curve. When it comes to microprocessor design, it doesn’t 
use large teams. The Athlon design was done with less than 200 
people. Therefore, finding the right talent is more important than 
making up the numbers.

Training
Some reports suggest that while sourcing talent, semiconductor 
companies find that is there a lack of engineers who can immedi-
ately be deployed on a design and that Indian electronics engineers 
need additional training and skill development. However, many 
industry insiders we spoke to beg to differ. In fact, they believe 
Indian engineers come with strong conceptual understanding and 
impressive learning aptitude. They need to be trained only on the 
latest tools and development methodologies as they are not usually 
exposed to these at the college level. However, they are able to pick 
up everything they need pretty quickly. 

When working on projects for designing low power chips, 
efficient multi-core architectures, mixed signal chips, memory 
sub-systems, interrupt controllers, and interfacing with video/audio 
processor, the basic textbook knowledge may be insufficient.

“Current curriculum touches the basics of computer architec-
ture, while taking up a school project and learning the relevant 
design automation tools, from companies like Cadence / Mentor 
Graphics / Synopsys will be a practical help,” said Sandeep. 

Some companies have strong mentorship programmes 
whereby junior engineers are paired with a senior engineer who 
coaches and guides them along their way. This is of course in 
addition to regular training programmes. 

Work culture
It’s not all work and no play when it 
comes to a career in chip designing. 
It’s a very young industry to work in 
and the average age of employees at 
most companies is low, making the work 
culture active and vibrant. Companies 
have extremely challenging programmes 
where the teams are motivated to 
deliver; but at the same time, there are 
several recreational activities such as 
team building, sports and quarterlies. 
Intel organises events that involve 
employees as well as their families 
such as  cricket sessions and tennis 
matches. So it’s a mixture of cutting 
edge work and fun.

Career path
Career paths in this industry are well 
defined for aspirants in both tech-
nical and management functions. 
Typically, an engineer takes about 
5 – 6 years to reach the position of a Senior Design Engineer. As the 
aspirant gains more work experience by working with different designs, 
he / she can advance to a Lead position. Post this level, the engineer can 

decide if he / she wants to continue in the technical function or move 
to a management function such as Project Manager, both of which are 
equally fulfilling depending on the inclination. How quickly you grow 
depends entirely on the individual ability. You can also branch off and 
choose to become an expert in a certain technology, for instance, L2 
design, and be a mentor or Senior Fellow.

As for the salaries in this industry, a fresher starts off at around 
5 lakhs per annum while a Lead Engineer generally gets 8 – 12 lakhs. 
In a few years, one can progress to Project Lead where 12 – 20 lakhs is 
the norm and the sky is the limit, depending on the brand.

Summing it up
To make a successful career one does need to have a special interest in 
the subject and a dream to make a difference. Conscious choices have 
to be made along the way which may be less rewarding in the short run 
such as going in for a focused Masters with a good project. The money 
and lucrative job offers will follow once one has developed the required 
skill-sets and gained the experience. Hence, chip design is an extremely 
fulfilling career option for the technically and technologically inclined. 
As for the areas to look out for, the general consensus is that chips 
designed for consumer electronics is a growth area. Designs for wireless 
devices and multi-core processor design is bound to go up too, while 
integration of MEMS is a growth area that has great applications in the 
healthcare and medical arena. Entertainment and graphics technolo-
gies coupled with designing chips that give you higher performance at 
lower power consumption should be the focus for young entrants. “The 
dawn of energy age has increased demand on semiconductors to do 
more with less energy (performance per unit of energy).  Another trend 
is towards always-on mobile connected devices. This is giving push to 
cloud computing where most of the horsepower is in a data centre and 
a smart connected device can access this capability from anywhere.” 
says Dr. Atul Garg (PhD), a senior chip designer at NVIDIA Corporation, 
Santa Clara, USA. The engineer from IIT Kanpur, who now holds ten 
design patents to his credit has this final advice for aspirants: “Keep 
yourself current with state of the art in such a fast moving industry, 
increase productivity to be in sync with industry trends, and keeping 
ahead of the competition. Learning is a lifelong process and nothing is 
impossible if you work hard.” n
	 	 	 siddharth.parwatay@thinkdigit.com

“Seeing technologies you’ve 
worked on, being put into 
day to day use is quite an 
exhilarating experience!” 

Rohit Vidwans 
Director,  

Digital Enterprise Group, 
Intel India.

Companies consider Tier A colleges in India such as 
IITs, BITS , NITs, etc., as a good source of qualified 
engineers. However, candidates from regional colleges 

such as VJTI or Manipal Institute are also considered, 
provided these students can opt for a course in VLSI design. 
Companies look for students at undergraduate and masters 
levels in computer science and electronics domains with a 
consistently high GPA. Here’s a list of some of the top places 
that offer courses in VLSI Design and allied fields, as recom-
mended by VLSI chip design companies.

CDAC, Hyderabad:
Certificate Course in Digital and Analog VLSI Design (CDAD)
Sandeepani School of VLSI Design, Bangalore & Hyderabad: 
Post-graduate diploma in VLSI design
Veda IIT, Hyderabad:
MS and Diploma in VLSI and Embedded systems
Cranes Software, Bangalore:
Embedded System certification
Vedant Chandigarh, Lucknow: Course in front-end and 
back-end design including Analogue & Mixed Signal design

The right Course
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developer corner
Command Line
According to dedicated command line users, 
the command line is much faster than a GUI. 

Kshitij Sobti

s
erious command line interface (CLI) advocates always shy 
away from Windows, deterred by the weak command inter-
face it provides, and the lack of a pure CLI mode. With 
Windows PowerShell, Microsoft has brought power to the 

console, and given some geeks a road back to Windows.
Until Windows 98, we were used to an option to go into the 

pure console mode if all things fell apart. The presence of DOS in 
the event everything else failed was always comforting. Microsoft 
seems to have abandoned its CLI since then, with only a few minor 
enhancements, ‘command.com’ became ‘cmd.exe’ but significant 
changes were yet to come. Compared to the advanced nature of 
commands available for *nix environments, Windows can be said 
to effectively have no CLI.

Microsoft tried to give developer features such as Windows 
Script Host (WSH) to enable automating tasks, and scripting redun-
dant procedures. However, it only managed to open numerous 
security backdoors, and become more associated with viruses than 
anything else. Finding the WSH process in your process list was a 
trigger of panic.

Microsoft fortunately hasn’t given up. Windows PowerShell is 
its cure for the Windows CLI. Released in November 2006, Windows 
PowerShell is truly a powerful CLI option. Although it is still in 
its infancy with just one release, it has managed to live up to its 
name. 

The CLI really?
Many people swear by the command line interface and sing praises 
of how much faster it performs some complex tasks. However, for 
most users, graphical user interfaces have become indispensable. 
Command lines may make complex tasks achievable. However, the 
truth often is that GUIs make simpler tasks easier. So why bother 
with a CLI?

Often we need to perform simple tasks that have rather trivial 
command line solutions. For example, how would you rename 
all the ‘.abc’ files in a folder to ‘.xyz’? While the command line 
solution is a simple ‘ren *.abc *.xyz’ executed in the said 
directory, the GUI by default offers no such comfort. How about 
renaming all the files in a directory which are greater than a fixed 
size? While such a thing would have required a complicated script 
before, with PowerShell, all this can be done in one line! Don’t 
believe us! Read on and find out.

Setting up PowerShell
PowerShell is a free download available from the Microsoft web 
site, and is available for Windows XP onwards. The current 
stable version is V1. However, Microsoft has also released a CTP3 
(Community Technology Preview) of its upcoming V2. Both versions 
are included on this month’s DVD for your convenience.

Once you start the console, you will realise that it is quite simi-
lar to your normal command line, except that the colour scheme 
is different, with a blue backdrop and white text, and with a ‘PS’ in 

the beginning of the prompt. This is where all the magic happens. 

Cmdlets
Windows PowerShell introduces the concept of cmdlets, which 
are basically small commands that can be run from the command 
line. They are unique to PowerShell, in that they won’t run outside 
a PowerShell Window. Similar to normal Windows CLI commands, 
you run them by typing the command name, along with param-
eters to control their functioning.

In PowerShell, all commands follow the same naming conven-
tion of Verb-Noun, making the command names longer, but still 
easy to memorise. For example, some common commands are Get-
Content, Move-Item, Rename-Item and Format-List.

In PowerShell, commands do not directly output the result to 
the screen, but instead return all the information as a .NET object, 
which PowerShell then displays. This allows for further processing 
of the output before it is finally written to the screen. PowerShell 
comes with many output formatting cmdlets for this purpose.

A very important and powerful new concept in PowerShell 
is pipelining, a concept with which DOS users will be familiar. 
Pipelining allows you to pass the output of one command as the 
input to another. Something like the example given above could be 
done with three commands:
l	 A command to get the directory listing
l	 A command to filter out the files to be renamed
l	 A command to rename the files

We pass the directory listing to the filter, and the filtered 
results to the renaming command, forming a ‘pipeline’ of sorts.

So what would this command look like in PowerScript?
PS> Get-ChildItem | Where-Object {$_.length -gt 

50kb} | Rename-Item -newname {$_.name + ‘.big’}
This will rename all the files in the current folder which have a 

size greater than 50 kB, and add an extension of ‘.big’. 
This might seem an unnecessary way of running commands. 

However, PowerShell provides multiple aliases for each command, 
so that the same result as above could have also been achieved by:

PS> ls | where {$_.length -gt 50kb} | ren -new 
{$_.name + ‘.big’}

Almost all commands have short forms for faster typing. 
However, while writing a script that will be used later, using the 
full command name can be helpful for future readers.

The command we just saw is divided into three different parts, 
separated by the vertical bar (aka. the pipe character).

Get-ChildItem {$_.length -gt 50kb}
This is similar to the ‘dir’ command. However, it is also capable 

of listing registry entries. You can also have a parameter such as 
‘*.xyz’, to display all ‘.xyz’ files, or use the ‘-recurse’ parameter to 
get a recursive list of all the files in the folder and its child folders. 
This output is being piped on to:
l	 Where-Object 
Now this immediately highlights the difference between the 
regular commands you are used to, and PowerShell. The ‘Where-
Object’ command filters the input it gets from ‘Get-ChildItem’ 

based on the conditions provided in the 
parameters.

Here the condition enclosed in 
braces, ‘{$_.length -gt 50kb}’, specifies 
that for each object the required condi-
tion is that its size should be greater 
than 50 kB. Here, ‘$_’ represents the 
object being tested for the condition. By 
using ‘$_.Length’, we obtain the size or 
length of the Object, and since the object 
we are considering here is a file, the 
length is basically the file size. The final 
piece is ‘-gt 50kb’, which means greater 
than 50 kB. 

PowerShell: Empower the Windows CLI
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TECH@WORKHack alert
Two security experts recently took control of 
a Windows 7 system during the boot process 
using a code they developed. Reassuring to 
know it can’t be done remotely. 

XP Popularity
According to Forrester research, Windows XP 
powers 71 per cent of all PCs

There are a multitude of options available at this point. We 
could use ‘name’ instead of length to obtain the file name and test 
it however we like, or the modification date, or the attributes, the 
possibilities are endless. Even while considering the file size, we 
can change the ‘-gt’ to ‘-lt’ to get all files smaller that 50 kB or ‘-eq’ 
to get all files of exactly 50 kB.

This command will test each file object for the prescribed 
condition, and output those that comply. This output is now 
further piped to:

l	 Rename-Item -newname {$_.name + ‘.big’}
This final part of the command gets the filtered list of files from 
the previous command, and renames them according to the param-
eters specified. The ‘-newname’ parameter, as one might guess, 
specifies the new name to give to each file. Here we simply take the 
input file name ‘$_.name’, and add a ‘.big’ after it. Simple!

However we can do much, much more, by using the ‘-replace’ 
parameter for example, we can replace certain strings in the file 
name by other strings. For example, we could replace all instances 
of ‘Music’ with ‘Song’ by:

Rename-Item -newname {$_.name –replace 
‘Music’,’Song’}

PowerShell to the Rescue
So we renamed a couple of file. What more can we do?

PowerShell is extremely diverse. It supports functions, loops, 
if-else conditions, reading / writing to files, downloading files from 
the internet, administering windows settings, regular expressions, 
pipelining, etc. In fact, all the cmdlets are actually .NET classes, so 
you can create some yourself.

Let’s take a look at some of the things you can easily do with 
PowerShell.
Write the list of files in a directory to an HTML formatted file

Get-ChildItem | ConvertTo-Html | Out-File .\dirl-
ist.htm

Here we use the ‘ConvertTo-HTML’ cmdlet to get an HTML 
output, and use the ‘Out-File’ cmdlet to write it to a file. We could 
as easily get a CSV output for use in a spreadsheet by using the 
‘ConvertTo-CSV’ cmd.
Organise files in folder by name
$filelist = Get-ChildItem 
$filelist | ForEach-Object -Process {mkdir $_.name.
substring(0,1) -ErrorAction SilentlyContinue } 
$filelist | Move-Item -Destination {$_.name.
substring(0,1)}

Now here’s some actual scripting work. This is what’s going 
on:

First we store the list of files in the current folder to a variable 
called ‘$filelist’. 

Secondly we use the ‘ForEach-Object’ cmdlet to perform 
an operation on each file on the folder. The ‘-Process’ param-
eter  tells PowerShell the action to be performed for each 
object. What we are doing is creating a new folder for each file. 
The folder name is the same as the first character of the file 
name (which we get using $_.name.SubString(0,1) which extracts 
1 character starting from the 0th position of the filename). 
This will essentially create folders named ‘0’, ‘1’,’2’…’A’,’B’,’C’… 
depending on the names of the files in current folder. 
Here, we have also added a parameter ‘-ErrorAction SilentlyContinue’ 
which tells the shell not to display any errors that occur. This is 
done as there will be many error messages displayed since many 
files will begin with the same name.

Finally, the last command takes our file list, and moves each 
file to a folder corresponding to the first character in its name.
List all processes which are taking up to much memory
Get-Process | Where-Object {$_.VM -gt 500MB}

Simple enough, this takes the output of Get-Process and pipes 
it through the ‘Where-Object’ cmdlet to get a list of processes 
which have a ‘VM’ (Virtual Memory usage) greater than 500 MB. 
You can further pipe this to the ‘Stop-Process’ cmdlet to stop all 
such processes!
List all large files in a drive

Get-ChildItem -Recurse | Where-Object {$_.Length -gt 
300MB} | Sort-Object -Property length –Descending

Here we take the recursive directory listing of the drive 
using ‘Get-ChildItem’, and pipe it to ‘Where-Object’ 
for filtering. ‘Where-Object’ then filters out the files 
greater than 300 MB, and pipes them to ‘Sort-Object’.  
‘Sort-Object’, as the name suggests, is used for sorting the 
data. Here we sort it based on the length (i.e. size) of the file, 
and also tell the ‘Sort-Object’ to arrange them in descending 
order. You can use a multiple order sort by specifying multiple 
properties separated by commas e.g. ‘-Property length, name’. 
This information can be very useful when cleaning up your 
hard drive. So you can, if you want, further pass this data to the 
‘ConvertTo-HTML’ or ConvertTo-CSV’ cmdlets followed by the ‘Out-
File’ cmdlet to generate a report of sorts. For example,

Get-ChildItem -Recurse | Where-Object {$_.Length 
-gt 300MB} | Sort-Object -Property length –De | 
ConvertTo-Csv | Out-File report.csv

Empower the PowerShell!
You thought that was all!?

Microsoft and many third party developers have created 
PowerShell extensions, which add cmdlets or other features to 
control many more aspects of the computer.  Till windows Vista, 
PowerShell was an add-on product that needed to be installed, 
however starting with Windows 7 onwards, it will come inte-
grated with Windows. Microsoft will also drop support for the old 
Windows Scripting Host, and focus on PowerShell instead.

PowerShell v2, which is currently in development, is now 
available as a pre-release version. It will feature some powerful 
new features, and even a GUI based script editor called PowerShell 
ISE (Integrated Scripting Environment). Some of its interesting 
features being:
l	 Remoting: allowing you  administer a remote computer
l	 Background Jobs: enables you to run commands in the back-
ground, asynchronously, without the need of the console.
l	 Modules: allow for modular programming of PowerShell 
scripts, by compartmentalising your code. It adds a file type ‘.psm1’ 
for module files
l	 Script Cmdlets: these allow you to make cmdlets using 
PowerScript itself! No programming knowledge required.
l	 And many other features such as: Transactions, Eventing, 
Exception Handling, Steppable Pipelines, Internationalisation, 
Debugging etc. 

Best of all, PowerShell is a free tool for Windows users, so it’s worth 
getting even if you use it only occasionally. A large number of ready-
made scripts are already available online, from Microsoft and others 
to ease administrative tasks, so even if you don’t want to commit to 
learning it, it can still ease a lot of your tasks. With PowerShell becom-
ing a core part of Windows from Windows 7 onwards, an elementary 
knowledge of it will surely go a long way. n

readersletters@thinkdigit.com
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Entertainment Unlimited

Kumar Jhuremalani

Not going anywhere this holiday season? Have spare time 
to kill, but don’t want to go out in the heat or watch TV 
at home? Well then we have the perfect solution for you 

– Logon to the net and visit the sites we are about to reveal to you. 
Spend hours and days on these fun filled sites and proudly say 
that you have had the best summer sitting at home. 

Online videos 
The first thing that pops up in your mind when reading 
something like Online Videos is the ever famous YouTube.
com. This web site is considered the best web site to host 
videos that range from anything to everything. Even if 
you type something like ‘I hate Mars’ there will be a 

video available on YouTube. It 
may not be accurate, but you 
will find some video that will 
entertain you. 

Why does Google keep 
trying to put their hand into 
everything. http://video.google.
com is Google’s solution to 
a video hosting web site. We 
really don’t see the need for 

Google videos as most of the videos that are put up there 
are from YouTube itself. 

Veoh.com is another web site that allows video hosting 
services. The videos on this site are nicely categorised into 
movies, TV, dramas, etc and there are also many Channels 
and Groups that you can watch videos at. The thing that 
is really unique with this web site is that while watching 
a video you can simultaneously browse the other videos 
through all the categories. These videos are displayed on 
the right side of the video you are viewing. There is a small 
catch to this web site though. For small videos it is fine, but 
Vimeo is another simple video sharing web site. The reason 
why we are mentioning this site is that it gives you full 720p 
high definition videos instead of the FLV file formats that 
are offered by others. 

Trick Photography
Combine the power of an image editor and a 
camera to create mind-boggling images! 112

Online radio 
For those of you who like 
to listen to music and 
want to experiment and 
hear new music other 
than what’s playing on 
the radio, then the best 
thing to use your inter-
net connection for is to 
tune in to an online radio 
station. SHOUTcast is one 
such online radio that 

hosts many individual radio 
stations. There are a whole 
bunch of radio channels that 
you can listen to, each having 
some really great music. 

Social networking 

Facebook 
By now, most would already 
know what Facebook is. But 
for the benefit of the doubt for a few, Facebook is a social 
networking site where you can invite and make new friends 
from all corners of 
the world. There are 
some great applica-
tions on Facebook 
that will either irri-
tate or encourage you 
to participate in those 
applications further.   

Twitter 
Twitter is the new fad 
that people around the 
world have got hooked 
onto. For those of you 
who don’t know, Twitter 
is sort of an instant status 
update that is shared 
with everybody in your 
network. It’s similar to the status updates that are present in 
Facebook, but that’s it, nothing more than status updates. With 
these small little ‘Tweets’, as they are called, is how people share 
daily activities, experiences and news events happening across 
the world. Once you setup a profile, you invite your friends 
to follow you and you need to follow your friends to get their 
updates. Twitter has grown to such an extent that you can now 
get twitter updates from your friends on your mobile phone as 
well as use twitter through SMS. The next time you meet a celeb-
rity, you could just send out a Tweet and inform all your friends 
about it. But beware there have been many incidents where 
people have used twitter to spread bogus news around just to get 
their 15 minutes of fame. 

There are many who don’t like Twitter, but then there 
are more than many who love it, but we feel this is just a 
passing phase and some of us hope that this comes to an 
end soon.

Applications to try out on 
Facebook 
l	 LettersCube 
l	 Twirl 
l	 Scrabble 
l	 UNO 
l	 Counter Strike: Red 

Team Go 

List of some hilarious 
videos to search on 
YouTube 
l	 Indian Thriller 
l	 Crazy Kung Fu
l	 Buffalax

Register at Twitter.com and start sending 
out your own Tweets

esc
feature

The best  
web sites to 
waste time on
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Gaming 

Flash/casual games 
Almost everybody loves to play 
those casual flash-based games 
just for fun. It’s a great way to 
pass your time on the internet. 
These games have grown to a huge 
extent. There are a number of free 
games now available by Indian 
developers itself, such as Zapak 

and Indiagames. These 
web site even host 
competitions where you 
could win either money 
or some merchandise. 
These games are such 
that you just have to 
log in to their web site 
and lay them, no hassle 
about downloading the 
games, just pure fun. 

Text Based MMOGs 
Flash games which fall 
under the category of a casual gamer is not the only tye of game 
available online. For those of you who want something more apeal-
ing and a little more thought provoking and to keep you coming 
back for more, there are text based MMOGs available too. 

Take Ogame (www.ogame.org) for example, the storyline of this 
game will just blow you away. The game is based in the future 
and you basically have to colonise a planet that you are assigned. 
You have to mine for resources to build structures. You proceed 
to create a fleet and you can also expand your colony by taking 
over another colony. Along the way to form trade alliances that 
help in protecting your colony. You also have the choice to attack 
other planets to get their resources. It’s a fight for survival in this 
futuristic game. 

If you are not that into sci-fi and intergalactic warfare then you 
could also give Tribal Wars (www.tribalwars.net) a try. This text based 
MMO has a little more colour than Ogame. The back story of this 
game is not that interesting as you start off by controlling a village. 
You can’t go off invading other tribes right at the start, but you will 
have to start with just developing your village at first and then move 
on to forming alliances with the other tribes around you. Of course 
the main goal on this game is for you to be the most powerful tribe, 
but that will take some time and effort. 

Here’s an online game that is fun and interactive and at the 
same time will keep you busy for quite some time. We are talking 
about My Brute and the web site is www.mybrute.com. To start off all 
you have to do is think of a character name and select your brute. 
Once that is done, enter the arena, pick an opponent and the fight 
starts. You will be able to see the fight and just hope for your brute 
to win as the outcome is completely random. Well stats do play a 
role to lead you to win the fight. By beating other brutes you earn 
experience points and level up. 

The Akinator knows what you are thinking. Well at least he 
tries to guess who you are thinking off. Head over to en.akinator.com 
and just think of somebody famous such as an actor or a sports 
person or even a model. Then just answer the string of questions 
the Akinator asks as he will try to guess who you are thinking of. 

Just for fun
There are many of you who might have seen some really funny inci-
dents, maybe a funny a sign board or even your pet doing something 
silly. Well here are a few sites that have photos of people around the 
world who have also shared such hilarious experiences. 

Cat lovers will go crazy at icanhazcheeseburger.com as it has photos of 
cats doing really funny things. Well these pet owners are those who carry 

a camera at all times as 
they have got some really 
awesome pictures. And 
to support these pictures, 
they have also provided 
some witty phrases which 
make for a really fun read. 

You have to check 
out Failblog.org as the 
site has a huge collec-
tions of all the photos 
that are related to fail-
ing in some way or the 
other. We can’t really 
explain it, you just have 
to have a look at it. 

A site similar to 
failblog is engrish.com. 
At Engrish, you get to 
see the photos of all 
the goof-ups made in 
Asian countries that 
are trying their best to 
adapt to English. 

If you love to solve 
quizzes then www.
blogthings.com is just 
perfect for you. There 
are so many quizzes 
that sometimes will appeal to you, but some 
just don’t make sense, but at the same time 
you need to know the outcome of it.

Comics 
Another really good way to waste time 
on the net — read online comics. There 
are a bunch of online comics, but we 
are going to share with you our personal 
favourites. First off, www.ctrlaltdel-online.
com is a comic about two guys who love 
to play video games all day. Integrated 
into this comic is the writer's personal 
reviews on the latest games too. The Noob 
Comic (www.thenoobcomic.com) is a comic 
that makes fun of mostly all MMORPGs 
and mainly the Everquest series. They not only make fun of 
role playing, but also bash up the way a game company runs 
a game itself. 

 Looking For Group (www.lfgcomic.com), the comic, has more 
of a subtle storyline where a group of people accidently meet and 
they begin a new journey together as all their fates are actually 
connected. 

Forums 
Forums are a very popular means of a community where you can 
discuss whatever you want to and there will be a whole bunch 
of other people either contradicting you or befriending you and 
supporting your beliefs and ideas. Forums are not only used to 
voice your opinions but also is a place where you can learn a 
whole lot of new things that you had no prior knowledge about. 
The NeoGaf (www.neogaf.com) forums is one example of such 
forums. NeoGaf has two basic topics — Game Discussions and 
Off-Topic Discussions. You can also check out i-am-bored.com as 
the last resort. As the name suggests these forums have topics 
that range from utter nonsense to actual intelligent debates 
taking place online. 

We won’t stop you from stepping out once in awhile, but with 
all the addictive web sites that we have mentioned, you will be 
drawn back home to your beloved computer. You should now be 
set to totally enjoy the summer. n

kumar.j@thinkdigit.com

Game review
A Ninja — an Xbox 360 game 
reviewed

Game review
Hanuman:Warrior boy, India's first 
PS2 game reviewed 

List of web sites you 
should visit 

www.zapak.com 
www.indiagames.com 
www.flash-games.net 
www.games2win.com 
www.neopets.com 
www.kongrgate.com

The Akinator will read your mind

Read the finest use of the English 
language at Engrish.com 

Create your own music

Here is a very innovative digital 
sinewave synthesizer that has been 
created by Andre Michelle. When you 
go to lab.andre-michelle.com/tonema-
trix you are greeted with a 16 cell grid. 
The way this works is that the cells 
when clicked on emit sounds and the 
direction of the sound is from left to 
right. So when you highlight cells you 
get to create some really great music. 

Ctrl Alt Del the comic

118 120
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Did you know that digital SLRs still 
use mechanical shutters?

Rossi Fernandes

W
e’ve always told you which cameras to buy and 
how to shoot photographs the right way, but there 
should also be time for fun, as there is so much 
that can be done with photography. You don’t 

need a lot to have fun — a camera and decent image editing 
software will suffice. As much as you may prefer not to use it, 
Photoshop (or any other image editor) always goes hand in hand 
with this kind of work. We’ll be using Photoshop to alter images 
so that they look completely over the top.

Illusions
One of the simplest photography tricks is to use perspective in 
funny ways. A distant object, and a nearby object, when angled 
correctly to the lense, gives startling results. This can include plac-
ing a distant person on a nearby person's hand, or someone about 
to eat up the sun. Positioning the two elements is paramount. 
Zoom in to the preview to check if you have got the shot that you 
need. There is no need to use the macro mode to get these kinds of 
shots right. Play it safe by taking multiple exposures. 

The levitation trick
Most of the photographic illusion trick photos that we see in 
our mailboxes might seem very complicated, but in fact, making 
them is quite simple. The levitation trick might seem really 
difficult to pull off in a video clip but in a still photo, it really 
is much simpler. In fact, it’s something that you can make in 
under 15 minutes.

We want to give people the impression that the object is 
hovering over the ground. For this, we need to take a couple of 
photos. Obviously we can’t have an object stay afloat, so we’ll 
need to get the object to be placed on a short stool or a bench. 
We’ll then use a photo without the stool and the object and 
clear out the stool from underneath it

We start by taking a suitable position for the camera from 
where a believable photograph can be taken. We need to make 
sure that all the photos are taken from the exact same spot, 
so we’ll need a tripod for this trick or at least a sturdy base on 
which to place the camera.

Step 1: Place the tripod and mount the camera. Make sure to 
set a manual setting. Try to fix an aperture size, shutter speed, 
ISO setting for the shot. Use a timer to click the photo so you 
don’t have to manually operate the shutter release mechanism. 
This eliminates any chances of blurry images due to shaking of 
the tripod or your hand. You could also use a remote camera 
control.

Step 2: Take a photo of a scene without the object in place. 
Use the same steps and settings that you used for the previous 
step but now remove the stool and the object.

Step 3: Copy the captured images to your hard drive and 
open it in Photoshop or any other image editor you’ve been 
using.

Step 4: Open the two images in Photoshop (See Figure 1)and 
double-click the first image so that it becomes a new layer. (See 
figure 2) Now, open the other image, select the entire image by 
pressing [Ctrl] + [A] then, copy the second image and add 

it as a layer on top. This should happen automatically when you 
paste the image. Make sure you arrange the layers in such a way 
that the layer with the object is positioned above the layer with-
out the object (See figure 3).

Step 5: Use the Pen tool and draw an outline around the 
object (See figure 4). Using the eraser increases the chances for 
mistakes. A path drawn with the pen tool is more accurate and 

can be modified easily if required. Hold down the mouse, click 
and draw curves around the object you’re trying to cut out. 
Zoom into the image while you are working on this, and work 
your way around carefully, adding many nodes. Complete the 
path. 

Step 6: Right-click on the path and click on make selec-
tion. (Figure 5) Now invert the selection by clicking on the Edit 
menu again. The object will be selected now. Delete the selec-

Trick Photography
...isn’t so tricky 

Figure 1: Opening the three slides with Photoshop

Figure 2: Converting each of the images into a layer



Sony took over the Konica-
Minolta DSLR business

The Leica S2 has a DSLR sensor 
some 50 per-cent larger than 
other full-frame DSLRs

DIGIT MAY 2009114

E
sc

DIY

tion by pressing the [Del] key or through the Edit menu so 
you are left with just the object floating in air.

Step 7: Save the image by clicking on File > Save As. 
Choose a format such as JPG that doesn’t show layers or masks.

Improvements can always be made to this technique. Adding 
a shadow under the object adds more realism to the photo. You 
can do this by using a large sized, but soft brush tool and adding 
some darkness on the floor where the shadow would fall. You 

can also take an additional photograph and ask someone to hold 
a sheet or paper or a big bag over the where the object would 
float so you can capture a shadow and similarly composite it 
into your image.

Replicating objects
There are plenty of tricks one can do with the method in the previ-
ous trick. In this particular trick, we’ll use the same idea but have 
the same object in different places at the same time.

Take multiple shots with the camera on a tripod with the 
object in different places. While starting off, simply use two or 
three instances of yourself preferably not overlapping anywhere in 
the photo. Keep the same distance and do not move anything else 
in the scene. Use Photoshop to open all these photographs into 
separate layers and use the eraser tool as well as the Pen tool to 
clear out each of the instances.

One of the biggest hurdles has to do with the variations in 
colours and the characteristics of the photo that take place espe-
cially with automated point and shoot cameras. Small changes are 
made by the camera which result in the image turning out a little 
bit brighter or darker. If the outlines for the characters aren’t cut 

out clearly, then there’s a layer around the subject with a slightly 
different shade left behind. Use a soft healing tool from the tool-
bar to clear these patches up. Do not merge the layers together as 
you can control each of the layers individually. This way, you can 
continue to change properties of the layers independently, such as 
the lighting and colour balances. Tweak these to make the final 
image as realistic as possible.

Gigapixel imaging
Now this isn’t really a trick but it’s something cool that you might 
have read of or seen online. People boast of really high resolution 
images going into gigapixel resolutions. But you don’t need a really 
expensive camera that costs several lakh to do that. The trick is to 
taking a gigapixel image is to use any camera and take as many 
shots as possible. Obviously you can’t just go around shooting 
random photographs — it has been done in an orderly manner. It is 
preferable to use a tripod for this experiment as well. 

We’ll be using a program called Microsoft HD View which let’s 
you view and create your own gigapixel images with your standard 
point and shoot camera. You can download and install the plugin 
for Windows browsers from http://tinyurl.com/dkp27g.

Step 1: Mount the camera, set the camera to capture at its 
maximum resolution, and turn off the flash. Set the aperture 
size, shutter speed and ISO rating such that your exposure 
ratings are normal and you won’t get dark results. Click a few 
test shots to be sure.

Figure 3: The different images copied into a single file as layers

Figure 5: Converting the path to a selection

Three instances of a bottle

Figure 4: Creating a path to isolate the object
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Tokina, the Japanese lens 
manufacturer was made by 
ex-Nikon engineers

Step 2: Set the zoom to maximum and click photos just as you 
would for any sort of panorama. Turn off digital zoom from the 
Settings menu in your camera so you don’t lose any quality, and 
then zoom to the extreme end and start clicking photos from one 
end such as the left bottom of the view and slowly move to the 
right and then upwards. In short, cover the entire area in front of 
you. You don’t have to make it a complete panorama for this. 

Step 3: Download and install HD View from http://tinyurl.
com/9ymwlj.

HD View is useful because loading a gigapixel image as large as 
the ones you’ve seen online will take forever, so software like this 
breaks that image into multiple smaller images at different quali-
ties and sizes so that regular PCs can easily load them. There is no 
loss of quality and there’s no way to make out the sliced images.

There is also a Photoshop plug-in developed by the community 
which lets you export panoramas directly from Photoshop into an 
HD View panorama. To be able to export the panorama to HD View, 
you also need a small add-on for Windows. It’s called Windows 
Imaging Component and is available on Microsoft’s site. 

Step 4: Download the HD View making plug-in for Photoshop 
from http://tinyurl.com/c35wgf. Once installed, copy the plugin 
file and the hdmake.exe file from the Program Files\
Microsoft Research\HD View Utilities folder to the 
Adobe Photoshop’s plugin folder. 

Step 5: Restart Photoshop, click on File > Automate > 
Photomerge. Choose the folder or photos that you’ve captured. 
This step will stitch together the images but will take a lot of 
time depending on the number of photos you have. You save the 
completed image by clicking on File > Save as and then 
selecting a format.

Step 6: To export the 
image for HD View, click 
on File > Export 
> HD View & Deep 
Zoom. Choose HD View 
as the Output and select 
an output folder. You can 
select image compression 
settings and the kind of 
panorama. In our case, we 
chose flat. Click OK when 
done.

The output will be 
opened in your browser 
but you can also upload 
this file or folder to your 
web page for others to be 
able to view it. They will 
require the HD View plugin 
to do so.
 
Using Microsoft’s Image Composite Editor
If you need to fiddle with the colour parameters of the images that 
you’ve shot, then using Photoshop is required. If you feel that all your 
photographs have similar contrast, brightness and colours, then using 
Microsoft’s Image Composite Editor is simple.

Microsoft Image Composite Editor (ICE) is available from  
http://tinyurl.com/cs4bp3. It’s free for download and is useful for 
making any kind of panorama and just gigapixel images. You’ll 
need .NET 3.5 framework for this application to work. 

Once you have the software installed, drag and drop the images 
for the panorama from your Windows Explorer window to the 
Microsoft ICE window. The software will automatically align and join 
the photographs together. You can move the control points to crop 
the area you want to use for the gigapixel photo. If you want to get the 
best cropping, click the Autocrop link in the Crop section. 

The next step is to export the final image as a photo which can 
be modified further in Photoshop. You can also export it as an HD 
View tileset. Click on the Format dropdown menu and choose the 
format. Finally, click the Export button.

Light painting
Ever seen those photos of words written in darkness using light. 
It’s one of the simplest things to try with the camera. All you 
need for this is a camera, a tripod, and a volunteer with a bright 
object — a torch or a candle. Light painting is done in the dark 
so you only see the bright lights in motion captured in a long 
exposure photo.

Step 1: Place camera on tripod, set the highest possible resolu-
tion and quality. Turn off the flash.

Step 2: Set the camera to manual mode. The aperture settings and 
ISO rating requires a little bit of fooling around before you can get the 
perfect shot. 

Step 3: Set the shutter speed to as high as possible. Most cameras 
can do around 15 seconds, although dSLRs offer at least 30 seconds. 
Some cameras will let you keep the shutter open for as long as you 
hold the clicker. 

Step 4: Set a timer for the shutter release of 10 seconds and 
prepare to make a design.

Step 5: The shutter will stay open for 30 seconds, so in that 
time, make movements with the candle or torch facing the camera. 
Preview the image to see the results. You will have to do this a few 
times over before you get the hang of completing the light painting 
in the time period. Move the source of light at a steady pace to get 
an even painting. 

If you want to write text, remember to use a mirror to figure out 
how to draw the text. Wearing dark clothes can help hide yourself in the 
image. Be in surroundings with no light present at all. n

rossi.fernandes@thinkdigit.com

Exporting the panorama to a HD View file

An example of light painting

Microsoft ICE is an alternative image stitching software
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Sameer Desai

N
inja Blade is the kind of game that can go unno-
ticed. This hack ‘n’ slash game seems at first 
glance eerily similar in style, setting and even 
name, to the massively popular Ninja Gaiden series. 

Understandably, when Ninja Blade was announced, many 
shrugged it off as simply a Ninja Gaiden clone. But being an 
Xbox 360 exclusive and published by the platform owner does 
have its benefits, and as a result Ninja Blade attracted the 
attention the developers would have wanted. But is it able to 
shrug off the ‘clone’ tag and match up to competing titles in 
the genre?

Ninja Blade is not a Ninja Gaiden clone. In fact, it’s quite 
a departure. While Ninja Gaiden’s USP is its punishing diffi-
culty, Ninja Blade stresses more on the cinematic aspects of 
the combat, more like Devil May Cry. Some of the cinematic 
sequences are so over the top that it’ll actually give DMC a run 
for its money, as improbable as that might seem. But, while 
combat may not be as punishing as Ninja Gaiden, it does offer 
up a lot of variety in the form of different weapons, huge 
mutant enemies, intriguing boss fights, and some of the most 
awesome finishing moves you’ll ever see.

You play a member of a highly-trained team of ninjas, who 
are sent to Tokyo to combat an outbreak of a parasite that 
infects humans, turning them into giant mutant monsters; 
the stuff ninjas are trained for. Unfortunately, your team ends 
up dead, leaving you to fight a lone battle. A moderately inter-
esting story unfolds through the game, and while it won’t be 
winning any awards, it does have its moments.

Combat is the cornerstone of a hack ‘n’ slash, and Ninja 
Blade actually handles it quite well. In your arsenal you have 
a selection of swords, each ideal for specific kinds of targets. 
You also have magical powers, known as Ninjutsu, to help you 
take out enemies and clear paths. The protagonist, Ken Ogawa, 
is also pretty nimble on his feet, able to perform acrobatic wall 

runs, both horizontally and vertically, and these abilities form 
a vital part of the game’s many boss fights.

Ninja Blade is heavily reliant on quick time events or QTEs, 
which play out a sequence by requiring you to push a particu-
lar button at a specified time. Timing the button presses 
correctly lets you progress through the sequence While this 
can get frustrating in many games, the QTEs work quite well 
here and aren’t as frustrating or unforgiving as in other games. 
If you fail, you can try again rather than having to go back to 
the last checkpoint, and you have a generous time window in 
which to press the required button. QTEs may feel like cheat-
ing, especially when you see your character performing such 
thrilling manoeuvres and all you’re doing to make that happen 
is push a button. But you won’t really mind that because you’re 
going to want to watch some of the outrageous set pieces in 
this game.

You can carry three weapons, and as you progress, you 
can upgrade these weapons to make them more powerful. You 
can also, if you choose, customise the look of your character. 
Combat itself is pretty easy and the smaller enemies will pose 
no challenge at all. To make up for that, there are multiple boss 
fights thrown at you, and while these aren’t particularly chal-
lenging either, they’re a lot of fun, and they ensure that the 
pace of the game is never anything but incessant.

The one big drawback to Ninja Blade is that there’s noth-
ing here that hasn’t been done before in hack ‘n’ slash games, 
and there isn’t much variation or uniqueness in the imple-
mentation of those methods either. The game isn’t all that 
difficult, either, so veterans of games like Ninja Gaiden won’t 
really find much of a challenge here. But that having being 
said, what it does, it does quite well. The boss fights are fun, 
the cinematic set pieces are some of the most entertaining, 
and the game plays out at a frantic pace from start to finish. 
Ninja Blade may not be a genre-defining game, but it’s one that 
fans of the genre, and in fact, fans of action games in general, 
might want to try out. n

readersletters@thinkdigit.com 

Score: 7/10

Genre: Third person action
Platform: Xbox 360
Studio: From Software
Publisher: Microsoft
Number of players: 1

NINJABLADE
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Sameer Desai

H
anuman: Boy Warrior is the first console game with 
Indian intellectual property and developed entirely in 
India. Created by Aurona Technologies for the PS2, it 
sets into motion Sony Computer Entertainment India’s 

plans to start infusing a steady stream of localised content for 
the PS2 into the Indian market, even as studios and publish-
ers elsewhere around the world are moving on from the PS2, 
towards the newer generation of consoles.

So the first of the many promised Indian PS2 games is finally 
here, and sadly it couldn’t have turned out any worse. Hanuman: 
Boy Warrior is a third-person action game with heavy emphasis on 
platforming. Aurona proudly proclaimed that it had developed the 
game in only ten months; and it shows. The game is found severely 
wanting in nearly every department, and even the popularity of 
the Hanuman character with kids and families is not enough to 
salvage this train wreck.

For starters, the camera angles are overly restrictive, and at 
times make it nearly impossible to progress beyond a particular 
point. The inability to move the camera vertically makes it difficult 
to spot high platforms that you will need to climb to in order to 
progress through the level. There are also segments where you’re 
required to get from one place to another by swinging across 
vines. Negotiating these sections is more a matter of luck than 
skill, because the same effort will at times lead to failure, and at 
other times you’ll get to your destination just fine. But you’ll more 
often than not fail a few times before the game decides you’ve 
suffered enough and lets you progress.

Visually, Hanuman would probably fall in the category of 
a bad PS2 launch title. The environments and characters seem 
extremely bland. Animations are some of the worst I’ve ever seen, 
particularly the jump animations, where there is almost no move-
ment in the legs while jumping. Character animations, besides 
looking bad, also adversely affect gameplay. Like Hanuman, the 
enemies too have a limited set of animations and there is no 
attack animation to speak of, so you never know when they’re 
really attacking you; they just seem to skid around and bump into 
you to cause damage.

Combat is standard hack ‘n’ slash fare. Hanuman starts out 
with basic light and heavy attacks. An hour or so into the game, 
he receives his golden mace, which also adds special moves to his 
combat arsenal. Again, combat is held back by the lack of anima-
tions and shifts from movement to combat, and between various 
combat animations is extremely jerky and delayed, which means 
that getting the timing right in your attacks is near impossible.

Hanuman: Boy Warrior can be played either in English or Hindi, 
and all dialogues and on-screen prompts will be in your chosen 
language. We played the game for a few minutes at the launch 
party, and recalled how horrible the English was. While playing, 
we chose Hindi, picked the easiest difficulty – Saral – and got on 
our way. We were shocked to find that the script-writing and voice 
acting in Hindi was even worse. Voice acting in particular was 
shockingly bad and sounded like the actors were reading off a 
piece of paper, sometimes without punctuation and almost always 
without any expression.

No matter how hard we look, there’s nothing remotely posi-
tive to write for Hanuman: Boy Warrior. Even if this isn’t a game 
targeted at the serious gamer, there are way too many flaws here 
even to hold a casual gamer’s attention. So it becomes impossible 
to justify at all why anyone should pony up cash for this one, even 
if it does cost only 500 bucks. If you’re feeling generous and would 
like to support the Indian gaming industry and its first console 
game, then pick this up. But if you intend to actually play it, save 
your money for one of the many other quality PS2 titles available 
for the same price. n

readersletters@thinkdigit.com

Score: 1/10

Genre: Third person action
Platform: PlayStation 2
Studio: Aurona Technologies
Publisher: Sony Computer Entertainment
Number of players: 1
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Aditya Madanapalle

Xmoto 
Xmoto is one of those few 
Linux games that manage to 
outshine the Windows coun-
terparts. Xmoto is based on 
an old Windows game called 
Elastomania, both games 
involve guiding a motorcycle 
through a demanding set of 
obstacles. Xmoto comes with 
a lot of levels to begin with, 
and you will have to employ 
a wide range of tricks to cross any given level. At first, the graphics 
might look very stupid, the proportion of the biker to the bike is 
horribly wrong. That itself, is an aspect of the game-play, as you 
will quickly learn. The game looks deceptively simple, as control-
ling the bike on later levels gets increasingly difficult. Balancing 
the bike, flipping it around at the right time, and riding on the 
back wheel are elementary skills and there are plenty of surprises 
headed your way. Each level is also a puzzle, and you will be forced 
to use all the creativity you possess to cross it. Another element 
of game-play is beating the high score, which is the shortest time 
anyone has taken to cross the level. There are a whole range of 
maps that can be downloaded from the internet, and if you main-
tain a connection, you can compare your shortest times with other 
players around the world.  

Gbrainy 
Gbrainy is a casual game, but don’t 
expect to sit back and relax. Gbrainy 
pushes your brain to the limit, 
with a wide range of puzzles and 
problems that you have to solve. 
There are three types of game-play 
to choose from; logic, calculation 
and memory. When you choose one 
of these, a puzzle shows up, and 
you have to solve it. Within the 
framework, the puzzles are very 
ingenious. By far, the best game-play 
is offered by the memory games. A 
grid of twelve words will be thrown 
up, then will disappear after half a minute. Then a grid of eleven 
words will be thrown up, and your task is to identify the missing 
word. Directions will be given which you have to interpret, or 
a grid of colours that you have to memorise and replicate. You 
can also choose to play a mix of the three game modes, which 
will throw up a random puzzle each time. Once you are done, 
you can click on finish to get a score reading across the different 
game modes. This score includes the number of games played, the  
win/loss ratio, and the number of time taken for each game. The 
more you play, the smarter you get.   

Gltron 
There are many tron games available, and a lot of them for Linux, as 
the sci-fi fan base is bound to use the OS. Gltron is one of the simpler 

versions, which is nonetheless very addictive. The object of the game 
is to guide a lightcycle through a 
grid, while avoiding three other 
lightcycles. Each lightcycle leaves 
behind a trail, which becomes 
a wall, and which cannot be 
crossed. Your task is to outlast 
the other lightcycles, without 
hitting any of the light trails or 
the walls. At first, players will be 
focusing on staying alive instead 
of confusing the AI into crash 
into a wall. The game uses OpenGL to render the lightcycles and the 
trails, and the game itself looks like something a h4xx0r would have 
wet dreams over.   

Xweltris
Imagine a cube of Tetris, without the top face. The bricks come down 
from the top face, the player has to guide the bricks along the walls 
and settle them on the floor. The game gives the illusion of drop-
ping tetris bricks down a well. 
Traditionally, Tetris let you play a 
game with all possible combina-
tions of four squares. This game, 
lets you go all the way till sixtris, 
and lets you play all possible 
combinations of anywhere from 
two to six bricks. Calculate the 
number of possible bricks. Now, 
your aim is to make rows along 
the bottom face. However, if you exceed the bottom space, the bricks 
leak onto one of the four walls, and the walls get locked. Wait, it gets 
more complicated. As you successfully make rows, you level up. Every 
time you level up, the well adds a layer, and then twists as it reaches 
the bottom. The more you level up, the more twisted the game gets. 

Pingus 
Pingus is a real time strategy games involving penguins that have 
to be guided through a level. Individual penguins (or pingus) 
can be given specific tasks to cross a particular obstacle. These 
actions include building bridges, jumping across short gaps, 
digging holes, bashing through walls, floating down from high 
places and exploding on a timer. 
The game has a storyline with 
twenty two levels that have to 
be crossed. Figuring out the best 
way to cross the level is the chal-
lenge, and the game periodically 
focuses you to think out of the 
box. Many levels force you to kill 
as many pingus as you save, and 
some levels can be crossed with-
out losing a single pingu if you can think it out. In typical Linux 
fashion, at least seventy more levels are hidden away despite being 
packaged with the game. You will have to load them up from the 
filesystem. There is a level editor, and a lot of user made levels 
available on the internet. n

aditya.madanapalle@9dot9.in     

MOST ADDICTIVE 
LINUX GAMES 

These are small games that takes under  five minutes to download and install even on the most 
meagre internet connections. That does not stop them from excelling in gameplay 

The Quake III game engine get-
ting GPL’d was the best thing to  
happen to Linux gaming. Alien 
Arena and Warsow are two great 
Q3 based free games for Linux.  
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Geek culture : Hard Sci-Fi
Hard sci-fi is a genre of science fiction, where the science within 
the plots, or gameplay is highly accurate. Hard sci-fi typically 
involves a team of scientists or space explorers playing the main 

characters, and possibilities of future developments in exist-
ing technology is explored thoroughly. The social, political and 
economic aspects are also depicted. We’ve come across books 
where equations play a part in the plot. Hard sci-fi does not mean 
that you need multiple doctorates to understand the fiction, just 
that the technologies involved are explained in detail. 

Contact (1997) 

An advanced civilisa-
tion receives TV signals 
from the earth and 
beams back plans to 
construct a device that 
will take one human on 
an unforgettable journey. 

2001: A Space 
Odyssey (1968)

Probably the most 
accurate depiction of 
space exploration in 
cinema, this movie was 
so influential that some 
astronauts reported 
the monolith on the Moon. 

Gattaca (1997)

The consequences of 
genetic engineering is 
explored. In this future 
Earth, your place in 
society is decided by 
your genetic makeup. 

The Nanotech 
Chronicles

Michael Flynn explores 
the fallout of the advent 
of nanotechnology on the 
human race. The stories 
trace the research, tests, 
deployement and impact of 
the technology. 

A Fall of Moondust

Arthur C Clarke’s master-
piece about a lunar tourist 
vehicle that gets trapped 
in moon dust. A dramatic 
rescue attempt by scien-
tists on the Earth and the 
Moon follows. 

The Mars Trilogy

Kim Stanley Robinson’s 
three books, Red Mars, 
Green Mars and Blue Mars 
chronicle mankind’s efforts 
to change the face of the 
red planet and make it 
habitable. 

Drake Equation

The Drake equation is 
an often used equation 
by Dr. Frank Drake, to 
calculate the number 
of civilisations in 
the galaxy that can 
communicate with 
humans. 

Occam’s Razor

The Occam’s Razor is 
the rule of the thumb 
for all Hard sci-fi, which 
states that the simplest 
possible explanation 
is probably the correct 
one. 

Clarke’s Third Law

The law simply states 
that “Any sufficiently 
advanced technology is 
indistinguishable from 
magic.” The law has 
seeped firmly into the 
subconsciousness of 
every sci-fi fan out there. 
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Movies
Little Zizou: A Parsi boy’s views 
on his community.
Sita Sings the Blues: A free 
animated feature length movie 
about an epic breakup. 

Music
The Dark Side of Phobos: A free 
electronica album with tracks 
from Doom remixed. 
Stadium Arcadium: The team 
can’t have enough of RHCP. 

Game 
Fallen Earth (Closed Beta): An 
MMO in a post-apocalyptic 
America.
Heretic II: One of the classics we 
still like to play. 

April was a month of wishful thinking for the team. Technology 
almost always fell short of the team’s high expectations. Vijay 
came back after a short sabbatical, and was drowned in a large 
amount of work, making him instantly wish he was back in 
America. Raaabo wanted cloning technology to be available 
on a commercial basis, so we could have more people like 
Vijay. Rossi wanted the dSLRs to come out with models for 
left-handed people, as only the right-handed people could hold 
these cameras in the “correct” position. Kumar wished to win 

at table tennis, but Siddharth beat him at zero. Nash wished for 
a new computer so he could play multiplayer games with the 
team, and got one too. Michael wished he would permanently 
get to keep the ergonomic chairs that came in for testing. A 
little into the month, he wished the ergonomic chairs hadn’t 
come in for testing in the first place, as he had a tendency to 
nod off when he was sitting in one of them. Aditya wished the 
Republic would have cloned Rajnikanth instead of Jango Fett. 
Everyone has something ready for the next time they see a 
shooting star, or find one of those magic lamps. 

Astronauts and cosmonauts 
aboard the ISS also fight over 
who gets to use which toilet. 
The official policy now is that 
each team has to use their own 
national toilets. 

Digit Diary
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for those who came in late

Muddled by so many terms used in the mag? Here’s your 
short guide 

 TED (Technology, Entertainment and Design): An annual invita-
tion only conference where industry leaders come together 
to discuss the latest innovations.  

Gartner Inc: A firm that is the leader in analysing technology 
trends. They are leading technology consultants, for statis-
tics, figures and market analysis.  

Botnet: A network of computers infected by a trojan or worm, 
maliciously controlled by hackers for denial of service 
attacks, infiltrating secure networks and other criminal 
activities.  

VGA (Video Graphics Array) : The global standard for the mini-
mum video specifications on any modern display system. 
Supports a basic 640x480 display resolution.  

Swap Space: Processes running on a system store memory in 
the swap space, where the memory is cycled according to the 
needs of the programs operating on the computer. 

SLR (Single Lense Reflex): A type of digital or analogue camera, 
where parallax error is removed completely by using a prism 
or mirror to direct the light coming into the lense to the 
viewfinder. 

Toggle: Switching from one mode or state to another. 

Vector art uses lines and shapes for creating graphics. All the 
elements in a piece of vector art work can be defined using 
co-ordinates and matehmetical formulae. Vector artwork can 
be resized to fill any dimensions, and stay as clear. Vector art 
work itself varies in style, from minimalistic design to elaborate 
artwork with many layers. Generally, vector art has much of the 
same design sensibilities as Web 2.0, with bright contrasting 
colours, and highly detailed elements set against plain back-
grounds. Two great places to find vector art is www.deviantart.
com and www.pixelgirl.com. Head over to www.jthreeconcepts.com 
for more from this artist. 

tech art

Lateral universe 
GOOGLE 2.0 BETA 
The symantec web is here with the 
launch of Google 2.0 beta. The highly 
expanded version of the search engine, 
now crawls into the deep web, includ-
ing bionic implants and government 
databases. Words in videos and lyrics in 
songs are also a part of the search database. Tax, phone and credit 
records are just a click away from now on. 

Tinyurl roulette
Do this right now. Go to the address bar of your favourite web 
browser, and type in http://tinyurl.com/ followed by one of the 
codes below. In case you are wondering where it will take you 
— we are not telling; we probably don’t know ourselves! Are you 
bold enough to find out? 

59qmg4	 c5k2ok	 dgjj88  
2v7dfw	 26mcws	 663s9d  
3m8xj	 cmtpah	 c34qw6 
jqm2	 c7fw3e	 bxc9lt

Don’t dump that  
old phone 

You never know when a bug or glitch in an old phone turns 
out to be a very profitable feature. Criminals in Europe are appar-
ently paying twenty five thousand Euros for a particular model. 
The Nokia 1100 had nothing distinct about it, except perhaps 
a flashlight on the top and a software bug that allowed you to 
cheat on snake and score incredibly high scores. (When the snake 
dies, cancel the game, navigate to the tournament mode, play 
a bit, cancel and come back, your snake lives, and your score is 
preserved). Apparently, some 1100s can be hacked and be cloaked 
with another number. Once this is done, messages meant for 
someone else will be delivered to the tampered model. This allows 
criminals to pretend they are someone else, and intercept their 
transactions during mobile banking. The model has to be made 
in Germany for this to work though. However, if you have a 1100 
lying around, it’s a good time to sell it on eBay. It’s ok to cheat a 
criminal right?  

Astronaut claims  
Aliens exist

UFO enthusiasts and believers are normally ignored as quacks 
and hacks, liable to go to prison if their blood is tested. Increasing 
the credibility of UFOlogists around the world, by something like 
a factor of infinity, are the claims of ex-Apollo astronaut Edger 
Mitchell. Edger Mitchell was one of the most sucessful astronauts 
on NASA’s moon missions, accomplishing the longest moon walk 
by any human.

Edger Mitchell claimed in a Radio show, that the govern-
ment and NASA were covering up Alien visitations. He says the 
Aliens are here, with superior technology, and are “little people”, 
with large heads, large, pupil-less eyeballs and basically the typi-
cal “greys” that UFOlogists see floating over every empty field. 
Mitchell grew up in Rosswell, which would explain a lot. He says 
locals didn’t want government cover-ups to die with them, so 
they told the most reputed person they knew all about it. NASA 
released a statement saying that they don't track UFOs. 

?

NEWS

The owners of Pirate Bay  
arrested and sentenced to one 
year in prison, but the web site  
is still up and running.

The latest trend to hit the web? 
Japanese bug fights, where 
insects fight each other to death 
in a small plastic arena. 
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“Why do some 
criticise the use of 
a promoter gene 
from the tobacco 
mosaic virus?”

I
Semantic search

edward.henning@9dot9.in

I have been hearing for some time now 
that we will soon be seeing many new 
search engines, and that Google’s days are 
numbered. Given what I have seen and read 
so far, the developers at Google need not lose 
much sleep.

I met up recently with Anand Rajaraman, 
one of the founders of kosmix.com, a new 
search engine. I have to say that I am deeply 
unimpressed by the engine — it seems to 
give very superficial results and leans far 
too heavily on the sometimes unreliable 
Wikipedia. But, the developers have some 
good ideas. The engine is editorialised: it 
makes use of about 1,00,000 sites that the 
team has decided are reliable.

This means that if the subject of interest 
is something they have not considered, or 
might be found on a site with which they are 
not familar, your search will miss out. Now, 
the developers claim that if you want specific 
information then perhaps you should use 
Google, but if you want “content based on 
the underlying concept” then you should use 
Kosmix. I have not figured out what that is 
supposed to mean, but if the subject is not 
covered in those 1,00,000 sites, then you will 
get nothing. If the engine cannot find what 
you want, it serves up Google results — it is 
very easy to enter a query that produces such 
a result. This site brings new meaning to the 
term Limited Area Search Engine. (Look it 
up; but don’t use Kosmix. Actually do, and 
you’ll get only Google results; at least I did 
while writing this!)

One point on which I agreed with 
Kosmix’s Anand Rajaraman was with regard 
to semantic search and the semantic web. 
He is sceptical of them both, and Kosmix is 
certainly not a semantic search engine. The 
idea behind such a search engine is that it will 
appear to understand questions and produce 
appropriate results. For example, you may 
be interested in a controversy related to GM 
foods, and want to ask the question “Why 
do some criticise the use of a promoter gene 
from the tobacco mosaic virus?” Type some 
of those words into Google and you will get a 
mix of results; go through a few of them and 
you will almost certainly find the answer. A 
semantic search engine should, however, get 
you straight to the right answer.

So, why the scepticism? In the long run, 
I think we will have semantic interfaces for 
our computers, the internet, probably our 
cars and TVs as well. It is just that the meth-
ods currently described — most famously by 
the web founder Tim Berners-Lee — seem to 
rely too much on people building semantic 
expression into web content. That might 
work well for a scientific paper database, 

or genome project, but for the general web? 
Some would have us all entering semantic 
tags into content so that search engines can 
glean a deeper understanding of the content 
and answer more detailed questions, but I 
just do not see that happening. The work 
involved in creating the content is just too 
specialised and too time consuming — and 
what about all the existing content out 
there? Who is going to go and convert is all 
into some kind of semantic XML?

Their soon to be released (May) new 
system is not a search engine but a “compu-
tational knowledge engine”. We will look 
into this in more detail in a future edition 
of Digit, but for now, the interesting point is 
that this engine will accept natural language 
questions about factual subjects and then 
compute an answer. Note the verb — compute. 
It does not look up pre-prepared answers in 
some kind of database; instead, it computes 
the answer on the basis of a huge quantity of 
prepared data.

The limitation here lies in the data that 
have been chosen and prepared and the 
algorithms that have been engineered for 
answering particular types of questions. It 
is said to be particularly good at scientific 
subjects and mathematics, but also subjects 
such as economics and cookery.

Not many details have been released 
yet, and it is unclear how broad will be 
the spread of data that Wolfram Alpha will 
cover; how and how quickly will it incorpo-
rate new data; how will it handle facts that 
are in dispute (something that Wikipedia is 
spectacularly bad at doing)?

However, the approach that is being 
taken is very promising, and it looks as 
though this is going to be a very useful 
tool. But one that will be used alongside 
Google, and not instead of it. Search is not 
the only thing that we need to do with the 
vast amount of information available on 
the internet. We do not really need better 
or different search engines like Kosmix, but 
we do need other ways of interacting with 
all that information, and the new Wolfram 
system looks promising.
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